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SAFETY SUMMARY 

The following general safety precautions must be observed during all phases of 
operation, service and repair of this instrument. Failure to comply with these 
precautions or with specific warnings else where in this manual violates safety 
standards of design, manufacture, and intended use of this instrument. Hewlett-Packard 
Company assumes no liability for the customer's failure to comply with these 
requirements. 

Safety Classification 

This is a Safety Class I instrument (provided with terminal for protective grounding). 

Operation. 

BEFORE APPLYING POWER, verify that the line voltage select switch is set to match 
the power transformer primary to the avaiJable line voltage, the correct fuse is installed, 
and safety precautions are taken (see the following warnings). 

Ground the Instrument. 

To minimize shock hazard, the instrument chassis and cabinet must be connected to an 
electrical ground. The instrument is equipped with a three-conductor ac power cable. 
The power cable must either be plugged into an approved three-contact electrical out.let 
or used with a three-contact to two-contact adapter with the grounding wire (green) 
firmly connected to an electrical ground (safety ground) at the power outlet. The 
power jack and mating plug of the power cable must meet International 
Electrotechnical Commission (lEC) safety. standards. 

Use correct fuses. 

Only fuses with the required rated current, voltage, and specified type (normal blow, 
time deJay, etc.) should be used. Do not use repaired fuses or short circuited fuse 
holders. To do so could cause a shock or fire hazard. 

Do not operate in an explosive atmosphere. 

Do not operate the instrument in the presence of flammable gases or fumes. Operation 
of any electrical instrument in such an environment. constitutes a definite safety hazard. 
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Keep away from live circuits. 

Operating personnel must not remove instrument covers. Component replacement and 
internal adjustments must be made by qualified maintenance personnel. Do not replace 
components with power cable connected. Under certain conditions, dangerous voltages 
may exist even with the power cable removed. To avoid injuries, always disconnect 
power and discharge circuits before touching them. Capacitors inside the instrument 
may still be charged even if the instrument has been disconnected from its source of 
supply. 

Use caution when exposing or handling the CRT. 

Breakage of the Cathode-Ray Tube (CRT) causes a high velocity scattering of glass 
fragments (implosion). To prevent CRT implosion, avoid rough handling or jarring of 
the instrument. Handling of the CRT shall be done only by qualified maintenance 
personnel using approved safety mask and gloves. 

Do not service or adjust alone. 

Do not attempt internal service or adjustments unless another person, capable of 
rendering first aid and resuscitation, is present. 

Do not substitute parts or modify instrument. 

Do not install substitute parts or perform any unauthorized modification to the 
instrument. 
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PRINTING HISTORY 

Each new edition of this manual incorporates all material updated since the previous 
edition. Manual change sheets are issued between editions, allowing you to correct or 
insert information in the current edition. 

The part number of the manual changes only when each new edition is published. 
Minor corrections or additions may be made as the manual is reprinted between 
editions. 

First printing Feb 1986 

Second printing Mar 1987 
Update manual to new revision system software. 
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CERTIFICATION 

Hewlett-Packard Company certifies that this product met its published 
specifications at the time of shipment from the factory. Hewlett-Packard further 
certifies that its calibration measurements are traceable to the United States 
National Bureau of Standards, to the extent allowed by the Bureau's calibration 
facility, and to the calibration facilities of other International Standards 
Organization members. 

WARRANTY 

This Hewlett-Packard product is warranted against defects in material and 
workmanship from the date of delivery. The standard warranty requires the product 
to be returned to a service facility designated by HP and is in effect for one year 
from the date of shipment. An optional 90-day, on-site repair warranty is also 
available. 

For products returned to HP for warrnnty service, Buyer shall prepay shipping 
charges to HP and HP shall pay shipping charges to return the product to Buyer. 
However, Buyer shalt pay all shipping charges, duties, and taxes for products 
returned to HP from another country. 

HP warrants that its software and firmware designated by HP for use with an 
instrument will execute its programming instructions when properly installed on 
that instrument. HP does not warrant that the operation of the instrument, or 
software, or firmware will be uninterrupted or error free. 

Limitatiof! of Warranty 

The foregoing warranty shall not apply to defects resulting from improper or 
inadequate maintenance by Buyer, Buyer-supplied software or interfacing, 
unauthorized modification or misuse, operation outside of the environmental 
specifications for the product, or improper site preparation or maintenance. 

NO OTHER WARRANTY IS EXPRESSED OR IMPLIED. HP SPECIFICALLY DISCLAIMS THE IMPLIED 
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. 

Exclusive Remedies 

THE REMEDIES PROVIDED HEREIN ARE BUYER'S SOLE AND EXCLUSIVE REMEDIES. HP SHALL NOT 
BE LIABLE FOR ANY DIRECT, INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES, 
WHETHER BASED ON CONTRACT, TORT, OR ANY OTHER LEGAL THEORY. 

ASSISTANCE 

Product maintenance agreements and other customer assistance agreements are 
available for Hewlett-Packard products. 

For any assistance, contact your nearest Hewlett-Packard Sales and Service Off ice, 
Addresses are provided at the back of this mnnual. 
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Safety Classification 
This is a Safety Class 

grounding). 

Operation. 

SAFETY CONSIDERATIONS 

instrument (provided with terminal for protective 

BEFORE APPLYING POWER, verify that the line voltage select switch is set to match 
the power transformer primary to the available line voltage, the correct fuse is 
installed, and safety precautions are taken (see the following warnings). In 
addition, note the instrument's external markings which are described under "Safety 

Symbols". 

Ground the Instrument. 
To minimize shock hazard, the instrument chassis and cabinet must be connected to 

an electrical ground. The instrument is equipped with a three-conductor ac power 

cable. The power cable must either be plugged into an approved three-contact 

electrical outlet or used with a three-contact to two-contact adapter with the 

grounding wire (green) firmly connected to an electrical ground (safety ground) at 

the power outlet. The power jack and mating plug of the power cable must meet 
International Electrotechnical Commission (IEC) safety standards. 

Do not operate in an explosive atmosphere. 
Do not operate the instrument in the 
Operation of any electrical instrument 
definite safety hazard. 

Keep away from live circuits. 

presence of f lammabte gases or fumes. 
in ;such an environment constitutes a 

Operating personnel must not remove instrument covers. Component replacement and 

internal adjustments must be made by qualified maintenance personnel. Do not 
replace components with power cable connected. Under certain conditions, dangerous 

voltages may exist even with the power cable removed. To avoid injuries, always 
disconnect power and discharge circuits before touching them. Capacitors inside the 

instrument may still be charged even if the instrument has been disconnected from 
its source of supply. 

Use caution when exposing or handling the CRT. 
Breakage of the Cathode-Ray Tube (CRT) causes a high velocity scattering of glass 

fragments (implosion). To prevent CRT implosion, avoid rough handling or jarring 

of the instrument. Handling of the CRT shall be done only by qualified maintenance 
personnel using approved safety mask and gloves. 
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Do not service or adjust alone. 
Do not attempt internal service or adjustments unless another person, capable of 
rendering first aid and resuscitation, is present. 

Use correct fuses. 
Only fuses with the required rated current, voltage, and specified type (normal 
blow, time delay, etc.) should be used. Do not use repaired fuses or short 

circuited fuse holders. To do so could cause a shock or fire hazard. 

Do not substitute parts or modify instrument. 
Do not install substitute parts or perform any unauthorized modification to the 

instrument. 

_J_ 

WARNING 

SAFETY SYMBOLS 

Instruction manual symbol: The product will be marked with this 
symbol when it is necessary for the user to refer to the instruction 

manual in order to protect against damage to the product. 

Indicates hazardous voltages. 

Earth terminal (sometimes used in manual to indicate circuit common 
connected to grounded chassis). 

I The WARNING sign denotes a hazard. It calls attention to a 
procedure, practice, or the like, which, if not correctly performed 

•••••••or adhered to, could result in personal injury. Do not proceed 

beyond a WARNING sign until the indicated conditions are fully 

understood and met. 

The CAUTION sign denotes a hazard. It calls attention to an 

operating procedure, practice, or the like, which, if not correctly 

performed or adhered to, could result in damage to or destruction of 

part or all of the product. Do not proceed beyond a CAUTION sign 

until the indicated conditions are fully understood and met. 

IX 



PRINTING HISTORY 

Each new edition of this manual incorporates all material updated since the previous 
edition. Manual change sheets are issued between editions, allowing you to correct or 
insert information in the current edition. 

The part number of the manual changes only when each new edition is published. 
Minor corrections or additions may be made as the manual is reprinted between 
editions. 

First printing ..... Feb I 986 
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CHAPTER 1 

USING THIS MANUAL 

The HP 4971S manual is divided into two volumes: GETTING STARTED and 
OPERATING THE HP 497lS. GETTING STARTED is an installation and beginning 
operation guide. Follow the chapters in sequence in GETTING STARTED to learn 
what accessories and options are available for the protocol analyzer, how to install the 
different devices making up your system, and finally how to begin operating the system. 
Also included in GETTING ST ART ED is an introduction to local area networks 
(LANs) and to the HP 497 lS LAN Protocol Analyzer. 

The second volume, OPERATJNG THE HP 4971S, is a reference section. This volume 
covers in detail the softkey guided menus used to control the operation of the protocol 
analyzer. Each major softkey function is covered as a separate chapter. 

This chapter includes: 

• The GETTING STARTED Volume 

Chapter Descriptions 

• OPERA TING THE HP 497 IS Volume 

Chapter Descriptions 

• Softkey Conventions 

Softkey Designation 
Sof tkey Levels 
Other Choices 
Toggling Softkeys 
Active Sof tkeys 

• Editing With Keyboard Keys 

• Repeating Keys 

• Text Entry Conventions 
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Using This Mamwl 

The GETTING STARTED Volume 

Chapters in this volume describe the HP 497 lS system's features and how to install the 
system. Afler installation is complete, instructions are given to install the operating 
system software. 

An introduction to LA N's and the HP 4971 S LAN Protocol analyzer follmvs the 
installation and beginning operation steps. These sections will give helpful background 
information to you if you are new to LANs or protocol analyzers. 

CHAPTER DESCRIPTIONS 

The GETTING ST ART ED volume includes the chapters: 

Chapter 1 

Chapter 2 

Chapter 3 

Chapter 4 

Chapter 5 

Using This Manual 
This chapter describes the functions of the manual supplied 
with the HP 4971S. Softkey and keyboard conventions used in 
the manual are discussed. 

Product Information 
This chapter describes the devices that make up an HP 4971S 
system. Included are operating characteristics of the protocol 
analyzer system and the specifications for the individua I 
devices. The accessories and options available for the HP 
497 lS are listed. 

Site Preparation 
This chapter describes the requirements of the site where the 
protocol analyzer is to be installed. 

Installation 
This chapter describes how to install each of the devices used 
in the HP 497 lS system. 

Getting Started 
This chapter describes how to install the operating system 
software. 
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Chapter 6 

Chapter 7 

Chapter 8 

Appendix A 

Index 

Using This Manual 

Introduction to LANs 
This chapter provides an introduction to Ethernet Local Area 
Networks. 

Introduction to HP 4971 S 
This chapter describes the basic functions of the HP 497 JS. 

Preventative Maintenance 
This chapter describes the preventative maintenance that may 
be performed on the HP 497 lS devices. A common 
replaceable parts list is included. 

Glossary of LAN Terms 
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Using This Manual 

The OPERATING THE HP 49715 Volume 

In the OPERATING THE HP 4971S volume, each chapter describes a major function 
of the protocol analyzer that may be selected by softkeys shown at the bottom of the 
display. 

Chapter introductions 

An introduction is presented in each chapter to help you understand the purpose or 
application for that function. You may also want to read the Introduction To LANs 
and Introduction To The HP 4971S chapters in the GETTING STARTED volume to 
help you understand more about protocol analyzer applications. 

Softkey selections 

In each chapter, a chart is provided to show the different soft.key selections for that 
function. Softkey levels are indicated by indenting the softkeys on the chart. An 
indented softkey indicates that the previous level softkey has to be selected before you 
can access the next lower key. 

For example: 

Setup HP 4971S 

Monitor Network 
Execute Program 

Edit Node List 
Edit Fi Lters 
Edit Programs 
Edit Messages 

In this example, you must press the <Setup HP 497 lS> softkey before <Edit Node List>, 
<Edit Filters>, etc. can be selected. 

Softkey descriptions 

In each chapter, the softkeys available for that function are described. The softkey 
descriptions are presented in the approximate order they appear on the selection charts 
from top to bottom. In some menus, the descriptions are grouped by the tasks available 
under that softkey function. 
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OPERATING THE HP 4971S CHAPTER DESCRIPTIONS 

Each chapter in this volume describes a particular softkey function. The chapters are 
presented in the sequence the softkeys are displayed on the HP 497 lS. 

Chapter 9 

Chapter 10 

Chapter 11 

Chapter 12 

Chapter 13 

Chapter 14 

Top Level Menu 
This chapter describes the choices available from the top level 
menu. 

<Setup HP 4971 S> Menu 
This chapter describes the softkey functions available to 
configure or setup the HP 497 l S to perform its primary 
functions. 

<Edit Node List> Menu 
A node list may be created that identifies the addresses on a 
network by their function or by their user name. 

<Edit Filters> Menu 
Filters may be created to screen or control what network 
frames are stored into the protocol analyzer. Filters may also 
be used to control the protocol analyzer programmed 
operation. 

<Edit Programs> Menu 
You can create programs to control the operation of the 
protocol analyzer. 

<Edit Messages> Menu 
You can create messages to simulate operation of other nodes 
on the network. Messages can simulate a request to another 
node or they can simulate a response to another nodes inquiry. 
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Using This Manual 

Chapter 15 

Chapter 16 

Chapter 17 

Chapter 18 

Chapter 19 

Chapter 20 

Chapter 21 

<1/0 Functions> Menu 
An HP 4971S can be used with another HP 4971S to form a 
master/slave combination that lets you test a LAN from a 
remote location. 

<Execute Program> Menu 
Programs you have created can be run on frames currently 
appearing on the network cable or a program can be run to 
analyze frames already stored in the protocol analyzer. 

<Monitor Network> Menu 
A very quick and simple softkey selection lets you immediately 
begin using a protocol analyzer to let you view frames 
occurring on your network. 

<Disc Functions> Menu 
A floppy disc or hard disc can be used for mass storage of 
network frames captured in the protocol analyzer. ln addition, 
different protocol analyzer setup or configuration files can be 
stored on the disc. 

<Examine Data> Menu 
After network frames are stored in the protocol analyzer, they 
may be viewed in different formats for easy recognition of 
frame patterns and contents. 

<Printer Functions> Menu 
Hard copies may be made of the protocol analyzer screen 
contents, the HP 497 lS setup menus, as well as stored data. 

<Test Hardware> Menu 
Several hardware self tests for the instrument portion of the 
protocol analyzer may be chosen by softkey selection. 
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Chapter 22 

Appendix B 

Appendix C 

Appendix D 

Index 

Using This Manual 

<Set Date-Time> Menu 
At each power-on cycle, you can set the date and time. This 
information is used to timestamp when frames are received 
and when files are stored on the disc. 

ASCII, EBCDIC Character Conversion Tables 

Error Messages 
When incorrect operation is performed with the protocol 
analyzer an error message is displayed. An explanation and 
possible causes of the error are described. 

Execution Times for Program Instructions 
Approximate execution times for program instructions are 
listed. 
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Softkey Conventions 

The HP 4971 S lets you use softkeys shown on the display to control its operation. 
When you turn the system power on, the instrument portion of the HP 4971 S system 
goes through a self test. After the self test is completed, a "Top Level Menu" is shown. 
This menu is sho\.vn below. 

Setup 
HP 4971S 

HEWLETT PACKARD 

49715 
LAN PROTOCOL ANALYZER 

Revision: 1.0 

1 Mar 86 00:00:00 

4971S power-on self-test PASSED 

Execute Monitor 
Program Network 

Disc Examine OTHER 
Functions Data CHOICES 

From the Top Level Menu, you can use the softkeys shown at the bottom of the 
display to select primary functions that control the protocol analyzer. As you press any 
one of these softkeys, you will cause the display to change to new softkeys used to 
control the function you ha ve'n chosen. 
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SOFTKEY DESIGNATION 

Softkeys are indicated in the manual by enclosing the softkey word(s) with the <> 
characters. The list below shows examples of softkeys displayed in the Top Level 
Menu: 

SOFTKEY LEVELS 

<Setup HP 4971S> 
<Monitor Network> 
<Examine Data> 

From the Top Level Menu, when you press any labeled softkey, you branch to new 
softkeys to control that particular function. Some of the function menus may branch 
to several levels as you press the different softkeys. To escape from a lower level menu 
display, press the <EXIT> softkey until you return to the primary menu display for that 
function. If you press the <EXJT> softkey again, you return to the Top Level Menu. 
For Example: 

<Setup HP 4971S> 
<Edit Node List> 
<Edit Filters> 
<Edit Programs> 
<Edit Messages> 

From the Top Level Menu, if you select <Setup HP 4971S> softkey, you will see the 
choices shown above. If you select one of these choices, you will branch to new 
softkeys for that function. If you continue to make selections from new softkeys 
displayed, you can continue branching to even lower levels. 

It is easy to escape or return to an upper level menu, just repeat pressing the <EXIT> 
softkey until you have returned to the level you want. 

To go to another HP 4971S function, you have to return to the Top Level Menu and 
then select the next softkey function you want:. 
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<OTHER CHOICES> SOFTKEY 

Some menus have more softkey selections than can be shown on one display. When 
this occurs, the softkey <OTHER CHOICES> is displayed. Press <OTHER CHOICES> 
to display additional softkeys available in that menu. 

TOGGLING SOFTKEYS 

Some softkeys have an on-off toggle capability. 

These keys are marked by an asterisk (*) when they are on. Press the soft.key again to 
turn the function off and the asterisk is removed. Not all keys with an asterisk will 
toggle. 

ACTIVE SOFTKEYS 

When the cursor is positioned in some fields, several choices are displayed as softkeys to 
control that field. An asterisk (*) is automatically displayed in one of the softkeys to 
show the currentiy selected choice. When you select another softkey for that field, the 
asterisk will move to that softkey. 

Examples of softkeys marked by an asterisk when they are active include: 

<Show Node Names*> <Show Hex Addresses> 

<ASCII 7> <ASCII 8*> <EBCDIC> 

<Detailed Format*> <Summary Format> <Filter Format> 
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Editing With The Keyboard Keys 

Several of the keys on the keyboard may be used to edit the display of the protocol 
analyzer. In this manual, these keys are denoted by using all capital letters for the key. 

ARROW-DOWN moves the cursor down to the next available field. 

ARROW-HOME 

ARROW-LEFT 

is the key with a diagonal arrow symbol. In general, this key 
causes the cursor to move to the field nearest the upper left 
corner of the display. 

<Edit Nodelist> 
In <Edit Nodelist> Menu, this key moves the cursor to the 
beginning of the node list. 

<Edit Programs> 
Jn <Edit Programs> Menu, this key moves the cursor to the 
"Store:" command at the beginning of the program. 

<Examine Data> 
Jn <Examine Data> Menu, this key shows the first frame in the 
buff er at top of the display. 

<Edit Messages> <Format As Filter> 
<Edit Filters> <Edit All Fields> 

In these menus, ARROW-HOME key moves the cursor to the 
first byte of the Destination Address Field. 

<Edit Messages> <Edit Datafield> 
Jn this menu, ARROW-HOME key moves the cursor to the 
first byte of the Data Field. 

moves the cursor to the left within a field. After reaching the 
left end of a field, the arrow key moves the cursor to the next 
field if another field is available on the same line. 

To quickly move the cursor to another field, use the TAB key 
or the UP-ARROW /DOWN-ARROW keys. 
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ARROW-RIGHT 

ARROW-UP 

CLEAR LINE 

DELETE CHAR 

DELETE LINE 

INSERT CHAR 

INSERT LINE 

moves the cursor to the right within a field. After reaching 
the right end of a field, the arrow key moves the cursor to the 
next field if another field is available on the same line. 

To move the cursor to another field, use the TAB key or the 
UP-ARROW /DOWN-ARROW keys. 

moves the cursor up to the next available field. 

clears the alphanumeric field currently marked by the cursor. 
CLEAR LlNE resets numeric fields to zero. 

In some fields, this key deletes the character marked by the 
cursor. 

In some menus, this key deletes the current line marked by the 
cursor. The line immediately below the cursor is moved up to 
the cursor position. 

in "label" fields, this key provides a space where the cursor is 
located. You can then enter a new character from the 
keyboard. INSERT CHAR must be pressed each time a 
character is to be added. 

<Edit Node List> 
The INSERT LINE key inserts a new node having the default 
protocol analyzer values. 

<Edit Programs> 
The INSERT LINE key inserts a blank line before the current 
cursor position. 
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NEXT 

PREV 

Using This Manual 

<Examine Data> 
The NEXT keyboard key acts similar to the <Next Frame> 
softkey in the <Examine Data> Menu. It advances the display 
to the next frame in the buffer memory. 

When the <Scroll Marked> softkey is selected, only marked 
frames are displayed. After the display stops scrolling, the 
NEXT key advances the display to the next marked frame. 
The key skips over any unmarked frames. 

<Edit Node List> 
<Edit Messages> 
<Edit Programs> 
<Disc Functions><List Directory> 

The NEXT key advances the display to the next page. 

<Examine Data> 
The PREVlOUS keyboard key acts similar to the <Previous 
Frame> softkey in <Examine Data> Menu. It moves the 
display down with a new frame being displayed at the top of 
the screen. 

When the <Scroll Marked> softkey is selected, only marked 
frames are displayed. After the display stops scrolling, the 
PREVIOUS key advances the display to the previous marked 
frame. The key skips over any unmarked frames. 

<Edit Node List> 
<Edit Messages> 
<Edit Programs> 
<Disc Functions><List Directory> 

The PREY key moves the display to the previous page. 
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RETURN 

TAB 

is used to complete an entry when the protocol analyzer 
prompts you to enter information in a field. 

After you complete an entry and press the RETURN key, the 
cursor moves to the next field. 

You can also use the RETURN key to perform insertions at 
the end of messages, filter, and node lists. 

moves the cursor to the first character in the next available 
field. 

TAB moves the cursor from the last field to the first field. 

Press SHIFT and TAB keys at the same time to move the 
cursor back wards through the fields. When the cursor is in 
the first field of a display, you can use the SHIFT and TAB 
keys to quickly move the cursor to the last field. 
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Repeating Keys 

When keys are held down, the protocol analyzer interprets this as a request to repeat 
the function. 

For example, in the <Edit Node List> Menu, look at the bottom left corner of the 
display as you hold the <Insert Node> softkey down. The hex code for that key is 
displayed. If you continue to hold the key down, the character code will stack along 
the bottom of the display. 

To quickly remove the stacked keyboard keys, press CTRL and BACKSPACE keys at 
the same time until the stacked keys are removed. 
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Text Entry Conventions 

ALPHA AND HEX CHARACTER ENTRY 

For entry fields using alpha or hex characters, when you use the TAB key to move the 
cursor to the field, the cursor is automatically positioned at the left of the field and 
characters you enter are automatically left justified. 

lf you position the cursor in a field with one of the ARROW keys, and enter a 
character, the character is written where ever the cursor is positioned. 

NUMERIC ENTRY (OTHER THAN HEX) 

When you use any key to move the cursor to an entry field using numeric characters, 
the cursor is automatically positioned at the right of the field an<l characters you enter 
are automatically right justified. 

SPACES IN ENTRY FIELDS 

You can enter spaces in name fields such as: node names, program names, disc file 
names, filter names, etc. The spaces are replaced with an underscore character when 
you exit the field. 
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CHAPTER 2 

PRODUCT INFORMATION 

This chapter identifies the HP 497 lS operating characteristics, specifications, product 
structure and accessories. 

This chapter includes: 

• Product Description 

• HP 497 lS Operating Specifications 

• HP 4971S Specifications 

• Accessories Available For The HP 497 lS 

• Recommended Peripherals For The HP 4971 S 

• Accessories Supp1ied With The HP 4971 A 

• Options Available For The HP 4971A 

• Support Services Available 
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Product Information 

HP 49715 Product Description 

The HP 497 lS is a protocol analyzer for troubleshooting on local area networks 
employing Ethernet or IEEE 802.3 protocols on a 10 Mbps baseband coaxial medium. It 
lets you monitor traffic on the network, generate data frames to test other nodes, and 
write programs to verify network performance. For testing remote LANs, an HP 4971 S 
can down load programs via an RS-232C link to another HP 4971 S for troubleshooting 
a LAN in a distant location. The HP 497 lS provides a comprehensive, easy-to-use, 
troubleshooting tool for maintaining a local area network. 

Features: 

HP 49715 
vs 

HP 4971A 

• Analysis of IEEE 802.3 and Ethernet data frames 

• Generation of data frames 

• Softkey-guided programming for user created applications 

• High level naming of node addresses 

• Flexible display formats 

• Up to 20 Mbyte of fixed disc storage 

• Full remote operation 

• Printer output 

• Softkey guided measurements 

In order to be a stand-alone operating system, the HP 4971 S must 
consist of: 
HP 4971A LAN Protocol Analyzer 

Disc Drive 
Display 
Keyboard 

You may also use a printer to get hard copies of displays and copies 
of setup functions defined for the HP 497 lS. 

The HP 4971A term applies directly to the instrument portion of the 
HP 497 lS system. The HP 497 lA consists of an instrument package 
containing a microprocessor board and related hardware 
measurement boards. 
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HP 49715 Operating Specifications 

Protocols 

Interfaces 

Data Transfer 
Rate 

Data Codes 

Data Formats 

Capture Buffer 
Memory 

Mass Storage 

Node Names 

Filters 

Timers 

Counters 

IEEE 802.3, Ethernet 

IEEE 802.3, Ethernet, and other Ethernet compatible 
interfaces. The HP 4971 S will only support media access units 
(MAUs) using receive-based collision detection conforming to 
IEEE 802.3 or Ethernet 2.0 standards. 

10 Mbps. 

ASCII 7,8 and EBCDIC. 

IEEE 802.2, IEEE 802.3, and Ethernet frame formats. 

One Mbyte memory for incoming data that has passed the 
filtering process. Jn terms of actual frame capacity, typically 
storage of 655 frames independent of frame length within the 
IEEE 802.3 and Ethernet specifications. 

Two 3 1/2 inch external microfloppy discs (1420 kbytes) or a 
single 710 K byte 3 l/2 inch external floppy disc and up to 20 
Mbyte on an external hard disc for storage of programs, data 
and configurations. 

User definable names. for up to 500 network addresses. 

Sixteen filters with 14 trigger bytes defined for addresses and 
type or length field and 47 non-contiguous user-definable 
trigger bytes. 

Maximum 1.5 days for timestamping. For event timing, 
maximum 3 hours per interval, maximum accumulation to l.5 
days. 

Sixteen each with a maximum count of 99,999,999. 
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Time Stamping 

Transmitter 
Performance 

Receiver 
Performance 

Traffic Generation 

Display 

Printer Support 

Remote RS .. 232C 
Interface 

Self .. Test 

Timestamp for each incoming frame accurate to 32 
microseconds. Displayed as time of day, time from start of 
monitor, time between frames, time from triggered event, and 
time from specified captured frame. 

Typically responds to an incoming frame within 10 
milliseconds. Define and transmit messages from 5 to 2026 
bytes including frame check sequence. 

In monitor mode, captures and displays all frames within 
Ethernet or IEEE 802.3 specifications. 

Using maximum legal frame length (1518 bytes), 90% network 
loading can be achieved. 

A 12 inch external monochromatic display with 80 characters 
on 25 lines. 

Supports HP 2225A ThinkJet printer via HP-IB interface. 

Supports data rates from 300 bps to 9600 bps. 

Extensive self-test and functional verification routines isolate 
failures to the field replaceable unit. 
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Product lnf ormation 

HP 4971S Specifications 

SAFETY CLASSIFICATION 

This is a Safety Class 1 instrument system (provided with terminal for protective 
grounding). 

DIMENSIONS 

Model Height Width Depth Weight 

Instrument 
4971A 19.1 cm 42.6 cm 37.7 cm 9.5 kg 

7.5 in 16.8 in 25.75 in 21. lb 

Display 
35731B 33.2 cm 34.0 cm 34.0 cm 10.0 kg 

13.l in 13.4 in 13.4 in 22.0 lb 

Disc Drive 
91220 76.0 cm 32.5 cm 28.S cm 4.5 kg 

2.99in 12.8 in 11.2 in 10.0 lb 

9133H 13.2 cm 32.5 cm 28.5 cm 9.0 kg 
5.2 in 12.8 in 11.2 in 20.0 lb 

9153A 10.6 cm 32.5 cm 28.5 cm 8.2 kg 
4.1 in 12.8 in 11.2 in 18.0 lb 

Printer 
2225A 8.9 cm 29.2 cm 20.6 cm 3.4 kg 

3.5 in 11.5 in 8.1 in 7.4 lb 
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Product Information 

TEMPERATURE 

Operating 
Non-operating 

HUMIDITY 

Operating 

Non-operating 

ALTITUDE 

Operating 
Non-opera ting 

to° C to +40° C 
-40° C to +60° C 

(+50° F to +104° F) 
(-40° F to + 140° F) 

20% to 80% 

8% to 80% 

0 to 4572 m 
0 to 15,240m 
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Product Inf ormntion 

POWER REQUIREMENTS 

Model Line Volts Line Freq (Hz) Power 
(Vac) (Single Phase) 

Instrument 
4971A 90-125 48-66 hz 200 

195-250 

Display 
35731B 90-125 48-66 50 

195-250 

Disc Drive 
91220 

9133H 

9153A 

Printer 
2225A 

90-125 48-66 67 
195-250 

90-125 48-66 125 
195-250 

90-125 48-66 100 
195-250 

90-125 48-66 (max non-print) 2 
195-250 (max printing) 17 

Note 

The HP 4971S system is designed to run at the voltage ranges 
of either 90-125 Vac or 195-250 Vac. Some devices used in the 
HP 497 IS system have wider operating ranges than 90-125 Vac 
or 195-250 Vac. However, these ranges are the maximum for 
the system. 
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Product lnf ormation 

Accessories Available For The HP 4971 S 

HP Model 

92254A 
92254B 
92254C 
92254D 

30241A 
92256C 

10833A 
108338 
10833C 

92192A 

92261 A 
92261 L 
92261S 

18213A 
18214A 

1008A Opt.006 

19500B 

Description 

6 meter AUI cable 
12 meter AUi cable 
24 meter AU I cable 
48 meter AU I cable 

Media Access Unit & Cable Tap 
MAU Tap Installation Kit 

I meter H P-18 cable 
2 meter H P-lB cable 
4 meter HP-IB cable 

Double sided Microfloppy Discs 
Box of 10 

ThinkJet print head ink cartridge 
ThinkJet paper, I 000 sheets 
ThinkJet printer stand 

HP 4971 A Carrying Case 
Carrying case for CRT, keyboard and HP 9122D 

Cart 

Disc Drive Rack Mount Adapter Kit 
HP 91220, 9133H/9153A 
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Recommended Peripherals For The HP 4971 S 

DISPLAY 

HP Model 

35731BB 
35731BM 
35731 BQ 
35731 BU 
35731 BY 
35731BK 

KEYBOARD 

DISC DRIVE 

PRINTER 

For local operation, an HP 497 IS must have a display. All 
displays have 12 inch monochrome CRTs with built-in tilt and 
swivel. The different display models provide the appropriate 
power cord for the country indicated. 

Description 

Display with power cord 
Display with power cord 
Display with power cord 
Display with power cord 
Display with power cord 
Display without power cord 

Country 

-European Continent 
-U.S./Canada 
-Switzerland 
-United Kingdom 
-Denmark 

For local operation, a station must have a keyboard. 

HP Model Description 

46021A U.S. keyboard 

The HP 497 IS must have a disc drive to operate. Software is 
only distributed on 3 1/2 inch, double sided, floppy discs. A disc 
can also be used to store data collected from the network as well 
as programs and other configuration information. 

HP Model 

9122D 
9153A 
9133H 

Description 

Dual double sided 3 I /2 inch floppy disc drive 
10 Mb Winchester and 3 l /2 inch floppy drive 
20 Mb Winchester and 3 l/2 inch floppy drive 

A print.er may be selected for output purposes on the HP 4971 S. 
The HP 497 IS supports printing of selected data from the its 
buffer, programs and other configuration information. 

HP Model Description 

2225A 150 cps, ThinkJet Printer 
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Accessories Supplied With The HP 4971A 

For a HP 4971 S to be a stand-alone operating system, a keyboard, display monitor, and 
disc drive are needed in addition to the HP 497 lA instrument. 

The standard HP 4971 A consists of the components listed below. 

HP Model Quantity 

4971A 

92192A 

Description 

LAN Protocol Analyzer Instrument 
also includes: 2 meter HP-IB cable 

Keyboard cable 
Audio cable 
Power cord 
System software discs 
Tutorial disc 
Operating Manual 

Box of ten 3 1 /2 inch floppy discs 
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Options Available For The HP 4971A 

Several options are available that apply directly to the HP 497 lA instrument. These 
options are listed below: 

Option 
Number 

001 

002 

200 
210 

908 

915 

916 

W03 

Description 

Video Interface Card & Cable. 
(Must be ordered if monitor is to be used.) 

RS-232C Remote Communications Interface 
Includes DTE (male) cable 
(Requires l each for each master and slave station) 

Additional 256 kbyte of system memory 
Additional 1 Mbyte of system memory 

(Maximum of two additional memory cards per 
system.) 

HP 4971 A Rack Mount Kit 

Hardware Support Manual 

Additional Operating Manual 

Convert l year return-to-HP warranty to 
90 day on-site repair 
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Support Services Available 

SOFTWARE SUPPORT 

HP Part No. 

4971A +NOO 

HARDWARE SUPPORT 

Description 

Software Notification Service (SNS) 
Includes periodic distribution of applications and 
update/upgrade information. 

On-site hardware support is available for the HP 4971 A, the specified disc drives, the 
specified displays, and the printer. The following list shows the types of hardware 
support service available. 

Category 

BSMS 

SMMS 

FMMC 

Place of Service 

Basic System Maintenance Service 
Next day, on site. 

Standard Monthly Maintenance Service 
Four hours, on site. 

Field Monthly Maintenance Charge 
Return to HP. 
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CHAPTER 3 

SITE PREPARATION 

You can install the HP 4971S LAN Protocol Analyzer yourself or, if assistance is 
needed, contact your local HP Sales and Service office. 

This section contains information about site requirements and preparation needed to 
install the HP 497 IS LAN Protocol Analyzer. 

This chapter includes: 

• Operating Environment Requirements 

Temperature 

Humidity 

Altitude 

Space 

Power 

• Initial Inspection 

Claims for Damage 

Storage and Shipment 

Repackaging for Shipment 
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Site Preparation 

Operating Environment Requirements 

TEMPERATURE REQUIREMENTS 

Operating 
Non-operating 

1 o0 c to +4o0 c 
-4o0 c to +6o0 c 

HUMIDITY REQUIREMENTS 

Operating 

Non-operating 

ALTITUDE REQUIREMENTS 

Operating 
Non-operating 

20% to 80% 

8% to 80% 

0 to 4572 m 
0 to 15,240 m 

3-2 

(+50°F to +104°F) 
(-40°F to + J 40°F) 
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Site Preparation 

SPACE REQUIREMENTS 

HP 4971 A Instrument 
Position your HP 497 lA instrument so there is at least 6 cm (2.5 in) of clearance on the 
left side. The fan draws cooling air into the left side near the back and exhausts the air 
at the left side near the front. Ensure that there is an unrestricted supply of cool air to 
the intake holes. 

Allmv at least 15 cm (6 inches) of clearance beyond the back cover of the HP 497 l A 
for cable connections. If pressure is exerted against the instrument-end of these cables, 
the connectors could be damaged. No top, bottom, or right side clearance is required 
for the mainframe. 

Disc Drive 
Position your disc drive so there is at least 6 cm (2.5 inches) of clearance at the front 
and back. The fan for the disc drives draws cooling air in from the front and exhausts 
the air at the back. Ensure that there is an unrestricted supply of cool air to the intake 
holes. 

Printer 
The ThinkJet printer is designed to print on single sheet or fanfold paper. If fanfold 
paper is used, provide space below or behind the printer for the paper supply. Also, 
provide space behind the printer for the printed paper output. 
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Site Preparation 

POWER REQUIREMENTS 

The total power requirement for your HP 497 IS system will vary depending on what 
components your system has. The following list shows what power is required for each 
of the primary components. 

HP Model Line Volts Line Freg {Hz} Power 
(Vac) (Single Phase) max 

Instrument 
4971A 90-125 48-66 200 w 

195-250 

Display 
35731B 90-125 48-66 50 w 

195-250 

Disc Drive 
9122D 90-125 48-66 67 w 

195-250 

9133H 90-125 48-66 125 w 
195-250 

9153A 90-125 48-66 100 w 
195-250 

Printer 
2225A 90-125 48-66 (max non-print) 2W 

195-250 (max printing) 17 w 
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Initial Inspection 

I WARNING I 
To avoid hazardous electrical shock, do not perform electrical tests when 
there are signs of shipping damage to any portion of the instrument 

Inspect the shipping containers for damage. If the shipping containers or packaging 
materbls are damaged, they should be kept until the contents of the shipment have 
been checked for completeness and the instruments have been checked mechanically 
and electrically. The contents of the shipment should be as listed in the Accessories 
Supplied and Accessories Available portions of Section l. If the contents are 
incomplete. or if there is mechanical damage or defect, notify the nearest 
Hewlett-Packard office. Jf either the shipping containers are damaged or the packaging 
materials show signs of stress, notify the carrier as well as the Hewlett-Packard office. 
Keep the shipping materials for the carrier's inspection. The HP office will arrange for 
repair or replacement without waiting for claim settlement. 

CLAIMS FOR DAMAGE 

If physical damage is evident or if the instrument does not meet specifications when 
received, notify the carrier and replace the nearest Hewlett-Packard Sales/Service 
Office. The sales/service office will arrange for repair or replacement of the unit 
without waiting for settlement of the claim against the carrier. 

STORAGE AND SHIPMENT 

The HP 497 lS LAN Protocol Analyzer may be stored and shipped in environments that 
do not exceed the following limits: 

Temperature 

Humidity 

Altitude 

-4o0 c to +6o0 c (-40°F to +140°F) 

<8°ir> or >80<Yo (non-condensing, 26°C max. wet bulb 
temperature) 

15,240 meters (50,000 ft) 

The instrument should be protected from temperature extremes that would cause 
condensation in the instrument. 
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Site Preparation 

REPACKAGING FOR SHIPMENT 

Original packaging i.e., the containers and materials identical to those used in factory 
packaging are available from Hewlett-Packard. Jf the unit is being returned to 
Hewlett-Packard for servicing, attach a tag indicating the type of servicing required, 
return address, model number, and full serial number. Mark the container FRAGILE. 
Jn any correspondence, refer to the instrument by model number and full serial number. 

If other packaging is to be used, the following general instructions for repackaging with 
commercially available materials should be followed: 

a. Wrap the instrument in heavy paper or plastic. If you are shipping the unit to 
a Hewlett-Packard office or service center be sure to attach a tag to the 
instrument indicating the type of service required, return address, model 
number and full serial number. 

b. Use a strong shipping container. A double wall carton made of 2.4 MPa (350 
psi) test material is adequate. 

c. Use a layer of shock absorbing material 75 to I 00 mm (3 to 4 in.) thick around 
ali sides of the instrument to provide firm cushioning and prevent movement 
inside the container. Protect the control panel with cardboard. 

d. Seal the shipping container securely. 

e. Mark the shipping container FRAGILE to insure careful handling. 

f. In any correspondence, ref er to instrument by model number and full serial 
number. 
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CHAPTER 4 

INSTALLING THE HP 4971S SYSTEM 

This chapter tells you how to install your HP 4971 S LAN Protocol Analyzer system. 
Instructions are given for each of the standard and optional devices that may be used. 
Where additional specific details are available for the different devices, directions are 
given to let you know where to find the more detailed information in each of the 
system device manuals. 

This chapter includes: 

• Identify The System Parts 

• Position The System 

• Check Line Voltage Select Switches 

• Check Line Fuses 

• Connect Power Cords 

• Install The Keyboard 

• Install The Display 

• Install The HP-IB Cables 

• Turn On Your System 

• Connect The HP 4971S To Your Network Cable 

• Identify Accessory Slots 

• Optional Memory Board Address Switches 
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Figure 4-1. HP 497lS System Devices. 
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Installing The HP 497 lS System 

Identify The System Parts 

The HP 4971 S LAN Protocol Analyzer consists of several separate devices. Fold out 
the previous page and familiarize yourself with the system parts. Find each part in 
your system as you look over the following list. 

Power Switches 

Voltage Select 
Switches 

Power Sockets 

Display 
Interface 

Keyboard/HP-IS 
Interface 

Fuses 

Fans 

These are the switches you use to turn power on and off. Power 
indicators on the display and HP 497 lA instrument light when 
power is on. Never plug or unplug a device with the power on. 

The HP 497 lS system is designed to run at the voltage ranges 
of either 90-125 Vac or 195-250 Vac. The line frequency range is 
48-66 Hz. 

Note 

Some devices used in the HP 497 lS system have wider 
operating voltage ranges than 90-125 Vac or 195-250 Vac. 
These ranges are the maximum for the system. 

The power sockets are especially designed for an HP power cord. 
Table 4-2 shows the power cord configurations and part numbers. 

This interface provides the connection for the display 

This interface provides connections for the keyboard and 
for HP-18 peripherals. 

A properly rated fuse must be installed in each device for your 
system to operate safely. The correct fuse rating depends on the 
input voltage. 

The mainframe and disc drive each have small built-in fans to 
keep the devices cool. These fans should always be running when 
the power is on. 
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Position the System 

Several of the devices in the HP 4971 S system require consideration for air flow for 
cooling or for operation. This section describes how to position the devices in your 
system. 

HP 4971A 
Instrument 

Disc Drive 

Display 

Printer 

Place the mainframe of your system on a flat level surface. 
Position it so there is at least 6 cm (2.5 inches) of clearance on 
the left side. The fan draws cooling air into the left side near 
the back and exhausts the air at the left side near the front. 
Ensure that there is an unrestricted supply of cool air to the 
intake holes. 

Allow at least 15 cm (6 inches) of clearance beyond the back 
cover of the HP 4971 A instrument for cable connections. 1f 
pressure is exerted against the instrument-end of these ca bl es, 
the connectors could be damaged. No top, bottom, or right 
side clearance is required. 

Position your disc drive so there is at ieast 6 cm (2.5 inches) of 
clearance at the front and back. The fan for the disc drive 
draws cooling air in from the front and exhausts the air at the 
back. Ensure that there is an unrestricted supply of cool air to 
the intake holes. 

The display should be placed so the ventilation holes at the 
top, bottom, and sides are not obstructed. To a void 
obstructing the air vents in the bottom of the display housing, 
do not locate the monitor on a felt pad or other soft surface. 

The HP 2225A ThinkJet printer prints on single sheet or fan 
fold paper. If fan fold paper is used, the paper supply feeds in 
from the rear. You should provide space behind or below the 
printer for the paper supply. The printer outputs pages to the 
rear. 
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Check Line Voltage Select Switches 

Each device in your system has its own line voltage select switch. Check each device as 
described below to verify that the switch is in the correct position. Always disconnect 
the power cord from the device before setting the power select switch. 

Detailed instructions and illustrations are available in each of the separate device 
manuals for the HP 4971S system. Refer to the installation section in each separate 
manual if additional details are needed. 

DEVICES IN YOUR SYSTEM CAN BE DAMAGED IF SET FOR 
THE LOWER VOLTAGE RANGE AND PLUGGED INTO A 
HIGHER VOLTAGE. 

HP 4971A The instrument line voltage select switch is at the upper left 
corner of the rear panel. 

Disc Drive 

Display 

The line voltage select switches for the 9 J 22D, 9 I 33H, and 
9 I 53A Disc Drives, recommended for use with the HP 4971 S, 
are located on the rear panel of each disc drive near the 
pmver socket. 

The HP 35731 Bx* Display line voltage select switch is at the 
lower center of the rear panel. 

Bx* Bx refers to displays in the HP 3573 lB family: BB, 
BM, BQ, BU, or BY. 
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Printer The power receptacle box on the rear panel of the 2225A 
Printer contains a voltage selector drum for selecting one of 
four line voltages. The line voltage selections are: 

JOO VAC 50-60 Hz 
I 20 V AC 50-60 Hz 
220 V AC 50-60 Hz 
240 V AC 50-60 Hz 

To select a line voltage: 

1. Remove the power cord from the print.er. 

2. Open the cover of the fuse box with a smnU screwdriver. 
The cover closes tightly but will yield to firm pressure. 

3. Pull out the voltage selector drum. 

4. Rotate the voltage selector drum until the setting that 
corresponds to the line voltage in your area faces out, and 
insert the drum back into its slot. Do not force the 
voltage selector drum into the slot. lf it is turned up side 
down, it will not fit. 

Additional information and figures are available in Appendix 
C, 'Changing the Fuse or Line Voltage', of the HP 2225A 
ThinkJet Printer Reference Manual. 
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Check Line Fuses 

Each of the devices in the HP 497 IS system that have a separate power cord also have 
a line fuse. Check each of the devices as described below to ensure you have the 
correct fuse installed. 

Table 4-1 lists the line fuses required for all the devices recommended for use with the 
HP 4971 S system. 

WARNING I 
DO NOT CHECK OR CHANGE ANY FUSE UNLESS POWER IS 
DISCONNECTED FROM THAT DEVICE. 
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VOLTAGE VOLTAGE REQUIRED FUSE 
MODEL SETT I NG RANGE (Vac) FUSE PART NUMBER -----

Instrument 
4971A 115 90-125 5.0 Amp/250 2110-0010 

230 195-250 2.5 Amp/250 2110-0083 

Dis~laz:: 

35731Bx 115 90-125 Internal, not replaceable 
230 195-250 Internal, not replaceable 

Disc Drive 
9122D 115 90-125 1. 0 Amp/250 2110-0001 

230 195-250 0.5 Amp/250 2110-0012 

9133H 115 90-125 3.0 Amp/250 2110-0003 
230 195-250 3.0 Amp/250 2110-0003 

9153A 115 90-125 2.0 Amp/250 2110-0002 
230 195-250 1. 0 Amp/250 2110-0001 

Printer 
2225A 100 100 0.5 Amp TD 2110-0621 

120 120 0.4 Amp TD 2110-0340 
220 220 0.25 Amp TD 2110-0489 
240 240 0.2 Amp TD 2110-0588 

Table 4-1. Fuse Cross Reference For HP 497 lS System. 
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FUSE LOCATIONS 

HP 4971A 

Disc Drive Fuse 

91220 

9133 H 

9153A 

Installing The HP 497 lS System 

The HP 497 lA instrument fuse holder is located at the lower 
left corner of the rear panel. To remove the fuse holder, press 
in on it and turn counterclockwise. 

Additional fuse figures are available in Chapter 2, "Installing 
Your Computer," of the Model 220 Installation Guide. 

The HP 91220 Disc Drive fuseholder is located at the lower 
right corner of the rear panel. To remove the fuseholder, 
press in and turn counterclockwise. Check that you have the 
correct fuse installed. 

Additional fuse figures are available in Part 1, "Installation 
Guide," of the HP 91220 Operator's Manual. 

The fuse holder for the HP 9133H Disc Drive is located at the 
lower right corner of the rear panel. To remove the fuse 
holder, press in and turn counterclockwise. 

Additional fuse information is available in Chapter 1, 
"Essentials," of the HP 9133H Operator's Manual. 

The fuse holder for the HP 9153A Disc Drive is located at the 
lower right corner of the rear panel. To remove the 
fuseholder, press in and turn counterclockwise. Check that you 
have the correct fuse installed. 

A figure for fuse location is available in Chapter 1, "Essentials," 
of the HP 9153A Operator's Manual. 
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Display 

Printer 

The display has no external line fuse. The line voltage select 
switch selects between two fuses mounted internally in the 
35731B. The fuses are soldered in the circuitry and are not 
field replaceable. 

Bx* Bx refers to any display monitor in the HP 35731 B 
family: BB, BM, BQ, BU or BY. 

The line fuse for the HP 2225A ThinkJet printer is located 
inside the power socket assembly. The fuse is behind the cover 
of the power socket. The fuse is in a carrier which slides into 
a cavity in the fuse box. There are two cavities for fuse 
carriers; one above the other. The fuse to be connected into 
the line circuit must be mounted in the upper cavity. The fuse 
size depends on the line voltage selected. 

Additional fuse information is available in Appendix C, 
"Changing the Fuse or Line Voltage," in the HP 2225A 
Reference Manual. 
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Connect The Power Cords 

This section describes how to connect the power cord from your HP 497 lS system 
devices to a power outlet. 

On each device, connect the power cord to that device and then connect the other end 
to the power outlet. 

WARNING I 
IF A REPLACEMENT POWER CORD lS NEEDED, MAKE SURE 
YOU ORDER AN HP POWER CORD THAT IS IDENTICAL TO 
THE ORIGINAL. OTHERWISE, ELECTRICAL SHOCK OR 
EQUIPMENT DAMAGE MAY RESULT. 

WARNING I 
Before applying power to an instrument, you must ensure that the 
chassis is properly grounded. This precaution is necessary to avoid 
the possibility of injury or death which may result if the protective 
ground is defeated. The devices used in an HP 497 lS system are 
provided with a 3-wire power cord. When this cord is connected to 
an appropriate AC power receptacle, it provides a ground for the 
instrument cabinet. 

The type of power cord shipped with each instrument depends on the country of 
destination. Table 4-2 describes the power cords and their applications. Figure 4-2 
illustrates the location of each power cord socket on the HP 497 lS. 
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Cable c Plug 
Cable Cable For Use 

Plug Type HP Part 
D Description 

Length Color In Country 
Number (inches) 

250V 8120-1351 0 Straight ·Bs1363A 90 Mint Gray United Kingdom, 

~ 
8120-1703 6 90° 90 Mint Gray Cyprus, Nigeria, 

Rhodesia, 
Singapore 

250V 8120 1369 0 Straight •NZSS198/ ASC112 79 Gray Australia, 
8120-0696 4 90° 87 Gray New Zealand 

~~ 
250V 8120-1689 7 Straight 'CEE7-Y11 79 Mint Gray East and West 

8120-1692 2 90° 79 Mint Gray Europe, Saudi 

~ 
Arabia, Egypt, 
So, Africa, India 

I unpolarized in 

many natrons1 

125V 8120-1 348 5 Straight 'NEMA5-15P 80 Black United States, 

8120-1398 5 90° 80 Black Canada, 

~ 
8120 1754 7 Straight •NEMA5-15P 36 Black Japan 11oov or 

8120-1378 1 Straight 'NEMA5-15P 80 Jade Gray 200V1, 

8120-1521 6 90° 80 Jade Gray Mexico, 

8120-1676 2 Straight •NEMA5-15P 36 Jade Gray Ph1l1pp1nes, 
Taiwan 

250V 8120-2104 3 Straight ·sEVlOl 1 79 Gray Switzerland 

1959-24507 

~ 
Type 12 

250V 8120-0698 6 Straight •NEMA6-15P United States 
Canada 

~~ 

220V 8120-1957 2 Straight ·oHCK 107 7g Gray Denmark 

~ 
8120-2g56 3 goo 7g Gray 

250V 8120-1860 6 Straight ·cEE22-VI 
1Systems Cabinet use1 

~~ 
250V 8120-4600 8 Straight BS 546/SABS 164 98 Blar.k So_ Africa, 

~ 
8120-4211 7 goo g8 Black India 

*Part number shown for plug 1s industry 1dent1f1er for plug only_ Number shown for cable 1s HP Part Number for complete cable 
1nclud1ng plug 

E = Earth Ground; L = Line; N = Neutra I 

Table 4-2. Hewlett-Packard Power Cords. 
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Figure 4-2. Connecting HP 497 lS Power Cords. 
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Install The Keyboard 

Use the following procedure to connect the keyboard to the Keyboard/f-JP-18 Interface 
card. 

Procedure: 

1. Turn off all system power switches. 

2. Connect the keyboard cable end with one dot to the back of the keyboard in 
the slot with one dot. 

The coiled cable connecting the keyboard to the 
Keyboard/HP-IB Interface card has polarized connectors at 
both ends. Do not use excessive force to plug the cable into 
the sockets. 

3. Connect the end of the keyboard cable with two dots to the the back of the 
Keyboard/HP-18 Interface card. 
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I I !!!!!!!!!•••••. B 

Figure 4-3. Connecting The Keyboard Cable. 
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Install The Display 

The HP 35731 Bx Display connects to the Composite Video Interface connector on the 
rear panel of the HP 4971A instrument. A speaker can also be connected to the 
Keyboard/HP-IB Interface card. 

Use the following procedure to connect the video cable and audio cable to the display. 

Procedure: 

VIDEO CABLE 

1. Check that the HP 4971A instrument power switch is set to the off position. 

2. Connect one end of the video cable to the HP 35731 Bx Display. 

3. Connect the other end of the video cable to the Composite Video Interface. 

AUDIO CABLE 

4. Connect one end of the audio cable to the SPEAKER connector on the back 
of the Keyboard/HP-IB Interface card. 

5. Connect the other end of the audio cable to the audio connector on the back 
of the display. 
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Figure 4-4. Connecting the Monitor Cables. 
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Install The HP-IB Cables 

Some of the HP 4971 S system devices are connected to the HP 4971 A instrument via 
HP-18 cables. Figure 4-5 shows the HP-IB cable connections. 

DISC DRIVE 

1. Connect an HP-IB cable from the HP 497 lA instrument connector to the disc 
drive connector. 

PRINTER 

l. If your system has a printer. connect an HP-IB cable from the HP 497 lA 
instrument connector to the printer HP-IB connector. 
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Figure 4-5. Installing The HP-IB Cable(s). 
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Turn On Your System 

Turn on each of your system devices with it's separate power switch. Verify that the 
power indicator lights are ON and the fans on the disc drive and HP 4971 A are 
operating. If the fans run and the indicator lights are on, you have successfully 
installed your HP 497 lS system. 

Problems? 

If all or part of your system does not turn on, check the following: 

1. Is the power switch to each device set to the ON position? 

2. Is the power cord firmly plugged into each device of the system? 

3. Is power present at the power outlet? 

If your answered "yes" to all three questions, replace the fuse in the component(s) that 
fail(s) to power on and try again to turn on the system. If it still does not turn on, 
contact your HP Service Representative. 

Note 

Loading the system software into the HP 497 IS is described in 
the "Getting Started" section. Before getting to that point 
however, the HP 4971 S should be connected to your Local 
Area Network (LAN). This procedure is described on the next 
page, "Connect The HP 497 lS To Your Network Cable". 
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Connect The HP 49715 To Your Network Cable 

In order to interface the system with your local area network, the HP 497 lS must be 
connected to your network cable. The method for this connection varies depending on 
what network type you are using. With IEEE 802.3 and Ethernet systems, the 
connection is made through an Access Unit Interface (AUi) cable to a Media Access 
Unit (MAU). The MAU provides a physical connection to the local area network 
cable. With a Cheapernet system, connection can be made directly from the HP 497 lS 
to a MAU adapter on the Cheapernet local area network cable. 

There are two kits recommended to help you connect your HP 4971 S to your network: 
HP 30241A MAU & Cable Tap and HP 92256C MAU & Tap Installation Kit 

Follow the instructions inc1uded with each of the kits. Remember to observe the 
following guidelines: 

I. The cable must be properly terminated with N-series terminators. 

2. The minimum distance between MAUs is 2.5 meters. 

3. These environmental specifications must be met: 
temperature 0 - 50°C 
humidity 5 - 95% relative humidity 

4. The power dissipation is 15.75 Vdc max, .5 Amp max, 6 Watts max. 

5. Do not connect the HP 4971S or the above mentioned installation kits to an 
ungrounded network coaxial cable. 

6. Cover all N-series connectors with a rubber boot. Inadvertent grounding to 
building grounds such as an exposed metal building structure or metal cable 
tray can damage the network components or cause the network to fail (except 
the grounded end of the coaxial cable). 
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Identify Accessory Slots 

The HP 4971 A instrument has 16 accessory slots as shown in Figure 4-6. The following 
list shows the assigned locations for boards used in the HP 497 lA. 

Slot 1 
Slot 2 
Slot 3 
Slot 4 
Slot 5 
Slot 6 
Slot 7 
Slot 8 

Slot 9 
Slot 10 

Slot l l 
Slot 12 
Slot 13 
Slot 14 
Slot 15 
Slot 16 

- Restricted 
- Restricted 
- Dual Port Memory. 
- Deep Trap 
- Shallow Trap 
- LAN Receiver 
- LAN Transmitter 
- Restricted 

- Memory Card (Standard, I Mbyte) 
- RS-232 Remote Communication Interface (Option 002) 

(Select Code 20) 
- Memory Card (Standard, 256 kbyte) 
- Memory Card [Opt. 200 (256 kbyte) or Opt. 210 (I mbyte)] 
- HP 98204A Video 1/0 
- HP 98204A Video 1/0 
- Memory Card [Opt. 200 (256 kbyte) or Opt. 210 (1 mbyte)] 
- Keyboard/HP-IB (Select Code 7) 
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SLOT SLOT 
NUMBER NUMBER 

1 

~ 
9 

2 10 

3 11 
4 12 

@ 5 13 ~ 
7 000 •• CJ E9 0 0 &O ICJI 
6 16 

~ p q 

Figure 4-6. HP 497 lA Card Cage Configuration. 
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Optional Memory Board Address Switches 

You can have up to four memory cards in your HP 4971A instrument. The standard 
memory of 1.256 Mbytes is composed of one HP 98257A board (lMbyte) and one HP 
98256A board (256 kbyte). 

Optional memory may be added to the protocol analyzer by Option 200 (additional 256 
kbytes) and/or Option 210 (additional l mbyte). 

If you ordered your HP 4971S with Options 200 and/or 210, the address switch 
configuration is set at the factory. 

If you add memory to a system you already have, Table 4-3 shows the address switch 
settings for different memory combinations. 

Ill Ill 

HP 98257A 98256A 

Figure 4-7. HP 98257 A and 98256A Address Switch Locations 
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Opt. 210 

(1.256 Mbyte) 

HP 98257 A BOARD 

std board 

std board 

std board 

opt. 210 

~ 
std board 

opt. 210 

~ 
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HP 98256A BOARD 

std board 

std board 

opt. 200 

std board 

std board 

opt. 200 

ffil!)f-7)-))1\ 
-~\;)t!) • 

ffil!)f-7)-))11 
.t!J~\;)t!) • 

\!?H!I~\ 
-~~~\!)\i) • 

Table 4-3. Memory Boards Address Switch Settings. 
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CHAPTER 5 

GETTING STARTED 

This chapter explains some of the first things you should do to begin operating the HP 
497 lS. 

In addition, a tutorial disc is supplied to introduce you to the protocol analyzer 
functions. 

This chapter includes: 

• Introduction 

• Loading The System Software 

91220 Dual Disc Drive 

9133H, 9153A Winchester Ori ve 

• Backing Up Your System Software 

• Using the Top Level Menu 

• Setting the Date and Time 

• Using the Tutorial Disc 
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Introduction 

The operating system for the HP 4971 S LAN Protocol Analyzer is delivered on floppy 
discs. These discs must be loaded into RAM memory in the protocol analyzer before 
the system can function. 

If your system has the HP 91220 Dual Disc Drive, go to page 5-4 for instructions to 
load the operating system software. 

If your system has a Winchester disc drive, go to page 5-6 for instructions to load the 
operating system software. 

SOFTWARE SUPPLIED 

The HP 497 lS system is delivered with several system floppy discs. The discs are 
labeled: 

LABEL 

LAN SYS 

LAN COD 

HP 4971S 
TUTORIAL 

FUNCTION 

(For LAN SYStem) contains the system software. 

(For LAN CODe) contains the operating code for the HP 497 lS 
system. 

is a self-paced tutorial supplied to introduce you to the 
basic functions of the protocol analyzer. 
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DISC DRIVES AVAILABLE 

Three models of disc drives are supported for use with your protocol analyzer. The 
power-up sequence depends on what model disc drive your system has. The following 
instructions describe the turn-on procedure for the different disc drives. 

MODEL 

Dual Disc Drive 
9122D 

Winchester Disc Drives 
9153A 
9133H 

DESCRIPTION 

Dual 3 1/2" floppy disc drive, 710 kbyte 

IO Mb Winchester and 3 I /2" floppy drive 
20 Mb Winchester and 3 1/2" floppy drive 
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Loading The System Software 

USING THE HP 91220 

If the disc drive with your system is the HP 91220 Dual Disc Drive, the floppy discs 
containing the system software must be manually loaded into the protocol analyzer 
memory each time the power is turned on. 

The system software is contained on the floppy discs: LANSYS, and LANCOD. 

The figure below shows the disc slot identification for protocol analyzer systems using 
the 91220 Disc Ori ve. 

HP 9122D Dual Diso Drive 

c:=i--

disc slot disc slot 

#3 #4 

Figure 5-1. 91220 Disc Drive Identification 

Use the following procedure to load system software into the HP 4971 S Protocol 
Analyzer. 

You should back up your operating system software. The section, Backing Up Your 
System Software, in this chapter, describes how to perform this operation. 

5-4 



91220 Disc Drive (cont.) 

Note 

If the TUTORIAL disc is to be used, do not load 
the LANSYS and LANCOD floppy discs. Skip 
ahead to the "Using The Tutorial Disc" in this 
section. 

Getting Started 

I. Before starting, set the HP 497 lS and HP 91220 Disc Drive power switches 
to OFF. 

2. Insert the LANCOD and LANSYS floppy discs into the two disc drive slots. 
The discs may go into either slot. 

3. Set the HP 9 I 22D disc drive power switch to ON and then set the HP 497 lS 
power switch to ON. 

Note 

lf you hit a key during the self test portion of the 
power on cycle, the boot up process halts. To 
proceed, press the 1 key and then press the P 

key. 

4. The protocol analyzer performs a self test of the mainframe at power on. 
After the two discs are loaded into the analyzer and the self test is 
complete, the Top Level Menu is displayed. 

If self test passes, a status message is displayed: 

4971S power-on self-test PASSED 

If the self-test fails, an error message is displayed. Ref er to the <Test 
Hardware> section. 

5. Skip ahead to Using the Top Level Menu or the TUTORIAL sections in this 
chapter. 
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USING HP 9133H, 9153A WINCHESTER DISC DRIVES 

If your system uses the HP Winchester disc drives, the floppy discs containing the 
system software can be stored onto the hard disc, and then, the protocol analyzer will 
automatically boot up each time the power is turned on. 

The Winchester disc drive requires more initial effort to get the system software stored 
than the HP 91220 Dual Disc Drive. However, after the system software is stored in 
the Winchester disc drive, you will have a faster power up cycle and greatly increased 
file storage space. 

Is the Winchester disc drive initialized? 

No 

I WARNING I 
If you reinitialize a Winchester disc that has been previously 
used, any existing files will be lost. 

If the Winchester disc drive is being turned on for the first time, continue in this 
t' sec...ion. 

Yes 
lf the Winchester disc drive has previously been turned on with your system, the hard 
disc has been initialized, and the operating software stored on the disc, the system 
should boot up automatically. 

However, if for some reason, the operating system software files become corrupted, the 
protocol analyzer will not boot up at power on. 

If you detect that the operating system files on the hard disc have become corrupted, 
you can easily restore the files, if the power has not been turned off. Use the 
"Restoring System Software" procedure in the <Disc Functions> Menu section of your 
Operating Manual. 

If you detect that the operating system files on the hard disc have become corrupted 
and the power has been turned off, continue in this section to repeat the first time 
power on procedure. 
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Winchester disc drives (cont.) 

The following figure shows the disc drive identification for the Winchester disc drives. 

Oise Slot 

II\ 

#3 

WINCHESTER DISC DRIVES 

HP 9133H 

r - - - - - ., 

: Hard Oise : 

I /j\ I 

L - - -+ - - .J 

#13 

(HAR DSC) 

HP 91530 

r-----., 
I o· I 
I Hard ISC I 

I ,If\ I 
L---1 __ .J 

#13 

(HAR DSC) 

Figure 5-2. Winchester Disc Drive Identification. 

Disc Slot 
If\ 

#3 

Use the fo11owing procedure to Joad the system software into the Winchester disc 
drives for the first time. Three operations are needed to permanently store the 
operating system software onto the hard disc: 

A. Loading the operating system software for the first time. 

B. Initializing the Winchester disc drive. 

C. Storing the system software. 
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9133H, 91530 (cont.) 

A. Loading The Operating System 

The first part of this procedure loads the system software for the protocol analyzer 
into the HP 497 lS. This is necessary before the hard disc can be initialized. 

Note 

The following procedure needs to be performed 
only for the first time the disc drive and HP 4971 S 
are being turned on. It is not necessary to load the 
system software, initialize the hard disc, and save 
the system software onto hard disc each time the 
system is turned on. 

1. Before starting to load your system software into the Winchester disc drive, 
set the following switches: 

A. Power switches for the disc drive and HP 497 lA instrument are OFF. 

B. HP-JB switch on back of disc drive is set to 9 . 

2. Insert the floppy disc, LANSYS, in the disc drive slot. 

3. Set the disc drive power switch to ON and then set the HP 4971 A instrument 
power switch to ON. 

The disc drive access light should begin blinking. 

Note 

At power on, the The HP 497 lA instrument performs an initial 
processor circuits check followed by a self test of the hardware. 
If you hit a key during the initial test processor portion of the 
power-on cycle, the boot up process halts. To proceed, press the 
1 key and then press the P key. 
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9133H, 91530 (cont.) 

After displaying several other status messages, the protocol analyzer displays 
the message: 

Loading 'LANSYS.Library.Code' 

After a few seconds, the display shows the message: 

Loading 'LANCOD: HP4971S.CODE 1 

cannot open 'LANCOD.HP4971S.CODE' 
Logical volume not found. 

4. Remove the LANSYS floppy disc from the disc drive. 

5. Insert the LANCOD floppy disc in the disc drive. 

6. Enter the character x from the keyboard. 

The message Load what file? is displayed. 

7. Type the characters: LANCOD:HP4971S (use all capital letters) from the 
keyboard and press the RETURN key. 

The message Loading 'LANCOD.4971S.CODE' is displayed. 

8. After the LANCOD floppy disc is loaded, the Top Level Menu is displayed. 
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9133H, 91530 (cont.) 

B. Initializing The Hard Disc 

The following steps initialize the hard disc inside the Winchester disc drive. 

The following initialization procedure creates three blank logical volumes on the hard 
disc. Two, l Mbyte volumes are used to store LANSYS and LANCOD. The remaining 
volume is numbered #13: (or HARDSC) and is used as storage space for Network and 
Data files you create. 

MODEL 

9153A 
9133H 

NETWORK & DATA FILE STORAGE SIZE 

8 Mbytes 
18 Mbytes 

9. From the Top Level Menu, press the <Disc Functions> softkey. 

10. Press <OTHER CHOICES> softkey. 

11. Press <Format Disc> softkey, 

The message Drive number? is displayed. 

12. Enter the number 11 from the keyboard and press RETURN key. 

The following message is displayed: 

(9133H) 

(9153A) 

Device: HP 9133 fixed disc, xxx,x,x 
Logical unit #11 - < no directory > 

Device: HP 9153 fixed disc, xxx,x,x 
Logical unit #11 - <no directory> 

Are you sure you want to proceed? 

13. Press the <YES> softkey. 
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9133H, 91530 (Cont.) 

14. The disc drive requires several minutes to complete the initialization. 

MODEL 

9153A 
9133H 

APPROXIMATE JNITIALIZA TION TIME 

7 
33 

minutes 
minutes 

During initialization, the protocol analyzer displays the message: 

Disc formatting in progress 

15. When initialization is complete, the <Disc Functions> Menu is displayed. 

16. Press <List Directory> softkey to verify initialization. The figure below shows 
the directory headings: 

DIRECTORY OF -- VOLUME : HARDSC 
FILE # NAME TYPE SEQUENCE DATE TIME 

Selected disc is now HARDSC: 

Figure 5-3. Disc Drive Directory List 

5-11 



Getting Started 

9133H, 91530 (cont.) 

C. Storing The Operating System To Hard Disc 

After the hard disc is initialized, you need to store the HP 4971S system software from 
the floppy discs, LANSYS and LANCOD, onto the hard disc. 

After the system software is saved onto the hard disc, the system power S\vitches can be 
turned off and then back on and you will not have to repeat the preceding steps. The 
HP 497 lS system will automatically power up to the Top Level Menu. 

SAVING LANSYS TO HARD DISC 

If you make an error in the following steps, 17 through 20 or 21 through 24, just start 
the "Storing The Operating System" process over at step 17 or 21. There is no need to 
completely reinitialize the hard disc. 

17. Install the LANSYS floppy disc in the disc drive slot. 

18. Press the <Copy Files> sof tkey to display the message: 

Copy from: Copy to: 

19. Enter #3: in the Copy from: field and press the RETURN key. 

20. Enter #l l: in the Copy to: field and press the RETURN key. 

Message File copy in process is displayed. 

After the file is copied, Copy function complete is displayed. 
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9133H, 91530 (cont.) 

SA YING LANCOD TO HARD DISC 

20. Install the LANCOD floppy disc in the disc drive slot. 

21. Press the <Copy Files> softkey to display the message: 

Copy from: Copy to: __ 

23. Enter #3: in the copy from: field and press the RETURN key. 

24. Enter #12: in the Copy to: field and press the RETURN key. 

l\1essage File copy in process is displayed. 

After the file is copied, Copy function complete is displayed. 

The operating software you have stored to the hard disc now becomes your working 
copy of the software. You should keep the master floppy discs in a safe environment:. 
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Backing Up Your System Software 

If you have an HP 4971 S system with an HP 91220 Dual Disc Drive, you should make 
working copies of your LANSYS and LANCOD system software floppy discs and store 
the master copies in a safe environment. 

If you have a Winchester disc drive, when you store the operating software to the hard 
disc, you should use the hard disc as your working copy and store the original discs as 
your master copies. 

Follow the procedure below to make a working copy of your system software discs 
using the HP 91220 disc drive. 

FORMAT TWO FLOPPY DISCS 

You need to copy your master system software discs to two formatted floppy discs. 

1. Check that the write protect tab on the floppy disc is in the write enable 
position. (Slide tab toward center of disc.) 

2. Install the floppy disc to be formatted in a disc drive slot. 

3. Press the <Format Disc> softkey. 

Message Drive number? ~ is displayed. 

4. Enter the disc drive number where the floppy disc is installed and press the 
RETURN key. 

Message Are you sure you want to proceed? is displayed. 

5. Press the <Yes> softkey. 

Message Disc formatting in progress. is displayed. 
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6. After the floppy disc is formatted, message 

Select a disc name, default is 11 LANSAV 11
: ____ is displayed. 

We suggest you name the disc LANSYS. 

7. Repeat the steps I through 6 to format the second floppy disc. 

Name the second disc LANCOD. 

COPY THE SYSTEM SOFTWARE DISCS 

8. Install the new formatted disc, LANSYS, in disc drive slot #4. 

9. Install the master LANSYS system software disc in disc slot #3. 

10. From the <Disc Functions> Menu, press the <Copy Files> softkey. The 
following prompt is displayed: 

Copy from: Copy to: 

11. In the copy from: field, enter #3: and press the RETURN key. 

12. In the copy to: field, enter #4: and press the RETURN key. 

The copy function begins and the protocol analyzer displays the status 
messages: 

File copy in progress. 

Copy function complete. 

Use the second formatted blank disc and LANCOD disc and repeat steps 8 through 12 
to back up LANCOD software floppy disc. 

After you have copied both LANSYS and LANCOD system software discs, install the 
new working disc copies in the disc drive and cycle the protocol analyzer pmver to 
verify the discs let the protocol analyzer power up correctly. Store the original system 
software floppy discs in a protected environment. 
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Using The Top Level Menu 

The Top Level Menu is very important because it allows you to gain access to all the 
functions of the protocol analyzer. 

The Top Level Menu appears after power-on self-test is complete. Also, you can return 
to the Top Level Menu from lower level menus by pressing the <EXlT> softkey. You 
will use this menu often, so briefly experiment going to lower levels of softkeys and 
returning to the Top Level Menu. 

HEWLETT PACKARD 

49715 
LAN PROTOCOL ANALYZER 

Revision: 1.0 

Copyright 1986 Hewlett-Packard Company 

1 Mar 86 00:00:00 

4971S power-on self-test PASSED 

Setup Execute Monitor Disc Examine OTHER 
4971S Program Network Functions Data CHOICES 

<OTHER CHOICES> 
Printer Test Set Set OTHER 
Functions Hardware Date Time CHOICES 

Figure 5-4. Top Level Menu 
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Chapter I, Using This Manua1, describes the se]ections that you can make from the Top 
Level Menu. Chapter 1 also describes conventions used in the HP 4971 S and this 
operator's manual. 
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Setting The Date And Time 

At power up, or any time the power to the HP 4971 S system has been interrupted, the 
date and time should be set. When frames are captured and stored in the protocol 
analyzer, they are time stamped with the date and time the event occurred. Also, when 
network or data files are stored on a disc, the time of the event is noted. It is 
important to set date and time so that disc functions and time measurement functions 
will be accurate. 

SETTING THE DATE 

1. From the Top Level Menu, press the <OTHER CHOICES> softkey to 
display softkeys for setting the date and time. 

2. Press <Set Date> softkey. 

Entry format 

The date entry must follow the format: 

day month year 

For example: 

28 oct 85 -

Entry values 

(separate each entry with a space) 
(use three letters for month) 

October 28, 1985 

The values you can enter for the day and year must be within the range 
listed below: 

years - => 0 
=< 99 

days -

3. Press the RETURN key to complete the entry. 
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SETTING THE TIME 

1. From the Top Level Menu, press the <Set Time> softkey. 

Entry format 

2. The time entry must follow the format: 

hour:minute:second (separate each entry with a colon :) 
(use 24 hour entry to denote AM and PM) 

For example: 

9:30:00 9:30 AM 

21:30:00 9:30 PM 

Entry values 

The values you enter for the hours, minutes, and seconds must be within the 
ranges listed below: 

hours -

minutes -

seconds -

=> 0 
=< 23 

=> 0 
=< 59 

=> 0 
=< 59 

3. Press the RETURN key to complete the entry. 
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Using The TUTORIAL Disc 

The HP 4971S TUTORIAL floppy disc supplied with the HP 4971S LAN Protocol 
Analyzer provides an introduction to the features of the protocol analyzer. To use the 
HP 497 lS TUTORIAL disc, perform the following procedure: 

LOADING THE HP 4971 S TUTORIAL FLOPPY DISC 

l. The HP 497 IS system software on LANSYS and LANCOD floppy discs 
does not have to be loaded in the HP 497 lS before using the TUTORlAL 
disc. 

Remove the LANSYS and LANSYS floppy discs from the disc drive. 

2. Insert the TUTORIAL floppy disc in any disc drive slot. 

3. Set the HP 497 I A instrument powe.r switch to OFF and then back to the 
ON position. The floppy disc contents \Vill load into the HP 497 lA 
instrument. 

4. After the disc is loaded, a display similar to the Top Level Menu is shown. 

HEWLETT PACKARD 

49 
TUTORIAL. 

(Day Month Year Time} 

Press the <Space Bar> to continue. 

Figure 5-5. Tutorial Disc Power-on Display. 
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5. Press the keyboard SPACE bar to display the following tutorial topics: 

0 Introduction to HP 497 lS 

Introduction to Local Area Networks 

2 Monitor Network/ Examine Data 

3 Node List 

4 Filters 

5 Messages 

6 Programming 

7 Disc Functions 

8 1/0 Functions 

9 Conclusion 

CHOOSING A TUTORIAL TOPIC 

Press a number key on the keyboard to choose the tutorial topic you want to view and 
that tutorial topic will begin. 

Instructions to move through the tutorial are displayed in the status message line 
immediately above the softkeys. 

EXITING FROM A TUTORIAL TOPIC 

To exit from a module before reaching the end of that topic discussion, press either the 
<ESC>, <STOP>, or <BREAK> key on the keyboard. 

No key is provided to page backwards in the tutorial. 
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CHAPTER 6 

INTRODUCTION TO LANs 

This section describes the HP 497IS Protocol Analyzer and the Local Area Network 
(LAN) environment it is to be used in. 

This chapter includes: 

• Introduction 

• What is a Local Area Network? 

• Advantages of a Local Area Network. 

• Where and How are LANs used. 

• Network Topology. 

• Transmission Media. 

• Network Access Methods 

• The IEEE 802.3 Frame 

• Local Area Network System Differences 

• Local Area Network Performance Measurements 
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If you are unsure of what a (LAN) is and feel intimidated by having to use a LAN 
analyzer instrument, read the following chapter. 

If you feel comfortable about LANs and their details, you may want to skip to the next 
chapter. The next chapter describes the basic functions availab1e in the HP 497 lS 
protocol analyzer. 

The next few pages describe basic concepts of a LAN and put you more at ease in 
understanding its perf or ma nee measurements. 

A LAN is simply a method of connecting together a number of independent computers 
so they can share peripherals and other resources and communicate between themselves 
and other terminals. You now have the benefit of operating your computer 
independently and still enjoy the reduced cost of shared peripherals and resources. 

Connecting a group of computers and peripherals together requires some form of 
traffic control for the data communication between the stations. Data communication 
is not new, perhaps you are already familiar with RS-232C and its relatively slow speed 
modems and dial-up telephone lines. Network systems available today not only support 
data rates several hundred times faster than dial-up phone lines with modems, they 
allow simultaneous connection of many devices and much improved data transmission 
error rates. 

For simplicity, the following discussion is focused on the IEEE 802.3 standard. Ethernet 
and 1 OBASE2 standards are similar to the LEEE 802.3 and they are described in a 
summary table at the end of this section. This table shows the primary differences 
between the IEEE 802.3, Ethernet, and LOBASE2 standards. 
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What Is A Local Area Network? 

A LAN is a way of connecting multiple systems together in a limited geographical area. 
A LAN usually spans a distance of five kilometers or less. LANs can provide network 
communications in a building or a group of buildings in close proximity such as in a 
university, a hospital, or a cluster of manufacturing buildings on a site. 

A LAN is usually owned by one organization and can be configured by that 
organization to satisfy its unique needs. LANs are user controlled and are not subject 
to government regulations 

The follmving diagram shmvs a simplified Local Area Network. 

Terminator 

Hardware & 
~ Software -----,,___..___.__....., 

Interfacing D 
Shared 

Printer 

LAN Network 

/ Coaxial Cable 

Shared 
Disc 

Storage 

Personal 
Computer 

Personal 

Computer 

Shared 
Plotter 

D 
Terminal 

Minicomputer 

Mainframe 
(shared data files} 

' Repeater for 
extending cable 

Personal 
Computer 

Figure 6-1. Simpiified Local Area Net\vork 
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Advantages Of A Local Area Network 

HIGH DATA RATE 

With the IEEE 802.3 standard, LANs generally can transmit data at a rate of 10 million 
bits per second. In comparison, systems depending on data transmission through 
telephone lines are limited to several thousand bits per second. 

LOW TRANSMISSION ERROR RATE 

Due to the limited geographic range of the LAN, there is less opportunity for electrical 
interference on data transmission. Electrical signals typically weaken when transmitted 
over long distances; this is not as much a problem with LANs. 

FLEXIBLE TOPOLOGY 

Reliable hardware and good design can provide a flexible topology for a LAN, which 
means you can readily modify and reconfigure a net\.vork as your organization changes. 
Easy attachment or removal of devices means that computers, terminals and other 
peripherals can be added or moved around easily. Organizations can choose their own 
cable layouts for their special needs 

RESOURCE SHARING 

Sharing of resources such as computers, peripherals and software, saves expenses and 
provides for more efficient usage of equipment. A LAN can allow several departments 
to share resources without having systems duplicated in each area. 

LANs can help distribute system work loads evenly. For example, say there's one 
database that everyone in the building uses. Without a LAN, everyone would have to 
use the one system that held the database for all their computing needs. With a LAN, 
everyone could use a different computer for most of their daily work, but still be able 
to access the database computer vvhen necessary. This reduces the overall load on one 
system and improves response time and productivity. 
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Efficient Wiring 

The IEEE 802.3, Ethernet. and IOBASE2 networks all offer extremely simplified wiring; 
each computer, terminal or other peripheral only needs to connect to one main LAN 
cable. For example, suppose you want to connect four computers to each other. 
Rather than connect each computer to all the other computers, you can simply connect 
all four computers to one LAN cable. In this case, the number of physical 
communication cables is reduced and each computer requires only one point of 
connection. 

Traditional wiring methods have led to serious crmvding of cable ducts and raceways in 
buildings with large amounts of computer equipment. LANs are expected to be more 
cost effective for initial wiring of new buildings and for managing changes of wiring in 
existing buildings. 
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Where And How Are LANs Used? 

It is becoming very common to have your own personal computer in many work 
applications. While the cost for personal computers is becoming more favorable for 
the user, the cost of peripherals such as high speed printers, graphic plotters and large 
memory storage devices still make it expensive for each user to have their own 
complete system. Many applications exist that make it attractive to group individual 
workstations into networks. 

Some of these application environments include: 

• Personal computer networks 
• Office equipment 
• Data Processing 
• Manufacturing 
• Engineering 
• Integrated work environments 

PERSONAL COMPUTER NETWORKS. 

PC networks need special consideration since their growing importance and role has not 
yet been fully realized. They can be used in any computer environment. A PC takes 
advantage of the low cost of microprocessors to allow a single user environment for 
computing. The PC network reduces the overall cost of peripherals by permitting a 
multi-user environment for device sharing. Applications processing is done at the PC 
work station, while the network provides peripheral sharing. Sometimes, access to 
peripherals is controlled by a dedicated PC. 

PC LANs are based on two types of devices: 

• The network user: a PC that uses the resources of the network. 

• The net~'ork ~_crver: a PC or other device that provides the resources 
for the network. 

The network server may be dedicated to a service such as providing 
hard disc memory for the network. Or a PC can serve as a work station 
as well as a network server. 
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OFFICE ENVIRONMENT 

The office environment ranges from mainframe computers to minis to personal 
computers, with peripherals serving these computers. In the office, many users need to 
be connected at the same time, but generally don't need constant access to the 
computer system. The data traffic tends to be in bursts. That is, data is sent in 
sporadic, but often large, transmissions. 

The main characteristic of computer usage in the office environment is the sending and 
receiving of messages and data between the users. A simple single cable LAN can 
connect this environment. 

An office environment is an ideal place for a PC LAN to operate. PCs combine local 
processing power with a host computer's ability to share information, peripherals, and 
communications facilities. Printing, text processing, electronic mail, spreadsheet 
information, and data bases can be shared. Other functions like file transfer and 
remote file access are also available. When many users need to be connected to each 
other at the same time, but constant interaction is not necessary, a PC LAN can provide 
good computer response time. 

DATA PROCESSING ENVIRONMENT 

The data processing area has its own requirements that make LAN capabilities very 
attractive. A mixture of computer systems exists here. Mainframes do production jobs 
and manage large data bases while minicomputers do distributed processing. A large 
network of terminals may be used for interactive data entry, as well as being controlled 
by applications programs. LANs provide a solution for sharing data whenever updated 
information is important, and for notifying everyone on the network of the most 
current information. 

PC LANs are also found in this environment. Sometimes the data processing 
environment is broken up into small branch offices that need to do their mvn thing 
before sending information over a wide area network. 

The data processing environment often includes equipment from different vendors. A 
multi-vendor LAN requires multi-vendor compatibility, that is, a network containing 
equipment from many <liff erent vendors communicating with each other. 
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MANUFACTURING ENVIRONMENT 

Simple robots, programm0ble controllers, 0nd controlled machinery can be brought 
together to form automated production lines. The functions performed on the factory 
floor include automated production, testing and process control. An automated 
production assembly line could be linked to an automated warehouse. Supervising 
computers decide if a sub-assembly is needed. If so, the parts could be retrieved from 
the \Va rehouse bins by automatic devices. 

Jn some environments such as the chemical industry, the factory can be hazardous to 
humans, so automation becomes essential. Some processes are time sensitive and require 
real-time automated controls, especially where measurements are involved. Often, a 
production line needs real-time monitoring and control of a process. 

A high speed LAN is ideal for these purposes. The need to link order entry systems, 
production control systems, inventory systems, sales data and the production database 
makes the manufacturing environment especially v.rell suited for LANs. 

ENGINEERING ENVIRONMENT 

Within the engineering application area, workstations are the machines mainly used by 
engineers for computer aided design (CAD). These engineering workstations can now 
have the power of a minicomputer. Engineers using these workstation£ often utilize the 
local processor power only, since their primary function is designing. Typically, data 
exchange with larger minicomputers or mainframes occurs infrequently. 

A LAN provides interaction for shared resource functions like disc access, printer and 
plotter output, and file transfer between workstations or to a mainframe. Applications 
and databases are kept on a shared network disc and loaded via the network onto the 
individual workstations when needed. This makes updating applications easier since 
only one copy of the data exists. 
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INTEGRATED ENVIRONMENT 

Putting together the office, the data processing environment, and the engineering 
environment creates an integrated environment where the user can communicate with 
any of the other environments. For example, an engineering LAN linked to automated 
test equipment can allow a manufacturer's engineering section to directly tr3nsmit its 
performance criteria to the factory. The factory, in turn, can communicate its 
requirements and process constraints to the engineering design team. Input from the 
marketing department (customer preferences and order forecasts) is transmitted to both 
engineering and manufacturing areas. 

An integrated environment allows different LAN technologies to communicate. PBX 
networks and PC LANs can be connected together or connected to other LANs. When 
users in the office, the manufacturing environment, and the data processing 
environment have access to common data bases and have the ability to exchange data, 
the result will be a powerful network capable of being a corporate data network, 
handling many environments and a diverse combination of data traffic. 

The key to an integrated environment is the compatibility between individunl LANs. 
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Network Topology 

The computers, printers, memory devices, plotters, and other peripherals that are 
connected to a LAN are called "nodes". The physical layout of the network, that is, the 
way in which nodes are interconnected is the network topology. 

The goal of a topological design is to achieve a specified performance at a minimal cost 
or, in other words, deliver the right information at the right time and at the right price. 

BUS TOPOLOGY 

The simplest technology used to connect the nodes of a LAN is the Bus Topology. lt is 
a linear run of single conductor coaxial cable v.:ith nodes connected along the cables 
entire length. Nodes can be connected to the cable with regular coaxial cable 
connectors or by piercing the cable with a tap to connect to the center conductor. 

Transmissions from a node flow in both directions towards the ends of the bus cable. 
The destined receiver must recognize data intended for it and read the message as it 
passes by. Bus cables over 1500 feet or one half kilometer require a device called a 
repeater to regenerate the data signals. 

The bus topology offers several advantages: 

If one node fails, it does not affect the transmissions between the remaining 
nodes. 

Bus topologies are flexible enough to be configured in most physical 
environments and also allow for easy expansion. 

Relatively simple transmission hard ware can be used to access the bus. 
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Transmission Media 

The transm1ss1on medium is the physical connection over \vhich communication 
between nodes takes place. It is sometimes called the link, line, channel, or coaxial 
cable. 

COAXIAL CABLE 

Coaxial cable is the most common physical medium for LANs. It combines strong 
construction, light weight, and low cost with good electrical isolation for high data 
transmission rates. 

The transmission media used to connect the various devices is specified by IEEE 802.3 
as a 50 ohm coaxial cable. The center conductor is a 0.0855-inch diameter, tinned, solid 
copper wire. The center conductor is insulated by foam polyethylene or foam Teflon. 
A wire mesh cable shielding is protected by a polyvinyl chloride (PVC) or Teflon 
fluorinated ethylene proplyene (FEP) cover. The outside cable diameter should be 
0.405 inch. 

A transmission cable may consist of a single segment with a maximum length of 500 
meters, or, segments of cable may be connected by using repeating amplifiers. The 
longest coaxial cable length between any two work stations may not exceed 2500 
meters and any work station signal must not pass through more than four repeaters. An 
additional 400 meters may be added to the 2500 meters maximum length by the AUi 
cables connecting the repeaters to the cable segments. Up to I 00 work stations 
separated by a minimum distance of 2.5 meters may be connected to a network cable 
segment. 
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Coaxial Gable Segment 

IEEE 802.3. Ethernet max lenoth = 500 M 
Cheapernet max length = 200 M 

(Al.JI} 

Tu1nsceiver Cable 
Mirirrum spacing I 50 M max l 
between stations 

l~~I 

Work Stations 

T ransceivef' 
& 

Connector 
to Coaxial Cable 

I MAU l 

( 100 max per segment J 

Figure 6-2. Local Area Network With Single Segment 

Work Stations 

Figure 6-3. Local Area Network With Joined Segments 
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Half 
Repeater 

Point-to-Point 

Link 

( 1000 M max) 

Introduction To LANs 

Figure 6-4. Local Area Network With Five Segments. 

MEDIA ACCESS UNITS (MAUs) 

The MAU is a transmitter and receiver unit which sits on the coaxial bus cable of the 
network. MA Us perform the function of transmitting and receiving data, and of 
detecting collisions, thus earning the name "transceivers." MAUs must adhere to strict 
specifications regarding input impedance and capacitance. 

Connection to the coaxial cable may be made by a tap used to pierce through the cable 
to the center conductor. This type of "vampire" connection has the advantage of 
having a connection made or removed \vithout disturbing any communications 
occurring on the line. Another method of connecting to the transmission cable is to cut 
the cable and install coaxial cable connectors. 
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ACCESS UNIT INTERFACE CABLE (AUi Cable) 

The AUI cable is used to connect the MAU to the node device. It lets the coaxial cable 
and the MAU be located in the ceiling, while the 'Nork station sits on your desk. The 
A UL cable consists of four shielded wire pairs. One pair of wires is reserved for 
transmit data, another for receive data, and the third is reserved for the collision 
detection signal. The fourth wire pair provides pmver (+- 12v) to the MAU. Because 
of the susceptibility to electrical interference, the transceiver cable must be less than 50 
meters long. The ends of the cable are terminated into D-series 15 pin connectors with 
one male and one female connector at either end. 

BASEBAND SIGNALING 

The method that the IEEE 802. 3 standard uses to transmit signals over the coaxial cable 
is called baseband. In baseband signaling, the available band width is allocated to a 
single data transmission channel. This means that simultaneous transmissions cannot 
coexist on a channel. 

Baseband typically has high data transmission rates of about I 0 million bits per second. 
Most baseband networks are typically used for data transmission only. 

Because of the lower bandwidth used with baseband, it has an advantage over other 
signaling methods of easy reconfiguration and addition of equipment. Baseband taps 
can quickly connect to or disconnect from the cable without disturbing network 
transmissions in process. 

IEEE 802.3 is often referred to as a lOBASES network. In breaking up the term 
IOBASES, the 10 refers to the data rate. Data is transmitted at 10 Mbits or 10 million 
bits per second. The word base denotes that the network is baseband. The 5 in the 
term refers to the allowable length of a segment of coaxial cable. A 10BASE5 system 
allows each contiguous segment of coaxial bus cable to be a maximum of 500 meters in 
length. 
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Network Access Methods 

Transmitted messages simultaneously interconnect to all nodes in a bus net\vork 
topology. However, for proper communication between nodes, data must be able to 
travel along the coaxial cable \vithout interfering with other data transmissions. 
Network access methods are the techniques by which nodes gain use of the physical 
network medium to send a message across the network. These methods ensure that 
only one node transmits at a time, or, if more than one transmits, the proper recovery 
action is taken to provide correct data transmission. 

CARRIER SENSE MULTIPLE ACCESS WITH COLLISION DETECT (CSMA/CD) 

IEEE 802.3 standard uses Carrier Sense Multiple Access with Collision Detect 
(CSMA/CD) as an access method in which each node has equal access to the network. 
There is no central node that controls transmission. CSMA/CD is an access metho<l 
used predominately with bus topologies. 

Carrier Sense me~rns that the sending node has the responsibility to discern that there is 
no other node transmitting before it attempts transmission. 

Multiple Access means that all the nodes have equal access to the network. 

Collision Detect means that \vhile transmitting, the sending node must continue 
monitoring the network for evidence of a message collision from another node. 

When two or more nodes attempt to transmit at the same time, the signals interfere 
with each other, causing a collision. Jf a collision is detected, each colliding node 
initiates a jam signal to warn the other nodes on the network. The collision is remedied 
by having the colliding nodes cease transmitting, and then wait. Stopping transmission 
and waiting a while before transmitting again is called "backing off". 

CSMA/CD protocol involves two basic rules: 

First, when the bus is busy; that is, a message is being sent, all other nodes must wait 
until the channel clears before trying to send their own messages. 

Second, if multiple nodes try to transmit messages simultaneously, which would cause 
a collision, these nodes must stop transmitting and wait for randomly varying delay 
times before transmitting again. 
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MAU COLLISION DETECTION 

Collisions on the network can be detected using two different methods. The 
characteristics of the different methods are listed below: 

Received Based Detection 

MAUs using Received Based Detection have the follO\ving characteristics: 

1. The average DC level of the network cable is used to determine if a collision 
has occurred. 

2. Non-transmitting stations can detect collisions. 

3. Received Based Detection is dependent on the DC resistance of the network 
cable. 

Transmit Based Detection 

MA Us using Transmit Based Detection have the following characteristics: 

I. The transmitted signal is subtracted from the received signai, ie'aving oniy the 
interference signal. 

2. Transmit Based Detection can be used over greater distances than Received 
Based Detection. It is less susceptible to DC resistance losses. 
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The IEEE 802.3 Frame 

The word frame is used to describe the format of a node's transmissions on the 
network. The frame format specifies the location of routing information and the 
check for data integrity. The frame format is vital to proper function of the network. 
You must be well acquainted with the frame structure because it is the level at which 
the HP 4971 S is most effective as a diagnostic tool. In order of transmission, the fields 
are Preamble, Destination Address, Source Address, Length Field, Data Field, and FCS 
Field. 
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THE PREAMBLE (8 bytes) 

The Preamble is an eight byte field used for informing all the receivers on a network 
that a frame is coming. It is eight bytes long to provide ample time for the 
synchronization of clocks. The first seven bytes of the Preamble are AA hex, the last 
byte is an AB hex. It is important to note that MAUs and repeaters sometimes lose 
several bits from the front of the Preamble while synchronizing their clocks. (The HP 
497 lS does not display the Preamble Field of frames.) 

THE DESTINATION ADDRESS (6 bytes) 

The Destination Address Field contains the unique six byte address of the unit for 
which the frame is intended. The important fact about the Destination Address is that 
every unit manufactured to be connected to an Ethernet LAN has a unique 6 byte 
address. Thus, when any new device is added to a LAN, it is already equipped with an 
address different from those of the devices which have already been installed on the 
LAN. As a result, any and all of the LANs in the world could be connected without 
any conflicting addresses. 

THE SOURCE ADDRESS (6 bytes) 

The Source Address Field identifies the ong111 of a frame. When nodes transmit a 
message, they identify themselves by placing their unique six byte address in this field. 

THE LENGTH FIELD (2 bytes) 

The Length Field is used in IEEE 802.3 frames to indicate how many valid bytes are 
contained in the frames's Data Field. This count includes only valid data bytes, it does 
not include any padding characters added to make the Data Field long enough or the 
four bytes of the FCS Field. 

On Ethernet networks only, this two byte field is not used for describing the byte 
count, but for describing the type of data contained in the Data Field. 
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THE DATA FIELD (46-1500 bytes) 

The Data Field is reserved for information exchange. It is limited to 1500 bytes to 
prevent one node from consuming too much of the network capability with one 
transmission. The Data Field is required to be at least 46 bytes so that collisions can be 
detected before the transmitting node finishes its transmission. The minimum 46 byte 
Data Field length is sufficient even on very large networks where propagation delay is 
significant. Any type of data is permitted in the Data Field. 

THE .FCS FIELD (4 bytes) 

The FCS or Frame Check Sequence Field is used to verify that the frame was received 
intact. As a frame is received from the network, every byte of it (except the Preamble) 
is used in calculation of the frame check value. Most nodes discard frames which have 
incorrect FCS values. The HP 497 lS indicates Frame Check Sequence errors in the 
displayed frame header. 
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Local Area Network System Differences 

IEEE 802.3, Ethernet, and IOBASE2 networks share many characteristics. However, 
some differences do exist. The following text describes the primary differences. 

ETHERNET DIFFERENCES 

The primary difference between Ethernet and IEEE 802.3 networks is in the protocol 
frame structure. The two bytes between the Source Address field and the Data field 
are used to indicate message type in Ethernet. ln IEEE 802.3, this two byte field is used 
to indicate length of significant bytes in the Data Field. 
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1 OBASE2 DIFFERENCES 

IOBASE2 is very similar to IEEE 802.3. The primary difference is: smaller coaxial 
cable, shorter segment lengths and fewer work stations. Its advantages are lower cost 
and easier installation. 

The 10 Mbit/sec data rate is maintained similar to IEEE 802.3. A cost advantage gained 
by using regular RG-58 coaxial cable to connect the nodes via BNC connectors is offset 
by having the maximum cable segment length reduced to 200 meters with 1000 meters 
maximum overall network length. 10BASE2 networks support only 30 work stations on 
a segment; however, they must be separated by a minimum distance of only 0.5 meters. 

In contrast to IEEE 802.3, the 10BASE2 networks do not use a MAU and transceiver 
cable but connect directly to the network's primary cable via a simple BNC connector. 
The MAU function is usually built into the work stations's interface board. 

The protocol of the 10BASE2 messages is the same as IEEE 802.3. 
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Some of the IEEE 802.3, Ethernet, and l OBASE2 differences and similarities are 
summarized below. 

PARAMETER 

Data Rate 

Max Segment Length 

Max Network Span 

Max nodes 
per segment 

Max nodes 
per network 

Minimum 
Spacing 
Between Nodes 

LAN CABLE 
Type 

Connectors 

Impedance 

TRANSCEIVER CABLE 
Diameter 

Construction 

Connectors 

Max length 

IEEE 802.3 ETHERNET 
(10BASE5) 

10 Mbits/sec 10 Mbits/sec 

500 meters 500 meters 

2500 meters 2500 meters 

100 100 

1024 1024 

2.5 meters 2.5 meters 

RG-225 RG-225 

N series N series 

50 ohm 50 ohm 

0.38-in 0.38-in 

4 twisted- 4 twisted-
pair wires pair wires 
(Additional twisted pair optional) 

15 pin 
D-series 

50 meters 

6-22 

15 pin 
D·series 

50 meters 

10BASE2 

10 Mbits/sec 

200 meters 

1000 meters 

30 

1024 

0.5 meters 

RG-58 

BNC 

50 ohm 

not used 

not used 

not used 

not used 
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Local Area Network Performance Measurements 

The preceding section described the fundamentals of a LAN. Several measurements can 
be made that show the performance of the network. Examples of these measurements 
include: 

What stations are transmitting on the network? 

Are messages with frame errors being sent? 

Do stations respond correctly to some number of frames/second? 

Do stations respond to an average packet size? 

What is the length of messages? 

\Vhat time are messages transmitted/received? 

How much time occurs between messages? 

What station(s) is(are) talking to another station? 

The HP 4971 S can help you to answer these system questions. The following chapter 
summarizes the functions of the protocol analyzer that capture, display, and measure 
the operation of your LAN. 
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CHAPTER 7 

INTRODUCTION TO THE HP 49715 

This chapter provides an introduction to the functions and capabilities of the HP 497 lS. 

This chapter includes: 

• Functional View Of The HP 497JS 

• More Details About HP 497 lS Functions 

• The HP 4971 S System Devices 
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Functional View Of The HP 4971 S 

What will a protocol analyzer do for you? 

In Chapter 6, you learned about Local Area Networks (LANs) and in particular about 
CSMA/CD LANs. You should recall that there are some rigid rules regarding accessing 
the network, backing off, frame lengths, and frame formats. You should also recall 
that the data transmission on the network occurs at a rate of 10 million bits per second. 

What do you do when something goes wrong with a LAN? If you need to verify 
frames transmitted by a particular device on a busy network, how do you do it? If you 
only have an oscilloscope and a logic analyzer, it would require very complicated 
triggering to capture specific frames on the network. In addition, you would have to 
be able to decode the frame information from its binary state. The obvious solution to 
your network problem is a specialized tool, a LAN protocol analyzer. 

In the most simple monitor form, a LAN protocol analyzer will let you view on a 
display, the frames which are occurring on the LAN. Figure 7-1 shows a simple 
monitor function. 
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BUFFER MEMORY 

With frame information being transmitted at lO million bits per second, it is obvious 
that you cannot view the frames in real time. The HP 497 lS uses a Receive Buff er to 
capture and hold the frames so you can view the details of each frame. You are not 
viewing the frames as they occur on the network in real time. However, you do see the 
frames in the actual sequence they occurred on the network. 

Management of this memory buffer can be difficult. Considering the data rates on the 
LAN, the buffer should be large, but it should also be small enough to allow something 
less than a mainframe computer to operate on it in a reasonable amount of time. There 
are two primary ways to manage this buff er: in a non-stop mode, or in a 
stop-when-full mode. 

In non-stop mode, the oldest frame in the buffer is destroyed to make room for the 
next frame to be stored. Non-stop mode allows you to have a buffer full of the newest 
frames at all times. On a busy net work, non-stop mode may not permit you to view 
every frame before it is overwritten. Instead, the analyzer displays the newest complete 
frame each time. 

In the stop-when-full mode, every frame from the LAN is stored sequentially in the 
buffer memory. When the memory is full, the analyzer quits collecting frames and 
returns control to you. You can then view or examine the data at a slower rate that is 
convenient for you. 

NODE LIST 

LANs can have several hundred work stations or nodes installed. While each 
transmitted frame identifies the sending and receiving stations with a six byte address, 
recognizing six byte addresses for several hundred nodes would be difficult. It would 
be helpful to be able to identify nodes by a descriptive name that identifies the user or 
the node function. 
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DATA FILTERING 

Stop to consider for a moment that even a buff er memory of several million bits would 
be filled in just seconds with a transmission rate of 10 Mbits/second. Thus it is 
important for your protocol analyzer to be able to filter incoming frames, that is, to 
discard unwanted frames and prevent them from wasting the buff er memory available. 
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TIMESTAMPING 

The primary reason for a LAN is to allow different machines to talk to one another. 
Of course, they must be able to respond to each other's requests in a reasonable amount 
of time. At some point, when you are troubleshooting a LAN, you will need to know 
when different frames are transmitted on the network. In most cases, you need to see 
the time between related frames. 

The HP 497 IS solution to this problem is a timestamp feature which tags each incoming 
frame with the time the frame arrived. 
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SIMULATING MESSAGES 

Just for a-moment, think about what happens when computers exchange messages. The 
example messages below have been paraphrased to illustrate computer transmissions: 

Hey mainframe, this is Bill's PC, will you send me record 1234? 

Sure Bill's PC, this is the mainframe, here's record 1234. 
"The quick brown fox jumped over the lazy dog's back!? 11 

Hey mainframe, this ;is Bill's PC, thanks for record 1234. received it OK. 

At some time, you may want to start a transmission like the one above by asking a 
question of another LAN device. The HP 4971 S lets you impersonate or simulate 
another LAN device which normally talks to the device you are testing. 

To accomplish this simulation capability, the HP 497 lS has transmitting hardware and a 
buffer to store the messages you wish to send. 
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PROGRAMMING 

With the addition of the transmit hardware. you have a reasonably complete LAN 
protocol analyzer. You can store selected data in a buffer, analyze it at your leisure, 
observe exactly when the frame came in, and you only have to look at the frames you 
are interested in. 

You can even start a transaction by sending a message, but what if you need to respond 
to another device's query? Lt would be hard for you to ahvays be available when a 
message came in that requested a response from you. Clearly, a need exists for 
programming capability in your LAN protocol analyzer. 

The HP 497 lS has the programming capability to watch the incoming frames and make 
decisions based on their contents. It can control the display, transmit messages, make 
timing measurements as well as count events on the LAN. 
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MASS STORE 

As mentioned earlier, it would be difficult to create a buffer storage large enough to 
hold network traffic for long periods of time. What if you needed to save network 
data, protocol analyzer setup configuration or programs for future reference? A LAN 
protocol analyzer should have the quick reference to information that a disc drive can 
provide. 

PRINTER OUTPUT 

What if you wanted a hard copy of a program you have written or you want a printer 
output of the display? The HP 4971 S supports a printer to let you have these functions. 

SUMMARY 

In summary, the HP 497 JS provides the following primary functions: 

1. Monitoring a network in a transparent or unobtrusive manner. 
2. Simulating a node on the network. 

In addition these functions can be performed in a master-slave combination using two 
HP 497 lS stations. One station must be connected directly to the local area network 
while the second station can be positioned anywhere that an RS-232C link can be 
established. 

These primary functions are enhanced by having the following features available as 
softkey operations: 

Filtering 

Programming 

Friendly node identification 

Mass storage of programs and data to a disc drive 

Printed copies of received frames and system setup information 
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More Details About HP 4971 S Functions 

MONITOR FUNCTIONS 

Monitoring can be performed in two modes. One of the modes uses simple softkey 
selections while the second mode uses programming statements created by the user. 

Simple monitor- The simplest mode is available with only a few softkey selections. Jn 
this mode, all messages occurring on the network are stored in a Receive Buffer, no 
filtering can be done. 

Programmed monitor- The more complex monitor function can be done by using the 
programming capability of the protocol analyzer. In this mode, you can filter only the 
data that is important to you. Programs can also perform more complex triggering to 
start and stop the display or increment counters and timers. 

In either monitoring mode, the activity on a Local Area Network is viewed in a 
transparent mode that does not disturb the activity of the system. Both monitor modes 
store frames in a buffer~ however, in the programmed mode, up to 16 different traps 
or filters can be used to specify frames to be stored. The captured frames can be 
displayed in several formats. Jn addition, analysis on the stored frames can be 
performed in a variety of ways. 

Storage capacity- Depending on the length of the data message in each frame, 
different amounts of frames can be stored. The HP 4971 S memory will hold several 
hundred frames. 

SIMULATE FUNCTION 

In the simulate mode, programs can be written to allow messages to be transmitted in 
response to specific received frames. Sequences of different messages can be sent and 
specific messages can be repeated a selected number of times. The messages can be 
created with any address, data field content, and good or bad FCS. 

Messages can be sent that vary in length from one to 2022 bytes. This lets you observe 
how stations respond to messages that are too short or too long. 

Similar to the monitor function, simulate mode can store received frames. The same 
<;;torage capacity is available in simulate mode as in monitor mode. 
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MASTER/SLAVE OPERATION 

Monitor and simulate functions can be performed on your LAN from a remote 
location by using two HP 4971 S's connected by an RS-232C data link. 

The slave unit or measurement device is the unit connected to the LAN under test. 

The master unit or controlling device is the unit from which the measurements are 
controlled. The master or controlling device must be a HP 497 lS. 

Both the master and slave units must have an HP 98628A Datacomm Interface for the 
RS-232C data link. The slave or measurement device must contain HP 497 IA hardware 
but does not need a keyboard, a display monitor, or mass storage (disc drive). The 
controlling unit can provide all display and control functions for the remote unit as 
well as all disc operations such as system software and file storage. 
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The HP 4971 S System Devices 

Look over the figure below. Keep in mind that the parts shown below perform all the 
functions described on the previous pages. The display, mass store and printer 
functions are performed by the peripheral devices shown. The HP 497 LA instrument 
performs the LAN interfacing, buffering and programming functions. 

As you read more about this instrument system, it is important that you remember the 
product number HP 497 lS refers to the LAN Protocol Analyzer system which includes 
an HP 497 lA instrument, a disc drive, and possibly a display, keyboard and printer. 
(Systems operated only from a remote location need only the HP 497 l A instrument and 
a disc drive.) The product number HP 497 lA refers to the processor unit only. 

HP 49715 LAN PROTOCOL ANALYZER 

VIDEO DISPLAY 

/ THINKJET PRINTER 
"\ 

HP 497 lA 

Figure 7-8. HP 497 lS System Devices. 
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The Disc Drive 

The Video Display 

The Keyboard 

The Printer 

Introduction To The HP 497 lS 

The HP 4971 A processor is the heart of the HP 497 lS LAN 
Protocol Analyzer system. It contains the hardware which 
interfaces to the LAN and colJects data. 1t contains the 
processor which runs the system software and controls the 
LAN interface hardware. 

A double sided, double density 3.5 inch floppy disc drive is 
required for each HP 497 lS system. The disc drive is used to 
load the instrument code, and to store instrument data and 
setup configurations. You have a choice of what disc drive to 
order with the system. Your decision will be based upon the 
intended application of your system. 

The HP 9122D Dual Disc Drive should be ordered with any 
system that will be moved regularly. It is the most "portable" 
disc drive option for the HP 497 lS and will perform all the 
system functions. 

The Winchester disc drives are recommended for any 
application where large amounts of network data need to be 
stored. The hard disc offer a large storage capacity and faster 
storage and and retrieval than the HP 9 l 22D. The hard discs 
are more delicate and require special precautions whenever 
they are moved or shipped. 

A video display is ;required at any time the system will be used 
as a master in master-slave operation or in stand-alone 
operation. The Video Interface and cable (Option 001) must 
be ordered with every HP 497 lS that must support a video 
display. 

A keyboard is also required for master and stand-alone 
operation. The keyboard interface is included in every HP 
497 lS. 

The HP ThinkJet Printer is supported by the HP 497 LS. You 
will find printouts of particular displays, data and programs is 
a convenient feature. 
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CHAPTER 8 

PREVENTATIVE MAINTENANCE 

In general, the devices in the HP 4971 S do not require periodic maintenance. 
Suggestions are given for general cleaning. Also included is a list of common 
replaceable parts. 

This chapter includes: 

• Cleaning System Devices 

• Common Replaceable Parts 
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Cleaning System Devices 

WARNING I 
ALWAYS UNPLUG THE SYSTEM DEVICES BEFORE 
CLEANING THEM WITH A LIQUID SOLUTION. 

To remove dirt and smudges from your system devices, use a mild solution of dish 
washing detergent and water. Never use harsh chemicals to clean the devices. 

PRINTER 

Periodically clean paper dust out of the printer. 

See Chapter 4 of the llP 2225A ThinkJet Printer manual for details about maintenance 
of the print head cartridge. 

DISC DRIVE 

Make sure the shutter on the floppy disc is closed when any discs are not in use. 

Store the discs in a clean environment. 

Protect the discs from dust, fingerprints, and scratches. 
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Common Replaceable Parts 

Fuses 

Fuses for the HP 4971 S are listed in Table 4-1 of Chapter 4. 

Floppy Discs, double-sided, (box of I 0) 

HP-IB Cable, 1/2 meter 
HP-IB Cable, l meter 
HP-IB Cable, 2 meters 
HP-IB Cable, 4 meters 

Ink Jet Paper, 2000 sheets, single sheets 
Ink Jet Paper, 2500 sheets, fan fold 

Print Head Cartridge 
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Amplifier 

APPENDIX A 

GLOSSARY OF LAN TERMS 

An analog device designed to boost the strength of an electronic 
signal. lt compensates for the signal loss in a section of transmission 
medium. 

AUi (Attachment Unit Interface) cable 

Bandwidth 

Baseband 

Cable that attaches the MAU (Media Access Unit) to the interface at 
the computer. 

The range (band) of frequencies capable of being carried by a 
channel. The difference between the highest and the lowest 
frequencies of a band expressed in hertz. 

A transmission channel which carries only one communication 
channel. The transmission rate is typically 10 megabits/second. 

Baseband networks are sometimes ref erred to in the format, 
lOBASES. In this example, the 10 refers to the data rate. Data is 
transmitted at JO Mbits per second or lO million bits per second. The 
word BASE denotes the network is baseband. The 5 in the term 
refers to the allowable length of a segment of coaxial cable. A 
lOBASES system allows each contiguous segment of coaxial bus cable 
to be a maximum of 500 meters in length. 

IEEE 802.3 and Ethernet are examples of 1 OBASES networks. 

Cheapernet and ThinLAN are examples of 10BASE2 networks. 

Bits per second (bps) 

Bridge 

Measurement of rate at which data is transmitted over a channel. 

A device that provides an interconnection between LANs using 
similar protocols. 
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Glossary of LAN Terms 

Broadband 

Broadcast 

Bus 

A transmission channel with a wide frequency range that is 
multiplexed into separate communication channels. 

The act of one station transmitting a signal on a LAN to all the 
other stations capable of receiving signals. 

A topology in which nodes are attached to a linear cable segment. 

Carrier Sense Multiple Access with Collision Detection (CSMA/CD) 

Channel 

Cheapernet 

Coaxial cable 

Collision 

An access protocol in which devices contend for a shared 
communication line. 

Path on which signals travel. 

A de facto Local Area Network standard. Similar to IEEE 802.3 
standard. 

An insulated conducting wire surrounded by a fine copper braid or 
an extruded aluminum sleeve. It has the capability to carry 
transmissions with high data rates with high immunity to noise. 

The name for when two nodes on a network contend for the 
network at the same time. 

Collision Detection (CD) 

Common carrier 

The ability of a transmitting node to detect simultaneous 
transmission attempts on a shared medium. 

Companies which provide communication networks. 
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Contention 

Glossary of LAN Terms 

The condition when two or more stations attempt to use the channel 
at the same time. 

CRC (Cyclic Redundancy Check) 
An error checking algorithm which is included in a frame before 
transmission. The receiving station generates its own CRC and 
checks it against the received CRC. If the results are different, the 
system can either discard the frame or request a new transmission. 

CSMA (Carrier Sense Multiple Access) 
A medium access control technique for multiple access transmission 
media. A station wanting to transmit, senses the medium and 
transmits only if the medium is idle. 

CSMA/CD (Carrier Sense Multiple Access / Collision Detect) 

Ethernet 

Fiber optics 

Gateway 

Hertz 

A refinement of CSMA in which a station ceases transmission if it 
detects a collision. 

A Local Area Network standard. Similar to IEEE 802.3 standard. 

Thin, transparent fibers of glass or plastic that transmit light. Data is 
transferred through light pulses. 

A device that allows routing from one network to various other 
dissimilar networks. It provides protocol translation between the 
networks. 

A unit of frequency equal to one cycle per second. 
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Glossary of LAN Terms 

IEEE 802 

lnternetworking 

Jam 

An lEEE standard for the interconnection of local area networking 
computer equipment. The IEEE 802 standard describes the Physical 
and Link Layers of the ISO Reference Model for OSI. 

Communication between two or more different networks. 

A short encoded sequence emitted by a node to ensure that all other 
nodes have detected a collision. 

Local Area Network (LAN) 
A network of limited size (building or campus) with a high data rate, 
low delay and low error rate. 

Long Haul Network 
Network which spans areas as large as the entire world. Associated 
with Wide Area Networks rather than Local Area Networks. 

Manchester Encoding 
A digital signaling technique in which there is a transition in the 
middle of each bit time. A I is encoded with a high level during the 
first half of the bit time. A 0 is encoded with a low level during the 
first half of the bit time. 

MAU (Media Attachment Unit) 
Component which connects directly to the coaxial cable of the LAN 
system. This component is connected through the AUi to the 
computer interface circuit. 

MAN (Metropolitan Area Network) 

Modem 

A network of large geographic area (a city) with a high data rate, 
moderate delay and moderate error rate. 

Device which converts digital signnls into nnalog signnls nn<l vice 
versa; also called "data set". 
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Multicast 

Network 

Node 

Noise 

Glossary of LAN Terms 

The ability to broadcast messages to one node or a select group of 
nodes. 

A mixture of hard"-'are and software components that allow the 
transfer of data locally as well as over great distances. 

A computer or a device on a network. 

Undesirable electrical signals on a communication channel that can 
interfere or distort data signals. 

OSI Reference Model 

Packet 

Polling 

Open Systems Interconnection reference model defined by the 
International Standards Organization (ISO), which establishes a data 
communication architectural model for networks. 

A group of bits that includes data plus destination and source 
addresses. Control information is carried in the packet, along with 
the data, to provide for such functions as addressing, sequencing, 
flow control, and error control at different protocol levels. Packet 
length can be fixed or variable, but it commonly has a specified 
maximum length. 

An access method involving a central node asking each node in a 
predetermined order if it has data to send. 

Private Branch Exchange (PBX) 

Protocol 

A telephone system used to connect calls between offices in the same 
complex, and to switch calls between the site and the outside world. 

A formalized set of rules by which computers communicate. 
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Glossary of LAN Terms 

Packet Switching Network (PSN) 

Repeater 

Ring 

RS-232-C 

Server 

Star 

Network which uses packet switching for digital transmission of data. 

A device which continues signals from one segment of coaxial cable 
to another. 

A topology in which nodes are connected in a circular pattern. 

A standard developed by the Electronic Industries Association for 
interfacing data communications equipment and data terminal 
equipment. 

Dedicated processor to perform a function such as print server or 
file server. 

A topology in which all nodes join at a central node. 

Store and Forward 
A computer system capability in which messages are received at 
specific points and held there until they can be forwarded to their 
destination. 

Time division Multiplexing (TOM) 

Topology 

A method using specific time slots to access a communication link. 
This is done by combining data from seNeral devices into one 
transmission. 

Layout of a network, the way in which the nodes in a network are 
interconnected. 
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Twisted Pair 

Glossary of LAN Terms 

Pairs of wires twisted together, commonly used in telephone 
communications. 

Wide Area Network (WAN) 

Work station 

X.25 

A network with the capability of covering an area as large as the 
entire world. 

An intelligent terminal. 

Jnternational standard from CCJTT for interfacing computer 
equipment to Packet Switching Networks. 
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10BASE2 
lOBASES 

<802.2 Format> 
<802.2 Header> 
<802.3 Format> 
<802.3 Header> 
802.3 Frame Protocol 

<Abort Operation> 
Accessories for the HP 4971 A 
Accessories for the HP 497IS 
Accessory boards, locations 
Access Unit Interface (AUi) 

Active softkeys 
<Add Filter> 
<Add Message> 
Address switches, memory boards 
<All Frames> 

Altitude 
<And> 
<And Frame Traits> 
<And Then> 

ARROW-DOWN key 
ARROW-HOME key 
ARROW-LEFT key 
ARROW-RIGHT key 
ARROW-UP key 

<ASCII 7> 
<ASCII 8> 
<ASCH 8 Data> 
ASCII code table 
<ASCII Entry> 

A 

6-21, 6-22 
6-14, 6-22 

12-18 
19-28 
12-17 
19-27 

6-17, 9-4 

20-4 
2-10 

2-8 
4-22 
6-14 

1-l 0 
12-10 

13-4 
4-24 
14-6 

2-6, 3-2 
14-36 

14-10, 14-37 
14-24 

1-11 
1-1 1 
1-1 l 
1-12 
1-12 

19-33 
19-33 

13-6 
Appendix B 

12-16 

Volume I contains Chapters 1 through 8 and Appendix A 
Volume II contains Chapters 9 through 22 and Appendixes B through E. 
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Assigning A Printer 
Assigning The Mass Storage Device: 

Backing up system software 
BACKSPACE key 
Bad FCS 
Baseband 
Baud Rate: 
<Beep> 

<Binary LSB Left> 
<Binary LSB Right> 
<Bin LSB Left> 
<Bin LSB Right> 

Bits/Character: 
<Block l> 
Block structure 
Buff er Memory 

Bus position 
Bus Topology 

B 

Byte position in <Examine Data> Menu 

<Capture Slave> 
Carrier Sense 
<Centered About> 
<Change Datafield> 

<Change Headers> 
<Change Timestamp> 
Chapter introductions 
<Character Data> 
Character entry 
CLEAR LINE key 
Coaxial Cable 

c 

15-12 
15-13 

5-14 
1-15 

19-6, 19-48 
6-14 

15-17 
14-28 

1 1-1 l 
11-10 
12-16 
12-16 

15-18 
14-11 
14-18 

7-4 

l l-6 
6-10 
19-8 

15-5 
6-15 
14-8 

19-31 

19-25 
19-35 

1-2, L-5 
19-32 

1-16 
1-12 
6-11 

Volume I contains Chapters 1 through 8 and Appendix A 
Volume II contains Chapters 9 through 22 and Appendixes B through E. 
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Collision 
<Collision Counter> 
Collision Detect 
Collision LED 
Control field (IEEE 802.2) 

<Copy Block> 
<Copy Files> 
Copy Files Syntax 
<Copy Filter> 
<Copy Frame> 
Copying an Entire Disc 

<Copy Message> 
<Copy Program> 
Copy system software 
Corrupt Data 
<Counters & Timers> 

<Create New File> 
CSMA 
CSMA/CD 

<Data field = 0000 ... > 
<Datafield = 0101 ... > 
<Datafield = 1010 ... > 
<Datafield = 1111 ... > 

Data Field, IEEE 802.3, Ethernet 

<Data File> 
Date (Setting The Date) 
<Date/Time> 
DDCMP: 
<Delete Block> 

<Delete Bytes> 
DELETE CHAR key 

D 

12-21 
14-24, 14-34, 14-40 

6-15 
16-6, 17-7 

19-28 

14-31 
18-15 
18-15 
12-19 

13-8 
18-20 

13-8 
14-32 
5-14 

19-6, 19-4 7 
19-39 

18-9, 18-13 
6-15,A-3 
6-15, A-3 

13-7 
13-7 
13-7 
13-7 

6-19, 19-8 

18-10 
5-18, 22-2 

19-36 
15-15, 15-21 

14-32 

12-15, 13-5 
1-12 

Volume I contains Chapters 1 through 8 and Appendix A 
Volume II contains Chapters 9 through 22 and Appendixes B through E. 
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<Delete Field> 
<Delete File> 
<Delete Filter> 
DELETE LINE key 
<Delete Message> 

<Delete Node> 
<Delete Program> 
Destination Address, IEEE 802.3 
<Detailed Format> 
Disabled hand shaking 

Disc Designations 
Disc Drive Numbers 
Disc Drives 
Disc file syntax 
Disc File Type 

<Disc Functions> Menu 
Disc Number or Name 
Disc Sequence Number 
Discs Supplied With System 
<Display> 

<Display Frame> 
Display, installation 
DSAP 

<EBCDIC> 
EBCDIC code table 
<EBCDIC Data> 
<EBCDIC Entry> 
<Edit All Fields> 

<Edit Config.> 
<Edit Datafield> 
<Edit Filters> 

E 

12-15 
18-8 

12-IO 
1-12 
13-4 

11-7 
14-5 

6-18, I 9-7 
19-17 
15-19 

18-3 
18-3 
5-3 

18-15 
18-17 

I 8-1 
5-4, 5-7' 18-16 

18-17 
18-4 

14-21, 14-44 

14-26, 14-43 
4-16 

J 9-28 

19-33 
Appendix B 

13-6, 13-10 
12-16 
12-12 

15-4 
13-5 

12-1, 12-9, 14-36 

Volume I contains Chapters 1 through 8 and Appendix A 
Volume II contains Chapters 9 through 22 and Appendixes B through E. 
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Editing programs 
Editing With Keyboard Keys 
Edit Message example 
<Edit Messages> 
<Edit Modem Str> 
<Edit New Program?> 

<Edit Nodelist> 
adding stations to list 
deleting stations from list 
searching the node list 
sorting the node list 

<Edit Programs> 

Edit Which Program? 
<Else If> 
<Else When> 
<Enable [/0> 

Encoded DDCMP: 
<End Edit> 
<Ending With> 
End of Frame 
<Enter Node Name> 
Environment, operating 

Error, 1/0 
Error Messages 
<Ethernet> 
<Ethernet Format> 
Ethernet, frame 
<Ethernet Header> 

<Examine Data> 

14-18 
1-11 

13-12 
13-1 
15-7 
14-4 

1 1- l 
11-5 
11-7 
11-9 
11-8 
14-1 

14-4 
14-34 

14-34, 14-41 
15-9 

15-15, 15-22 
14-10, 14-24, 14-34 

14-9 
19-34 

12-11, 13-4 
3-2 

15-23 
Appendix C 

11-4 
12-17 
6-20 

19-27 

19-1 

Volume I contains Chapters 1 through 8 and Appendix A 
Volume II contains Chapters 9 through 22 and Appendixes B through E. 
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Examine Data Display 
Byte Position 
Data 
Destination Address 
Error 
Filters 
Frame Number 
Message Length 
Source Address 
Time Stamp 
Type 

<Execute Program> 
<EXIT> 

FCS, Bad, Good 
FCS, choosing an FCS value 
FCS Field, IEEE 802.3 
Files, disc syntax 
Filter examples 

<Filter Format> 
Filter, introduction 
Filter length 
<Find Block> 
Finding Frames 

<Floppy 0 (#3:)> 
<Floppy I (#4:)> 
<FoJlowed By> 
<Format As Filter #> 
<Format Disc> 

F 

Formatting (Initializing) a Floppy Disc 
Formatting (Initializing) a hard disc 

19-2 
19-8 
19-8 
19-7 
19-5 
19-4 
19-2 
19-3 
19-7 
19-3 
19-7 

I 6-1 
20-14 

12-21 
13-1 l 
6-19 

18-15 
12-24 

19-20 
7-6, 12-2 

12-22 
14-31 
19-12 

18-6 
18-6 

14-30 
13-9 

18-18 

5-14, 18-18 
5-10 

Volume I contains Chapters 1 through 8 and Appendix A 
Volume II contains Chapters 9 through 22 and Appendixes B through E. 
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Frame Acquisition vs Display Speed 
<Frame Counter> 
Frame Errors 
<Frame Matches> 
Frame match hierarchy 
Frame Number 
<Frames Matching> 
Fuses 

<Go To Byte> 
<Go To Frame #> 

<Hard Disc (# 13)> 
Hardware Handshake: 
<Hex> 
<Hex Data> 
<Hex/Char Data> 
<Hex Entry> 
HP 497 lS Files On Disc: 
HP-IB Cables, installation 
HP-IB Cables, part numbers 
Humidity 

IEEE 802.3 Frame 
If commands 
<If Counter> 
<Increment Counter> 
lnitializing (formatting) floppy disc 
Initializing (formatting) hard disc 

<Insert Block> 
<Insert Bytes> 
INSERT CHAR key 
<Insert Field> 
1 NSER T LINE key 
<insert Node> 
<Internal Loopback> 

G 

H 

16-2 
J 4-23, 14-34, 14-39 

19-41 
14-34, 14-36 

14-37 
19-2 

14- l l 
4-7 

13-6 
19-14 

5-7, 18-6 
15-19 
11-10 
19-32 
19-32 
12-16 
15-15 
4-I 8 

8-3 
2-6, 3-2 

6-17, 19-41 
14-19 

14-25, 14-33 
14-25 

5-14, 18-18 
5-10 

14-32 
12-15, 13-5 

1-12 
12-14 

1-12 
11-5 
21-6 

Volume I contains Chapters 1 through 8 and Appendix A 
Volume II contains Chapters 9 through 22 and Appendixes B through E. 

I- 8 



1/0 Functions 
1/0 Mode of Operation 
1/0 Status Messages 

Jabber Frames 

Keyboard, installation 
Keyboard keys 

J 

K 

L 
LAN (Local Area Network), introduction 
LAN terms, glossary 

LANCOD 
<LANSAV: Disc> 
LANSYS 
Length Field, IEEE 802.3 

Line voltage select switches 
<List Directory> 
<Load File> 
Loading The System Software 

Manual conventions 
<Mark Frame> 
<Marked Frames> 
<Marking Frames> 
<Mark/Unmark> Frame 

Mass Store Assigned To: 
Master/Sia ve 
Media Access Units (MAUs) 
Memory Bytes Available 
Message Length 

Misaligned Frame 
Modem Fl-Duplex 
Modem Hf-Duplex 
Monitor Function 

M 

15-1 
15-11 
15-23 

19-6, 19-45 

4-14 
1-11 

6-1 
Appendix A 

18-4 
J 8-5 
18-4 
6-18 

4-5 
18-7 

18-14 
5-4 

1-1 
14-27 

J 8-13, 20- J 3 
14-23 
19-15 

15-13 
7-18, 15-5 

6-13 
21-3 
19-3 

12-21, 19-6, 19-46 
15-19 
15-19 

7-17 

Volume I contains Chapters 1 through 8 and Appendix A 
Volume II contains Chapters 9 through 22 and Appendixes B through E. 

I- 9 

lnuex 



Index 

<Monitor Network> 17-1, 17-3 
Multiple Access 6-15 

N 
Network Access Methods 6-15 
<Network File> 18-9 
<Network Loop Test> 21-5 
Network Name, assigning a name l 1-3 
Network Topology 6-10 

Network Type, assigning a type 11-4 
<New String> 15-7 
<Next Block> 14-24, 14-34 
<Next Frame> 19-13 
NEXT key 1-13 
<Next Marked> 19-14 
<NO> 11-7 
Node address 11-6 

Node List 7-4 
Node list, adding stations to the list 11-5 
Node name 11-6 
Node number 11-6 
<No Frames> 14-11 
<Nonstop> 14-10 
<Nonstop Mode> 17-3 

<Not> 14-36 
<'Not' Byte> 12-16 
Numeric entry 

0 
1-16 

Options for the HP 497 lA 2-11 
<Or> 14-11, 14-37 p 
Parity Bit: 15-18 
Peripherals for the HP 497 lS 2-9 
<Physical Header> 19-26 
Power cords 4-11 
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Volume II contains Chapters 9 through 22 and Appendixes B through E. 
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Power Requirements 
Preamble, lEEE 802.3 
Preventative maintenance 
<Previous Frame> 
<Previous Marked> 
PREV key 

<Print Data> 
Printer Assigned To: 
<Printer Functions> 

Getting Top Of Forms 
Stopping The Printer 

<Print Filters> 
<Print Messages> 
<Print Nodes> 
<Print Programs> 
<Print The List> 
Print The Screen 

Product Description, HP 497 JS 
Product Information 

Programming examples 
Programming with softkeys 
Program structure 
Protocol 
Protocol Buff er Size: 
Protocol timeout: 
<Purge Node List> 

Range of Frames 
Received Based Detection 
Receive LED 
<Rename Counters & Timers> 
<Rename Programs> 
<Repeated Times> 

R 

2-7. 3-4 
6-18 

8-1 
19-13 
19-15 

1-13 

20-10 
15-11 
20-1 
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20-7 
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14-48 
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15-15 
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18-10, 18-12, 20-11 
6-16 

16-6, 17-7 
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Repeating Displays 
Repeating keys 
Replacement Parts 
<Reset> 
<Reset MAU> 
Restoring System Software 
RETURN key 

<Re-write Existing> 
<Run From Buffer> 
<Run From Network> 
Running Programs 
Runt Frames 

Safety Classification 
Safety Considerations 
Safety Symbols 

<Save Con fig.> 
<Save File> 
<Save The List> 
<Scroll Frames> 
<Scroll Marked> 

<Search For Addr> 
<Search For Name> 
<Search For Node #> 
<Search For Pos'n> 
<Select Bad FCS> 
<Select Data Code> 
<Select Disc> 
<Select Format> 
<Select Good FCS> 
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<Select Printer> 
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Sequence Number 
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<Set Time> 
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<Show Node Name> 

Simulate Function 
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Site Preparation 
Softkey conventions 
Softkey descriptions 
Softkey Levels 
Softkey programming 
Softkey selections 
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Software Handshake: 
Software, loading into the system 
Software, system 
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18-17 
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<Sort By Address> 
<Sort By Bus Pos'n> 
<Sort By Name> 
<Sort Nodes> 

Source Address, IEEE 802.3 
Spaces in entry fields 
Specifications, HP 4971 S Operating 
Specifications, physical 
SSAP field (IEEE 802.2) 

<Start> 
<Start Display> 
<Starting With> 
<Start Monitor> 
Start of Frame 

<Stop> 
Stop Bits: 
<Stop Display> 
<Stop Monitor> 
Store: command 
<Summary Format> 
<Suppress Data> 
<Suppress Headers> 

System Software 
Backing up system software 
Loading system software 
Software supplied with the HP 497 lS 

TAB key 
Temperature 
<Test> 
<Test All Hardware> 
<Test Deep Trapmach.> 
<Test Dual Port RAM> 

T 
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<Time From Frame #> 
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<Timer> 
Time Stamp 

Timestamping 
Toggling Softkeys 
Top Level Menu 
Transmission Media 
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Transmit LED 

Tutorial Disc 
Type Field, Ethernet 

<Unmark> 
<Until Buff er Full> 
<Until Full> 

Viewing data during a program run 

<Wait> 
When commands 
<When Event> 
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u 
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y 
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9 
TOP LEVEL MENU 

The softkey functions available in the protocol analyzer can be selected from the Top 
Level Menu. 

This chapter includes: 

• Top Level Menu Display 

• Top Level Menu Selections 

9-1 



Top Level Menu Display 

The Top Level Menu is very important because it allows you to gain access to all the 
features of the protocol analyzer. 

The Top Level Menu appears whenever you complete the power on for the protocol 
analyzer. Also, from lower level displays, you can return to the Top Level Menu by 
pressing the <EXIT> softkey. You will need to use this menu often, so briefly 
experiment going to lower levels of softkeys and returning to the Top Level Menu. 

Setup 
Ana l_y_zer 

KEY 1 

Execute 
Program 

KEY 2 

HEWLETT PACKARD 

49715 
LAN PROTOCOL ANALYZER 

Revision: __ _ 

Copyright 1987 Hewlett-Packard Company 

day month year 00:00:00 

4971S power-on self-test PASSED 

Monitor 
Network 

KEY 3 

Load Disc 
A_pQ_l i c. Functions 

KEY 4 I KEY 5 

Examine 
Data 

KEY 6 

<OTHER CHOICES> 
Printer Hardware Set 

Functions Functions Passwords Date 
Set 
Time 

Figure 9-1. Top Level Menu Selections. 

Top Level Menu 9-2 

OTHER 
CHOICES 

KEY 7 

OTHER 
CHOICES 

KEY 8 



Top Level Menu Selections 

The HP 497 lS is a softkey driven protocol analyzer. The softkeys shown at the bottom 
of the display allow you to select the different protocol analyzer functions and then to 
edit or control the functions. 

Softkey conventions are discussed in Chapter I, "Using This Manual." Chapter l also 
describes conventions used by the HP 497 JS and this operator's manual. 
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10 
< SETUP Analyzer > MENU 

This chapter describes the softkeys used to set up or configure the different HP 4971 S 
LAN Protocol Analyzer functions. 

This chapter includes: 

• Introduction 

• <Setup Analyzer> Function Descriptions 

10-1 



Introduction 

The HP 497 lS can be setup or configured to perform several functions. A block 
diagram discussion of these functions is presented in Chapter 7, Introduction To The 
HP 4971S. 

The primary functions of the HP 497 lS are integrated so that the functions can be 
viewed and referenced from several positions. For example. specific messages and 
filters you create can be referenced in programs you also create. 

After you have configured or "set up" the HP 497 lS for a particular application, you 
can save the setup information to a disc drive. This setup can later be recalled from 
the disc drive and quickly loaded into the HP 497 lS. This feature makes it very 
convenient for you to have several setups stored for different applications and then 
quickly load the file for your current application. 
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< Setup Analyzer > Function Descriptions 

From the Top Level Menu, press the < Setup Analyzer > softkey to display softkeys 
used to configure the protocol analyzer. Each of the setup softkeys are discussed 
separately in the following chapters. 

Setup functions include: 

<Edit Node List> 

<Edit Filters> 

<Edit Messages> 

<Edit Programs> 

<Disc Functions> 

<1/0 Functions> 

<EXIT> 

softkey lets you assign functional names for stations in place 
of having to use 6 byte hex numbers for the Destination and 
Source Addresses. 

softkey lets you create filters that will be used to qualify the 
information stored in memory and trigger other functions. 

lets you create messages to simulate stations on your LAN. 

lets you create programs to control operation of the protocol 
analyzer in both monitor and simulate operation. 

lets you access the mass storage functions from the <Setup HP 
4971S> softkey. You can create different types of files, store 
them in your disc drive, and any time later, load them into the 
protocol analyzer. This lets you quickly change your protocol 
analyzer to a setup you have previously established. 

lets you control another HP 4971S remotely by setting up a 
serial data link between the two protocol analyzers. 

softkey returns the protocol analyzer to the Top Level Menu. 
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11 
< Edit Node List > MENU 

This chapter describes the softkeys used to create a list of the nodes connected to your 
LAN. Labels can be created that identify nodes on the network by a user's name or by 
the device's function. 

Chapter 1, Using This Manual, describes the format used to explain the HP 497 lS 
menus. It also describes conventions used for softkeys and keyboard keys. 

This chapter includes: 

• <Edit Node List> Softkey Selections 

• Introduction 

• Assigning A Network Name 

• Assigning The Network Type 

• Adding Stations To The Node List 

• Deleting Stations From The Node List 

• Sorting The Node List 

• Searching For A Node 
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< Edit Node List > s.oftkey Selections 

Edit Node List 

Insert Node 
Delete Node 

Sort Nodes 

Search For 

Sort By Name 
Sort By Address 
Sort By Bus Pos•n 

Node 
Search For Node # 
Search For Name 
Search For Addr 

Hex 
Binary 
Binary 

Search for Pos•n 

LSB Right 
LSB Left 

Cursor in NODE NAME & BUS POSITION 
Fields 

Purge Node List 
YES 
NO 

EXIT 

<Edit Node List> Menu 11-2 

Cursor in 
NODE ADDRESS Field 

Select Format 
Hex 
Binary LSB Right 
Binary LSB Left 

Introduction 

<Edit Node List> Menu softkeys let you create a node list that displays all the stations 
on your Local Area Network. Nodes on the network are properly identified by 6 byte 
hexadecimal numbers. This menu lets you assign a more readable name to each node. 
The names can be grouped by descriptive names such as: 

Functional description 

User name 

Group/ Area identity 

print server 
main CPU 

GaryR 
Bil lM 

f inance123 
EngLab1 

The node names feature offers a real convenience in recognizing a node's identification 
in the <Examine Data> Menu or while you are viewing frames while monitoring the 
network. Station identities are much easier to recognize in filter summary or message 
summary displays where many nodes are presented on one display. It is much easier to 
recognize a station by a name than by 6 byte Hex numbers. 

Descriptions of <Edit Node List> softkeys are grouped by the following functions. 

• Assigning a network name 

• Assigning the network type 

• Adding stations to the node list 

• Deleting stations from the node list 

• Sorting the node list 

• Searching for a node 



Assigning A Network Name 

Since a Local Area Network can communicate with other Local Area Networks, it may 
be convenient for you to show the station names with the network name they are 
grouped under. 

At the top of the <Edit Node List> Menu, a label field is displayed for "NETWORK 
NAME". The name can be any functional name that you want to assign. The default 
network name is Network_ a. 

The protocol analyzer cannot access or store files by the network name. It is displayed 
for documentation purposes only. 

NETWORK NAME : NETWORK_O NETWORK TYPE : ETHERNET 

NODE # NODE NAME NODE ADDRESS BUS POSITION 

To change the network name, use the following procedure: 

1. Use the UP-ARROW cursor key to move the cursor to the "NETWORK 
NAME" name field. 

2. Use the keyboard keys to enter the network n~me you want. 

Network names may be up to 17 keyboard characters. Leading spaces are 
deleted. Spaces between characters are replaced with an underscore (_). 

3. Press the RETURN key or the TAB key to move the cursor to the 
"NETWORK TYPE" field or press the cursor down-arrow key to move the 
cursor to the first node name. 
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Assigning The Network Type 

The NETWORK TYPE field displayed at the top of the <Edit Node List> Menu is for 
documentation purposes only. 

NETWORK NAME : NETWORK_O NETWORK TYPE : ETHERNET 

NODE # NODE NAME NODE ADDRESS BUS POSITION 

ETHERNET IEEE 
802.3 

Figure 11-1. Network Type Selection. 

To select the protocol type, use the following procedure: 

1. From the <Edit Node List> Menu, use the cursor up-arrow key to move the 
cursor to the Network Type field. 

If the cursor is in the Network Name field, use the TAB or RETURN key to 
move the cursor to the Network Type field. 

2. Use the sof tkeys to select either <ETHERNET> or <IEEE 802.3> protocol. 

Select <ETHERNET> softkey for 10BASE2 networks. 
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Adding Stations To The Node List 

Up to IOOO stations can be added to the Node List by using the <Insert Node> softkey. 
The following softkeys and definitions are used to add stations. 

The figure below shows the display generated from the <Edit Node List> softkey. The 
default display shows the protocol analyzer and its Ethernet address. Each HP 497 JS 
LAN Protocol Analyzer has a unique address, only the first three bytes are similar. 

NETWORK NAME : NETWORK 0 NETWORK TYPE : ETHERNET 

NODE # 

0001 

Insert 
Node 

<Insert Node> 

NODE NAME NODE ADDRESS BUS POSIT I ON 

HP LAN Analyzer 08-00-09-

Delete 
Node 

Sort Search 
Nodes For Node 

Purge 
Node List 

EXIT 

Figure 11 ·2. <Edit Node List> Menu Display 

Pressing this softkey adds another field to the node table list. 
Additional nodes may be inserted at any point in the Node 
List. Each inserted node is added immediately above the line 
containing the cursor. 

Each node contains the following fields: 

Node number 
Node name 
Node address 
Bus position 
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ADDING STATIONS TO THE NODE LIST (cont.) 

Node number 

Node Name 

Node Address 

Bus Position 

Duplicate entries 

is a number generated by the protocol analyzer to provide an 
easy reference when viewing the node name list and is not 
used otherwise. 

The Node Name field enables you to enter a name that allows 
easier recognition of a specific station. 

The Node Name field may have up to 17 keyboard characters. 
Leading spaces are deleted. Spaces between characters are 
replaced with an underscore (_). Press TAB or RETURN key 
to complete the entry. 

The Node Address field entry must be in Hexadecimal 
characters. Six bytes are used for the address entry. 

The Bus Position field can be up to 4 numeric characters. The 
Bus Position is similar to the Node Name in that it is user 
defined. 

The Bus Position Field is for documentation purposes only and 
is not used by the protocol analyzer. You can use this field in 
any way that helps you identify your network to yourself. 

When you press the <EXIT> softkey to leave the <Edit Node List> Menu, duplicate 
entries are deleted from the list. The default node name, HP _LAN_Analyzer, and the 
Source Address unique to the analyzer cnn be duplicated while you are editing the node 
list. However, when you press <EXIT> softkey to leave the menu, all duplicate names 
and addresses are deleted. The first entry for duplicate names or addresses remain on 
the list. 

When duplicate names other than HP _LAN_Analyzer and the Source Address unique 
to the analyzer are entered and you try to leave the name or address field, the analyzer 
returns the previously entered name or address. 
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Deleting Stations From The Node List 

Stations can be removed from the node list one at a time or the entire list can be 
deleted at once. 

<Delete Node> 

<Purge Node List> 

<YES> 

<NO> 

This softkey is used to remove work stations one station at a 
time from the Node List. Stations may be deleted from the 
node list by positioning the cursor to either the Node Name, 
Node Address, or Bus Position field of the station you want to 
delete. When the station has been identified by the cursor, 
press <Delete Node> softkey to remove the station. 

Stations remaining on the node list below the deleted station 
are moved up one line to fill the deleted space. The Node # 

field updates to fill in where the node was deleted so that the 
numbers are always contiguous. 

The <Purge Node List> softkey removes all the stations from 
the node list at one time. When this softkey is pressed, 
message, Reinitialize the node list?, and softkey 
choices <YES> and <NO> are displayed. 

If you press the <YES> softkey, the entire node list is deleted. 
The node name list starts again at default node 
(HP _LAN_Analyzer). 

If the <NO> softkey is pressed, the existing node list is not 
deleted and the display returns to the previous softkey choices. 
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Sorting The Node List 

The node list can be displayed in a variety of sequences to help you easily find stations 
in the list. 

<Sort Nodes> 

<Sort By Name> 

<Sort By Address> 

<Sort By 
Bus Pos'n> 

Pressing the <Sort Nodes> softkey changes the softkey display 
to: 

<Sort By Name> 

<Sort By Address> 

<Sort By Bus Posit> 

The node list is sorted using the names in the Node Name 
field. Sorting is generally done in the standard ASCH collating 
sequence. For example, CTRL-X characters are followed by 
alphabet characters and then by numbers. Alphabet characters 
are not upper/lower case sensitive. 

sorts the node list using entries in the Node Address field. The 
sorting is done in the order of 0 through F and then with Xs 
(don't cares) sorted last. 

The node list is sorted using the entries in the Bus Position 
field. The sorting arranges the node list in an increasing bus 
position sequence. 
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Searching For A Node 

Softkeys on the protocol analyzer make it easy to look through the Node List to find 
stations by using their assigned identities: node number, node name, node address, or 
position on the bus. 

<Search. for 
Node#> 

The <Search For Node Number> softkey lets you search the 
node list for the node number you specify. 

Press <Search For Node Number> softkey and enter a node 
number in the displayed field. The node number entry must 
be in numeric characters. 

Press RETURN key to execute the search. 

When the specified node number is found, that station is 
displayed at the top of the node list. 

<Search For Name> This softkey lets you search the node list for a node name you 
specify. 

Press the <Search For Name> softkey to display a field for the 
Node Name entry. The node name entry must be exactly as 
displayed in the node list. Letter case is significant. 

Press RETURN key to execute the search. 

When the node name you are searching for is found, that node 
is displayed at the top of the node list. 
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SEARCHING FOR A NODE (cont.) 

<Search for Addr> 

<Hex> 

<Binary LSB 
Right> 

This soft.key lets you search the node list for a node address 
that you enter. 

When that node address is found, the node is displayed at the 
top of the node display. 

Pressing <Search For Addr> soft.key prompts you for the node 
address. The address may be entered in one of three formats 
selected by soft.keys: 

Enter the address in hex characters 0 - For X (don't care). 

You can use don't cares to view all nodes with a common 
prefix. For example: 

08-09-00-0A-XX-XX 

Press RETURN key to execute the search. 

softkey lets you enter each address character byte in 
binary with the least significant bit on the right sic.le. Only 
the byte marked by the cursor is displayed in binary. 

The address entry must be in binary l's and O's or X (don't 
care). 

After the address is entered, press RETURN key to 
execute the search. 

When you complete a binary entry using a don't care, the 
part of the byte having the don't care is displayed as ~ . 

For example: 

1010001X = A~ 

XXl 11010 = ~A 
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SEARCHING FOR A NODE (cont.) 

<Binary LSB 
Left> 

softkey lets you enter each address character 
byte in binary with the least significant bit on the left side. 
Only the byte marked by the cursor is displayed in binary. 

The address entry must be in binary l's and O's or X (don't 
care). 

After the address is entered, press RETURN key to 
execute the search. 

See the preceding description in <Binary LSB Right> for 
don't care opera ti on. 

<Search For Pos'n> The node list can be searched via the Bus Position column. 

Press <Search For Pos'n> and enter the bus position in the 
displayed field. Press the Return key to execute the search. 
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12 
< Edit Filters > MENU 

This section describes softkeys used to control filter functions in the HP 497 lS LAN 
Protocol Analyzer. 

This chapter includes: 

• Introduction 

• <Edit Filters> Softkey Selections 

• Add, Delete, And Label Filters 

• Add, Delete, And Label Filter Fields 

• Select Character Types 

• Select Network Protocol Display Format 

• <Edit Filters> Copy Functions 

• Select Frame Traits 

• Edit Filter Length 

• Filter Examples 
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Introduction 

Filtering capability greatly enhances the power of the HP 497 lS LAN Protocol 
Analyzer. The <Edit Filters> Menu lets you easily use this capability. Filtering frames 
on a Local Area Network (LAN) provides the following benefits: 

More effectively use buffer memory 

store only frames matching "xxxx" condition 

Make decisions in program flow 

"wait until" ... filter condition X is true, then goto ... 

"if" ... filter condition X is true, goto ... 

Interact with network in real-time program execution. 

when station ABC transmits XX message, reply with message_l 

Filter on higher level protocol formats 

Filters can be used to qualify what frames are stored in the protocol analyzer memory. 
The HP 497 lS has a large storage capacity; however, at a Local Area Network's 
transmission rate of 10 Mbits/second, the buffer memory would be filled in only a few 
seconds of heavy traffic. Filters allow you to store only the information that is of 
interest to you. In effect, this expands the time the protocol analyzer can monitor the 
network. 

Filtering the frames you store offers more convenience to you than just providing more 
effective memory capacity. Without filters, you would have to scroll through the 
equivalent of many typewritten pages of information to find the specific messages you 
are interested in each time you fill the memory buff er. 

Filters can be used with WAIT and IF commands to control the program flow in 
programs you can create. These commands allow you to make branching decisions 
depending on filters matching or not matching conditions occurring in frames on the 
network. 
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Filters let you control the functions of timers and counters available in programs you 
create. You can start, stop, and reset counters and timers by decisions made on filter 
conditions. 

While filters allow you to choose what messages to store from a specific station(s), you 
can also use filters to choose what response message to transmit in reply to a specific 
station(s). 

Frames received from an IEEE 802.3 or Ethernet LAN conform to a protocol standard. 
The standard assigns elements in the message to a particular byte or octet location. The 
elements and their assigned position within a frame are shown below. 

Bytes . ·> 

6 

Dest 
Add rs 

Frame Element 

Destination Address 

Source Address 

Type or Length Field 

Data field 

802.2 Header 
(user selected - optional) 

FCS (CRC error check) 

6 2 

source Type/ 
Add rs Length 

802.2. 
info 

Byte Location 

1-6 

7-12 

13-14 

15-1515 

15 -- DSAP field 
16 -- SSAP field 
17 -- 17-18 for Control field 

Last four byte locations in 
frame. 

46-1500 4 

~I' ,' :r 
Data res 
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The HP 497 lS Protocol AnaJyzer can identify bytes in frames from any station using 
Ethernet, IEEE 802.2, and IEEE 802.3 protocols and test them for some particular 
content. Depending on whether the contents of a byte pass or fail a comparison test in 
the protocol analyzer, you can decide to keep or ignore the frame. 

The protocol analyzer filter function may be viewed as a set of 62 indiv1ctual byte 
comparators. Each comparator can be assigned to a byte position within a frame. Each 
comparator can examine the contents of its assigned byte position within any frame 
received from the network. 

Fourteen of the available 62 filter comparators are permanently reserved to t.he 
Destination Address, Source Address, and Type/Length fields. Two additional 
comparators are reserved; one for byte 15, the first byte in the Data Field and one to 
detect when the maximum frame length exceeds 2022 bytes. 

Byte J 5 can be a single byte filter field or it may be included as part of a larger filter 
field. In contrast, the length of the Addresses and Type/Length filter fields can not be 
changed. 

62 Trapmachine bytes available 

16 Reserved filter bytes 

6 Destination Address 
6 Source Address 
2 Type/Length 
1 Data Byte 15 
l Max length (byte 2023) 

16 Total 

46 Trapmachine bytes available for user assignment 
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Things to know about filter construction. 

I. Filter Definitions. 

A. Up to 16 filters can be defined. 

B. Each filter includes both Address Fields, the Type/Length field and at 
least one Data Field byte. 

C. A filter can include 32 separate filter fields; and up to 29 of the 32 
separate fields can be defined in the Data Field. 

l Destination Address Field 
l Source Address Field 
l Type/Length Field 

29 Data Field 

32 separate filter fields 

11. Filter Field Definitions. 

A. Filter field length 
in bytes 

6 fixed 
6 fixed 
2 fixed 
1-15 variable 

Location 

Destination Address 
Source Address 
Type/Length field 
Anywhere in Data Field or in byte 
locations 1515--2022. 

B. Filter fields within a filter cannot share or overlap bytes. 

C. Filter fields in different filters can share a byte comparator location. 

1. When different filters share a byte comparator location, a "Filter 
bytes available" counter is reduced by one only for the first filter 
declaring the byte location. 

2. As additional filters share the same byte comparator location, the 
"Filter bytes available" count is not reduced again. 
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Filter_O 
Dest Source Type 
Addrs Addrs Data Field 

IAAAAAAlAAAAAAIAAlA._.~·----------
1 7 1 1 

3 5 

FCS 
(CRC) 

___ 1_1 

If only the default 15 filter bytes are being used, 
46 "Trapmachine Bytes Are Available" 

Filter_ 1 

Filter_2 

Filter_3 

I IJBBBBB IBBBBBB I BB t B._.~·---'---_.;._------''--- __ 1_._1 
1 7 1 1 

3 5 
FILTER_ uses exactly the same filter byte locations as defined in 
FILTER_O except that new byte contents are entered. 
46 11 Trapmachine Bytes Are Stitt Available" 

I ccc.ccc I cccccc I cc I c. _. _. _____ xxxxx __ _ --'-' 1 7 1 1 5 5 
3 5 5 

FILTER_2 uses the same filter byte locations as defined in FILTER_O, 
and 5 new filter bytes are assigned at byte locations 51-55. 
41 "Trapmachine Bytes Are Available" 

1ootlooo 1000000too10·~·-·-------vvnv __ ___ ,_l 
1 7 1 1 5 5 

3 5 4 8 
If FILTER_3 uses the same filter byte locations as defined in FILTER_2 
except that the 5 Data Field bytes are at locations 54-58, 
then only 3 filter bytes are new locations. 
38 "Trapmachine Bytes Are Available" 

Figure 12·1. Example for "Filter Bytes Available". 
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< Edit Filters > Softkey Selections 

Edit Filters 

Add Filter 

Delete Filter 

Show Node Names 

Show Hex Addresses 

Enter Node Name (displayed only when cursor is in ADDRESS fields) 

Edit all Fields 

Cursor in cursor in 

Addrs Fields 

'NOT' Byte Exp ain Fllter HW 
OTHER CHOICES 
BJn LSB Left 

Length/Type Field 

Insert Field 
•NOT' Byte 
E~p ain Filter HW 
Blh LSB Left 

Bln LSB Right 
Hex 

Bln LSB Rlght 
Hex 

ASCII 7 * 
ASCII 8 Roman 8 * 
EBCDIC * 

ASCII 7 * 
ASCII 8 Roman 8 * 
OT~ER CHOICES 

OT~ER CHOICES 80 .3 Format 
Et ernet Format 
80 .i! Format 
Copy Filter 
Copy Frame 

OTHER CHOICES 

Select Traits 

80 .3 Format 
Et ernet Format 
80 .2 format 
Copy Filter 
Copy Frame 

Accept/Reject Frame with GOOD FCS 

Accept/Reject Frame with BAD FCS 

Accept/Reject MISALIGNED Frame 

Accept/Rejec~ RUNT Frame 

Cursor in Cursor in 

Data Field MIN, MAX Field~ 

Insert Fjeld Explain Filter HW 
Delete Field 
6~f ~U R~i~~ ~ ~ 
'NOT' Byte Exp ain Fllter HW 
OTHER CHOICES 
B1n LSB Left 
Bln LS~ Rlght 
ASCII * 
ASCII Roman 8 * 
EBCDIC * 
802. Format OTHE~ CHOICES 

Et ernet Format 
80 .z format 
Copy Fllter 
Copy Frame 

Enter Node Name (displayed only when cursor is in ADDRESS Fields) 

EXIT 
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<Edit Filters> SOFTKEY 

The <Edit Filters> softkey displays an overview of the filters defined and available for 
programming the protocol analyzer. A given filter can test or compare only on 
messages received from the Source Address specified for that filter and/or messages 
transmitted to the Destination Address specified for that filter. 

To get to the <Edit Filters> softkey functions, use the following steps: 

From the Top Level Menu: 

1. Press <Setup 497 lS> softkey. 

2. Press <Edit Filters> softkey. 

The figure below shows the default display is a summary of filters that have been 
defined. Line 4 shows the default display for an undefined filter. Line 5 contains a 
filter with addresses displayed in Hexadecimal code. Line 6 is an example of a filter 
with user defined filter label and equivalent names displayed for the addresses. 

Frames can also be filtered by their length. Minimum and maximum frame lengths can 
be specified. 

1 FILTER FILTER DESTINATION SOURCE LENGTH OF FRAME: 
2 
3 
4 
5 
6 

21 
22 
23 

# 

0 

2 

Add 

LABEL ADDRESS 
-................ . . . . . .. . . . . .. . . . . . -
FILTER_O XX·XX·XX·XX·XX·XX 
FILTER 1 08·00·71·AB·CD·EF -
printer filter printer 4 

Delete Show Node Show Hex 

ADDRESS MINIMUM 
. .. -.............. 
XX·XX·XX·XX·XX·XX 15 
08·11·34·A1·23·10 15 
cpu_1 15 

24 Filter Fi l ter Names * Addresses 
Edit All 

Fields 
OTHER 

CHOICES 

Figure 12·2. <Edit Filters> Softkey Display. 
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2022 
2022 
2022 
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Add, Delete, And Label Filters 

Softkeys are provided to let you quickly add or delete filters to the summary filter 
display. Up to 16 filters can be created. 

<Add Filter> adds filters to the displayed filter list. Sixteen filters can be 
defined. the Filter #'s are labeled in Hexadecimal sequence, 
0 .. 9, A .. F. 

If all the filter #'s displayed are in sequence, the <Add Filter> 
softkey will add the next available Filter # to the bottom of 
the list. 

lf any Filter #'s are missing in the list, the <Add Filter> softkey 
inserts filters by the algorithm: 

1. Insert closest missing Frame # above the cursor location. 

2. If there is no room above the cursor location, then, insert 
closest missing Frame # below the cursor location. 

FILTER NAMES 

<Delete Filter> 

You can change the filter name to a descriptive label that 
identifies the filter function. 

Filter names can have up to 17 keyboard characters. Leading 
spaces are deleted. Spaces between characters are replaced 
with an underscore (_). Press RETURN or TAB keys to 
complete the name entry. 

removes filters from the displayed filter list. Use the keyboard 
Tab key or cursor keys to position the cursor to the filter to 
be removed. 

Filters below the deleted field will move up to fill the deleted 
position. Remaining filters retain their Filter # and Filter 
Label. 
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<Show Node Name> 

<Show Hex 
Addresses> 

causes the Destination and Source addresses to be converted 
from Hexadecimal code to the equivalent node name defined 
in the <Edit Node List> Menu. 

causes the Destination and Source Address fields to be 
displayed in Hexadecimal code. 

NOTE 

In the <Edit Filters> Menu, the softkey selections change 
when the cursor is moved from the FILTER LABEL Field to 
an address field. Use the keyboard TAB key or the cursor 
keys to move the cursor to a Destination or Source Address 
field. Notice the softkey fie.Ids change. 

<Enter Node Name> softkey lets you define the Destination and Source Address 
fields using node names. 

This softkey is displayed only when the cursor is in an 
ADDRESS FIELD. 

Node names that have been assigned in the <Edit Node List> 
menu will be displayed as softkeys when you press <Enter 
Node Name> softkey. You may use a softkey to enter a valid 
node name for its equivalent Destination or Source address. If 
more than 6 node names have been defined, use the <OTHER 
CHOICES> softkey to see additional node names. You can 
also type the node name from the keyboard. 
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Add, Delete, And Label Filter Fields 

Details of the filter fields are displayed and are available for editing when the <Edit all 
Fields> sof tkey is selected. 

After you press <Edit all Fields>, the softkey select.ions change as the cursor is moved 
between address fields, Type/Length Field, or Data Field. The foldout softkey selection 
chart for this chapter shows the choices available as you move the cursor. Fold out the 
selection chart and observe which softkeys are displayed as the cursor is moved 
between different fields. 

<Edit all Fields> softkey causes the protocol analyzer to display details of filter 
fields for the filter presently marked by the cursor. 

The following frame fields can be edited by choosing the 
<Edit all Fields> softkey: 

Address Fields Type Field Data Field 

FIELDS of FILTER #0 Label: Filter 0 MINIMUM Frame Length = 15 
MAXIMUM Frame Length 2022 

FIELD DATA 
46 Filter bytes available 

BYTE FIELD LABEL 

DESTINATION 
SOURCE 

XX·XX·XX·XX·XX·XX 
XX·XXrXX·XX·XX·XX 
XX·XX 

Node Name: Not Defined 
7 

13 

15 
TYPE 
DATA 

Bin LSB Bin LSB 
Left Ri_[ht 

Node Name: ·· Not Defined 

xx 

Hexadecimal (0 .. 9, A •. F or X) field data entry 

Hex ASCII 8 
Entry* Entr.}'.'._ 

EBCDIC 
Entrx 

OTHER 
CHOICES 

EXIT 

Figure 12·3. <Edit all Fields> Softkey Selected. 
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<Edit all Fields> 
(cont.) 

The softkey selection chart shows all the softkey choices 
available when the <Edit All Fields> softkey is pressed with 
the cursor in the different frame filter fields. 

Softkey descriptions are provided for the softkeys seen when 
the cursor is in a filter's Data Field. Since the same softkeys 
are used in the address and Type/Length Fields, the 
descriptions are given only once. 

<Edit all Fields> softkey selections are grouped into the 
following three primary functions: 

Add, delete, and edit filter fields. 
Insert Field 
Delete Field 
Insert Byte( s) 
Delete Byte(s) 

Select character type 
'NOT' Byte 
Bin LSB Left 
Bin LSB Right 
ASCII 7 
ASCII 8 Roman 8 
EBCDIC 

Select network protocol 
802.3 Format 
Ethernet Format 
802.2 Format 

Utility softkeys 
Copy Filter 
Copy Frame 
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<Insert Field> adds an additional filter field in the Data field. 

When the <Insert Field> softkey is pressed, a new filter field is 
inserted immediately below the cursor. 

The newly inserted BYTE field is automatically loaded with 
the next byte location available after the previous filter field. 
If you want to assign the new filter field to a different byte 
location, enter the new location number from the keyboard. 

Guidelines for inserting filter fields: 

1. You can not insert fields between consecutive numbered 
bytes. 

Filter fields can not overlap. If you need to insert a 
data field filter that would overlap existing filter fields, 
you must change the length and position of existing 
filter fields before the new filter field may be inserted. 

2. Up to 32 filter fields can be defined for each filter. 

WITH IEEE 802.2 FORMAT 
In addition to DSAP, SSAP. and CONTROL filters, up 
to 26 additional data filter fields can be defined. 

NOT lEEE 802.2 FORMAT 
Up to 29 data filter fields can be defined. 

The FIELD LABEL for each data field filter can be identified 
by up to 17 alphanumeric characters. Spaces or underscore(_) 
may be used between characters in the FJELD LABEL. 
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<Delete Field> 

<Insert Bytes> 

<Delete Bytes> 

removes the filter field currently marked by the cursor. 

The c•Jrsor can be positioned in any part of the filter field 
being deleted. 

adds or inserts bytes in the filter field currently marked by the 
cursor. 

Up to 15 byte locations can be defined in a filter field. 

If the cursor is in the FIELD DAT A field, new bytes are 
inserted immediately before the byte marked by the cursor. 

If the cursor is in the BYTE Field, FIELD LABEL Field, or at 
the last character position of a field displayed in hex, new 
bytes are added at the end of the FJELD DAT A Field. 

removes bytes from the filter field currently marked by the 
cursor. 

At least one byte must be left in each filter field. If you want 
to delete all bytes in a filter field, use the <Delete Field> 
softkey. 

If the cursor is m the FIELD DAT A Field, deleted bytes 
include the byte marked by the cursor and the bytes following 
the cursor. 

If you enter more bytes to be deleted than follow the cursor, 
remaining bytes will be removed from in front of the cursor. 

If the cursor is not in the FIELD DATA Field, the rightmost 
bytes will be deleted. 
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Select Character Type 

Characters in the Addresses, Type/Length, an<l Data Fields can be displayed in several 
formats by simple softkey selections. This enables you to change the character display 
for easier bit or byte pattern entry as you edit the filter contents. 

Optional keyboards may be used with the HP 497 lS to display additional character 
code sets. See appendix B in the Getting Started volume. 

Undefined 
characters 

Don't Care 

<'NOT' Byte> 

<Bin LSB Left> 

<Bin LSB Right> 

<Hex Entry> 

<ASCII 7> 

<ASCII 8 
<Roman 8> 

<EBCDIC Entry> 

are displayed as_. Appendix B shows keys that may be used 
to enter control characters such as s y and E Q' 

"Don't Care" characters or bits are displayed as " X " in hex or 
binary character types and as " t " in other character types. 

enables a filter to match any character except the character 
entered. 'NOT' Byte characters as shown as blinking 
characters. 

lets you enter characters in binary with the least significant bit 
at the left for each character. Only the byte marked by the 
cursor is displayed in the binary format. 

lets you enter characters in binary with the least significant bit 
at the right (or each character. Only the byte marked by the 
cursor is displayed in the binary format. 

lets you enter characters in Hexadecimal. 

lets you enter characters in ASCII 7. Different parity checking 
softkeys are displayed for your choice. 

lets you enter characters in ASCII 8 or Roman 8, depending 
on what keyboard is used. 

lets you enter characters in EBCDIC. 
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Select Network Protocol Display Format 

The network protocol for the displayed frame may be changed by softkey selection. 

<802.3 Format> causes the protocol header for the displayed filter to be shown 
in IEEE 802.3 protocol. This choice will display the third 
filter field as a Length Field. 

FIELDS of FILTER #0 Label: Filter_O MINIMUM Frame Length 15 
MAXIMUM Frame Length = 2022 

FIELD DATA 

46 Filter bytes available 
BYTE FIELD LABEL 

1 

7 

13 
15 

~ .. _,, "' "' .. '8 <II 9 ...... to "' ,. IF .. 

DESTINATION 

SOURCE 
LENGTH (TYPE) 

DATA 

XX-XX-XX·XX·XX·XX 
XX·XX·XX·XX·XX·XX 
XX·XX 
xx 

Node Name: Not Defined 
Node Name: ·· Not Defined 

<Ethernet Format> causes the protocol header for the displayed filter to be shown 
in Ethernet protocol. This choice will display the third filter 
field as a Type Field. 

FIELDS of FILTER #0 Label: Filter 0 MINIMUM Frame length = 15 
MAXIMUM Frame length = 2022 

FIELD DATA 

46 Filter bytes available 
BYTE FIELD LABEL 

1 

7 

13 

15 

DEST I NAT ION 

SOURCE 
TYPE 

DATA 

XX·XX·XX·XX·XX·XX 
XX-XX·XX-XX-XX·XX 
xx-xx 
xx 

Node Name: Not Defined 
Node Name: · · Not Defined 
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<802.2 Format> inserts the 802.2 fields; DSAP, SSAP, and CONTROL below the 
Length/Type Field. 

A one-byte CONTROL field is inserted. The CONTROL field 
can be expanded to 2 bytes by using the <Insert Byte> softkey. 

FIELDS of FILTER #0 Label: Fitter_O 
46 Filter bytes available 

MINIMUM Frame Length 17 
MAXIMUM Frame Length = 2022 

FIELD DATA BYTE FIELD LABEL 
.. "' ... - ..................... "' ... 

DESTINATION 
7 SOURCE 

13 LENGTH <TYPE) 
15 DSAP 

16 SSAP 
17 CONTROL 

XX·XX·XX·XX·XX·XX 
xx-xx-xx-xx-xx-xx 
xx-xx 
xx 
xx 
xx 

Node Name: Not Defined 
Node Name: -- Not Defined 

<Edit Filters> Menu 12-18 



<Copy Filter> 

<Copy Frame> 

< Edit Filters > Copy Functions 

copies the contents of a specified filter to the currently 
displayed filter. 

Press <Copy Filter#> softkey to display: 

Select softkey OR enter val id name: ___ _ 

Select a filter to copy by using the displayed softkeys or you 
can enter a filter name with the keyboard keys. Press 
RETURN key to execute the copy function. 

copies an existing frame from the Receive Buffer to load the 
fields of a filter. Bytes locations specified by the filter are 
filled by the contents from the same byte locations of the 
frame in the Receive Buff er. 
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Select Frame Traits 

In addition to filtering on specific byte comparator locations in a frame and minimum 
and maximum frame lengths, the HP 497 lS LAN Protocol Analyzer can filter on 
different types of frame errors. 

<Select Traits> al1ows you to choose to view good frames and/or frames with 
different types of errors. 

The "RlJNT FRAME FILTER" paragraph shown below is 
displayed only if "Runt Frame Filter" is enabled in the 
<Hardware Functions> Menu. 

Accept/Reject Frame with GOOD FCS 

Accept/Reject Frame with BAD FCS 

Accept/Reject Misaligned Frame (A frame with a bad FCS and with 1 to 
7 residual bits following the final 
byte of the FCS.) 

Accept/Reject RUNT Frame (A frame which contains fewer than 60 

bytes, not including the FCS. 

The frame traits selected in this menu will apply to all filters. 

The RUNT FRAME FILTER is installed, therefore Frames containing 
less than 512 bits including the preamble and FCS (equivalent to 
a length of approximately 53 bytes), ~ill not be recognized. 

Accept Reject 

Figure 12-4. <Frame Traits> Softkey Display. 
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Frame with GOOD FCS 
Frame with BAD FCS 

Mlsallgned 
Frame 

RUNT Frame 

These fields let you choose to accept or reject frames that you 
receive with good or bad FCS values. 

The majority frames would normally be received with good 
FCS values. To filter out unwanted frames, you may want to 
capture only the frames with FCS errors. This lets you view 
only the frames having problems and reduces the 
number of frames you have to view. 

A misaligned Frame has a total number of bits that is not 
divisible by eight and also has an FCS error. 

Runt frames are defined as frames having less than 60 bytes in 
the address, Type/Length and data fields. Runt frames may 
occur as a result of frame on the network, 

Figure 12-4 shows the display with "Runt Frame Filter: 
Enabled" in the <Hardware Functions> Menu. With the Runt 
Frame Filter: Enabled, the analyzer discards frames with less 
than 512 bits. 

If the Runt Fm.me Filter: is "Disabled'' in the <Hardware 
Functions> Menu, frames with as few as one in the data 
field are stored in the HP 497 lS. 

Frame errors are also discussed in "Displaying Frame Errors" section in Chapter 19, 
<Examine Data> Menu. 
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Edit Filter Length 

In addition to filtering on particular bytes in a frame, you can filter on frame lengths. 

In order to conserve buffer memory, you may want to exclude frames exceeding some 
maximum length, or, you may want to view only jabbering frames (frames with more 
than 1514 bytes). 

You can control the frame length for particular filters by positioning the cursor in the 
MINIMUM or MAXIMUM Frame Length Fields. The default values are: 

MINIMUM Frame Length 15 

MAXIMUM Frame Length = 2022 

You can manually set these values to what your filter needs are. The protocol analyzer 
will only let you enter numbers so that the minimum value is always less than the 
maximum value. 
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Minimum Filter Length 

The MINIMUM Filter Length Field uses the following rules: 

1. The minimum entry for the MINIMUM Filter Length Field is 15 bytes. 

2. The MINIMUM Filter Length Field entry must be an odd number. 

3. When you specify additional filter fields in the DAT A Field which occupy 
byte positions greater than the minimum value, the MlNIMlJM Frame Length 
Field automatically increases to be the largest odd numbered byte occurring in 
the filter field. 

Maximum Fiiter Length 

The MAXIMUM Filter Length Field uses the following rules: 

l. The maximum entry for the MAXIMUM Filter Length Field is 2022 bytes. 

2. The MAXIMUM Filter Length Field entry must be an even number. 

3. You can specify a maximum filter length less than 2022 bytes. However, if 
you then add a filter field which occupies byte positions greater than the new 
maximum filter length. the MAXIMUM Frame Length Field automatically 
increases to be the next largest even value which will contain all the bytes in 
the filter. 
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Filter Examples 

This section contains several examples to illustrate filter applications for high level 
protocols. 

The first three FIELD LABEL Fields are automatically entered by the HP 497 IS 
Protocol Analyzer. The following FIELD LABELS can be labels you choose to identify 
that fields function. 

The examples do not show specific bytes in the filter fields. Instead, only the number 
of bytes in the field is shown. You can enter any specific byte you need to filter on. 

FILTER EXAMPLE 1. 

REQUIREMENT: Define a filter to decode level 3 Internal Protocol (IP) for 
ARP ANET implementation. 

FIELDS of FILTER #0 Label: Filter_IP_header MINIMUM Frame Length 33 
27 Filter hardware bytes available MAXIMUM Frame Length= 2022 

BYTE FIELD LABEL FIELD DATA 

7 
13 
15 

DESTINATION XX·XX·XX·XX·XX·XX 
SOURCE XX·XX·XX·XX·XX·XX 
TYPE XX·XX 
IP_Ver_Hdr_length XX 

16 IP_Type_of_servic XX 
17 IP_Total_Length XX·XX 
19 IP_Identification XX·XX 
21 IP_Flg_Frgmt_Ofst XX·XX 
23 IP_Time_to_live XX 
24 IP Protocol XX 
25 IP Checksum XX-XX 
27 IP_Source_address XX-XX·XX·XX 
31 IP_Dest_addres XX·XX·XX·XX 

Node Name: Not Defined 
Node Name: ·· Not Defined 
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FILTER EXAMPLE 2. 

REQUIREMENT: Define a filter to decode level 4 Transmission Control Protocol 
(TCP) commonly found in local area network implementation. 

FIELDS of FILTER #0 Label: Filter_TCP_header 
26 Filter hardware bytes available 

53 
= 2022 

MINIMUM Frame Length = 
MAXIMUM Frame Length 

BYTE 

1 
7 

13 
35 
37 
39 
43 
47 
49 
51 
53 

FIELD LABEL 
·--------········ 
DESTINATION 
SOURCE 
TYPE 
TCP_Source_port 
TCP_Dest_port 
TCP_Seq_number 
TCP_Dest_addr 

FIELD DATA 

XX·XX·XX·XX·XX·XX 
XX·XX·XX·XX·XX·XX 
XX·XX 
XX·XX 
XX·XX 
XX·XX·XX·XX 
XX·XX·XX·XX 

Node Name: Not Defined 
Node Name: ·· Not Defined 

TCP_Flg_Ofst_Cflg XX·XX 
TCP_Window XX·XX 
TCP CHECKSUM XX·XX 
TCP_Urg_pointer XX·XX 
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FILTER EXAMPLE 3. 

REQUIREMENT: Define a filter format to decode a combined level 4 Transmission 
Control Protocol (TCP) and level 3 Internal Protocol (IP). 

FIELDS of FILTER #0 Label: Filter_TCP/IP_Hdr MINIMUM Frame Length 53 
7 Filter hardware bytes available MAXIMUM Frame Length= 2022 

BYTE FIELD LABEL FIELD DATA 

1 

7 

13 

15 
17 

19 

21 

23 
25 
27 
35 
39 
43 
47 
49 

53 

DESTINATION 
SOURCE 
TYPE 

XX·XX·XX·XX·XX·XX 
XX·XX·XX·XX·XX·XX 
XX·XX 

IP_Ver_Hdrlg_Type XX·XX 
IP_Total_Length XX·XX 
IP Identification 
IP_Flgs_Ofst 
IP T live 
IP_Checksum 
IP_Srce Dest addr 
TCP_Srce_Des_addr 
TCP_Seq_number 
TCP Dest_addr 
TCP_Data_Ofst_Cfg 
TCP_Window_Chksum 
TCP_Urg_pointer 

XX·XX 
XX·XX 
XX·XX 
XX·XX 
XX·XX·XX·XX·XX·XX·XX·XX 
XX·XX·XX·XX 
XX·XX·XX·XX 
XX·XX·XX·XX 
XX·XX 
XX·XX·XX-XX 
XX·XX· 

Node Name: Not Defined 
Node Name: ·· Not Defined 
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FILTER EXAMPLE 4. 

REQUIREMENT: Define a filter to decode level 3 protocol for Xerox Network 
System (XNS). 

FIELDS of FILTER #0 Label: INTERNET_DATAGRAM MINIMUM Frame Length = 43 
17 Filter hardware bytes available MAXIMUM Frame Length= 800 

BYTE FIELD LABEL FIELD DATA 

7 
13 
15 
17 
19 

20 

21 
25 
31 
33 
37 
43 

.. - ..... -................ 

DESTINATION 
SOURCE 
TYPE 
IDP Checksum 
IDP_Length 
IDP_Transport_Cnt 
IDP_Packet_Type 
IDP_Dest_Net 
IDP Dest Host -
IDP Dest Socket -
IDP_Source_Net 
IDP_Source_Host 
IDP_Source_Socket 

XX·XX·XX·XX·XX·XX 
xx-xx-xx-xx-xx-xx 
06-00 

xx-xx 
xx-xx 
xx 
xx 
xx-xx-xx-xx 
xx-xx-xx-xx-xx-xx 
XX·XX 
XX·XX·XX·XX 
XX·XX·XX·XX·XX·XX 
xx-xx 

Node Name: Not Defined 
Node Name: ·· Not Defined 
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FILTER EXAMPLE 5: 

REQUIREMENT: Create a filter to decode a combined level 3 and level 4 protocol 
for Xerox Network System (XNS). 

FIELDS of FILTER #0 Label: Sequenced_Packet 
5 Filter hardware bytes available 

MINIMUM Frame Length 
MAXIMUM Frame Length 

55 

= 2022 
BYTE 

1 

7 

13 
15 
17 
19 
20 
21 
33 
45 
46 
47 
49 
51 
53 
55 

FI ELD LABEL 
...... -.. --..... --.. -
DESTINATION 
SOURCE 
LENGTH (TYPE) 
Seq_Packet_Chksum 
IDP_Length 
IDP_Transport_Cnt 
IDP_Packet_Type 
IDP Destination 
IDP_Source 
SP_Connection_Cnt 
SP_Datastream_Type 
SP_Source_Conn_ ID 
SP_Dest_Conn_ID 
SP_Sequence_Numb 
SP_Ack_Number 
SP_Allocation_Num 

FIELD DATA 

XX·XX·XX·XX·XX·XX 
XX·XX·XX·XX·XX·XX 
06·00 
xx-xx 
xx-xx 
xx 

Node Name: Not Defined 
Node Name: · · Not Defined 

05 

XX·XX·XX·XX·XX·XX·XX·XX·XX·XX·XX·XX 
XX·XX·XX·XX·XX·XX·XX·XX·XX·XX·XX·XX 
xx 
xx 
xx-xx 
xx-xx 
xx-xx 
xx-xx 
xx_xx 
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13 
< Edit Messages > MENU 

This chapter describes the <Edit Messages> Menu functions. 

Messages that you create can be used with the <Edit Programs> Menu to simulate 
stations on the Local Area Network. 

Messages can be used to simulate a request or to initiate a transfer of information. The 
messages can also be used as an acknowledgment for transmissions from other stations. 

This chapter includes: 

• <Edit Messages> Softkey Selections 

• <Edit Messages> Display Description 

• <Edit Messages> Softkey Descriptions 

• Copying The Data Length Field 

• Selecting An FCS Value 

• Example For Editing A Message 
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< Edit Messages > Softkey Selections 

Edit Messages 

Add Message 
Delete Message 
Show Node Names 
Show Hex Addresses 
Enter Node Name (shown when cursor is in address fields) 
Edit Datafield 

Insert Byte(s) 
Delete Byte(s) 
ASC 11 7 

ASCII 7 ASCII 7 ASCII 7 ASCII 7 
Par 0 Par = 

ASCII 8 Roman 8 
EBCDIC 
Go To Byte # 
OTHER CHOICES 

Copy Frame 
Copy Message 

Datafield= 00000.. (0) 
Datafield= 01010.. (5) 
Datafield= 10101.. (A) 
Datafield= 11111.. (F) 
Random Dataf ield 

OTHER CHOICES 
Format as Filter# 

Copy Data Length (Cursor in FRAME TYPE field) 

Select Good FCS (Cursor in FCS Value field) 
Select Bad FCS 
Select Hex FCS 
EXIT 

Odd Par Even Par 
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< Edit Messages > Display Description 

The menu for <Edit Messages> is shown below. This menu shows a directory of the 
messages you have created. Elements included in this display are: 

MESSAGE MESSAGE 
# LABEL 

.. .. .. -... "' - ... --- .... - .. 

0 MESSAGE 0 -
MESSAGE 1 -

2 POLL CPU -
3 PRINT TEST -

Message number 
Message label 
Destination address 
Source address 
Frame Type 
Frame Length 
FCS value 

DESTINATION SOURCE 
ADDRESS ADDRESS 

.. .. .. .. . . .. .. .. .. -... -....... .. - -........ -- ..... -....... 

00-00-00-00-00-00 00-00-00-00-00-00 
00·00·00·00·00·00 00·00-00·00·00·00 
COMPUTER_1 HP_LAN_Analyzer 
PRINT SERVER HP_LAN_Analyzer -

FRAME FRAME FCS 
TYPE LENGTH VALUE 

................ 

00-00 60 Good 
00·00 60 Good 
00·00 60 Good 
00·00 60 Good 

Add 
Messa_g_e 

Delete 
Messa_g_e 

Show Node Show Hex Enter Edit OTHER EXIT 
Names Addresses Node Names Oataf ield CHOICES 

Figure 13· 1. <Edit Messages> Menu. 



The MESSAGE # is generated by the protocol analyzer. Up to 16 messages can be 
created and stored in the protocol analyzer. The messages are numbered in hex 
characters 0 through F. Your created messages can be stored in the system disc drive 
along with the other <Setup HP 497 lS> functions. When you need them, you can 
quickly load your own created messages along with the other setup functions back into 
the protocol analyzer to solve a particular application. 

The default MESSAGE LABEL field is in the format, MESSAGE_O. For your 
convenience, you can assign functional labels that describe the message function. 
Figure 13-1 shows the sample message labels POLL_ CPU and PRINT_TEST. 

The DESTINATION and SOURCE ADDRESS fields are both the same six byte address 
fields seen in <Edit Node List> and <Edit Filters> Menus. These address fields can also 
be described with functional name labels in place of the six byte hex code. Remember 
that equivalent node names must first be defined in the <Edit Node List> Menu before 
they can be used in other menus. 

The FRAME TYPE field contains the contents of bytes 13 and 14 of each frame. 

The default FRAME LENGTH field for each message is 60 bytes. This includes the 
Destination and Source addresses, the Type field, and Data Field. Frame length does 
not include the preamble field or FCS characters. 

FCS VALUE field lets you generate either good or bad FCS characters when the 
message is transmitted. For example, you may want to transmit a frame with bad FCS 
characters to see if the receiving station will detect the error. Also, you can enter an 
FCS value in HEX characters. 

<Edit Messages> Menu 13·3 



< Edit Messages > Softkey Descriptions 

<Add Message> softkey causes a new message to be added to the message table. 

The new message is added first at the closest available position 
above the cursor and then to the closest available position 
below the cursor. 

The cursor may be in any field of a message when the <Add 
Message> sof tkey is pressed. 

Naming The Message 

<Delete Message> 

<Show Node 
Names> 

<Show Hex 
Addresses> 

<Enter Node 
Name> 

Message names may be assigned that identify the function of 
the message. The name field may have up to 17 characters. 
Leading spaces are deleted. Spaces between characters are 
replaced with an underscore(_). Press RETURN or TAB keys 
to complete the entry. 

softkey deletes the message that contains the cursor. The 
cursor may be in any field of the message. 

softkey causes the Destination and Source Address fields to be· 
displayed as the equivalent Node Names assigned in the <Edit 
Node List> Menu. 

softkey causes the Destination and Source Address fields to be 
displayed in the hexadecimal code format. 

softkey is displayed only when the cursor is in an address 
field. 

This softkey causes names of nodes defined in <Edit Nodes> 
Menu to be displayed as softkeys. Press the softkey whose 
node name you want to assign to either the Destination 
Address Field or the Source Address Field. 

Type a node name from the keyboard and press the RETURN 
key to complete the command. 
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<Edit Datafield> 

Data Field of MESSAGE 

LI NE BYTES 

shows a default display containing a 60 byte data field for 
editing messages. 

MESSAGE Label: MESSAGE 1 
FRAME Length: ~ Bytes 

HEX DATA CHARACTER DATA 

1 15 .... 29 OO·OO·OO·OO·OO·OO·OO·OO·OO·OO~oo-00-00-00-00 *************** 
2 30 •... 44 00·00·00·00·00·00·00·00·00·00·00·00·00·00·00 *************** 
3 45 ••.. 59 00·00·00·00·00·00·00·00·00-00·00·00·00·00·00 *************** 
4 60 •... 60 00 * 

<Insert Byte(s)> 

<Delete Byte(s)> 

ASCII 7 ASCII 8 
Roman 8 

EBCDIC 
I 

* = N u 

Go To OTHER EXIT 
B te # CHOICES 

Figure 13-2. <Edit Datafield> Menu display 

prompts you to enter how many bytes you want to enter. 
Enter the number of new bytes you want and press the 
RETURN key. The new bytes are inserted before the position 
marked by the cursor. 

prompts you to enter how many bytes to delete. Enter the 
number of bytes to delete and press the RETURN key. The 
byte marked by the cursor and following bytes are deleted. 

Changing Message Length 
You can change the message field by inserting or deleting bytes. 

Another method to change the length of the message data field is to move the cursor to 
the "FRAME Length:" Field in the upper right corner. Enter how many bytes you want 
the field length to be and press the RETURN key to complete the entry. 
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A third method to change the length of the data field is to just keep typing characters 
at the end of the data field. New byte locations are added as new characters are typed. 
Up to 2022 byte positions may be entered. 

<ASCII 7> 
<ASCII 8 

Roman 8> 
<EBCDIC> 

<:ASCII 7 
Par= O> 

<ASCII 7 
Par= 1> 

<ASCII 7 
Odd Par> 

<ASCII 7 
Even Par> 

Depending on which of these softkeys you select. the protocol 
analyzer converts chara.cters in the HEX DAT A Field into the 
equivalent ASCH, Roman or EBCDIC characters for the 
CHARACTER DAT A Field. 

Optional keyboards can be used with the HP 497 lS. See 
appendix B for the different keyboards and character code 
sets available. 

Unknown character·· When a character is entered in hex code 
that does not have an equivalent character, the character is 
displayed as ~ in the CHARACTER DATA Field. 

You can move the cursor to the CHARACTER DATA Field 
and enter characters directly from the keyboard. The 
equivalent hex code for each character is automatically 
entered in the HEX DAT A Field. 

creates messages in ASCII 7 with the parity bit always set 
to zero. 

creates messages in ASCII 7 with the parity bit always set 
to one. 

creates messages in ASCU 7 so that the character byte 
always has an odd number of bits. 

creates messages in ASCII 7 so that the character byte 
always has an even number of bits. 
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<Go To Byte# 

<Copy Frame > 

causes the protocol analyzer to move the cursor and the 
message so the selected byte is at the top of the display. This 
lets you quickly move through large messages. 

Press <Go To Byte#> to display the following message: 

Go to which byte number? _ 

Enter the byte number you want to view and press RETURN 
key to execute the command. 

creates a message using a frame stored in the Receive Buffer. 
All of the contents of the frame in Receive Buffer are copied. 
This includes: Address fields, Type/Length Field, Data field, 
and Frame Check Sequence. The length of the frame is also 
updated. 

All frames are copied into your message with a good FCS 
value assigned. 

Press the softkey, to display the following message: 

Copy wh; ch frame number? __ 0 

Enter the frame number you wish to copy from the Receive 
Buffer. Press RETURN key to execute the command. 

Frame number 0 is the default value. Since no frame 0 exists 
in the protocol analyzer memory, you have to enter a valid 
frame number for a copy to occur. This prevents you from 
unintentionally overwriting a message which could happen if 
the default value was a real frame number. 
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<Copy Message > 

<Datafield = 
00000 .. > 

<Datafield = 
01010 .. > 

<Datafield = 
10101 .. > 

<Datafield = 
11111 .. > 

<Random Datafield> 

copies a previously defined message. The entire message is 
copied, including: Address fields, Type/Length field, Data field, 
and FCS field. 

The FCS value for the copied frame is automatically reset to a 
good value. 

Press the <Copy Message #> softkey to display the following 
message: 

Select softkey OR enter valid name: 

Enter the message number to be copied and press RETURN 
key to execute the command. 

fills the entire data field with all Os. 

fills the entire data field with all Ss. 
(Alternating Os and ls.) 

fills the entire data field with all A's. 
(Alternating ls and Os.) 

fills the entire data field with all Fs. 
(All ls.) 

uses an HP 497 lS internal random generator to fill the entire 
data field with random characters. 
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<Format as 
Filter#> 

softkey causes the message marked by the cursor to be 
formatted according to a specific protocol. This lets you more 
easily recognize if control or protocol characters are correctly 
placed in specific byte locations in the data field. 

The following frame header information is included in the 
display: 

Message Label 
Frame Length 
Destination Address 

Source Address 
Equivalent Node Names 
Type/Length Field 

In addition, the <Format as Filter #> softkey displays byte 
locations in the data field that have been declared as filter 
bytes. The data field characters are displayed in hex code with 
the equivalent characters displayed on the right side of the 
screen in the selected character format. 

The "FIELD LABEL" Field lets you can assign names to filter 
fields you create in the data field. The name can reflect byte 
position or a protocol function. 

MESSAGE #0 in format of FILTER 0 MESSAGE Label: MESSAGE 0 

FI ELD LABEL 

DESTINATION 
SOURCE 
TYPE 

DATA 

ASCII 7 
Par = 0 

ASCII 7 
Par = 1 

FRAME Length: 
HEX DATA 

~ Bytes 
CHARACTER DATA 

00-00·00·00·00·00 
00·00·00·00·00·00 
00-00 

Node Name: Not Defined 

00 

-------
Node Name: ·· Not Defined 

ASCII 7 ASCII 7 ASCII 8 
Odd Par Even Par Roman 8 

EBCDIC 

Figure 13-3. <Format as Filter#> Display. 
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<Format as 
Filter#> 
(cont.) 

The data field displays only the data bytes defined in the 
filter you chose for your pattern. 

Press the <Format As Filter#> softkey to display: 

Select softkey OR enter vaL;d name 

Press a displayed softkey or type the filter name whose format 
you want to copy and press RETURN key to execute the 
command. 
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Copying The Data Length Field 

Some protocols require that the "FRAME TYPE" Field show the length of the data 
field. 

MESSAGE MESSAGE DE!=:TINATION SOURCE FRAME FRAME FCS 
# LABEL ADDRESS ADDRESS TYPE LENGTH VALUE 

. . . . . .. .. . . . . . . . . .. .. ............................. .... .. .. .. .. .... .. . .. .. . .. . .. .. .. ................ 

1 Message_ 0 00·00·00·00·00·00 HP_LAN_Analyzer 'rio~~e', 60 GOOD 

In the <Edit Messages> Menu, when you position the cursor to the "FRAME TYPE" 
Field, the softkey, <Copy Data Length>, is displayed. 

<Copy Data Length> 
causes the protocol analyzer to enter the length of the data 
field, for the current message. in the "FRAME TYPE" Field. 
The data field length is displayed in Hex code. 

For example: 

If the data field contains 46 bytes, the "FRAME TYPE" 
Field would display 00·2E 

00·2E = Hex code for 46 10 

Don't confuse data field length with frame length. Frame length contains the 
Destination and Source Address fields, the Type/Length field, and the Data field. 
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Selecting An FCS Value 

When a frame is transmitted on the network, IEEE 802.3 uses a Cyclic Redundancy 
Check (CRC) technique to generate Frame Check Sequence (FCS) characters for 
determining if a message is received correctly. The receiving station generates its own 
FCS value and compares it to the received FCS value. If the values are the same, the 
receiving station knows it has a good frame. The algorithm used for the error checking 
sequence is CRC-32. 

The HP 497 lS displays the FCS Field in the <Edit Messages> Menu display: 

MESSAGE MESSAGE 
# LABEL 

DESTINATION 
ADDRESS 

SOURCE 
ADDRESS 

FRAME FRAME FCS 
TYPE LENGTH VALUE 

To view the softkey functions available for FCS values, use the TAB key to move the 
cursor to the "FCS VALUE" Field. The following softkeys are displayed: 

<Select Good FCS> is the default selection. This causes the protocol analyzer to 
transmit a good FCS sequence with the message you have 
created. 

<Select Bad FCS> softkey causes the protocol analyzer to create and purposely 
send a bad FCS value with the message. 

<Select Hex FCS> 

You may occasionally want to send a message with a bad FCS 
sequence in order to check if another station detects baci FCS 
values and how it responds to the bad value. 

softkey lets you type an FCS value in hex format from the 
keyboard. This lets you have complete control of generating 
an FCS test value. 
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Example For Editing A Message 

The simplest way to send a message with the HP 497 LS is to use all default menus and 
send Message_O. 

Creating a message may require coordination with other edit function menus. Node 
names and a filter may need to be defined before you complete your message. 

The following example creates a message for a station named "CPUl" to send to 
another station named "PRINT_SERVER". 

The outline below shows the steps that may be used for creating a message. Each step 
below is discussed in detail on the following pages. 

1. <Edit Node List> Menu. (Optional) 

This menu is used to assign user labels to the stations assigned HEX code 
address. 

2. <Edit Messages> Menu. 

In this menu, you do two functions. 

A. Name the message and identify the Destination and Source Addresses. 
B. Enter the data field contents. 

3. <Edit Filters> Menu. (Optional) 

This menu is optional for editing a message if you want to edit in a 
particular filter format. In some messages, you may want the data field to 
contain specific information at specific byte locations. By defining a filter 
to conveniently display the byte locations you are interested in, you can 
easily verify if your message meets your protocol. 

4. <Edit Messages> Menu. (Optional) 

Now you can use the filter format from step 3 to verify if your new 
message meets your filter specifications. 
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EXAMPLE (cont.) 

1. <Edit Nodes> (Optional) 

If node names are to be used, they should be declared in the <Edit Nodes> Menu. 

In the example below, network names "CPUl" and "PRINT_SERVER", are 
assigned to network addresses 08-00-09-0A-1 l-04 and 08-00-09-Bl-00-12 
respectively. 

If your node names are already declared, go ahead to step 2. 

Example for <Edit Node List>: 

NETWORK NAME : NETWORK 0 

NODE # NODE NAME 

1 CPU1 
2 PRINT_SERVER 

NODE ADDRESS 

08-00-09-0A-11-04 
08-00-09-01-00-12 

NETWORK TYPE : ETHERNET 

BUS POS I Tl ON 

0 

0 

Using labels for the message name, Destination, and Source addresses makes the message 
much easier to recognize when a large list of messages have been created. 

<Edit Messages> Menu 13·14 



EXAMPLE (cont.) 

2A. Assigning The Message Labels 

Select the <Edit Messages> softkey to assign the following elements of the message: 

MESSAGE LABEL is a functional label you can assign to describe the 
contents or purpose of your message. 

DESTINATION ADDRESS is the network address of the station that you 
want to receive your message. You can assign a functional label to this 
field in the <Edit Nodelist> Menu. 

SOURCE ADDRESS is the network address you want to simulate as the 
transmitter of the message. You can assign a functional label to this field in 
the <Edit Nodelist> Menu. 

Example for assigning a message: 

Press the <Show Node Names> softkey and the Destination and Source Addresses 
are converted to their equivalent labels as shown below. Remember that node 
name labels must be defined in the <Edit Node List> Menu. 

Example for <Show Node Names> 

MESSAGE MESSAGE 
# LABEL 

0 ALPHABET 

DESTINATION 
ADDRESS 

PRINT SERVER CPU1 

SOURCE 
ADDRESS 
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EXAMPLE (cont.) 

28. Creating the Message Data Field 

In the <Edit Messages> Menu, press the <Edit Datafield> softkey to create your 
frame's data field. 

When you create a message, be aware that it is easier to move the cursor to the 
equivalent "CHARACTER DAT A" Field and type your message from the 
keyboard. However, if you have memorized the hex values for ASCII or EBCDIC 
characters, you can enter your text directly in hex code in the "HEX DAT A" Field. 

When you enter characters in the "CHARACTER DAT A" Field, the equivalent 
"HEX DATA" Field display is updated after you press the RETURN or TAB keys. 

Example message for <Edit Datafield> 

DATA FIELD of MESSAGE 0 MESSAGE label hello 

LINE BYTES HEX DATA 
FRAME Length: ~ Bytes 

CHARACTER DATA 

2 
3 
4 

..... -----
15 ••.• 29 
30 •••. 44 
45 •.•• 59 
60 •••• 60 

61·62·63·64·65·66·67·78·79·6A·6B·6C·6D·6E·6F abcdefghijklmno 
70·71·72·73·74·75·76·77·78·79·7A·30·31·32·33 pgrstuvwxyz0123 
34·35·36·37·38·39·41·42·43·44·45·46·47·48·49 456789ABCDEFGHI 

Notice that the default data field length is 60 bytes. You can increase or decrease 
the data field to meet your message length by using the "Frame Length:" Field or, 
the <Insert Bytes> or <Delete Bytes> softkeys. 
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EXAMPLE (cont.) 

3. <Edit Filters> (Optional) 

This operation is optional, you do not have to do this step to get your message 
transmitted. However, the filters function does provide a convenient feature for 
you. 

In some messages, you may want the data field to contain control or protocol 
information at specific byte locations. By specifying a filter to contain the byte 
locations you are interested in, you can easily verify if your message meets your 
protocol. 

In the filter example that has been presented, a message is being sent from a 
computer on the network to a print server. Usually some protocol or formatting 
control information has to accompany messages to a print server. This protocol 
or control information has to occur at specific locations in the data field. 

In the example below, specific byte location:; are to be checked at byte locations 
15, 25, and 50 in the data field. An example for <Edit Filters> is shown below. 

FIELDS of FILTER #0 Label: Filter 0 MINIMUM Frame length = 53 
46 Filter hardware bytes available MAXIMUM Frame Length =2022 

BYTE FIELD LABEL FIELD DATA 

DESTINATION 
7 SOURCE 

13 TYPE 

15 first data 
25 second data 
50 third data 

XX·XX·XX·XX·XX·XX 
XX·XX·XX·XX·XX·XX 
XX·XX 
xx 
xx 
xx 

Node Name: ··Not Defined 
Node Name: ··Not Defined 

For now, the contents of this filter's bytes do not have to match your specific message, 
you are primarily interested the data field byte locations being identified. 
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EXAMPLE (cont.) 

4. Compare Message Data Field To Filter Format. (Optional) 

This step compares the message you have created to your filter pattern. You can 
easily verify the header labels of the message and also see if your protocol and 
format characters are correct in the data field. 

a. Press <Edit Messages> softkey. 

b. Position the cursor in any field of the message you have just created. 

c. Press <OTHER CHOICES> softkey. 

d. Press <Format As Filter> softkey. 

e. Select the softkey that identifies the filter you are using for your message 
pattern. In this case, Filter_ O. 

Example of Message in <Format as Filter> mode: 

MESSAGE #0 in format of FILTER_O MESSAGE Label: alphabet 
FRAME Length: 60 Bytes 

FIELD LABEL HEX DATA CHARACTER DATA 

DESTINATION 
SOURCE 
TYPE 
first data 
second data 
third data 

22·22·22·22·22·22 
11-11-11-11-11-11 
00·00 
61 

68 

39 

Node Name: LASER PRINTER 
Node Name: CPU1 

The filter pattern should be defined with a "FRAME Length" long enough to be 
able to show all the characters in the message data field. 
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14 
< Edit Programs > MENU 

This chapter describes the softkeys you can use to program the HP 497 lS Protocol 
Analyzer. Programs can be written to control the operation of the protocol analyzer in 
both monitor and simulate operation. 

This chapter includes: 
• Introduction 

• Selecting A Program To Edit 

• "Selecting A Program" Softkey Descriptions 

• "Store" Function Soft key Selections 

• "Store" Function Softkey Descriptions 

• Select The Log To Disc File 

• Program Commands Sof tkey Selections 

• Overview Of Programming 

• Conditional Program Statements 

• Program Commands Softkey Descriptions 

• Display Functions In <Edit Programs> Menu 

• Program Examples 
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Introduction 
The HP 497 lS Protocol Analyzer can be programmed to perform monitor and simulate 
operations. 

While you can have up to five programs created in the HP 497 lS at a time, the 
programs can be executed one at a time. This lets you have programs for different 
applications quickly available in the protocol analyzer. 

PROGRAMMING A MONITOR OPERATION 

The monitor function can be used to capture and view frames as they are occurring on 
the network or to display frames previously stored in the Receive Buffer. 

The HP 497 lS Protocol Analyzer provides a monitoring function using only a few 
simple softkey selections in the <Monitor Network> Menu. However, by using 
programming functions, you can use much more of the power of the protocol analyzer. 
Additional functions available when monitoring with programming include: 

Filters 
Timers 

Counters 
Conditional actions for data collection 
Logging to a disc for mass storage 

When monitoring messages on the network, the filter function can be used to control 
what messages are stored by the protocol analyzer. When monitoring frames previously 
stored in the Receive Buffer, the fiiter function can be used to dispiay on the screen 
only messages that meet conditions you specify. 

You can also use timers to measure time intervals between events you specify. 
Similarly, counters are provided to count how many times certain events occur. 
Conditional statements let you display, time, and count only the messages that meet 
filter conditions you specify. 

Monitored network messages may be saved from the Receive Buffer onto a floppy disc 
and later recalled back into the Receive Buff er for viewing or processing in a 
programmed monitor mode. 

You can also use the increased storage capacity of disc drives to log messages directly 
to disc as they occur on the network. 
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PROGRAMMING A SIMULATE OPERATION 

Jn simulate mode, the protocol analyzer has the same filter, timer. counter, and 
conditional action functions as in monitor mode. However, in simulate mode, the 
protocol analyzer can also transmit messages onto the Local Area Network. 

The protocol analyzer can be programmed to simulate a station or stations on the 
network. The protocol analyzer can start transmitting messages onto the Local Area 
Network on your command. Also, the protocol analyzer can transmit in response to a 
particular transmission received from another station on the network. This provides the 
capability to artificially increase network loading to test performance under higher 
traffic conditions. 
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Selecting A Program To Edit 

Edit Which Program? Program 0 

Edit New Program 

New Program Name? 

Rename Programs 

Rename Which Program? 

OTHER CHOICES 

Delete Program 
Delete Which Program? 

EX IT MENU 
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"Selecting A Program" Softkey Descriptions 

Edit Which Program? 

<Edit New 
Program?> 

lets you choose one of five programs to edit. 

If any programs have been created, the names of the programs 
are displayed as softkey selections. 

Press the softkey for the program you want to edit or enter 
the name from the keyboard and press RETURN key. 

A default program, Progrnm __ O, is in the protocol analyzer at 
power-on and consists of a "Store" command. This program 
lets the protocol analyzer perform simple monitor functions 
with only a few softkey entries. 

softkey lets you create a new program. If you press tnis 
softkey, the protocol analyzer displays: 

New Program Name? 

Enter the new program name from the keyboard. Up to nine 
keyboard characters may be entered. Leading spaces are 
deieted. Spaces between characters are repiaced with an 
underscore L). Press RETURN or TAB keys to complete the 
entry. 

This softkey is displayed until five programs are created. 
After five programs are created, the <Edit New Program?> 
softkey is not displayed again until an existing program is 
deleted. 



<Rename 
Programs> 

<Delete Program> 

softkey lets you assign new names for programs that 
already exist. Press <Rename Programs> softkey to display the 
message: 

Rename which program? 

If any programs exist, their names are displayed as softkeys. 
Press the softkey that identifies a program you want to 
rename. 

Rename program xxxxxxxxx to ___ _ 

Up to nine keyboard characters may be entered for the 
program name. Leading spaces are deleted. Spaces between 
characters are replaced with an underscore (_). Press 
RETURN key to complete the entry. 

softkey deletes programs from the protocol analyzer. 

Press the <Delete Program> softkey to display the message: 

Delete which program? 

Press a softkey label for the program you want deleted or 
enter the program name from the keyboard and press the 
RETURN key. 

The protocol analyzer prompt asks if you really want to delete 
the program. Press <YES> to delete the program or <NO> to 
exit the menu. 

If you try to delete all programs, a default program remains as 
Program_ 0. "This program contains only the "Store: all frames 
until full" command which lets the protocol analyzer acquire 
frames in monitor modes. 

The default Program_O stores all frames in the Receive Buffer 
until the buff er is filled. 
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Store Function Sonkey Selections 

Store: 
All Frames-------->l·Until Full---------·> 1 

I 
I 
I A 
·Starting With-->l·>l··Filter_O·>I····-····> END EDIT 
·Centered About·>I l··Filter_1·>1 
·Ending with····>I l·-Filter_2·>1* And Frame Traits·> 1 

I _ I 
l··Filter_F·>l··Or-----> A 

I 
l··Block 1···> 1 

·Nonstop-················--··-··>I 1 
• - • - > 

·Block 1-----> 1 

- - - .... - .... - . - . ·<· .. - ... - - - . - . - - ·<· - . 

B 
Frames ·>j·Filter_O·>j·····················>j······> 
Matching I _1·>1 

I _2·>1··And Frame Traits* >I 
I _3·> I I 
I _4·> I 

Not -···>I I 
Matching I I· ·Or · - ·> B 

I I 
I _15->l··<Block 1> ··> 1 

I 
I-Frame 
I Traits·>l··········------·······----1 

No Frames···> 1 
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Store Function Softkey Descriptions 

The command, Store: all frames 
until buffer full, 

is automatically presented at the top of each program. The "Store" command is not 
executed as part of the program; it is used to set up internal circuitry to store frames in 
the Receive Buff er when the program run starts. 

The program sees only those frames which meet the requirements of the store 
statement. It is important to remember that the frame counter function counts only 
the frames going into the Receive Buff er. Frames not stored in the Receive Buffer are 
not counted by the f ra.me counter. 

The store function sets up the hardware when you execute a program using <Run From 
Network> softkey. 

Log to disc . 
If the "Log file:" command beneath the "Store:" command is used, frames can be stored 
to a disc drive. Files can be created on a disc drive that are much larger than the 
Receive Buffer. 

Only frames that pass filter and trigger conditions are stored to the Receive Buffer. In 
"Log file:" mode, frames are first stored to the Receive Buffer and then to the disc file. 
interactions between the Receive Buff er and log-data disc files are described in the 
following store command descriptions. 

To view softkey selections for the store command, position the cursor in the "Store:" 
command line. 



Choosing what frames to store. 
In the store field, you first have to choose what frames to store and then how you 
want the frames stored. 

<All Frames> 

<Frames Matching> 

<Not Matching> 

<No Frames> 

softkey stores all incoming frames into the Receive Buffer 
that pass the "Runt Frame Filter:" selected in the <Hardware 
Functions> Menu. 

lets the protocol analyzer store only the frames matching the 
filter or frame traits you specify. 

Frames to be stored by the protocol analyzer can be further 
qualified by ANDing or ORing frames with frame traits. 
Before a frame will be stored, it has to match the filters you 
specify AND/OR it has to meet the frame traits you specified 
in <Edit Filters> Menu. 

softkey lets you store only frames that do not match filters or 
frame traits you specify. You can also use the AND or OR 
functions to make combinations of filters and frame traits that 
you want. 

The not condition applies to all the filter and frame trait 
elements that follow the <Not Matching> command in the 
store field. 

softkey lets the protocol analyzer ignore incoming frames. 

This function can be used when trying to transmit a group of 
messages at the fastest rate. Not having to look for frames to 
be stored allows faster transmission of messages when trying to 
load a network. 
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EXAMPLES OF "Store:" COMMANDS 

Store: frames matching Filter O 
until full 

Store: frames not matching Filter_O 
until full 

Store: frames matching Filter 0 
or Filter_1 

until full 

Store: frames not matching Filter_O 
or Filter 1 

until full 

Store: frames matching Filter_O 
as well as Frame Traits 

until full 

Store: frames not matching Filter_O 
as well as Frame Traits 

until full. 

Store: frame matching Filter 0 
or Filter 1 
as well as Frame Traits 

until full 

Store: frame matching Filter 0 
or Filter 1 
or Frame Traits 

until full 

Stores only frames that do match 
Filter 0. 

Stores only frames that do not match 
Filter_O. 

Stores any frame that matches either 
Filter 0 or Filter_1. 

Stores only frames that do not match 
either Filter_O or Filter 1. -

Stores only frames that match both 
Filter O and Frame Traits. 

Stores only frames that do not match 
both Filter_O and Frame Traits. 

Stores only frames that match either 
Filter_O or Filter_1 
and also match Frame Traits. 

Stores only frames that match 
at least one of either 
Filter 0 or Filter 1 or Frame Traits. 

<Edit Programs> Menu 14·8 



Choosing how to fill memory. 
After you have chosen which frames to store, you have to choose how you want the 
frames organized in memory. the selections are: 

<Until Full> 

Until Full 
Starting With 
Centered About 
Ending With 
Nonstop 

Storing to Receive Buffer. 
If the program does not log data to disc, the analyzer initializes 
the Receive Buffer and starts storing frames until the buff er is 
full. 

Storing to log-data file. 
If the program logs data to a disc, data is stored until the 
designated disc file is full. Since the log-data file is normally 
much larger than the Receive Buffer, data is overwritten in 
the Receive Buffer until the log-data file is filled. 
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<Starting With> 
softkey lets you begin filling the Receive Buffer or log-data 
file only when a particular filter or combination of filters has 
been found. After the starting event is found, all frames 
matching filter conditions are stored. 

Example: Store: all frames 
starting with FILTER_O 

····frame 1· first frame matching FILTER_O 
-·-·frame 2· 
····frame 3· 

After Filter 0 occurs, the protocol analyzer starts to store 
frames into memory. All frames occurring on the network are 
stored until the memory is filled. 

When you view the frames in <Examine Data>, the frame 
"starting with FILTER_O" is displayed with a blinking frame 
number. 
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<Centered about> 
softkey causes the protocol analyzer to start filling the Receive 
Buffer or log-data disc file in a circular manner. If the buffer 
is filled before the trigger event occurs, new frames are 
written over previously stored frames. 

This process of writing over previously stored frames 
continues until the filter condition you specify is found. At 
that time, the protocol analyzer calculates the approximate 
center of the circular memory; notes where the starting frame 
would be; and then allows more incoming frames to be stored 
until the buffer is filled from the calculated starting point. 
For example: 

---frame 1- Store: all frames 
---frame 2- centered about FILTER 0 

-----frame matching FILTER_O 

----last frame 

The <Centered About> softkey is more closely related to the 
number of bytes of data in the buffer than the number of 
frames in the buffer. For example, if long frames precede the 
filter and short frames follow the filter, there are more frames 
stored after the filter than before the filter. However, the 
frame matching your filter condition is approximately at the 
center of the total quantity of bytes stored. 

If the program logs data to disc, the trigger is still centered in 
the Receive Buff er. Frames are stored after the trigger event 
to fill the remainder of the Receive Buffer. Since the log-data 
file is typically much larger than the Receive buffer, the 
trigger event may not occur at the center of the log-data file. 

In <Examine Data> Menu, use the <Go to Trigger> softkey to 
display the trigger event with a blinking frame number. 
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<Ending With> 
softkey causes the protocol analyzer to begin storing frames 
into the Receive Buffer or log-data file and stop when a filter 
condition you specify occurs. 

Similar to <Centered About> softkey, <Ending With> softkey 
uses a circular mode to fill the buffer and log-data file. Only 
frames matching the specified filter conditions are stored to 
the Receive Buffer and log-data file. Once the buffer is filled, 
new frames are written over existing frames. This function of 
repeatedly writing over frames continues until the trigger you 
specify is found. 

Example: 

* 

Store: all frames 

- - - ·frame 1-
· ···frame 2-
- - · - frame 3 · 

ending with FILTER 0 

····frame matching FILTER 0 

When you view the stored frames in <Examine Data>, the 
"frame matching FILTER_X" is displayed with the frame 
number in blinking, half-bright, inverse video. If the same 
frame is also "marked" by the program, the frame number is 
displayed in blinking full-bright inverse video. 

* Due to the fast speed of the data acquisition circuits, some 
additional frames may be stored after the protocol analyzer 
matches a filter and initiates stopping frame acquisition. 

<Edit Programs> Menu 14-12 



<Nonstop> softkey lets the protocol analyzer store frames in the Receive 
Buffer or log-data file in a circular buffer mode. 

Similar to <Centered About> and <Ending With> softkeys, 
after <Nonstop> softkey fills the memory, it continues to write 
new frames over the oldest previously stored frames. 

Example: Store: all frames 
nonstop 

····frame 1· 
····frame 2· 

after the buffer ;s 
f;Lled once, new frames 
w;Ll be wr;tten over 
previously stored 
frames 
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<End Edit> softkey lets you exit the current program you are editing. 
After you press <End Edit>, you can select a new program to 
edit, or, you can press <EXIT> to return to the Top Level 
Menu. 

<And Frame Traits> 

<Or> 

<Block 1> 

softkey enables the frame error traits you selected in <Edit 
Filters> Menu. The selection includes: 

Accept/Reject Frame with GOOD FCS 
Accept/Reject Frame with BAD FCS 
Accept/Reject MISALIGNED Frame 
Accept/Reject RUNT Frame 

<And Frame Traits> softkey ANDs the selected frame traits 
with all the filters in store command line. 

Frame errors are discussed in more detail in the section, 
"Displaying Frame Errors," in <Examine Data> Menu chapter. 

softkey lets you combine filters used to specify the store 
operation. 

Example: Store: all frames 
starting with FILTER_O 

or FILTER 1 

This example starts storing frames into memory when either 
FIL TER_O or FIL TER_l has been found. 

This softkey moves the cursor to the program starting position 
in program block 1. This is a program editing key, it is not a 
program step. 
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Select The Log To Disc File 

Log file: 

New File ·······>!···( select )···( select )···( select )··>I 
I (volume number) (file name) (file size) I 
I I 1 

Existing File ··>I I 
I 
I 

Not Used · · · - - - - - - - - · - - - · · · · · · · · - · · · · · · · · · · · · · · · · · · · · - · · · · - - · - · · · - >I 

Disc functions 

When you want to store frames occurring on the network to a disc drive, you must 
supply the following information: 

<New File> 

Volume number 
Volume file name 
File size (in bytes) 

lets you assign a name to a new file. 

Select Volume 
After you select <New File>, the protocol analyzer displays a 
choice of disc volumes available for logging. You must enter 
the volume number from softkeys. Press a softkey for a 
volume to be used for logging. 
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Name File 
Enter a file name. The name may be up to seven keyboard 
characters. Leading spaces are deleted. Spaces between names 
are replaced with an underscore (_). The following reserved 
characters may not be used in log-data file names: 

@ 
# 

$ I 

. (period) 
CTRL-x (control characters) 

Press RETURN key to complete the file name entry. 

Choose File Size 
You can control how much disc space you want to allocate to 
the file. Use the <Maximum Size> soft.key to show the 
maximum continuous file space available for the chosen 
volume. 

If you need less than the maximum available space, enter the 
file size you want. The minimum file size is 32, 768 bytes. 

Press <EXIT> to return to the Log File menu. Enter the file 
size you want. 

Default File Size 
If you do not enter a file size, the protocol analyzer 
automatically assigns the maximum contiguous space available 
on the selected volume. 
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<Existing File> 

<Not Used> 

<Disc Functions> 

displays the names of files already existing on the volume you 
have selected to logging. 

Logging to an existing file overwrites information previously 
stored on the disc. 

When a program does not use the log to disc function, you do 
not have to enter a disc volume and file name. 

However, if you do enter a log to disc command in the 
following program, when you try to <Execute Program>, the 
protocol analyzer stops and displays the message: 

LOG FILE NOT DECLARED FOR "Log frame" STATEMENT IN BLOCK x. 

Press <Continue CompiHng> softkey and the protocol analyzer 
ignores the log statement and continues compiling, however, 
the program won't run. 

provides quick access to the <Disc Functions> Menu. When 
you go to the <Disc Functions> Menu, you can press <EXIT> 
softkey to return to the <Edit Programs> Menu. 
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Program Commands Softkey Selections 

1 

1-·Start·-·····>I Display ·········>I 

I I I 
I I Marking Frames ··>I 

I I 
I I 
I I Ti mer - · - - - · - · · - · ->I 

I I· -· - ·>I I 
I I I Frame Counter--·-·>! 

I I I I 
I I Collision Counter·>! 

I I 

... - -... -...... -..... >I 
I 
I 
I 
I 

o ->I --· · -· -· · --- -->I 
·>I I 
->I I 
·>I 

F - >I 

I I Logging To Disc ············-············>I 
I 
I 
I 

I 
I 
I 

··Stop·>l·····>I Test·--·-···-·>! . - -. -............ -..... ,,. I 

I 
I 
I 

--Increment Counter·>! 

I 
I 
I 
I 

1----If Counter------·> 2 
I 
I 

0 ... > 1- -- -.. - - --- - -- . - . - - - --- ---
1 - - . >I 
2 ···>I 

- . ->I 
F - •• >I 

l····Go to Block····> (Keyboard entry 

I 
I 
I· ·When (event) - · · · - -> 3 

<Edit 1 

I 
I 
I 
I 
I 

And Then ---····>I 
I 1 

<Next Block> ···>I 

END ED IT 

ED 
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Program Commands Softkey Selections 

1 (cont.) 

- -D i s p l a y F r a me - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - · - - - - - - - - - - · · · > 

- -Mark Frame - - - - · - • • · · - · - · · - - · · · - - · - · · · - - · · - · · - - · • · - · - · · · · - - > 

-·Log Frame To Disc··--·-----··-··-·-···-------------------··> 

c 
··Send -·>I 

Message I 
I 
I 
I 

·-Reset-·->! 

I 
I 

o ·>I·······-·······--------·-··-··--··-····-···> 

, - >I 

2 ->1--->I Repeated_ Times I·---···-·-··-·····> 

->I I I Followed By--> C 
F ->I I 

I 
I Followed By~-> C 

T i mer - - - " > I - - · - · > I 
I I 

Counter-> I I 

I 
I 

o - ->I· - - - - - - ..• - . - - .. - ... - > 

_1 - ·>I 
2 - ->I 

.. >I 
F • - >I 

-~Wait-·->ICKeyboard entry_) Ms···--·->I············--·-···> 

I " Seconds·->! 

I " Minutes·-> I 

I " Hours---->I 

- - Beep - - - - • - - - · - - - - - - · - - - - - · - - - - • - - - - · - - - - · - - · - - - - - - · - · - · · - · > I 
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And Then ···->I 

I 1 
<Next Block>->! 

END EDIT 
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Program Commands Softkey Selections 

1 (cont.) 

--<Find Block> ---------·>I (Keyboard entry_)------------>! 1 

D 
--<Copy Block> ------·-··>I (Keyboard entry_)--·--------·>! D 

I 
I 

- - <Insert Block> · · · · · · · · · · · - - · · · - - - · - - - - · - - · · - - - - · - - - - - - - - - - > I 
I 
I 

··<Delete Block> ····-·································-·····>I 

I 
I 

··Copy Program······->I _0···>1··········-···-·······-······->I 

I _ 1- ··>I I 
I _2- - - >I I 
I _3· ··>I I 
I _4- ·->I I 
I _s--->I I 

I 
I 

--Rename Ctr/Tmrs-···>l·-Counter_O···-·Timer_O···-·>l········>I 
1 

2 2 -
3 3 - -
4 4 - -

F 
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Program Commands Softkey Selections 

2 
I·. If Counter··>! -0 ·····>l····>I = .. >I· .. > Then Go - . ->I Else If 2 
I 
I 
I 
I 
I 
I 

I • 1 ..... >I I <> - . >I To Block I 
I -2 ... - - >I I < - . >I I Else When 3 
I - - - - -> I I > . ->I I 
I - F - - - - ->I I <= - - >I I Next Block 1 
!<Rename I I >= - ->I I 
I Counters> I I END EDIT 

3 When (event) 

Frame Matches·> I 

I 
I 
I 
I 
I 
I 
I 
I 
I 
I 

E 
Filter 0 ---------·>I-Then Go To Block 

-1 ---------->! 
- 2 - - - - - - - - - - >I· And - -> E 

- - - - - - - - - • > I 
-F ---·-·····>I· And Frame Traits 

Not (Filter _)---->I Then Go To Block_ 
(Frame Traits)·>! 

I ·Or - ·> E 
<Edit Filters>--·-·>! 

Frame Traits ------>l·Then Go To Block 

- - - - - - - - - ->I 

I 
I 
I 
I 

- - - - - - - - - ->I 

I 
I 
I 
I 

- - - - - - - - - . >I 

I 
Time Of Day--->j exceeds(enter time) j- Th•~n Go To Block_ --------->j 

Timer 0 exceeds···>l··>(enter 
exceeds··->! (time 

2 exceeds-·->! 
exceeds--->! 

F exceeds--->! 
!<Rename Timers>! 

Frame Counter -0 exceeds----->! 
1 exceeds----->! 

Collision 2 exceeds----->! 
Counter exceeds----·>I 

F exceeds----·>! 
!<Rename Counters>! 

I 
--->I Ms ------->l··Then Go ---->I 

I Seconds--->! To Block I 

I 
I 
I 
I 
I 

(enter )--->!·Then Go To Block ··>I 
(count ) I 

Else When 3 

<Next Block> 1 

END EDIT 
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Overview of Programming 

SOFTKEY PROGRAMMING 

When you press a softkey in the <Edit Programs> Menu, other softkeys are displayed to 
lead you through a program step. For example, when you press the <Start> softkey, 
only the program functions that can be "started" are displayed as your new softkey 
choices. 
Block 1: 

Start 

Display Marking 
Frames 

BLOCK STRUCTURE 

Timer Frame Collision Logging 
Counter Counter To Disc 

EXIT 
EDIT 

Programs are organized in blocks. Blocks in the program are numbered consecutively 
and you can have up to 999 blocks in a program. Block numbers provide labels for 
program looping or jumping operations. When you add or delete blocks in a program, 
the protocol analyzer automatically renumbers the program blocks. 

Comment fields are available for each program block. 

EDITING PROGRAMS 

When you need to edit a program, editing softkeys such as <Insert Block>, <Delete 
Block>, and <Copy Block> are provided. In addition, you can use the TAB key, cursor 
keys and other keyboard keys described in the chapter, "Using This Manual", to edit 
programs. 

RUNNING PROGRAMS 

After your program is developed, return to the Top Level Menu and press <Execute 
Program>. Select the data source you want to test with the program. Select either 
<Run From Network> or <Run From Buff er>. 



Conditional Program Statements 

The HP 497 lS Protocol Analyzer uses the conditional programming statements: 

If 
When 

The differences between these two commands allow more flexible programs to be 
written. 

If 

The "If" command causes the contents of a counter to be compared to a Boolean 
condition to see if the condition is true or false. Regardless of whether the comparison 
is true or false, the program moves to another program step. 

A true <If Counter> comparison lets you branch to another program block. When the 
<Jf Counter> comparison is false, the program increments to the next program step 
even if the next step is in another program block. 

When 

The "When" command also compares events in the protocol analyzer to see if particular 
Boolean conditions are true or false. Unlike the "If" command, the "When" command 
waits at a program step until it is true. 

If the protocol analyzer finds a <When (event)> condition to be false, the protocol 
analyzer waits at that program step until the condition becomes true. 

Fortunately, it is possible to escape rrom a 'When' command by using an <Else When> 
command immediately after the <When (Event)> step. The program uses the following 
logic: 

1. If an <Else When> command immediately follows a false <When (event)> 
condition, the program continues to the <Else When> command. 

2. If the <.Else When> condition is true, the program observes the <Else When> 
command. 

3. If the <Else When> condition is false, the program loops back to the preceding 
<When (events)> step. 
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Program Commands Softkey Descriptions 

The <Edit Programs> softkey selections are organized in three groups. The groups are 
indicated by the bold numbers; 1, 2, or 3 at the top of each softkey selection chart on 
the previous foldout pages. 

The softkey descriptions are also described under the same group numbers. 

PROGRAM BLOCK COMMENT FIELD 

When you move the cursor to a block label, a field opens for you to make descriptive 
comments about the block's function or purpose. Up to 66 keyboard characters may be 
entered in the block comment field. 

Block 1: Example of a program block comment field 

<End Comment> Press the <End Comment> softkey, cursor keys, or the 
RETURN key to exit the block label field. 
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Group 1 Program Commands Descriptions 

<Start> softkey can cause six functions to begin. The functions that 
can be started are: 

<Display> 

Display 
Marking Frames 
Timer 
Frame Counter 
Collision Counter 
Logging To Disc 

The default program mode for the HP 497 lS is to start a 
progrnm run with the display blank. 

The command <Start> <Display> causes the HP 497 lS to 
display timers and counters while the program is executing. 

While timers and counters are shown, the softkey <Display 
Frames> is displayed. Press the softkey during program 
execution to cause the protocol analyzer to display frames. 
While frames are being displayed, the same softkey changes to 
<Timers & Counters>. Press <Timers & Counters> to return to 
displaying the contents of the timers and counters. 

For more details about the command <Start><Display>, se~ the 
section, Display Functions In <Edit Programs> Menu, in this 
chapter. 

(Continued) 
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Group 1 (cont.) 
NOTE 

Be aware that displaying frames or counters/timers slows 
the operation of the protocol analyzer. In circular mode 
(Nonstop, Centered About, or Ending With), if frames are 
stored in the Receive Buffer faster than they are displayed, 
the Receive Buffer may be completely filled before the 
contents are displayed. The protocol analyzer cannot begin 
to write over previously stored data that has not been 
displayed. If this happens, the protocol analyzer stops the 
program and displays the message: 

Program_X aborted by buffer overflow 
PROGRAM TOO COMPLEX FOR CURRENT TRAFFIC LEVEL 

A suggestion is to not display frames, counters/timers, or 
use the beeper when storing frames in circular modes. 

<Marking 
Frames> 

softkey causes the protocol analyzer to add a frame 
marker to frames that match your specified conditions. 

In <Run From Buffer> mode. the frame marker is 
added to the frames currentiy in the Receive Buffer 
that match your filter and these frames are then 
displayed on the screen as marked frames. 

In <Run From Network> mode. the frame mark is 
added to frames as they are stored in the Receive 
Buff er. The frame mark is also displayed on the screen. 

Marked frames are displayed with the Frame Number 
Field in inverse video. 
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Group 1 (cont.) 

<Timer> 

<Frame 
Counter> 

softkey lets one of up to sixteen available timers be 
selected to be clocked when the program is executed. 

At the beginning of the program execution, all timers 
are reset to zero. If you halt the timer during the 
program and then <Start> the timer again, the timer 
continues from its previous count. 

Use the <Reset> softkey command if you want to reset 
the timer to zero during the program. 

softkey is incremented differently in <Run From 
Buffer> mode than in <Run From Network> mode. In 
<Run From Buffer> mode, the frame counter is 
incremented sequentially by frames existing in the 
buffer. 

In <Run From Network> mode, the frame counter is 
incremented only by the frames that pass the filter and 
are stored in the Receive Buffer, not by all frames 
occurring on the network. 

<Collision Counter> soft.key lets you assign a specific counter to 
count when collisions occur on the network. 

The counter you assign to count collisions cannot be 
incremented by the program command <Increment 
Counter>. The counter designated as the collision 
counter is not displayed as a softkey choice when 
<Increment Counter> softkey is pressed. 

When you view counters and timers, the counter you 
designate for collision counting has the display: 

counter x = nnn collisions 

Remember that you can rename the collision counter to 
a functional name. 
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Group 1 (cont.) 

<Logging To Disc> 
This program command causes the protocol analyzer to 
begin logging frames from the network to the disc drive 
and file name you assigned in the "Log File:" field above 
Block l. 

The logging to disc function follows the operation of 
the "Store:" command. Store commands used to control 
logging to disc include: Until Full, Starting With, 
Centered About, Ending With, and Nonstop. 

Filters used to control or limit the frnmes stored in the 
protocol analyzer also control which frames are logged 
to disc. 

NOTE 

Since frames are first stored In the Receive Buffer and then 
transferred to the disc file, If new frames are stored in the 
Receive Buffer faster than the analyzer can transfer them to 
the disc file, the analyzer skips storing frames to the disc 
file and displays the error message: 

Receive buffer overflow detected. Frames skipped! 

Skipped frames are indicated by a dashed line in the 
<Examine Data> Menu. 

<Stop> softkey can be used to end any of the functions began by the 
<Start> softkey. In addition, the <Stop> softkey can end tht 
program by using the <Test> softkey. 

<Test> softkey stops the program execution. All counter, timer 
and data acquisition is halted. 
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Group 1 (cont.) 

<And Then> 

<Next Block> 

<END EDIT> 

<Increment 
Counter> 

softkey lets multiple program actions occur within a single 
block of program. After the first program step is completed, 
the second program step is executed. 

softkey ends the current program block and moves the cursor 
to the first position in the next block. 

Up to 999 blocks may be generated in a program. 

ends programming for the current program. The softkey 
selection returns to the previous level to select either a new 
program to edit or to exit this menu to the next higher level. 

causes a particular counter to be incremented. This is an 
unconditional command and does not depend on other events. 

When this key is pressed, the softkeys change to display 
counter la be ls. You select a counter by using a sof tkey or by 
entering a counter label from the keyboard. If the name is 
entered from the keyboard, press RETURN key to complete 
the program step. 

You can assign names to the counters to more easily identify 
the counter function. Press the <Rename Counters> soft.key to 
assign a counter name that identifies its function. 

NOTE 

Be careful not to confuse event counters with frame 
counters. Frame counters are incremented automatically by 
frames as they are stored in the Receive Buffer. Frame 
counters can not be incremented manually by your program 
since this would cause it's count to differ from the actual 
number of frames it has seen. 
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Group 1 (cont.) 

<If Counter> 

<Go To Block> 

<When (event)> 

<Display Frame> 

See description under Group 2. 

softkey lets you jump to another program block. This is an 
unconditional command. It does not use a preceding If or 
When command. When the program steps to that line, the 
command is executed. 

Press the softkey to display a prompt for entering the block 
number you wish the program to go to. Press RETURN key 
to complete the program command. 

see description under Group 3. 

If <Display Frame> is used to begin the display, only one 
frame .is displayed. 

When the program executes a <Start> <Display> command, 
timers and counters are displayed. When <Display Frame> 
command follows a <Start>< Display> command, the analyzer 
display changes to show incrementing frames. 

NOTE 

Similar to the <Start> <Display> commands, <Display 
Frame> can cause the protocol analyzer to halt if the 
display process is too much slower than the rate at which 
frames are being acquired. This condition only happens in 
circular modes of frame acquisition (Nonstop, Centered 
About, and Ending With). A recommendation to prevent 
halting the run is to not display frames, counters/timers, or 
use the beeper while frames are being stored. 
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Group 1 (cont.) 

<Mark Frame> softkey will cause the frame currently being processed in the 
Receive Buffer to have a mark condition. This soft.key is 
normally used with filters to indicate when a frame matched a 
filter condition. 

The <Examine data> Menu displays marked frames with the 
frame number in inverse video. 

Jn the following example, the protocol analyzer marks all 
frames matching Filter_O. 

Example: 

Block 1: 
When frame matches FlLTER_O then go to Block 2 

Block 2: 
Mark Frame 

Block 3: 
Go to Block 
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Grouo 1 (cont.) 

<Log Frame To Disc> 
This command logs one frame to the log-data file. 

When a filter condition you specify occurs, the <Log Frame 
To Disc> comman<l stores that particular frame to the log-data 
file. 

Do not confuse <Log Frame To Disc> command with the 
<Start> <Logging To Disc> commands. The <Start> <Logging 
To Disc> commands let you store frames continuously. 
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Group 1 (cont.) 

<Send Message> 

<Repeated 
Times> 

softkey lets the protocol analyzer transmit messages to the 
local area network. Messages created in the <:Edit Messages> 
Menu may be transmitted on program command. 

Up to 16 messages can be created in the <Edit Messages> 
Menu and then transmitted under your program control. 

You can use lf, When, and Else commands to determine what 
message to transmit and when it should be sent. 

Also, messages may be transmitted repeatedly or they may be 
sent in combination with other messages by using the 
commands: 

<Repeated _ Times> 

<Followed by > 

softkey lets you repeat a message up to 9999 times 
without interruption. 

No repeat - causes the message to be sent only once. 

Repeat J. time - causes the message to be sent once and 
then repeated once. 

Repeat 1. times - causes the message to be sent once 
and then repeated twice. 
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Group 1 (cont.) 

<Followed by> command lets a series of different messages be 
transmitted in a particular sequence. By assigning 
different Destination and Source Addresses to each 
message, you can simulate transmitting to and from 
different stations. 

<Reset> 

The following example sends message_O ten times and 
then send message_ l one time followed by message_ 2 
one time. 

Block 1: 
Send message MESSAGE_O repeated 9 times 

followed by MESSAGE_1 
followed by MESSAGE_2 

command causes either a specific timer or counter to be reset 
to it's zero state. 

Press the <Reset> softkey to display a choice of <Timers> and 
<Counters> softkeys. Press the softkey for the function you 
need to reset and the counters or timers you have defined are 
displayed. Press the softkey for the counter or timer you want 
to reset. 

Counters or timers may be started and stopped in the program. 
If you <Start> them again, they continue from their previous 
count. Use the <Reset> softkey command when you wish the 
function to be reset to zero before beginning to count again. 
In the example below, whenever Filter_O occurs, Timer_l i., 
reset to zero and immediately started again. 

Block 8: 
When frame matches FILTER_O then go to block 9 

Block 9: 
Reset timer Timer 

and then 
Start timer Timer_1 
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Group 1 (cont.) 

<Walt> 

<Beep> 

softkey lets you create waits or pauses in your program using 
the following units of time: 

Ms 
Seconds 

Minutes 
Hours 

The minimum time for a wait period is 1.0 Ms. The maximum 
time for a wait period is 9999 hours. 

softkey causes the protocol analyzer to produce an audible 
beep. The <Beep> softkey would be used to note a condition 
or status point has occurred. An example would be when a 
filter has been matched, or, a timer or counter has reached a 
particular event. 

Block 2: 
When timer Timer_1 exceeds 10 Ms then go to Block 3 

Block 3: 
Beep 

and then 
Go to block 4 

NOTE 

Using the Beeper slows the operation of the protocol analyzer. 
In circular mode, Nonstop, Centered About, or Ending With, if 
frames are stored in the Receive Buffer faster than the Beep 
command can be executed, the buffer may be filled before the 
Beep is executed. The protocol analyzer cannot begin to write 
over previously stored data if it is still waiting for the Beep 
command. If this happens, the protocol analyzer stops the 
program and displays the message: 

Program_X aborted by buffer overflow. 
PROGRAM TOO COMPLEX FOR CURRENT TRAFFIC LEVEL. 

If this message occurs, delete the beep command from the 
program. 
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Group 1 (cont.) 

<Find Block> 

<Copy Block> 

softkey is a program edit key; it is not a program command. 
This softkey is used to move quickly to another program block 
in the program. 

When you press the <Find Block> softkey, enter a program 
block number, and then press the RETURN key; the cursor 
moves to the program block entered. 

softkey is also a program edit softkey, not a program 
command. This softkey lets you quickly duplicate an existing 
program block and insert it anywhere in the program. 

The <Copy Block> softkey copies a specified block 
immediately below the block currently containing the cursor. 
The protocol analyzer automatically renumbers the program 
blocks and all block references in the program. 

To copy an existing block, use the following procedure. 

1. Position the cursor to the program block you want the 
new block to follow. 

2. Press the <Copy Block> softkey. 

3. Enter the program block number to be copied. 

4. Press the RETURN key to execute the copy. 
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Group 1 (cont.) 

<Insert Block> 

<Delete Block> 

<Copy Program> 

<Rename CtrjTmrs> 

softkey lets you add a new program block between existing 
program blocks and automatically renumber the blocks 
including all block location references. 

The new block is inserted immediately above the block 
currently containing the cursor. 

When the <Insert Block> sof tkey is pressed, the protocol 
analyzer immediately creates the new block. 

softkey deletes the block currently marked by the cursor. The 
remaining program blocks and block location references are 
automatically renumbered. 

When the <Delete Block> softkey is pressed, the protocol 
analyzer immediately deletes the block containing the cursor. 

softkey lets you copy another program already existing in the 
protocol analyzer. 

This softkey sounds the beeper and displays a warning message 
to alert you that the program you copy will overwrite your 
existing program. 

softkey Jets you change the name of a counter or timer. The 
name can be changed to describe the event or function you 
are monitoring. 

Counter and timer names can be up to nine keyboard 
characters. Leading spaces are deleted. Spaces between 
characters are replaced with an underscore (_). Press TAB or 
RETURN keys to complete the entry. 
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GROUP 2 PROGRAM COMMAND DESCRIPTIONS 

<If Counter> is a conditional statement using the 'If' construct. 

This softkey causes the content of a counter to be compared 
to Boolean conditions using relational comparator 
combinations of equal to, greater than, or less than. 

If the comparison is true, the program can be jumped to 
another program block. 

If the comparison is false, the program increments to the 
following program step. 

Comparison states that may be used include: 

= 
<> 

> 
< 

<= 
>= 

<> comparison is true when the counter is not equal to 
the entered count. 

Example: If counter Counter <> 10 Then Go To Block 4 

If Counter_ l is any number except I 0, the program goes to 
program block 4. If the counter is at I 0, the program goes to 
the following program step. 

Sixteen counters are available in the protocol analyzer. You 
can assign labels to the counters to more easily identify their 
function. Use <Rename Counters> softkey to label the 
counters. 

<Then Go To Block> lets you specify the block to branch to when the 'If' 
comparison is true. 

Enter a block number and press RETURN key to finish that 
program step. 
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Group 2 (cont.) 

<Else If> 

<Else When> 

<Next Block> 

<END EDIT> 

lets you select an alternative 'IF' statement. 

lets you select an alternative "When (events)" statement. 

See group 3 command descriptions. 

ends the current program block and moves the cursor to the 
first Position in the next block. 

ends programming for the current program. The softkey 
selection returns to the previous soft.key level to select either a 
new program to edit or to exit this menu to the next higher 
level. 
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GROUP 3 PROGRAM COMMANDS DESCRIPTIONS 

<When (event)> is a conditional statement using the 'when' construct. 

<When (event)> softkey causes the program to wait at that 
point until the test condition is true. Conditions that may be 
tested by this command include: 

Frame Matches 
Time Of Day 
Timer 
Frame Counter 
Collision Counter 

When a comparison is true for the function you specify, the 
program branches to the program block you select. 

Example: 

Block 6: 
When frame matches FILTER_O then go to Block 7 

Block 7: 
Start timer TIMER_1 

Block 8: 
When frame matches FILTER 1 then go to Block 9 

Block 9: 
Stop timer TIMER 1 

In this example, TIMER_! is measuring the time between filter 
events, FILTER_ O and FILTER_ l. The program waits at 
Block 6 until FILTER_ 0 occurs. After the timer is started, the 
program waits at Block 8 until FIL TER_l occurs. 
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Group 3 (cont.) 

<Frame Matches> 

<Not> 

compares a fitter you created in <Edit Filters> Menu to 
incoming frames. When an incoming frame matches the filter 
you specify, the following "Then Go To Block _ " inst.ruction 
is executed. The program waits at a <When (Frame Matches)> 
command until a true condition occurs. 

Events to describe <Frame Matches> can be grouped in logical 
combinations to make even more powerful filtering choices. 
The combinations can be grouped with the following 
commands: 

Not filter 
And Frame Traits 

And 
Or 

The "when" program step is satisfied when any frame 
occurs that does not match the specified filter or 
specified frame traits. 

<Edit Filters> 
softkey branches to the summary of filters display. This 
lets you review the filters available for selection. Press 
<EXIT> to return to <Edit Programs>. 

<Frame Traits> 

<And> 

checks if incoming frames match frame traits selected 
in the <Edit Filters> Menu. 

command can be used to require more than one filter 
match to occur before the program can continue. 

The following example requires a single frame to match 
both FILTER_O AND FILTER_l before the program 
will move to Block 2. 

Block 1: 
When frame matches FILTER 0 

and FILTER_1 then go to block 2 
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Group 3 (cont.) 

<And Frame 
Traits> 

<Or> 

softkey requires the protocol analyzer to find a frame 
matching the <Frame Matches> conditions AND the 
frame traits identified in the <Edit Filters> Menu. 
Frame Traits selections include: 

Accept I Reject Frame with GOOD FCS 
Accept I Reject Frame with BAD FCS 
Accept I Reject MI SALi GNED Frame 
Accept I Reject Runt Frame 

command lets one or more of several filters to cause a 
program step to be executed. 

The following example requires a frame to match one 
or more of FILTERS_O, or I, or 2 before the program 
moves to Block 2. For example: 

Block 1: 
When frame matches FILTER_O 

or F lL TER_ 1 
or FILTER_2 then go to Block 2 

<Frame Match> Operation Precedence 

The <Frame Match> operation precedence for the Not, And, Or, and And Frame Traits 
commands is: 

l. <Not> 

2. <And> 

3. <Or> 

4. <And Frame Traits> 
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Group 3 (cont.) 

<Time Of Day> 

<Timer> 

The protocol analyzer detects when the system clock exceeds a 
time-of-day value that you entered. The time clock you set in 
the <Set Time> Menu at power on is used for this comparison. 

compares the state of a specific timer to a number you have 
entered. When the timer exceeds the time you have entered, 
the program goes to the program block you specify. The 
program waits at this command until a true condition is found. 

Sixteen timers are available to be used for this command. 
Labels that relate to the function being checked may be 
assigned to each timer. Use the <Rename Timer> softkey to 
enter the menu for naming timers. 

In <Run From Network> mode, the timer completes the time 
interval you enter even if no frames are detected on the 
network. In <Run From Buffer> mode, the protocol analyzer 
automatically halts the timer when an empty buffer is 
detected. 

The following example program counts how many frames are 
stored in one second: 

Store: all frames 
until buffer full 

Block 1: 
Start timer Timer 1 

Block 2: 
Start frame counter Counter_1 

and then 
When timer Timer_1 exceeds 1 Seconds then go to block ..J. 

Block 3: 
Stop frame counter Counter_1 
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Group 3 (cont.) 

<Frame Counter> softkey is used to assign the task of counting frames to one of 
sixteen available counters. 

The <When> <Frame Counter> softkeys are used to detect 
when the number of frames meeting your criteria has 
exceeded some quantity. 

An example follows for <When> <Frame Counter> being used 
to measure the time while the protocol analyzer waits for l 00 
frames to be stored in memory. 

The example performs-the following functions: 

Frames are loaded into the protocol analyzer until the 
Receive Buffer is full or the program stops operation. 
A timer is started. 
A frame counter is enabled to start counting frames. 
Frames are stored in the Receive Buffer until the counter 
reaches 100 and the timer is stopped. 

Store: all frames 
until buffer full 

Block 1: 
Start timer Timer 1 

Block 2: 
Start frame counter Counter_1 

and then 
When frame counter Counter 1 exceeds 99 then go to block 3 

Block 3: 
Stop timer Timer~1 

and then 
Stop Test 
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Group 3 (cont.) 

<Collision 
Counter> 

softkey is used to assign the task of counting collisions 
to one of the 16 available counters. 

The collision counter is exclusively assigned to count collisions. 
You cannot increment that counter by another program 
command. The collision counter is not displayed as a softkey 
choice for <increment Counter> sof tkey. 

The <When> <Collision Counter> softkeys can be used in 
combination to detect when the number of collisions has 
exceeded some quantity. 

The example below detects how many collisions occurred in 
10 seconds. 

Store: all frames 
nonstop 

Block 1: 
Start timer Timer 0 

Block 2: 
Start collision counter counter_3 

Block 3: 
When timer Timer_O exceeds 10 seconds then go to Block 4 

Block 4: 
Stop timer Timer 0 

and then 
Stop Test 

<Edit Programs> Menu 14·47 



Group 3 (cont.) 

<Then Go To 
Block> 

<Else When> 

Block 6: 

lets you specify the block to branch to when the 'When' 
comparison is true. 

Enter a block number from the keyboard and press RETURN 
key to complete the program step. 

lets you select an alternative 'when' statement. 

The <Else When> command follows a <When (event)> 
command. 

The program first checks the status of the <When (event)> 
line. If the <When (event)> statement is false and if an <Else 
When> command follows, the program then checks the status 
of the <Else When> command. 

If the <Else When> condition is true, the program branches to 
wherever the <Else When> command directs. 

If the <Else When> condition is false, the program goes back 
to the <When (event) 

Example: 

When frame counter Count_Frames exceeds 100 then go to Block 7 
else When timer TIMER_O > 5 Seconds then go to Block 10 

In this example, the program first checks to see if the frame 
counter has exceeded 100. If the counter has exceeded 100, 
the program jumps to Block 7. 

If the counter has not exceeded 100, the program looks at the 
<Else When> command on the following line. If the timer is 
greater than 5 seconds, the program goes to Block 10. If the 
counter has not exceeded 5 seconds, the program returns to 
the previous program line. 
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Display Functions In < Edit Programs > Menu 

This section provides a summary for viewing data during a program run. Each of the 
program commands discussed in the following text have been described in the previous 
section, Program Command Descriptions. See the appendix section for the execution 
time for program instructions. 

During a program run, the default mode for the HP 497 lS is to not display data. This 
lets the protocol analyzer more easily keep up with traffic on the network during heavy 
network loads. 

As described earlier in this chapter, displaying frames or timers and counters slows the 
processor operation and may cause it to get behind in its task of capturing frames 
occurring on the network. When the processor gets behind, it halts the program run. 

See the appendix section, "Execution Time." This section lists the time to execute 
different program instructions. 

There are two modes of display available in programs: 

Selective Display 

Continuous. 

The selective display mode can be used to selectively display frames under program 
control. whereas the continuous display mode updates the display continuously under 
program control. 
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SELECTIVE DISPLAY MODE 

The selective display mode is activated by the <Display Frames> program command. 
This command causes a single frame (the last frame processed by the program) to be 
displayed in the format chosen in the <Examine Data> Menu. 

This selective display mode should be used when it is desirable to display rarely 
occurring frames while storing more frequently occurring ones. 

When the selective display mode is used, a dashed line will appear between frames to 
indicate they are not necessarily contiguous in the buffer. 

Example to: 

Problem: 

Program: 

Summary: 

Display Selected Frames 

You are running a protocol in which a certain frame type is an 
acknowledgment frame. You suspect that occasionally an 
acknowledgment is getting lost because it has a bad FCS or alignment 
error. To test this, use <Edit Filters> Menu to define an 
acknowledgment frame filter. Name the filter "ack_frame" and 
select <Frame Traits> softkey. Frame Traits should be selected to 
Accept bad FCS and Alignment errors. You will Re iect Good FCS 
and RUNT frames. With these frame traits selected, write the 
following program. 

Store: frames matching ack frame 
nonstop 

Block 1: 
When frame matches ack_f rame 

as well as Frame Traits then go to Block 2 

Block 2: 
Display frame 

and then 
Go to Block 1 

This program stores all "ack_frames" but only displays the frames 
also containing a frame error. 
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CONTINUOUS DISPLAY MODE 

The continuous display mode has two formats: 

Counters & Timers 

Frames 

Counters & Timers 

Counters & Timers is the recommended display mode since their values can be updated 
much faster than frames can be displayed. The continuous mode is accessed by using 
the <Start>< Display> program command. The command remains in effect until a 
<Stop> <Display> command is encountered. This mode should only be used for viewing 
data on a lightly loaded or heavily filtered network. 

The continuous display form defaults (at the start of a run) to the Counters & Timers 
display. Thus the first <Start> <Display> executed (with the exception described below) 
will begin displaying Counter & Timer data and keep updating this display until it is 
either stopped or changed. When this display format is active, the softkey <Display 
Frames> will appear and can be used to switch the display to Frames. 

Frames 

The continuous frame display will display all frames stored in the "Store" line as they 
are received. Since these will be contiguous in the buffer, no dashed lines appear 
between them. This form can be accessed in one of two ways: either by pressing the 
<Display Frames> softkey in the Counters & Timers display or by using the <Display 
Frame> command described in the selective display mode description. When a <Display 
Frame> command is executed in between a <Start> <Display> and a <Stop> <Display>, 
the display will start off in the Counters & Timers format and then switch to the 
frames display format. When operating in the continuous frames display, a softkey 
<Counters & Timers> is displayed and can be used to return to the continuous Counter 
& Timers display. 

The <Stop> <Display> command automatically switches the continuous display form 
back to Counters & Timers. Therefore, to switch back from the frame display mode to 
the Counters & Timers mode, you need only stop the display and then start it again. 
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Example to: 

Count Frames And Display Counters And Timers Continuously. 

Program: 

Example to: 

Program: 

Store: all frames 
nonstop 

Block 1: 
Start display 

and then 
Start frame counter all frame 

Display All Frames Continuously 

Store: all frames 
nonstop 

Block 1: 
Display frame 

and then 
Start Display 

<Edit Programs> Menu 14·52 



Example to: 

Problem: 

Program: 

display) 

Alternate Displaying Counters & Timers With Frames 

To count frames, display counters & timers for five seconds, 
switch to displaying frames for five seconds, and then switch 
back to counters & timers. 

Store: all frames 
nonstop 

Block 1: 
Start timer 5 secs 

and then 
Start frame counter alt frames 

Block 2: 
Start display (begins Counter & Timer 

and then 
When timer 5 secs exceeds 5 seconds then go to Block 3 

Block 3: 
Reset timer 5 secs 

and then 
Displ'ay frame 

and then 
(switches display to frames) 

When timer 5 secs exceeds 5 seconds then go to Block 4 

Block 4: 
Stop display 

and then 
Reset timer S_secs 

and then 
Go to Block 2 
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Programming Examples 

This section lists several example programs. These are simple programs that illustrate 
using timers, counters, messages and filters in programs. 

PROGRAM EXAMPLE 1. 

REQUlREMENT: 

CONDITIONS: 

You want to know how many network collisions and frames 
with bad FCS occur in a five minute period. 

You also want to mark all frames occurring with a bad FCS. 

You need to define the following items: 

A timer named DURATION 

A counter named CNT_FCS 

A filter named BAD _FCS 

When the program is completed, the protocol analyzer will display the Timers & 
Counters Menu. 
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PROGRAM 1: 

Store: all frames 
nonstop 

Block 1: 
Start timer DURATION 

and then 
Start collision cntr COLLISION 

Block 2: 
When timer DURATION exceeds 300 seconds then go to block 4 
else when frame matches BAD FCS then go to block 3 

Block 3: 
Increment counter CNT_FCS 

and then 
Mark frame 

and then 
Go to block 2 

Block 4: 
Start display 

and then 
Stop test 
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PROGRAM EXAMPLE 2. 

REQUIREMENT: 

CONDITIONS: 

You want to view your network for 60 seconds. During that 
time, you want to count how many times three different types 
of addresses occur in the frames seen. 

In addition, you will count the total number of frames 
received during the 60 second period. 

You need to define the following items: 

A timer named DURATION 

A counter named TOT FRAME 
A counter named CT_ GLOBAL 
A counter named CT_LOCAL 
A counter named CT_BROAD 

A filter named GLOBAL 
A filter named LOCAL 
A filter named BROADCAST 

The three filters test the address fields in each frame to see how they are administered. 
The address tests are: Local, Global, and Broadcast. 

The filters you define will use the Destination and Source Address Fields to determine 
what type of frame is being received. 
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PROGRAM 2: 

Store: all frames 
nonstop 

Block 1: 
Start timer DURATION 

and then 
Start frame counter TOT_FRAME 

Block 2: 
When timer DURATION exceeds 60 seconds then go to block 6 
else when frame matches GLOBAL then go to block 3 
else when frame matches LOCAL then go to block 4 
else when frame matches BROADCAST then go to block 5 

Block 3: 
Increment counter CT GLOBAL 

and then 
Go to block 2 

Block 4: 
Increment counter CT_LOCAL 

and then 
Go to block 2 

Block 5: 
Increment counter CT BROADCAST 

and then 
Go to block 2 

Block 6: 
Start Display 

and then 
Stop test 
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PROGRAM EXAMPLE 3. 

REQUIREMENT: 

CONDITIONS: 

You want to know how often a particular frame with 
Ethernet Type 06-00 occurs. You also want to know when a 
frame with a length or 500 bytes occurs. When either of these 
frames occur, you want to mark the frame. You need to 
know how many times these two events occur in a 60 second 
period. 

You need to define the following items: 

A timer named DURATION 

A counter named CT TYPE 
A counter named CT_ LENGTH 

A filter named TYPE_06_00 
A filter named LENGTH 500 

This program is testing for two different conditions. Both events are detected by 
filters. 
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PROGRAM 3: 

Store: all frames Block 6: 
nonstop 

Block 1 : 

Start timer DURATION 
and then 

Start frame counter TOT FRAME 

Block 2: 
When timer DURATION exceeds 60 seconds then go to block 6 
else when frame matches TYPE_06_00 

and LENGTH_500 then go to block 3 
else when frame matches TYPE_06_00 then go to block 4 
else when frame matches LENGTH_SOO then go to block 5 

Block 3: 
Increment counter CT_TYPE 
and then 

Increment counter CT LENGTH 
and then 

Mark Frame 
and then 

Go to Block 2 

Block 4: 
Increment counter CT_TYPE 
and then 

Mark frame 
and then 

Go to block 2 

Block 5: 

Increment counter CT_LENGTH 
and then 

Mark frame 
and then 

Go to block 2 
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and then 

Start display 
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Stop test 



PROGRAM EXAMPLE 4. 

REQUIREMENT: 

CONDITIONS: 

You want to know the length of frames that are occurring on 
the network. You need to know how frames are distributed 
within several ranges of frame length. 

The ranges you wish to use are: 

51- 100 bytes 
101- 500 bytes 
501- 2022 bytes 

You need to define the following items: 

A timer named DURATION 

A frame counter named TOT FRAME 

A counter named 51_100 
A counter named 101-500 
A counter named 501 2022 

A filter named FILTER 51 100 
A filter named FILTER 101 500 
A filter named FILTER_501_2022 

The filters will look for frame lengths within certain ranges. As each filter is matched, 
a corresponding counter will be incremented. 
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PROGRAM 4: 

Store: all frames 
nonstop 

Block 1: 
Start frame counter TOT_FRAME 

and then 
Start timer DURATION 

Block 2: 
When timer DURATION exceeds 30 seconds then go to block 6 
else when frame matches FILTER_51_100 then go to block 3 
else when frame matches FILTER_101_500 then go to block 4 
else when frame matches FILTER_501_2022 then go to block 5 

Block 3: 
Increment counter 51_100 

and then 
Go to block 2 

Block 4: 
Increment counter 101_500 

and then 
Go to block 2 

Block 5: 
Increment counter 501·2022 

and then 
Go to block 2 

Block 6: 
Stop timer DURATION 

and then 
Start display 

and then 
Stop test 
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15 
< 1/0 FUNCTIONS > MENU 

This section describes the <1/0 Functions> softkey control of the HP 497 lS LAN 
Protocol Analyzer in master/slave (remote/local) applications. 

This section includes: 

• <1/0 Functions> Softkey Selections 

• Introduction 

• Editing The 1/0 Configuration 

• Saving the 1/0 Configuration 

• Capturing A Slave LAN Protocol Analyzer 

• Editing And Sending A Modem String 

• Enabling 1/0 Operation 

• 1/0 Status Messages 

• <Terminal Emulator> Description 
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< 1/0 Functions > Softkey Selections 

<I/0 Functions> 

Edit Config. 

Save Conf ig. 

Capture Slave 

Edit Modem Str 

Send Modem Str 

Enable I/0 

OTHER CHOICES 

Send At Power On 

ASCII 7 

ASCII 8 Roman 8 

EBCDIC 

EXIT 

Terminal Emulator 

Local Echo 

Auto Linefeed 

Show Non-printing 

ASCII 7 ASCII 8 Roman 8 

EXIT 
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Introduction 

The master/slave feature lets you view the operation of a Local Area Network (LAN) 
or LAN segment from a site not directly adjacent to the LAN. For example, you could 
view all the LANs in your company from one remote location. 

Performing HP 497 lS logic analyzer operations on a LAN from a remote location 
requires two HP 497 lS instruments. 

Primary capabilities or features offered by using two HP 4971S's in master/slave 
operation are: 

Testing a LAN from a remote location. 
Selecting a printer located at the master or slave location. 
Selecting a mass storage located at the master or slave location. 

Your two HP 497 lS systems must be connected by an RS-232C link. Option 002 
provides a RS-232C Remote Communications Interface package which includes an 
interface board and cables. Each station requires an Opt. 002 to be installed in the 
497 lA instrument. 

In remote operation, the master protocol analyzer shows the same screen display that 
the slave protocol analyzer would display if it were under local control. 

The keyboard of the master unit is the controlling keyboard. Local keyboard control 
may be regained at either the master or .slave location by pressing the BREAK key on 
the keyboard. The BREAK key disconnects the RS-232 link and returns both units to 
local operation. 

When an HP 497 lS is linked for remote operation it communicates with another station 
with the protocol, DDCMP. This protocol allows stations to send and receive data or 
command information with the protocol handling the problems of framing, error 
control, sequence control, and message transparency. 

The protocol makes sure that one station is ready to receive information and another 
station is ready to transmit information at the right time. The protocol automatically 
handles retransmission in case of errors. 
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The I/O Configuration table shown below is stored on the LANSYS volume. The menu 
shown below is displayed when you press the <1/0 Functions> <Edit Config.> softkeys. 

1 

2 
3 RS-323 Configuration 
4 

5 

6 

7 
8 
9 

10 
11 
12 
13 
14 

15 

16 
17 

18 
19 

20 
21 

22 
23 

Baud Rate: 1200 
Stop Bits: .! 
Parity Bit: None 
Bits/character: 8 
Hardware handshake: Disabled 
Software handshake: Disabled 

Remote protocol: DDCMP 

DDCMP timeout: ~ seconds 
DDCMP buffer size: 2..1.f bytes 

300 600 1200 2400 

(Defaulted by protocol selection) 
(Defaulted by protocol selection) 

(Defaulted by protocol selection) 

4800 9600 EXIT 

24'----------------------------------------------------------------......1 

Figure 15-1. <1/0 Functions> Configuration Display. 
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Editing The 1/0 Configuration 

Communication between the master and the slave protocol analyzers occurs over an 
RS-232 link. 

At power on, the protocol analyzer automatically loads your configuration. The 
power-on configuration can be changed by using <Edit Config.> to define a new 
configuration and then usmg <Save Config> to rewrite the configuration to the disc 
volume currently selected in <Disc Functions> Menu. 

<Edit Config.> 

Baud rate: 

softkey lets you edit the HP 497 lS l/O configuration table to 
meet your system configuration. 

The fields that can be changed are shown in inverse video. To 
change a field, use the TAB key or the cursor keys to move 
the cursor to the field you want changed. 

When the cursor is placed in a highlighted field, the softkey 
choices for that field are displayed. Press the softkey for the 
choice you want. The menu field is changed immediately. 

This line displays the selected transmission rate. 

This line is used to select how fast the transmission occurs on 
the RS-232 link between the protocol analyzers. 

The default transmission rate is 1200. To select a different 
baud rate, move the cursor to the "Baud Rate:" field. Press one 
of the displayed softkeys to choose a new transmission speed. 
The choices are: 

300, 600, 1200, 2400, 4800, 9600 



Stop bits: 

Parity bit: 

This line shows the selection for stop bits. 

Stop bits are supplied after each transmitted character as part 
of the system for maintaining synchronization between 
transmitting and receiving stations. 

The default stop bit length is l. 

To choose a different stop bit length. move the cursor to the 
"Stop Bits:" field. Press one of the displayed softkeys to choose 
a new stop bit length. The choices are: 

1, 1.5, 2 

This field may be edited only when Encoded DDCMP 
protocol has been selected. 

The "Parity Bit:" field lets you choose what parity format is 
used with each transmitted character. The HP 497 IS transmits 
the parity bit(s) with each character for error checking by 
other computer systems. The HP 497 IS does not use the parity 
bit(s) itself; it uses CRC error checking. 

In standard DDCMP, the parity bit is not selectable and the 
default state is None 

In Encoded DDCMP, the parity bit is used and the default 
selection i~ Odd. To choose a different parity bit condition, 
move the cursor to the "Parity bit:" field. Press a displayed 
softkey to choose a new parity bit format. The choices are: 

None Odd Even 
Parity Parity 
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Bits/character: 

Hardware handshake: 

DISABLED 

This field enables the RS-232 link to group the transmission in 
character lengths of 7 bits or 8 bits. 

Bits/character field can be edited only when Encoded 
DDCMP is selected. 

In DDCMP mode, the default Bits/character selection is 8. 

Encoded DDCMP mode lets you choose bits/character. To 
choose a different character length, move the cursor to the 
"Bits/character:" field. Press a displayed softkey to choose a 
new character bit length. The choices are: 

7 8 
Bits/char Bits/char 

This field lets you choose how your modem handles messages 
between the modem and the protocol analyzer. Hardware 
hand shaking involves the control lines between the protocol 
analyzer and the modem such as: Request To Send (CTS), Clear 
To Send (CTS), and Carrier Detect (CD). 

To choose a different hand shaking method, move the cursor 
to the "Hardware Handshake:" field. Press a displayed softkey 
selection to enable the new hand shake function. The softkey 
choices a re: 

Disabled Modem Modem 
____ Hf-Duplex Fl·Duplex 

Hand shaking can be disabled when two HP 497 lS protocol 
analyzers are hard wired together. In this application, modems 
are not used and hand shaking is not required. 

Select the hand shaking required for the modems used in your 
system. 
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MODEM HF-DUPLEX 
hand shaking is selected when either modem transmits or 
receives but not both directions simultaneously. 

MODEM FL-DUPLEX 

Software Handshake: 

hand shaking is selected when either modem transmits or 
receives simultaneously in both directions. 

This field lets you choose different methods of hand shaking 
between protocol analyzers and other computers to control 
message flow. 

Software hand shaking may be selected only in the Encoded 
DDCMP mode. With standard DDCMP, only hardware hand 
shaking may be used. 

Some systems using Encoded DDCMP may use a combination 
of hardware and software hand shaking. 

To choose a software hand shaking function, move the cursor 
to the Software Handshake Field. Press a displayed softkey to 
choose the mode you want. The choices are: 

Disabled ENQ/ACK ENQ/ACK DC1/DC3 DC1/DC3 DC1/DC3 
Host Terminal Host Terminal Both ---- ----
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Remote protocol: 

DDCMP 

field shows your selection for the RS-232 link protocol. 

To choose a different protocol, move the cursor to the 
Protocol Field. Press one of the displayed softkeys to choose a 
new protocol. The choices are: 

DDCMP Encoded 
DDCMP 

DDCMP is the default choice. 

DDCMP is a byte count oriented protocol that breaks its 
messages into two parts: a header containing control 
information and a text body that contains the data portion of 
the message. 

Encoded DDCMP 
Encoded DDCMP groups the DDCMP frames of the protocol 
analyzer communications into printable ASCII characters. This 
allows characters in the protocol analyzer's communications to 
pass through data communication equipment or a host 
computer with none of the characters recognized as control, 
transparent, or escape characters. 

Figures 15-2 and 15-3 show the differences in the configuration fields that may be 
selected between DDCMP and Encoded DDCMP. 
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DDCMP timeout: 

DDCMP Buffer Size: 

field lets you select how long the protocol analyzers wait for 
responses to queries or commands. If the response does not 
come in the required time, the protocol analyzer goes to its 
next decision point to decide what action to take. 

The default timeout is 3 seconds. 

The timeout period may be selected from softkeys by moving 
the cursor to the protocol time out field and pressing one of 
the displayed softkeys: 

2 3 10 30 60 
Seconds Seconds Seconds Seconds Seconds Seconds 

When using two HP 497 lAs in half duplex, it may be helpful 
to enter different times for the timeout. In half duplex, if a 
fault occurs and both units back off, they may wait the same 
time and then try to establish contact again at the same time. 
It may be better to have the master station slightly faster than 
the slave station. 

field lets you vary the size of the messages being sent between 
stations. 

If you are sending messages to some station other than an HP 
497 lS, the receiving station's buffer may not be able to receive 
512 bytes at a time. If longer message lengths are transmitted 
than the recetver can handle, a buffer overrun may occur. 

The default choice for buff er size is 512 bytes. Softkey 
choices for buffer size are: 

32 
Bytes 

64 

Bytes 
80 

Bytes 
128 

Bytes 
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RS-232 Configuration: 

Baud rate: 
Stop bits 
Parity bits: 
Bits/character: 
Hardware handshake: 

1200 
1 
None 
8 
Disabled 

* 
* 

SOFTK EY CHOfCES 

300, 600, 1200, 2400, 4800, 9600 

.!. 1.5, 2 

DISABLED, Modem Hf ·Duplex, 
Modem Fl-Duplex 

Software Handshake: Disabled * 

Remote protocol: DDCMP 

Protocol timeout: 
DDCMP buffer size: 

3 seconds 
lli bytes 

1, 2, ~. 10, 30, 60 
32, 64, 80, 128, 256, 2..1.f 

* (Defaulted by protocol selection.) 
IO: 

Figure 15-2. Configuration Choices With DDCMP Selected. 
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RS-232 Configuration: 

Baud rate: 
Stop bits 

1200 
1 

Parity bits: None 
Bits/character: 8 
Hardware handshake: Disabled 

Software Handshake: Disabled 

Remote protocol: DDCMP 

Protocol timeout: 3 seconds 
DDCMP buffer size: 512 bytes 

SOFTKEY CHOICES 

300, 600, 1200, 2400, 4800, 9600 
_l, 1.5, 2 
None, Odd Parity, Even Parity 
7 bits/char, 8 Bits/char 
DISABLED, Modem Hf-Duplex, 
Modem Fl-Duplex 
Disabled, ENQ/ACK Host, 
ENQ/ACK Terminal, DC1/DC3 Host, 
DC1/DC3 Terminal, DC1/DC3 Both 

1, 2, ~. 10, 30, 60 
32, 64, 80, 128, 256, 512 

IO: 

Figure 15-3. Configuration Choices With Encoded DDCMP Selected. 
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<Save Config.> 

Saving The 1/0 Configuration 

softkey saves a copy of the configuration table to the 
Configuration File, CNFG. 

The Configuration file is located on the LA NCOD system disc. 
When you save the configuration, the protocol analyzer looks 
for the LANCOD volume. The analyzer prompts you to 
install LANCOD if it is not found. 

In systems using only the HP 9122D Dual disc Drive, you must 
install the LANCOD disc in a disc drive slot. In systems with 
system software loaded on a Winchester disc drive, the 
analyzer will find LANCOD on one of the hard disc volumes. 

If two LANCOD volumes are found in the system, the 
protocol analyzer saves the Configuration File, CN FG, to the 
lowest volume unit number. 
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Capturing A Slave LAN Protocol Analyzer 

<Capture Slave> softkey starts the process of combining two HP 497 lS systems 
into a master/slave operation. The protocol analyzer where 
you press <Capture Stave> softkey becomes the master or 
controlling device. The other HP 497 lS then becomes the 
slave or measuring device. 

After the <Capture Slave> soft.key is pressed, the master 
analyzer displays: 

To terminate Master · Slave mode, hit the "BREAK" key. 

Waiting for permission to take control. IO: 

The master analyzer then establishes contact with the slave. 
After contact is established, the slave displays the message: 

A request to take over control has been received 
over the I/O. Do you wish to relinquish control? 
If you do not respond in 10 seconds, control will 
be given to the requesting device. 

Al low 
Takeover 

Block 
Takeover 

If you do not want to loose control at the slave unit, you must 
press the <Block Takeover> sof tkey within 10 seconds. If you 
do not, the slave defers control to the master device. 

After the master captures control of the slave protocol 
analyzer, the master displays the Top Level Menu and the 
message: 

You are now controlling the remote analyzer. IO: 

(continued) 
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<Capture Slave> 
(cont.) 

Also after capture, the slave displays the message: 

This instrument is being remotely controlled. 
Hit 11 BREAK 11 key and wait to rea::iin control. 

If no RS-232 link up occurs, the master cannot capture control 
of the slave protocol analyzer and the master displays: 

SLAVE IS NOT RESPONDING 

Troubleshooting <Capture Slave> softkey 

If the master HP 497 lS is not able to capture control of the slave HP 497 lS, several 
steps are listed below that may help you resolve the problem. 

I. Press <1/0 Functions> softkey at each device. 

Verify the configuration table is the same for each device. 

2. Verify <Enable l/0*> soft.key is active at each protocol analyzer. 

* is displayed in the <Enable I/0> soft.key when it is enabled. 

If an IO message is displayed in the lower right corner of the screen, see the 10 
STATUS tables in this section for how to read the status message. 

3. Verify the connections from the protocol analyzers to each modem. 
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Editing And Sending A Modem String 

<Edit Modem Str> softkey may be used with modems whose functions can be 
programmed via a message string from the device the modem 
supports. 

The modem string can consist of up to 80 characters. When 
you perform a <Save Config.> operation, you also save the 
modem string. In default mode, a modem string is not defined. 
If you want to define a modem string, press <Edit Modem Str> 
soft key. 

If the string needs a return character. use CONTROL M or 
press RETURN key to enter a return character. 

Modem Substrings 

/2+++ 

/2ATzcR 

/lATD404cR 

The modem string can be divided into segments with a user 
defined amount of delay between sending each segment. 

The character sequence "/N" (N = 0 .. 9) can be used to divide 
the modem string. If "/N" is used, characters to the left of the 
"/N" will be sent first followed by a delay of "N" seconds, then 
followed by the characters to the right of the "/N". More than 
one "/N" may appear in the Modem String. 

Example: 12+++/2ATzc R/1ATD404c R 

After the string is enabled to be sent, the analyzer waits 2 
seconds and sends" +++ ". 

The analyzer waits 2 seconds and sends 
carriage return. 

" ATZ " and a 

The analyzer waits 1 second and sends " ATD404 " and a 
carriage return. 

The sequence "//" or a single "/" foil owed by any character 
other than "0 .. 9" is treated as a "/" character in an undivided 
string. 

<1/0 Functions> Menu 15-15 



<Send At Power On> 

<ASCII 7> 

softkey lets the message automatically be sent to your modem 
each time the power switch is cycled on. To do this, you must 
first define a string, enable the <Send At Power On> softkey, 
and then use <Save Config.> softkey to save the modem string 
in the configuration file. 

You must save the configuration file before you turn power 
off or it is lost. 

<Send At Power On> acts as a toggle switch. When the 
softkey is active, an asterisk (*) is displayed in the softkey field 
and the modem string is sent at power on. Press the softkey 
again; the asterisk is removed from the softkey field and the 
modem string is not sent at power on. 

<ASCII 8 Roman 8> 
<EBCDIC> 

<Send Modem Str> 

These softkeys let you choose the character code used in the 
modem string. Choose the character code required by your 
modem. 

Other character codes are displayed if optional keyboards are 
used. See Appendix B. 

softkey manual1y sends a modem string without having to 
cycle the protocol analyzer power. Check that you have 
created the string you want and then press <Send Modem Str> 
softkey. 

The <Enable 1/0> softkey must be off in order to send the 
modem string. 
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EXAMPLE FOR USING HP 4971 S WITH HP "SUPPORT LINK" MODEM 

PROCEDURE 

1. Set the HP 497 lS Configuration Menu parameters as follows: 
Baud Rate: 1200 
Stop Bits: l 
Parity Bit: None 
Bits/Char: 8 
Hardware Handshake: Full Duplex; modem connection 
Software handshake: Disabled 

2. Use the following modem strings: (ASCII 7-bit or 8-bit data code). 

Caller: 
<CTRL·E>CR/10CR/11CR/13CR/1CR/1DCR/1<number>CR/1CR/1 

L letter '0' 

Unit to be called: 

<CTRL-E> = 
c 

R 
<number> 

= 
= 

'CTRL' key plus ·letter 'E' key. 
RETURN key 
Telephone number (l or more digits) 

3. Before pressing the <Save Config.> softkey to save the configuration, check that 
the following softkeys are enabled: 

<Send At Power On*> 
<1/0 Ena bled*> 
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EXAMPLE FOR USING THE HP 4971 S WITH THE HA YES "Smartmodem 1200" 

PROCEDURE 

1. Set the configuration switches for the Hayes "Smartmodem 1200" as follows: 
(Switches are behind the front panel.) 

Sl 
S2 
S3 
S4 

Down 
Up 
Down 
Up 

SS 
S6 
S7 
SS 

Up 
Up 
Up 
Down 

2. Set the HP 497 lS configuration menu parameters as follows: 

Baud Rate: 
Stop bits: 
Parity Bit: 
Bits/Char: 
Hardware Handshake: 
Software Handshake: 

1200 
I 
None 
8 
Full duplex; modem connection 
Disabled 

3. Use the following modem strings: 

Caller: 

Unit to be called: 

c 
R 

<number> 
= RETURN key 
= telephone number ( l or more digits) 

4. Before pressing the <Save Config.> softkey to save the configuration, check that 
the following softkeys are enabled: 

<Send At Power On*> 
<1/0 Enabled*> 
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<Enable 1/0> 

Enabling 1/0 Operation 

soft key enables the HP 4971 S LAN Protocol Analyzer to 
communicate with another HP 497 lS. 

The <Enable 1/0*> softkey must be off in order to <Send 
Modem Str*> manually or to <Edit Config>. 

<Enable 1/0> acts as a toggle switch. An asterisk (*) is 
displayed when the function is on. Press the softkey again to 
remove the(*) and disable the function. 

Status Messages 
<Enable 1/0*> softkey also enables a status message field to 
help you know what activity is occurring on the master/slave 
link. 

This status field is located at the lower right corner of the 
display, just above the <EXIT> softkey. 

IO status messages are discussed on the following pages. 
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1/0 Status Messages 

The HP 497 lS shows I/0 status messages at the lower right corner of the display, just 
above the <EXIT> softkey. 

Each protocol analyzer displays what i! is doing or seeing. For example, if Station is 
transmitting a message to Station 2, the display on each terminal would be: 

Station 

IO: __ t __ : __ _ 

This unit is transferring a 
frame to the RS-232 card's 
buff er. 

Station 2 

IO: ____ :_r __ 

This unit is receiving a 
frame. 
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1/0 status messages can be grouped in the foJiowing functions: 

NORMAL STATUS 

This group of status characters reports the normal operation of your 
master/slave systems in remote operation. 

PERSISTENT ERRORS 

This group of status words and characters reports persistent problems that 
are occurring. 

MODEM NOT READY ERRORS 

The modem attached to your protocol analyzer is not ready for establishing 
communications between the stations. 

RUN TIME ERRORS 

This group of error messages reports hardware failures. 
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NORMAL STATUS 

The two following tables describe status characters that may be displayed in the 
Normal Status fields. These fields report the activity of your systems remote 
communications. 

1/0: ____ _ 

I 
Protocol State __ I 
Transmit Information_! 

Transmit Information Field 

CHARACTER(S) 
DISPLAYED 

PROTOCOL STATE 

!~~Receive Information 

DESCRIPTION 

A This unit is attempting to acknowledge the start of 
communication by other unit. 

H This unit is halted. 

This unit is attempting to start communication with other unit. 

FRAME TRANSMISSION INFORMATION 
B Other unit has received a good data frame but was unable to 

accept it because there was no message buffer available. 

C Other unit has received a frame with an FCS error. 

O Other unit has had a receiver overrun error. 

t This unit is transferring a frame to the RS-232 card's buffer. 

w This unit is constructing one or more data frames for 
transmission of a message. 
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NORMAL STATUS (cont.) 

I/0: ____ _ 

Protocol State __ ! 
Transmit Information_! 

! __ Receive Information 

Receive Information Field 

CHARACTER(S) 
DISPLAYED 

B This unit has 

DESCRIPTION 

received a good data frame but was unable 
accept it because there was no message buffer available. 

c This unit has received a· frame with an FCS error. 

0 This unit has had a receiver overrun error. 

p This unit is processing a received message. 

r This unit is receiving a frame. 

<1/0 Functions> Menu 15-23 

to 



PERSISTENT ERRORS 

lf persistent errors occur on the 1/0 interface, each protocol analyzer displays, in 
inverse video, one of the following messages. 

Persistent error messages are displayed in the following groups: 

START 

START ACK 

ACK 

RCV 

IO:START 

I 
Pershtent Error_! 

10: START 

10: START ACK 

This unit is having difficulty starting communication. 

This unit is having difficulty acknowledging the start of 
communication. 
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10: ACK 

PERSISTENT ERRORS (cont.) 

This unit is having difficulty sending a frame to the 
other unit. 

! __ Status Character( s) 

CHARACTER(S) 
DlSPLAYED DESCRIPTION 

B Other unit received a good data frame one or more ti mes but was 
unable to accept it because there was no message buffer available. 

D Other unit received one or more frames with an FCS error in the 
Data Field. 

F Other unit has r_ecei ved one or more frame headers with a format 
error. 

H Other unit received one or more frame headers with an FCS error. 

L Other unit has received one or more data frames that are too long. 

O Other unit has had one or more receiver overrun errors. 

T Other unit has failed to respond for some period of time. 
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10: RCV 

PERSISTENT ERRORS (cont.) 

This unit is having difficulty receiving a frame from the 
other unit. 

'~~-Status Character(s) 

CHARACTER(S) 
DISPLAYED DESCRIPTION 

B This unit received a good data frame one or more ti mes but was 
unable to accept it because there was no message buffer available. 

D This unit received one or more frames with an FCS error in the 
data field. 

This unit has received one or more frame headers with a format 
error. 

H This unit received one or more frame headers with an FCS error. 

L This unit has received one or more data frames that are too long. 

O This unit has had one or more receiver overrun errors. 
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MODEM NOT READY ERRORS 

MODEM NOT READY The modem at the station displaying this message is not 
ready. Possible causes are listed below: 

HALF DUPLEX MODE 
Data Set Ready line is false. 

FULL DUPLEX MODE 
Data Set Ready or Carrier Detect lines are false. 
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RUN TIME ERRORS 

IO: Error 

I I 
_ I I __ 

11 ESCAPECODE 11 FIELD 11 IOE RESULT" or 11 IORESULT 11 FI ELD 

Example: 

IO: Error -12 CPU bus error. 

-26 12 No driver for this card. 

-26 17 A time out has occurred. 

-26 19 Bad status or control. 

-26 21 Interface card is not operating. 

-26 306 Datacomm interface failure. 

If other Run Time Errors occur, contact your HP Response Center. 
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< Terminal Emulator > Description 

The <Terminal Emulator> softkey provides access to configuration menus of 
intelligent modems. It lets you interactively configure modem parameters. 

Using convenient keyboard entry, you can send and receive on a character basis to 
the modem. The terminal transmits each character as it is typed. Modem responses 
are shown on the terminal display. 

Using the HP 497 lS in terminal emulator mode requires detailed knowledge about 
your modem's operation. Refer to your modem's manual for guidelines to follow 
when sending commands to the modem and decoding modem responses. 

Configuring The Terminal 

Use the <1/0 Functions> <Edit Config.> softkeys to configure the terminal to be 
compatible with your modem. The 1/0 configuration menu is described earlier in 
this chapter. 

Choosing Terminal Functions 

<Local Echo> 

<Auto Linefeed> 

causes each key selection to be shown on the display. 

When the receiving modem does not provide echo printing 
back to the display, this softkey lets you see your entry as 
you type each character. 

If you select <Local Echo> and the receiving modem also 
provides echo printing, double characters are displayed. 

causes the terminal to automatically send a line feed 
character to the display after a carriage return character is 
sent to the display. 
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<Show 
Non-printing> 

<ASCII 7> 
<ASCII 8 Roman 8> 
<EBCDIC> 

shows non-printing characters on the display. 
Characters are displayed if they are entered from the 
keyboard or received from the modem. 

For example: in ASCII-7 character code. pressing the keys, 
CTRL and D, displays the character ET only when <Show 
Non-printing> softkey is enabled. 

softkeys let you select the character code set for the 
displayed and transmitted characters. 

Optional keyboards let other character codes be displayed. 
See appendix B for keyboard and character code 
descriptions. 
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16 
<Execute Program> MENU 

This chapter describes the softkeys used for the <Execute Program> Menu. 

From this menu, you select the source of frames for the program you want to execute. 
The frames may be already stored in the Receive Buff er, or, the source may be frames 
that are occurring on your Local Area Network. 

In addition, this menu allows access to the <Edit Programs> Menu and to the <Examine 
Data> Menu. 

This chapter includes: 

• <Execute Program> Softkey Selection 

• <Execute Program> Operation Considerations 

• Running Programs From The Network 

• Running Programs From The Buff er 

• Examine Data After Program Run 

• Edit Functions In <Execute Program> Menu 

• <Execute Program> Soft LED Indicators 
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< Execute Program > Softkey Selections 

Execute Program 

Run From Network 

Run From Buffer 

Edit Program 

Examine Data 

EXIT 

Run which program? 
Program·O 
Program· 1 
Program·: 
Program-5 
EXIT 

Run which progr.am from buffer? -----
Program· 0 
Program· 1 

Program·: 
Program-5 
EXIT 

Edit which program? 
Program·O 
Program· 1 
Program·: 
Program-5 
Edit New Program 
Rename Program 
OTHER CHOICES 
Delete Program 
EXIT 

(See <Examine data> Menu section) 
EXIT 
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< Execute Program > Operating Considerations 

See the appendix section for a list of program execution times. The following 
paragraphs give general considerations for program execution. 

Frame Acquisition Versus Display Speed. 
The protocol analyzer operating software performs two functions. First, it must look 
for frames matching filter conditions and store all qualified frames in the Receive 
Buff er. Second, it must run the <Edit Program> routines that you have programmed. 

The task of looking at all frames for filter matches and then storing the selected frames 
in the Receive Buff er is happening in realtime at 10 Mbits/sec. The frames can not be 
displayed in real time. As the display is updated, the last frame stored in the receive 
buffer is displayed next. 

At the same time the protocol analyzer is storing frames in realtime, your <Edit 
Program> softkey program is also being executed. Routines such as updating the 
display, controlling the counters and timers, and beeping are performed relatively 
slowly compared to the· realtime data acquisition rate. 

In any circular mode of memory storage ( Nonstop, Centered About, and Ending 
With }, if the Receive Buff er is filled before the display, counter, timer, and beeper 
routines are completed, the protocol analyzer cannot begin writing new frames over the 
oldest frames previously stored in memory. 

If network traffic loading is heavy, the program may cause the protocol analyzer to 
stop acquiring frames and display a message stating that a buffer overflow has 
occurred. 

Recommendation 
In order to reduce processor time spent displaying frames, counters, timers, and 
controlling the beeper, try to minimize using these programmable functions while 
storing frames. 

An alternative is to capture the frames first, without displaying information, and then 
run your program in <Run From Buffer> mode. 

In <Run From Buffer> mode, no conflict occurs between storing frames and displaying 
information since the frames are already captured. 



Running Programs From The Network 

NOTE 

If you have not created a program, the protocol analyzer 
goes to a default PROGRAM_O. This program contains the 
default "Store" command: 

Store: all frames 
until buffer full 

This lets the protocol analyzer monitor the network or 
Receive Buffer in the absence of a user created program in 
<Run From Network> or <Run From Buffer> modes. 

<Run From 
Network> 

causes the protocol analyzer to execute a selected program 
using frames presently occurring on the Local Area Network. 

Press the <Run From Network> softkey to display: 

Run which program? _ 

Press the softkey whose label contains the program you wish 
to execute. The sof tkey ca uses the program to begin executing 
immediately. 

If only 1 program is defined, it is run automatically without 
going through the "Run which program?" question. 

Up to five programs can be created and displayed as softkey 
selections. 
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Running Programs From The Buffer 

<Run From Buffer> causes the protocol analyzer to execute a selected program 
using data previously stored in the Receive Buff er or in 
log-data disc files. 

Choose the data source. 

RECEIVE BUFFER 
To execute a program from the Receive Buffer, load the 
buff er with frames directly from the network. 

LOG-DAT A DISC FILE 
To execute a. program from a log-data file, use the <Disc 
Functions> Menu to load a log-data file to the Receive Buffer. 
The analyzer then automatically uses the log-data file as the 
frame source while executing the program. 

Choose the program to execute. 

Press the <Run From Buffer> softkey to display: 

Run Which Program From Buffer? 

Press the softkey whose label contains the program you wish 
to execute. The softkey causes the program to immediately 
begin execution. 

If only one program is defined, it is run automatically without 
going through the "Run which program?" question. 

Up to five programs can be created and displayed as softkey 
selections. 
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Run from Receive Buffer. 

When the Receive Buff er is the source of frames used for 
executing a program, the "Store" command shown in the top 
line of your program display is ignored in <Run From Buffer> 
operation since the frames you are using are already stored in 
the Receive Buffer. 

The frames in the receive buffer are not changed .by executing 
the program. 

<Execute Program> updates the "Filters" field to show what 
filters are matched in each frame. Trigger events specified by 
the program's "Store:" statement are updated. Trigger events 
are frames that match the statements: Starting With, Centered 
About and Ending With. 

Executing <Run From Buff er> automatically clears the "Mark 
Frame" condition from frames in the Receive Buffer. Timers 
and counters are reset. The timestamp for when each frame 
occurred on the network is retained. 

Run from Log-data disc file. 

If the Receive Buffer has been filled from a log-data file, the 
<Run From Buffer> command executes using frames in the 
log-data disc file. 

Only frames from the log-data file that match the selected 
program's "Store:" command, filters and trigger events are 
written to the Receive Buffer or output file. The original 
timestamp for when each frame occurred on the network is 
kept. 

The contents of the log-data file on the disc are not disturbed. 
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Examine Data After Program Run 

After a program run is completed, the protocol analyzer automatically goes to 
<Examine Data> Menu. The list below shows what information is displayed. 

Program Data Source 

Run from Network 

Run from Network 

Run from Buff er 
(Buffer filled 

from network) 

Run from Buff er 
(Buffer filled 

from network) 

Run from Buffer 
(Buffer filled from 

log-data file) 

Run from Buff er 
(Buffer filled from 

log-data file) 

"Log File:" 
command used? 

NO 

YES 

NO 

YES 

NO 

YES 

<Examine Data> Display 

Receive Buffer data 

Log·data file on disc 

Receive Buffer data 

Receive Buffer data 

Original log·data file on disc 

New log-data file on disc 

To fill the Receive Buff er from a log-data file, use <Disc Functions> <Load File> menu 
and select a log-data file existing on the selected volume. 
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Edit Functions In <Execute Programs> Menu 

<Edit Program> 

<Examine Data> 

softkey provides a convenient branch to the <Edit Programs> 
Menu. 

You can choose to edit the following programming functions: 

<Edit New Programs> 

<Rename Programs> 

<Delete Program> 

Detailed descriptions of these softkey functions are given in 
the <Edit ProgramS> Softkey Descriptions section in Chapter 
14. 

When you branch to the <Edit Programs> Menu and finish 
editing a program. press the <EXIT> softkey to return to the 
<Execute Program> Menu. 

softkey lets you view data stored in the Receive Buffer. 

See the <Examine Data> Menu section for a description of the 
softkeys available. 

When you press the <Examine Data> softkey, the protocol 
analyzer branches to the <Examine Data> Menu. All the 
normal <Examine Data> Menu softkeys are available for you 
to view the frames. However, when you press the <EXIT> 
softkey in <Examine Data> mode, you return to this <Execute 
Program> Menu. 
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< Execute Program > Soft LED Indicators 

In <Execute Program> operation, characters are provided to indicate the following 
activities: 

The protocol analyzer is transmitting a frame. 

The protocol analyzer has detected a collision. 

The protocol analyzer is receiving a frame. 

These activities are indicated by the characters shown below the softkeys at the lower 
right corner of the display. 

T 'C R 

Each character is displayed in normal video when there is no activity, that is, the 
function is "Off". Characters are displayed inverse video when their function is active 
or "On". 

T 

c 

R 

indicates the protocol analyzer is transmitting on the network. 

indicates colilsions are occurring on the network. Hardware for 
the collision counter detection circuit has detected a collision. 

indicates the protocol analyzer is receiving a frame. This soft 
LED turns on when a frame passes through the Runt frame 
filter. 
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WHEN ARE THE SOFT LEDs DISPLA YEO? 

The soft LEDs are displayed during the following program execution: 

1. When a <Run From Network> program specifies any "Store:" operation that 
stores frames in the Receive Buffer. 

2. Only the "T" soft LED appears when a <Run From Network> program 
specifies storing no frames and also specifies sending messages. 

The "T" does not appear until the first message is sent in this program's 
execution . 

WHAT IS THE DISPLAY TIME FOR THE SOFT LEDs? 

Short display 

Long Display 

Since the frames on a LAN are being transmitted at 10 
Mbits/sec, there are times when the soft LEDs will be on too 
briefly to notice. 

This is most likely to happen when the network traffic load is 
very light. 

In contrast, there are times when the soft LEDs will be on 
longer than the duration of an event. 

For the Collision and Receive soft LEDs, the "On" duration 
can be from five milliseconds to one second. The time 
depends on the amount of traffic on the network and the 
contents of the program for the Collision and Receive soft 
LEDs. 

For the Transmit soft LED, the duration depends on the 
length of the message to be transmitted, the frequency of 
transmission, and how often other traffic on the network 
permits the frame to be transmitted. 
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WHAT DISTORTS THE SOFT LEDs DISPLAY? 

Transmit 

Collision 
Receive 

Because frames are transmitted at 10 Mbits/sec, the duration 
of frames is very short. This soft LED appears to not be on if 
your program uses "Store: no frames" and short frames are 
sent in small groupings. 

These two soft LEDs do not display in real time. When a 
collision or received frame happens, the soft LED indication 
occurs some time later. 

This time lag can vary from one millisecond to one second. 
Maximum time lag occurs when: 

The network is lightly loaded 
(less than 64 frames/second) 

AND 

A <When> statement is not being executed ,in the program. 
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17 
<Monitor Network> MENU 

This chapter describes the softkeys used to monitor network message traffic. 

<Monitor Network> softkey lets you quickly begin looking at frames on your Local 
Area Network with only a few simple softkey selections. 

This chapter includes: 

• <Monitor Network> Softkey Selections. 

• <Monitor Network> Softkey Descriptions. 

• <Monitor Network> Soft LED Indicators 

• <Monitor Network> Anomalies 
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< Monitor Network > Softkey Selections 

Monitor Network ... _ ....... _ ... _ ............................................................. . 
Nonstop Mode 

Until Full 

Start Monitor 

Stop Display/Start Display 

Stop Monitor 
(Examine Data selections) A 

Next Frame 

I 

EXIr 
I 

Continue Monitor 

Select Format B 

EXIT (to Monitor Notwork Menu) 

Examine Data A (see Examine Data Selections) 

EXIT (to Top Level Menu) 
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A, B Functions from <Examine Data> Menu 
See <Examine Data> Menu section for details. 

A Examine Data 
Next Frame 

2 Previous Frame 
3 Scroll Frames 
4 Go To Frame # 

5 Timers & Counters 
B 6 Select Format 

7 Other Choices 
8 Next Marked 

Detailed Format 
Summary Format 
Filter Format 
Change Headers 
Change Dataf ield 
Change Timestamps 
EXIT 

9 Previous Marked 
10 Scroll Marked 
11 Mark/Unmark 
12 Show Node Names 
13 Show Hex Addresses 
14 EXIT 



< Monitor Network > Softkey Descriptions 

<Monitor Network> provides an easy-to-use method for capturing and viewing network 
messages with the protocol analyzer. 

In <Monitor Network> mode, you capture all messages appearing on a local area 
network. The messages are captured exactly as they appear on the network. The 
display updates with the most recently stored frame in the Receive Buffer. Monitoring 
is done in a transparent or unobtrusive mode with the protocol analyzer generating no 
signals back to the network. 

<Monitor Network> 

<Nonstop Mode> 

<Until Full> 

uses the Store command: Store: all frames 

to capture frames occurring on the Local Area Network. 
Softkeys <Nonstop Mode> or <Until Full> mode determine 
how the protocol analyzer fills ifs Receive Buffer. 

causes the receive buffer to be filled continuously. 

The <Nonstop Mode> is sometimes ref erred to as a circular 
memory. The captured information increments from the 
beginning of the buffer to the end of the buffer. As 
information continues to be received, the pro1ocol analyzer 
moves back to the beginning of the memory buff er and starts 
writing over information previously stored. This process of 
writing over previously stored information continues until the 
<Stop Monitor> sof tkey is pressed. 

stores network information in the receive buff er until it is full 
and the protocol analyzer stops acquiring data. 

The <Until Full> mode is sometimes referred to as a linear 
memory. The captured information increments from the 
beginning of the buffer to the end of the buff er. In contrast 
to the <Nonstop Mode>, the <Until Full> mode does not 
continuously write over previously stored information. When 
the Receive Buff er is filled, the protocol analyzer halts the 
monitor function and automatically goes to the <Examine 
Data> Menu. 
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<Start Monitor> 

<Stop Display> 

<Start Display> 

initializes the Receive Buff er and causes the protocol analyzer 
to start storing information in the same order that it appears 
on the local area network. 

Several messages are displayed at the beginning of <Start 
Monitor> to show the status of the protocol analyzer during 
the acquisition cycle: 

Loading filter hardware 
Initializing Receive Buffers 
Acquiring data. Waiting for incoming frames 

The task of storing the frames in the Receive buffer is 
happening in realtime at 10 Mbits/sec. The frames can not be 
displayed in real time. As the display is updated, the last frame 
stored in the Receive Buffer is displayed next. 

When the monitor operation is ended, frames are displayed in 
the consecutive sequence they occurred on the network. 

stops displaying new frames as they are stored into the Receive 
Buffer. Although the protocol analyzer stops displaying new 
frames, additional frames continue to be stored in the 
<Nonstop Mode> or until the memory is full in <Until Full> 
Mode. 

A reason to stop the display might be when acquisition is 
occurring slowly, you can examine some frame in detail 
without having to wait until the buffer is full or not having to 
disrupt the frame acquisition. 

Changing the format at this point allows you to display the 
frame in another format. 

restarts the protocol analyzer displaying new frames as they 
are being loaded into the Receive Buffer. 
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<Stop Monitor> 

<Continue Monitor> 

<Examine Data> 

<Select Format> 

stops loading new frames into the Receive Buff er and displays 
the frames in the <Examine Data> mode. 

In the <Nonstop Mode>, the following status message is 
momentarily displayed: Run Suspended ; then the protocol 
analyzer goes to <Examine Data> mode to display frames in 
the Receive Buffer. 

Press the <EXIT> softkey to display the choice to either <Start 
Monitor> which reinitializes the Receive Buffer and throws 
away. the contents previously stored, or, to <Continue 
Monitor> which retains previously stored information, and 
starts filling memory from where it left off. 

lets the protocol analyzer resume loading new frames into the 
Receive Buffer and displaying frames in the <Examine Data> 
Mode. 

is a softkey that also may be selected from the Top Level 
Menu. The function of the <Examine Data> softkey is to 
provide an easy method of viewing the network frames stored 
in the Receive Buffer. 

<Examine Data> softkeys are explained in detail in the 
<Examine Data> Menu chapter. 

is a softkey from the <Examine Data> Menu. 

In this monitor mode, <Select Format> softkey lets you change 
the display format of information stored in the Receive 
Buffer. By changing the display format, you can exclude 
unwanted information and identify more easily information 
that is important to you. 

Choices available from the <Select Format> softkey are 
explained in detail in the <Examine Data> Menu section. 
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< Monitor Network > Soft LED Indicators 

In <Monitor Network> operation, characters are provided to indicate the following 
activities: 

The protocol analyzer has detected a collision. 
The protocol analyzer is receiving a frame. 

These activities are indicated by characters shown below the softkeys at the lower right 
corner of the display. 

T .. C· ·~ 

Each character is displayed in normal video when there is no activity, that is, the 
function is "Off". Characters are displayed in inverse video when their function is 
active or "On". 

T 

c 

R 

indicates the protocol analyzer is transmitting on the network. 

NOTE 

Monitor operation is a unobtrusive or passive operation; the 
protocol analyzer will never be transmitting during monitor 
operation. The "T" LED is only used during <Execute 
Programs> operation. 

indicates collisions are occurring on the network. Hardware for the 
collision counter detection circuit has detected a collision. 

indicates the protocol analyzer is receiving a frame. The LED turns 
on when ever a frame passes through the Runt frame filter. Only 
frames greater than 512 bits will turn this soft LED on if the Runt 
Frame Filter is enabled in the <Hardware Functions> Menu. 
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WHEN ARE THE SOFT LEDs DISPLAYED IN MONITOR OPERATION? 

The soft LEDs are displayed during the following monitor operations: 

1. <Monitor Network> mode is running. 

2. <Monitor Network> mode has run and has been manually stopped with no 
frames received after the monitor has stopped. 

WHAT IS THE DISPLAY TIME FOR THE SOFT LEDs? 

Short Display 

Long Display 

Since the frames on a LAN are being transmitted at 10 
Mbits/sec, there are times when the soft LEDs will be on too 
briefly to notice. 

In contrast, there are times when the soft LEDs will be on 
longer than the duration of an event. 

For the Collision and Receive LEDs, the duration depends on 
the amount of traffic on the network. 

LED on continuously 
occurs when the network Joad is rece1v111g more than one 
frame/second and less than 64 frames/second. 

LED on continuously with low blink rate 
occurs when the network load is greater than 64 
frames/second and some inter-frame spacing is greater than 
200 ms. 

LED on continuously with occasional flicker 
Occurs when the network load is greater than 64 
frames/second and all inter-frame spacing is less than 200 ms. 

LED always off or blinks at one second rate 
occurs when the network load is less than one frame/second. 
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WHAT DISTORTS THE LED DISPLAY? 

Transmit 

Collision 
& Receive 

(Not active in monitor mode.) 

The soft LEDs do not operate in real time; a collision can 
occur or a frame can be received but the indication is not 
displayed until some time later. 

The time lag can range from one millisecond to one second. 
The maximum time lag occurs when the network is very 
lightly loaded (less than 64 frames/second). 
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< Monitor Network > Anomalies 

Repeating Displays 

The HP 497 lS does not display all frames while monitoring the network. Since frames 
are transmitted at 10 Mbits/sec, the display skips some frames and updates with the 
most recently stored frame in the Receive Buffer. 

In <Monitor Network> <Nonstop Mode>, if you are monitoring a repeating group of 
frames on the network, the protocol analyzer may appear to be displaying only a few 
of the frames. This may happen when the display cycle of the protocol analyzer 
synchronizes with the frames appearing on the network. 

To assure yourself that all the frames are being received, you may want to stop the 
monitor function and use <Examine Data> softkey to verify that other frames are 
indeed being captured. 

No Frame Number Displayed 

Frame numbers are not displayed when you monitor the network in <Nonstop> mode. 
After you stop the monitor, the frames will be numbered with the oldest frame in the 
buffer starting as number 1. 
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18 
< Disc Functions > MENU 

This chapter describes the disc functions and the softkeys used to control the mass 
storage operations. 

The <Disc Functions> softkey functions provide mass storage capability for the HP 
497 lS Protocol Analyzer. 

This chapter includes: 

• <Disc Functions> Softkey • <Copy Files> Introduction 
Selections 

• Copying <Analyzer Files> 

• Introduction To Disc 
Functions • Copying <All Files> 

• Selecting A Volume • Copying <Unique Files> 

• Listing The Directory • Formatting A Volume 

• Deleting A File • Compressing A Volume 

• Saving A File • <Disc Functions> In 
Remote Mode 

• Loading A File 

• Copying A File 
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< Disc Functions > Softkey Selections 

Disc Functions 
Select Volume 

List Directory 

Delete File 

Save File 

Load File 

Copy Files 

OTHER CHOICES 

Format Volume 

Compress Volume 

EXIT 
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Introduction To Disc Functions 

<Disc Functions> softkey provides many conveniences for analyzing a Local Area 
Network. Programs, messages, node lists and filters can be created for application on 
your particular system and saved to a disc drive. 

The <Log Frames To Disc> program command in <Edit Programs> Menu lets the HP 
497 IS log frames directly to the disc drive as the frames are occurring on the network. 
This lets you take advantage of the larger storage capacity of the disc drives. 

In non-logging modes, after the HP 497 lS Protocol Analyzer captures frames occurring 
on the Local Area Network, you can manually transfer the frames to the larger storage 
capacity of a disc drive. 

Equally as important as the increased data storage is the easy storage and recall of 
previously defined setup information that you can create to control the HP 497 lS 
operation. Examples of functions desirable to store on a disc are: 

User defined node name list 
User defined filters 

User created programs 
User created messages 

The <Disc Functions> menu lets the HP 497 lS Protocol Analyzer perform the 
following data storage and transfer functions. 

Initialize discs or volumes. 

Save files from the protocol analyzer onto discs or volumes. 

Load files from volumes into the protocol analyzer. 

Copy files from one volume to another disc volume. 

Delete files from volumes. 



Discs supplied with system. 

Several discs are provided with the HP 497 lS protocol analyzer system. These disc are: 

DISC LABEL 

LANSYS 

LAN COD 

HP 4971S 
TUTORIAL 

92192A 

DESCRIPTION 

Includes the operating system software and some operating 
tables. 

Includes code unique to protocol analyzer functions. 

is a self-paced tutorial supplied to introduce you to the 
basic functions of the protocol analyzer. 

Box of ten 3 1/2 inch floppy discs 

With HP 9122D Dual Disc drives, LANSYS and LANCOD must be installed in the disc 
drive each time the protocol analyzer is powered on. 

With Winchester drives, you permanently store LANSYS and LANCOD on the hard 
disc after the initial power up procedure. 
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<Select Volume> 

Selecting A Volume 

lets you to select the disc volume to use for your mass storage 
operations. 

Up to three disc drives can be supported by the HP 4971S. 
The HP-18 switch address settings on a disc drive determines 
the volume unit numbers displayed by the analyzer when you 
press the <Select Volume> softkey. 

In the chapter "Installing The HP 497 lS," the section "Set The 
HP-lB Address Switches" describes the options for setting the 
address switches for system disc drive(s). 
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<List Directory> 

Listing The Directory 

displays a directory list of files contained in the selected 
volume. 

The <List Directory> function recognizes and displays Pascal 
TEXT and CODE files. If another type of file is found, the 
file is labeled as OTHER in the type field. 

DIRECTORY OF VOLUME : (volume name) 
VOLUME SIZE (BYTES): 630784 LARGEST AVAILABLE SPACE (BYTES): 21248 

FILE # NAME 

1 CNFG 
2 new 
3 sys71 
4 Netwrk1 
5 Nli st 

VOLUME SIZE 

LARGEST 
AVAILABLE SPACE 

TYPE SEQUENCE DATE SAVED TIME SAVED SIZE (BYTES) 
. . . . . . . .. . . . . . .. . .. . . ............ .. . -.. - .. - ....... "' 

Conf ig 0 15·Apr·85 10:01 :01 1024 
Data 0 16·Jun·85 01:03:39 56780 
OTHER * 09·Mar·86 12:15:22 237954 
Network 0 17·Jun·86 13:01:55 2283 
Nodes 0 17·Jun·86 09:30:02 743961 

Printing The Directory 
If your system has an HP ThinkJet printer, press SHIFT and 
PRINT keys to print the complete directory. 

displays the total size in bytes of the selected volume. 

is the largest contiguous space available. This may be space 
bet.ween existing files or space at the end of the files. The HP 
497 lS does not fragment files when performing a save file or 
copy file operation. 

You can use this number to see if you have enough room to 
save or copy an additional file to the current volume. 

If files have been deleted, use the <Compress Volume> softkey 
to move all free file space to the end of the volume. 
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TYPE field indicates the type of file. Protocol analyzer files include: 

Application 
Configuration 
Data (frames) 
Data (log-to-disc) 

Filter 
Message 
Network 
Node 

TEXT, CODE, or OTHER files are not HP 497 IS user defined 
protocol analyzer files. 

SEQUENCE number is used only for files saved from the protocol analyzer. 

DATE 

TIME 

OTHER, TEXT, and CODE files have an asterisk (*) in the 
sequence column. 

When large files are saved to a disc, there may not be enough 
room to save all of a file on one disc. The HP 497 lS prompts 
you to insert a new disc when the current disc capacity has 
been filled. The HP 497 IS automatically assigns sequence 
number one to the first disc and then increments the sequence 
number for the remainder of the file created on the next 
disc(s). 

is the day, month, and year the file was saved in the protocol 
analyzer. 

If the. date is not set in the <Set Date> Menu when the 
protocol analyzer power is turned on, the "DA TE" field 
defaults to the HP 497 lS software revision date. 

is the hour, minute, and second the file was saved in the 
protocol analyzer. 

If the time is not set in the <Set Time> Menu when the 
protocol analyzer power is turned on, the "TIME" clock starts 
from zero and <List Directory> TIME is not relevant to the 
actual time of day the file was stored on disc. 
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<Delete File> 

Deleting A File 

softkey lets you remove an unwanted file from a selected 
volume. 

Press the <Delete File> softkey to display a list of the types of 
files on the selected volume. 

After the type of file softkey is pressed, a prompt is displayed 
to enter the file name to be deleted. All of the files that 
match the file type you selected are displayed as softkey 
clH>ices. Press a softkey type the file name from the keyboard. 
If you enter the file name from the keyboard, press RETURN 
key to complete the entry. 

Are You Sure?. 
After you enter a file name you want to delete, a prompt is 
displayed to be sure that you have identified the correct file 
and really want to delete the information. Press the <YES> 
softkey to execute the delete command. 

One File At A Time 
For safety, only one file may be deleted at a time. A wild 
card can not be used to delete multiple files in one operation. 
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<Save File> 

Network 
File 

Saving A File 

lets you copy a file from the protocol analyzer to a selected 
volume. The original information is left intact in the protocol 
analyzer. 

After you press the <Save File> softkey, the softkeys change to 
display a choice of the type of file to be saved. Types of files 
that can be saved from the protocol analyzer include: 

Data 

File 

Node 
Fi le 

Filter 

Fi le 

Message 

Fi le 

Program 
File 

OTHER 
CHOICES 

EXIT 

<OTHER CHOICES> 

Conf ig. 

File 

<Conflg File> 

OTHER 
CHOICES 

EXIT 

softkey lets you copy the current HP 4971 S 
configuration into a file. The configuration file 
contains data rate, hand shaking and protocol 
information for communicating over the RS-232 port as 
well as set-up information for several menus. 

Set-up items included in the configuration file include: 
Passwords 
Autostart file 
Default volume 
<Examine Data> Menu data formats 
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<Save File> (cont.) 

<Network File> softkey copies the following information from the 
protocol analyzer onto the disc. 

User defined node name list 
User defined filters 
User defined messages 
User defined programs 

If no Network file exists on the selected volume, the 
display prompts you to enter a file name. If network 
files already exist, the <Network File> softkey requires 
you to choose between creating a new file or re-writing 
the file to an existing file name. 

<Re-write Existing> 
softkey displays the names of network files existing on 
the selected volume. 

Press a displayed softkey representing the file to be 
replaced to immediately execute storing the current 
network files in the protocol analyzer to that disc file, 
or, enter the name of an existing disc file from the 
keyboard and press RETURN to execute saving the 
network file. 

<Create New File> 
softkey prompts you to enter a new file name. Volume 
file names can be up to seven keyboard characters. 
Leading spaces are deleted. Spaces between characters 
are replaced with an underscore (_). Characters not 
valid for volume file names are: 
@ . (period) 
# I CTRL-x (control characters) 
$ 

After a name is entered for <Create New File>, press 
RETURN key to execute storing the network setups 
from the protocol analyzer to the new file. 
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<Save Fiie> (cont.) 

<Data File> softkey lets you copy Data Files from the protocol 
analyzer's Receive Buffer onto a selected volume. 

If no data file exists on the selected volume, the display 
prompts you to enter a file name. If data files already 
exist, the <Data File> softkey requires you to choose 

·between creating a new file and re-writing the file to an 
existing file name. 

<Create New File> writes the file to a new fiie name. 
<Re-write Existing> removes information from an 
existing file and writes the new information in its place. 

To save network frames from the Receiver Buffer to a 
data file on the volume, you have to decide what 
portion of the Receive Buffer you want to copy. 

Up to 15 combinations of network message frame 
groups can be stored in one volume file. Softkey 
choices let you select frames to copy. 

<Range Of Frames> 
<Single Frame> 
<Marked Frame> 
<All Frames> 
<Save The List> 
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<Save File> (cont.) 

NOTE 

Frames are saved with the same frame number they have in 
the Receive Buffer. If a frame is saved more than one time, 
it is shown with the same frame number each time it is 
displayed. 

An example is shown below of <Save File> softkey with all 15 
available elements defined with frames to be saved from the 
Receive Buff er Data File. Notice that several frames are 
copied in more than one element. 

FRAMES IN THE LIST (15 elements maximum) : 

1. RANGE OF FRAMES FROM # __ 4 TO # __ 9 
2. SINGLE FRAME # __ 2 
3. RANGE OF FRAMES FROM # __ 1_4 TO # 20 
4. RANGE OF FRAMES FROM # ~~3_1 TO # ~ 

5. SINGLE FRAME # ~ 

6. MARKED FRAMES 
7. RANGE OF FRAMES FROM # ~ TO # __lQQ 
8. RANGE OF FRAMES FROM # ~ TO # 500 
9. RANGE OF FRAMES FROM # ~ TO # ~ 

10. SINGLE FRAME # ___i2Q 
11. SINGLE FRAME # __ 1 
12. SINGLE FRAME # 250 
13. RANGE OF FRAMES FROM # ~ TO # 600 
14. RANGE OF FRAMES FROM # __ 1_0 TO # ~ 

15. SINGLE FRAME # 625 
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<Save File> (cont.) 

<Range Of Frames> 
lets you choose a group of consecutive frames to be copied 
from the Receive Buffer Data File to a selected disc. The 
prompt for choosing the range of frames is: 

RANGE OF FRAMES FROM # TO # 

The frame numbers ref er to the numbers assigned to each 
frame as it is viewed in <Examine Data> Menu. To specify a 
number range, use numeric keys from the keyboard in the 
prompt, ·From # __ , and then press the RETURN key. 
Enter the ·To # frame number and press the 
RETURN key. 

If you want to know the last frame number, enter a number 
you know is greater than the last stored frame number such as 
999999 and press the RETURN key. The last frame number 
available in the Receive Buff er is displayed in the field. 

Frame numbers can overlap or be duplicated in different 
combinations or data files. 

<Single Frame> 
lets you choose one specific frame number to be copied from 
the Receive Buffer Data File. 

A <Single Frame> choice may be duplicated in other frame 
selections to be saved to the disc. 

Enter the single frame number and then press the RETURN 
key to complete the entry. 

If no additional frames need to be saved, press <Save The List> 
softkey. 
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<Save File> (cont.) 

<Marked Frames> 
stores all frames from the Receive Buffer that have been 
identified by the <Mark Frame> softkey in <Examine Data> 
operation. 

<All Frames> 
lets you save all frames in the Receive Buffer. <All Frames> 
can be used by itself to save the entire group of frames in the 
Receive Buffer or it may be used in combination with the 
other softkeys for saving frames. 

<Save The List> 
immediately executes saving the frames identified in the list by 
<Range Of Frames>. <Single Frame>, <All Frames>, and 
<Marked Frames> softkeys. 

If you press <Save The List> softkey and no frames have been 
identified to be stored, an empty file is generated. 

Save Timers And Counters? 

After you press <Save The List>, the protocol analyzer asks if 
you want to also save the Timers and Counters with the 
current data file to be saved. Press <YES> to begin saving the 
data list and the counters/timers information. Press <NO> 
softkey, to save only the previously defined data list. 
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<SAVE FILE> (cont.) 

<Node File> 
<Filter File> 
<Message File> 
<Program File> 

You can save each of these individual files that you 
have created in <Setup Analyzer> Menu to a volume 
you select. 

After one of the above menus is created, go to <Disc 
Functions> menu. 

Press the <Save File> <xxxxxxx File> softkey and the 
protocol analyzer prompts you to choose between 
saving the file to to a new file name or re-writing an 
existing file 

Press <Create New File> to save the <xxxxxxx File> to a 
new file name. 

Press <Re-write Existing> to save the menu or 
information to an existing file name. Re-write removes 
the old file information and then writes the new 
information. 
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<Load File> 

Loading A File 

lets you copy an HP 497 lS file from a selected volume into 
the HP 497 lS protocol analyzer. 

Press the <Load File> soft.key to display the selection of files 
available on the selected disc. Depending on which file type 
you select, soft.keys display names for that type from the 
selected volume directory. 

Press the soft.key name of the file you want loaded into the 
protocol analyzer to immediately start loading the file. 

Append Or Overwrite Current Node List? 
When you load a network or node file into the protocol 
analyzer and the node list already has nodes defined, the 
display prompts you to choose whether to append or 
overwrite the current node list. 

<Append Nodes> soft.key adds the new names to the current 
node list. 

<Overwrite Nodes> soft.key deletes the current node list and 
writes the file into the node list. 

Status Messages 
Status messages are displayed in the upper left corner during 
the load operation. For example: 

Loading Nodes 

Loading Frame # in to Buff er # 

When the file is loaded, a status message is displayed above the 
soft.keys: 

•(your file name)' loaded. 
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< Copy File > Introduction 

<Copy Files> The HP 497 lS can copy a file from one volume into another 
volume. The copy function is softkey controlled. 

Softkey selections copy a single file or all files from one 
volume to another. You can use a wild card to copy files with 
common characters from one volume to another. You can 
copy non HP 497 lS files. 

Jn any of the copy file modes, when a file to be copied 
already exists on the TO volume, the file is over written. 

NOTE 

Floppy discs must be initialized by the HP 4971S system 
before you can copy to the disc. 

After you press <Copy Files> and select a volume to copy FROM, the protocol analyzer 
displays the following softkeys: 

<Analyzer Files> <All Files> <Unique Files> 

Files types that may be in each of these file groups include: 

<Analyzer Files> 

Config file 
Network file 
Data file 
Node file 
Filter file 
Message file 
Program file 
Log-to-disc 
Application 

<All Files> 

Includes all 
files stored on 
the FROM volume. 
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<Unique Files> 

May be any 
file. 
This includes 
analyzer files 
or other system 
files. 
Wild card (@) 
can be used. 



<Analyzer Files> 

<All Files> 

<Unique Files> 

softkey lets you copy any of the protocol analyzer file types 
listed on the previous page. 

In <Analyzer Files> copy operations, only one file may be 
copied at a time. Softkey operation is provided for quick file 
copy operation. 

softkey lets you copy all files (analyzer files and unique files) 
from one volume to another volume in one operation. 

softkey lets copy protocol analyzer files as well as files other 
than user defined protocol analyzer files. Other file types may 
be system files. 

A "wild card" feature in the <Unique Files> operation lets you 
copy more than one file at a time. 

Each of these copy file groups is discussed in detail on the following pages. 
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COPYING < ANALYZER FILES > 
<Analyzer Files> lets you copy any of the files you use for protocol analyzer operation. 
Using <Copy Files> <Analyzer Files> lets you copy one file at a time. Softkey are 
provided to let you quickly move through the copy operation. 

The different types of files used for protocol analyzer operation include: 

Configuration File 
Network File 
Data File 
Node File 
Filter File 

Message File 
Program File 
Log-to-disc File 
Application File 

PROCEDURE 

1. Press <Copy Files> softkey. 

2. HP 4971S prompts: Copy file FROM which volume? 

3. Press a softkey for the number of the FROM volume. 

4. HP 497 lS displays: FROM: #(volume number:),(name of volume) TO: 

For example: FROM: #3, SAVE1 TO: 

Copies a file from volume #3:. Volume #3: is named SAVEL 

5. The protocol analyzer reads the directory of the FROM volume and displays 
soft keys: 

<Analyzer Files> <All Files> <Unique Files> 

6. Press <Analyzer Files> softkey. 

7. HP 497 lS displays only the analyzer type files that are currently on the 
selected volume. 

8. HP 497 lS prompts: Choose a file type to copy. 
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PROCEDURE: Copy <Analyzer Files> (cont.) 

9. Press a softkey for the file type you want to copy. 

10. HP 4971S displays softkey choices for the files currently existing on the 
selected volume. 

11. HP 497 lS prompts: Select softkey or enter valid name 

12. Press a softkey for the file you want to copy. 

13. HP 497 lS lists the file name and file type you just selected and prompts: 
Copy file TO which volume? 

14. HP 497 lS displays softkey choices for the volumes available on your system. 

15. Press a softkey for the volume destination you want. 

16. HP 497 lS displays the name, type, and size of the file you have selected. 

17. HP 497 lS displays softkeys to let you rename the file on the TO volume or to 
begin copying to the current file name. 

<Begin Copy> 
<Begin Copy> causes the protocol analyzer to begin the copy operation. 

<Change Name> 
<Change Name> lets you change the name of the file in the TO volume. 
Press the softkey, <Change Name>, and enter the new name. 

Volume file names can be up to seven characters. Leading spaces are 
deleted. Spaces between characters are replaced with an underscore (_). 
Press RETURN key to complete the entry. Characters not valid for volume 
file names are: 

@ 
# 

$ 
I 

. (period) 
CTRL-x (CONTROL characters) 

Press <Begin Copy> to start the copy function. 
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Copying < All Files > 
In some applications, you may need to copy the entire contents of a volume. This can 
be done in one operation and is easier than copying a volume file by file. 

When you need to copy all the files from a hard disc to floppy disc(s), you may not 
have enough room on the floppy disc. The protocol analyzer prompts you when to 
install a new floppy disc. 

PROCEDURE: 

l. Press the <Copy Files> softkey. 

2. HP 497 lS prompts: Copy file FROM which volume? 

3. HP 4971S displays softkeys for you to select which group of files to copy 

4. Press <All Files> softkey. 

5. HP 4971 S prompts: Copy file TO which volume? 

6. Press a softkey for the volume you want to copy files TO. 

7. The protocol analyzer displays the copy FROM volume, the copy TO volume, 
and a list of the files to be copied. 

You can scroll the file list with the cursor arrow UP and DOWN keys. 

8. HP 497 lS displays softkeys to execute the copy function, <Begin Copy> or to 
quit the copy function, <Abort Copy>. 

9. Press <Begin Copy> softkey to start the copy function. 
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Copying < Unique Files> 

<Unique Files> lets you copy files used for protocol analyzer operation as well as other 
system files. System files are labeled OTHER, TEXT, or CODE in the TYPE field of 
directory listings. 

You can copy one file at a time, or, you can use a wild card to copy multiple files. 

PROCEDURE Copy <Unique Files> (cont.) 

l. Press <Copy Files> softkey. 

2. HP 497 lS prompts: Copy file FROM which volume? 

3. Press a softkey for the FROM volume you want to copy from. 

4. HP 497 lS displays: FROM: #(volume number:),(volume name) TO: 

For example: FROM: #3, SAVE1 TO: 

Copies a file from volume number 3. Volume #3: is named SA VEI. 

5. The protocol analyzer reads the directory of the FROM volume and displays: 

<Analyzer Files> <All Files> <Unique Files> 

6. Press <Unique Files> softkey. 

7. HP 497 LS displays a data entry field and the prompt: 

Enter the file name you wish to copy. 

8. Enter a file name and press the RETURN key. 

File name syntax and wild cards are described on the following pages. 
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"ANALYZER" FILE NAME SYNTAX 

nnnnnnns.t 

AA A--- field type 

11 
II 
II 
11 
II 

D (Receive Buffer data) 
d (Log·to·disc data) 
N (Network) 
n (Node> 

II ____ separate with C.) 

I 
I ____ disc sequence number 

F (Filter) 
M (Message) 
C (Configuration) 
A (Application) 

(Needed only with Analyzer files) 

-------file name ( 7 char max ) 

"UNIQUE" FILE NAME SYNTAX 

n n n n n n n n n n . TYPE 

___ field type 
CODE or TEXT 

____ separate with (.) 
(TEXT and CODE files only) 
(TYPE entry not needed for OTHER file types.) 

------- file name ( 10 char max ) 

COPY FILE SYNTAX FILE NAME SEQUENCE FILE TYPE 
msgAl.M = msgA 1 M (Message) 
setuplO.C = setup! 0 C (Config) 
RonnO.n Rona 0 n (node) 
BADDATO.D BADDAT 0 D (Data) 

Rectangle.TEXT = Rectangle * TEXT 
JOB_SUMRY JOB SUMRY * OTHER 
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File Names 
ANALYZER files -- names are limited to 7 keyboard characters and 
must be followed by the disc sequence number and TYPE character. 

UNIQUE files -- names are limited to 15 characters. If file is TEXT 
or CODE, enter file name and .TEXT or .CODE . 

If file is OTHER type, enter just the file name and press RETURN 
key. 

Leading spaces in file names are deleted. Spaces between characters 
are replaced with an underscore L). Characters not valid for volume 
file names are: 

@ 
# 
$ 

I 
. (period) 
CTRL-x (control characters) 

WILD CARD -- can be used to copy more than one file at a time. 
See wild card description on next page. 

Sequence number 
When large files are copied to discs, there may not be enough room 
to save all the file on one disc. The HP 497 lS prompts you to insert 
a new disc when the current disc capacity has been filled. 

Type ANALYZER files use the letter cases shown below to indicate the 
type of file: 

D (Data saved from F (Filter) 
Receive Buffer) M (Message) 

d (log-to-disc data) c (Configuration) 
N (Network) A (Application) 
n (node) 

UNIQUE files use the following names to show type of file: TEXT, 
CODE. 
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<Copy Files> SYNTAX (cont.) 

WILD CARDS 

The wild card character, (@), lets you copy more that one file at a time. If several files 
have names that share common characters in sequence, you can copy all the files in one 
operation. 

Wild cards can be used with Analyzer Files or with Unique Files. The file is copied 
with the same sequence and type information as the original file. 

Examples: DAT@ 

@CODE 

@DEF@ 

@O.D 

copies all files beginning with DAT 

copies all .CODE files. 

copies all files with the consecutive letters DEF any 
where in the name. 

copies all Data files with sequence number 0. 
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Formatting A Volume 

<Format Volume> softkey lets you format (or initinlize) a volume on a 
Winchester disc or a 3 1 /2 inch floppy disc to the HP 497 lS 
system. 

To format a volume, use the following procedure. 

WARNING 

Formatting a used volume erases the current files. Back up 
files you need to keep. 

PROCEDURE: 

1. If the volume you want to format is a floppy disc, check that the write 
protect tab on the floppy disc is in the write enable position. (Slide tab 
toward center of disc.) 

2. If you are formatting a floppy disc, install the floppy disc to be formatted in 
a disc drive slot. 

3. Press <Format Volume> softkey. 

4. HP 4971S prompts: Select a volume to format. 

5. Softkeys are displayed for the volumes connected to your HP 497 IS system. 

Press the softkey for the volume you want to format. 

WARNING 

If you have a Winchester disc drive with more than one 
volume on the hard disc, if you select any one of the 
volumes to format, all volumes on the hard disc are 
formatted. 
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6. HP 497lS displays volume number, the current logical volume name, and how 
many files are currently on the volume. 

7. HP 497 lS prompts: Do you want to proceed with the formatting? 

8. Press <YES> softkey to format the volume and HP 497 lS displays: 

Volume formatting in progress. 

Press <No> or <EXIT> softkey if you do not want to proceed. 

9. After the volume is formatted, 

HP 4971S prompts: Volume name for #X 

If the volume has been formatted previously and named, the old name is 
displayed in the prompt. If the volume is new, the name field is blank. 

10. If you want the old name, press RETURN. 

11. If you want a new name, enter the new name and press RETURN key. 

Volume names may be up to six keyboard characters. Leading spaces in 
volume names are deleted. Spaces between characters are replaced with an 
underscore L). Characters not valid for volume file names are: 

@ $ I . (period) 
# = CTRL-x (control characters) 

12. After a volume is formatted, 

HP 497 lS displays: Formatting successful. 

The name you give to a volume is displayed when you do a directory of the volume. 

DIRECTORY OF VOLUME : (volume name) 
VOLUME SIZE (BYTES): 630784 LARGEST AVAILABLE SPACE (BYTES): 21248 

FILE # NAME TYPE SEQUENCE DATE SAVED TIME SAVED SIZE (BYTES) 
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Compressing A Volume 

<Compress Volume> softkey lets you compress or compact the files stored in a 
volume. 

The directory is checked for current files. Valid existing files 
are relocated to recover space previously occupied by deleted 
files. 

After a volume is compressed, all free space is contiguous at 
the end of the compressed volume. 

Compressing a volume lets you have access to all the free 
space on the volume. You now have the maximum space 
available displayed when you view the "LARGEST 
AVAILABLE SPACE (BYTES)" field of a volume directory 
list. 
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< Disc Functions > IN REMOTE MODE 

When two protocol analyzers are connected for remote operation, the slave protocol 
analyzer, at the remote site, makes all the measurements on the local Area Network 
(LAN) it is connected to and the slave also executes the disc function commands. 

Selecting A Volume In Remote Mode 

When a remote link is established and you press <Select Volume>, <Copy Files>, 
<Compress Volume>, etc. the display prompts you to choose either <Master> or <Slave>. 
Select the station that has the mass storage devices you want to use. Softkeys then 
display the choice of volumes available at the selected station. 

Copy Functions In Remote 

In remote mode, you can perform the following copy functions: 

Slave volume to slave volume 
Slave volume to master volume 
Master volume to slave volume 
Master volume to master volume 

OPERATING EXCEPTIONS FOR DISC FUNCTIONS IN REMOTE MODE 

Remote operation does not allow two primary functions normally available in the 
<Disc Functions> Menu. These functions are: 

Log-To-Disc 
Format volumes 

Log-to-disc - If you try to use <Execute Program> and the program has a 
log-to-disc command, the command is ignored. The rest of the program executes 
normally. 

Format volumes - During remote operation, you can not format volumes at either the 
master or the slave protocol analyzer. Volumes can be formatted only when a station is 
in local control. 
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19 
< Examine Data > MENU 

The <Examine Data> Menu lets you easily control the format of displayed network 
traffic for quicker recognition of frames that interest you. 

This chapter includes: 

• <Examine Data> Display 

• <Examine Data> Softkey Selections 

• <Examine Data> Softkey Descriptions 

Finding Frames 

Selecting A Frame Display Format 

Selecting Frame Header Formats 

Selecting Datafield Character Formats 

Displaying Data In Filter Formats 

Selecting Timestamp Measurements 

Selecting Timers And Counters 

• Displaying Frame Errors 
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#1 Mar 9@ 6.10.34.55533 Len 61 Filters 0 ............... No error 
2 Destination 01·23·45·67·89·AB Source FE·DC·BA-99·76·54 .!..YE! OA·OB 
3 15 54·68·69·73·20·69·73·20·46·72·61·6D·65·20·4E-75·6D This is Frame Num 
4 32 62·65·72·20·30·30·30·31·27·73·20·44·41·54·41·20·46 ber 0001's Data F 
5 49 49·45·4C·44·20·63·6F·6E·74·65·6E·74·2E ield content. 
6 
7 #2 
8 
9 

10 
11 
12 
13 
14 
15 
16 
17 
18 
19 
20 
21 
22 
23 
24 

#3 

#4 

Mar 9 Cil 6:10:34.66893 Len 61 Filters 0 ............... No error 
Destination 01·23-45·67·89-AB ....... . 

15 54·68·69·73· ..•..... This ..... . 
32 62·65. 72 ...... . ber ..... . 
49 49·45·4C·44·20· ••.•.••• ield •.••• 

Mar 9@ 6:10:35.01446 Len 61 Filters 0 ............... No error 
Destination 

15 54·68·69·73· ...... . This ..... . 
32 62·65·72· ....... . ber ...... . 
49 49·45·4C·44·2E ..... . i eld ..... . 

Mar 9@ 6:10:35.12345 Len 61 Filters: 0 ............... No error 

STATUS MESSAGE FIELD 
ERROR MESSAGE FIELD 

Next Previous Scroll Go to Timers & Select OTHER 
Frame Frame Frames Frame # Counters Format CHOICES 

<OTHER CHOICES> 
Next Previous Scroll Go to Mark/ 

Marked Marked Marked Trigger Unmark 
Search 
Buffer 

OTHER 
CHOICES 

Figure 19-1. Default <Examine Data> Menu Display. 

EXIT 

EXIT 
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< Examine Data > Display_ 

In the default <Examine Data> display, messages are displayed in detailed format. The 
protocol analyzer displays a physical header with each frame to give additional 
information about the frame. In addition, an Ethernet header is displayed. The data 
field is displayed in a hex and ASCII 8 format. 

Figure 19-l shows an <Examine Data> default display for network messages. The 
numbers on the left side of the display are for explanation use and are not part of the 
display. 

Line 1 

Line 1 is the physical header included with each frame by the protocol analyzer. It 
contains the following details: 

Frame Number 

Frame number 

The physical elements, which includes: 

Time Stamp 
Message length 
Filters matched 
Error indicator or frame status 

The "#l" in line l indicates that this is the first message stored 
in the protocol analyzer memory. Following messages are 
counted in the sequence they were stored in the Receive 
Buffer. 

The frame number is always shown in <Examine Data> 
displays. 

The frame number is not shown while <Monitor Network> 
Menu is operated in <Nonstop Mode>. 



<Examine Data> Display 

Time Stamp 

Message Length 

Mar 9 @ 6:10:34.55533" is the month, day, hour, minute, and 
second the message was stored in memory. The seconds are 
displayed in microseconds. 

The default time stamp display mode is <Date/Time>. This 
references all frames stored to the time when each frame 
occurred on the network. 

The calculated length of the message, in bytes, is displayed in 
the "Len" Field of line 1. 

The frame length is calculated by the protocol analyzer and 
includes all the information fields, which are: Destination 
Address, Source Address, Length (Length in Ethernet, Type in 
IEEE 802.3), and Data fields. Preamble and FCS Fields are 
not included in the message length. 
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<Examine Data> Display 

Filters field is a display showing currently defined filters and if a 
filter match occurred when the frame was captured. 

Filters 0 ••••••••••••••• 

Indicates the first filter defined is matched by this message. 

Filters 0123456789ABCOEF 

Up to 16 filters can be defined using the <Edit Filters> 
function. This example indicates all 16 available filters are 
defined and have been matched by the current message. 

Filters Ox •••••••••••••• 

Indicates Filter 0 was defined and matched in a message. 
Filter 1 was defined but did not find a match. 

No filter match is indicated by the "x" character. 

Only filters 0 and 1 are defined. All the other filters that are 
undefined are indicated by the "." character. 

The Filters: Field uses the filters defined when the data was 
captured. Because of this, if you edit an existing filter to no 
longer match a frame and again look at the same data in the 
Receive Buffer, the <Examine Data> display still indicates a 
match. If you delete a filter that matched a frame, that filter 
position is displayed as undefined. 

If you create a new filter and return to examine the previously 
captured data, the <Examine Data> display shows an x to 
indicate the new filter exists. It does not show if a match 
occurred with the new filter. 

To update the filters-matched field with frames already stored 
in the Receive Buff er, perform an <Execute Programs> with 
<Run From Buffer> selected. 
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<Examine Data> Display 

Error 

Line 2 

NOTE 

Frame errors are discussed in more detail in the "Displaying 
Frame Errors" section later in this chapter 

"No Error" indicates the frame was stored in the Receive 
Buffer with no errors detected. Possible errors that can be 
detected are indicated by the error messages: 

Runt Frame 
Jabbering 
Misaligned 

Corrupt Data 
Bad FCS 

The HP 497 lS can also detect combinations of these possible 
frame errors. The possible error combinations are listed below: 

Runt-Bad FCS 
Runt-Alignmt 

Jabr-Bad FCS 
Jabr-Alignmt 

In default <Examine Data> Menu, the protocol analyzer defaults to the <Ethernet 
Header> mode and displays the following information in line 2: 

Destination 
Address 

Destination Address 
Source Address 
Type 

The Destination Address consists of six bytes that identify 
where the message is being sent. Destination addresses are 
displayed in hexadecimal. 

The Destination Address field can be displayed as a functional 
node name by using the <Show Node Names> softkey. 
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<Examine Data> Display 

Source Address 

Type 

Line 3 

The Source Address consists of six bytes to identify where the 
message originated. Source Addresses are displayed in 
hexadecimal. 

The Source Address field can be displayed as a functional 
node name by using the <Show Node Names> softkey. 

The Type Field is displayed as two hexadecimal bytes. Type: 
is used in the Ethernet protocol to indicate the higher level 
protocol being used. The contents displayed in the Type Field 
will be bytes 13 and 14 of the frame contents. 

Line 2 can be changed to display the IEEE 802.3 header by 
pressing the <Select Format>, <Change Headers>, and <802.3 
Header> softkeys. The IEEE 802.3 header changes the Type: 
Field to Length: Field. The Length: Field also displays the 
contents of bytes 13 and 14. 

In the default display, line 3 of the <Examine Data> Menu contains the first line of text 
or data for the frame. In addition, the byte position for the first character on the line 
is shown at the left side of the display. 

Byte position 

Data 

On line 3, the " 15 " identifies that the first byte on line 3 is 
the 15th byte in the frame. Following lines use this column to 
indicate the location of the first byte on each line in the 
frame. 

The power on, or default <Examine Data> mode, displays 
characters in the message in hexadecima I and ASCII for ma ts. 
The frame data is first displayed in Hexadecimal with up to 17 
bytes per line. Each line is then interpreted on the right side 
of the display in ASCII format. 
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<Examine Data> Display 

Line 21 

Line 21 displays status messages. Examples of status messages are: 

No next frame 

Empty buffer 

Line 22 

Line 22 displays error messages. See the appendix section for error message 
information. 

Lines 23, 24 

The softkey selections that may be used to control operation of the HP 497 IS are 
displayed on lines 23 and 24. 
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Examine Data <Examine Data> Softkey Selections 
Next Frame 
Previous Frame 
Scroll Frames/Stop Scrolling 
Go To Frame # 

Timers & Counters 

Select Format 
Return To Data 

Detailed format 
Summary Format 
Filter Format 
Show Node Names 
Show Hex Addresses 
OTHER CHOICES 
Change Headers 

Suppress Physical Ethernet 802.3 
Headers Header Header Header 

Change Dataf ield 
Suppress 

Data 
Hex 
Data 

Character Hex/Char 
Data Data 

802.2 
Header 

Select * 
Data Code 

ASCII7 

** 
ime from Time from Time from Time 

ASCI 18 

btwn 
Change Timestamp 

Date/ 
Time 

Change Filters 
Start Frame # Trigger Frames 

Use First 
Matched 

Filter_O 

OTHER CHOICES 
Next Marked 
Previous Marked 
Scroll Marked 
Go To Trigger 
Mark/Unmark 
Search Buff er Search Next 

Search Prev 
Define Search 

Show Node Names 
Show Hex Addresses 
EXIT 
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Dest source 
Address Address 

Filters 
Matched 

*** 

Error 
Frame 

**** 

Dataf ield 
Pattern 

EBCDIC 

* Optional keyboards can be used to display other character codes. See appendix B. 

** ASCII 7 

ASCII 7 ASCII 7 ASCII 7 ASCII 7 ASCII 7 

No Par Par = 0 Par = Odd Par Even Par 

*** Filters 
Matched 

Filter 0 Filter 1 

**** Error 
Frame 

No Bad FCS Misalign Runt Jabber Any 
Error Error 

< Examine Data > Softkey. Descriptions 

The <Examine Data> softkeys are described in the following functional groups: 

Finding Frames 

<Next Frame> 

<Previous Frame> 

<Scroll Frames> 

<Go To Frame #> 

<Next Marked> 

<Previous Marked> 

<Scroll Marked> 

<Mark/Unmark> 

<Search Buff er> 
<Search Next> 
<Search Prev> 
<Define Search> 

<Dest Address> 
<Source Address> 
<Filters Matched> 
<Error Frame> 
<Dataf ield Pattern> 



Selecting Frame Display Format 

<Select Format> <Filter Format> 

<Detailed Format> <Summary Format> 

Selecting Frame Header Format 

<Change Headers> <Physical Header> 

<Suppress Headers> <Ethernet Header> 

Selecting Datafield Character Format 

<Change Dataf ield> <Character Data> 

<Suppress Data> <Hex/Char Data> 

<Hex Data> 

Displaying Data In Filter Formats 

<Use First Matched> 

<Filter_O> 

Selecting Timestamp Measurements 

<Change Timestamp> <Time From Start> 

<Date/Ti me> <Time From Frame #> 

Selecting Counters & Timers 

<Counters & Timers> 

<Show Node Name> 

<Show Hex Address> 

<802.3 Header> 

<802.2 Header> 

<Select Data Code> 
<ASCII 7> 
<ASCII 8> 
<EBCDIC> 

<Time From Trigger> 

<Time btwn Frames> 
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Finding Frames 

You can use softkeys in the <Examine Data> Menu to quickly and easily move through 
frames stored in the Receive Buffer to locate specific frames of interest to you. 

The following softkeys can be used to move through the stored frames: 

<Next Frame> 

<Previous Frame> 

<Scroll Frames> 

<Scroll Frames> 

<Go to Frame #> 

<Next Marked> 

<Previous Marked> 

<Scroll Marked> 

<Go To Trigger> 

<Mark/Unmark> 

<Search Buff er> 
<Search Next> 
<Search Prev> 

Remember that in addition to the above softkeys for controlling frame display, you can 
use keys on the keyboard. These keys are discussed in the section "Editing With The 
Keyboard Keys", in Chapter 1. 
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FINDING FRAMES (cont.) 

<Next Frame> 

<Previous Frame> 

<Scroll Frames> 

<Go To Frame #> 

softkey appears to move the displayed frames up one frame. 
What was the second frame being shown is now displayed at 
the top of the display. The next frame stored in the Receive 
Buffer memory is added to the bottom of the displayed 
frames. 

If <Next Frame> softkey is pressed while the last frame in 
memory being displayed, status message, No next frame., is 
displayed above the softkey selections. 

softkey appears to move the display down with a new frame 
added at the top. The new frame now seen at the top of the 
display is the frame in the Receive Buffer that precedes the 
previously displayed top frame. 

If <Previous Frame> softkey is pressed while the first frame in 
memory is being displayed, status message, No previous frame., 
is displayed above the softkey selections. 

Press <Scroll Frames> to cause the protocol analyzer to start 
incrementing the display through the frames stored in the 
Receive Buff er. 

Press <Stop Scrolling> or <EX IT> softkeys to end the scroll 
function, or, you can let the protocol analyzer automatically 
stop incrementing the display when the last frame in the 
Receive Buff er is displayed. 

No reverse scroll function is available. You can use <Go To 
Frame #> softkey to quickly move to previous frames or hold 
down the PREY keyboard key. 

lets you place a particular frame at the top of the display. 

Enter the frame number as an integer value such as; 3, 15, 
or 455. Non-integer entries will cause an error message to be 
displayed. Press the RETURN key to execute the command. 
(continued) 
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FINDING FRAMES (cont.) 

<Next Marked> 

<Previous Marked> 

<Scroll Marked> 

To quickly find and show the last frame in the Receive 
Buff er, enter a number you know is greater than the last 
frame number in the receive Buff er and press the RETURN 
key. 

Go to what frame #? 999999 

lets you update the display with the next following frame 
identified by a "Mark" to be displayed at the top of the screen. 

Frames can be marked manually by softkey selection as you 
scroll the frames or they can be marked by your program. 
Frames are marked to indicate a special filter condition or that 
they are of some particular interest to you. 

Using marked frames provides a quick method to scroll 
through the memory buffer to find only frames of interest to 
you. 

lets you update the display so that the closest previous frame 
identified with a "Mark" is displayed at the top of the screen. 

provides a method to get non-consecutive frames grouped 
together on the screen. 

Only marked frames are displayed. Unmarked frames 
occurring between marked frames are not displayed. 

After <Scroll Marked> function is selected, subsequent 
<Previous Marked> and <Next Marked> softkeys maintain this 
function of only displaying marked frames. Also, 
PREY /NEXT keyboard keys act like <Prev Marked> and 
<Next Marked> softkeys. 
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FINDING FRAMES (cont.) 

<Go To Trigger> 

<Mark/Unmark> 

causes the display to show the trigger frame identified in <Edit 
Programs> Menu for controlling the "Store" function: 

<Starting With> 

<Centered About> 

<Ending With> 

When one of these functions is used to control the "Store:" 
function, that trigger frame is displayed when the <Go To 
Trigger> sof tkey is pressed. 

This softkey toggles the mark condition either on or off. If no 
mark exists, the softkey marks the frame. If the frame is 
marked, press this sof tkey to remove the mark condition. 

<Mark> Puts a transparent mark on a single frame in the 
Receiver Buff er. When later examined in the buffer, 
marked frames can be selectively located and displayed. 

The frame currently at the top of the display is marked 
when you press the <Mark Frame> softkey. The frame 
number field is changed to inverse video to indicate a 
marked frame. 

<Unmark> Removes the frame "Mark" from the frame currently at 
the top of the display. 
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FINDING FRAMES (cont.) 

<Search Buffer> softkey lets you look through the buffer for a particular 
element(s) you have specified. Frame elements you may search 
for include: 

Destination Address 
Frames with errors 
Data Field Patterns (up to 6 bytes) 

Source Address 
Filters matched 

<Search Next> 
causes the protocol analyzer to look for the next frame in the 
buffer that contains the search elements you have defined. 

<Search Previous> 
causes the protocol analyzer to look for a frame stored 
previous to the currently displayed frame. The protocol 
analyzer looks for the search elements you have defined. 

<Define Search> 
softkey lets you identify or define the different frame 
elements you want to look for in the buffer. 

<Dest Address> 
lets you specify any message addressed to a specific 
node on the network. 

Enter the Hex code for the Destination Address you 
want to search for. Press RETURN key to complete 
the entry. 
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FINDING FRAMES (cont.) 

<Define Search> (cont.) 

<Source Address> 
lets you specify any message addressed from a specific 
node on the network. 

Enter the Hex code for the Source Address you want to 
search for. Press RETURN key to complete the entry. 

<Filter Matched> 
lets you see if a filter defined in the <Edit Filters> 
Menu can be matched to a frame stored in the receive 
buffer. 

Press <Filter Matched> softkey and then press the 
softkey that identifies the filter you want to use the 
next time you search the buff er. Press <EXIT> sof tkey 
to complete the entry. Choose a softkey to search 
forward (next) or backward (previous) in the buffer. 

<Error Frame> 
lets you search the buffer for frames that have a frame 
error. Press <Error Frame> and choose the error type 
you want to search for from the displayed softkeys. 
The frame error choices are: 

No Error 
Bad FCS 
Misalign 

Runt 
Jabber 
Any Error 

You can look for frames with a specific error, frames 
without any error, or only frames that have some type 
of error. 

Types of frame errors are described at the end of this 
chapter in the section, "Displaying Frame Errors." 

<Examine Data> Menu 19-15 



FINDING FRAMES (cont.) 

<Datafield Pattern> 

1A·6E·XX·XX·XX-XX at offset 13 

54-68·69·73·20·69 at offset 15 

lets you search through the buff er for a frame with a 
specific data field pattern that starts at a byte offset 
you define. 

Press <Datafield Pattern> softkey and enter the pattern 
you want. The data field entry must be in Hex code. 
You can enter up to 6 characters. Don't care characters 
(XX) may be used in any of the positions. 

You must specify at what byte location in the frame 
you want to look for the characters. You can specify 
patterns starting from byte position l. 

Examples: 

Look for pattern 1A-6E in the 
TY PE/LENGTH field. 

Look for pattern 54-68-69-73-20-69 
at the first of the data field. 

starting 

16·16·16·XX·XX-XX at offset 214 Look for pattern 16-16-16-XX-XX-XX 
starting at the 200th byte in the data 

field. 
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Selecting A Frame Display Format 

The format used to display frames stored in the Receive Buff er can be changed by 
using sof tkey selections. 

In addition, the entire group of counters and timers can be viewed on one display 
screen. 

The softkeys used to change the frame display format and display counters, and timers 
include: 

<Select Format> 

<Detailed Format> 

<Summary Format> 

<Filter Format> 

<Show Node Names> 

<Show Hex Addresses> 

<Counters & Timers> 
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SELECTING FRAME DISPLAY FORMAT (cont.) 

<Select Format> 

<Detailed Format> 

<Summary Format> 

softkey provides another level of softkeys to let you group or 
display the frames in the following formats: 

Detailed format 

Summary Format 

Filter Format 

is the default format for displaying frame contents. <Detailed 
Format> displays the headers you have selected along with the 
data field of the frame. 

The default protocol for <Detailed Format> is Ethernet 
protocol. The default header display has <Physical Header> 
and <Ethernet Header> softkeys selected. The data field is 
displayed in combined <Hex and Char> format with <ASCII 
8> character code. 

An example of this softkey display is described in the previous 
pages under the "Default Display Description" heading. 

softkey lets you quickly get an overview of the messages 
received into the Receive Buffer. This display lets you view as 
many as eight messages at a time which enables you to easily 
recognize trends or patterns in the messages. The information 
displayed is: 

Frame number Calculated frame length 

Destination Address Filters matched 

Source Address Error indicators 
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SELECTING A FRAME DISPLAY FORMAT (cont.) 

<Summary Format> 
(cont.) 

With this display, you can get an overview of what stations 
are doing the transmitting and what stations are being 
transmitted to. 

FRAME DESTINATION SOURCE FRAME FILTERS ERRORS 
NUMBER ADDRESS ADDRESS LENGTH MATCHED 

. ... ... - ... --........... .................... . ... - ................. -............... 
01·23·45·67·89·AB FE·DC·BA·98·76·54 1267 Oxxx ••••...••••• No error 

2 08·00·09·FF·FF·FF 08·00·09-00·0A·08 342 01xx ..........•. No error 

3 OO·DD·OO·OD-08-00 08·00·09-00·0A-08 655 012x •...•....... No error 

4 08·00·09·00·0A·08 08·00·09·FF·FF·FF 1400 0123 ............ No error 

5 01·23-45-67-89-AB FE·DC·BA·98·76·54 67 Oxxx .......•.... Bad FCS 

6 01·23·45·67-89·AB FE·DC·BA-98·76·54 67 Oxxx ....•....... No error 

7 print_server CPU1 854 01xx ........•.•• No error 

8 mass store MAINCPU 1514 0123 .•..•.....•. No error -

Detailed Summary Filter Show Node Show Hex OTHER 
Names* Addresses CHOICES 

EXIT 
Format Format * Format 

Figure 19-2. <Summary Format> Softkey Display 

In the <Summary Format> display above, the Destination and Source Addresses are 
shown in hexadecimal format. If a node has been assigned a node name in the <Edit 
Nodelist> Menu, the assigned name is displayed. Frames #7 and #8 show the addresses 
displayed in functional node names which make it much easier to recognize address 
patterns in Destination and Source Addresses. 

<Examine Data> Menu 19-19 



SELECTING A FRAME DISPLAY FORMAT (cont.) 

<Summary Format> 
(cont.) 

Frame lengths for the stored frames are displayed. 
The frame length field lets you recognize if only long frames 
are being transmitted or if any short frames occurred or if 
there is a mixture of long and short frames occurring. 

The "FILTERS MATCHED" Field makes it is easy to see 
what filters are being matched. This field shows currently 
defined filters and if a filter match occurs. In programs using 
several filters to trap or store the frames into memory, this 
display makes it easy to see what filters have been matched in 
a group of captured frames. 

The filter field function is described earlier in this chapter in 
the Default Display Description section. 

Different types of frames errors can occur during 
transmission. Having all the frames error status listed in a 
column makes it convenient to scroll the frames to look for 
frame errors. Types of frame errors that can be displayed are 
described in "Default Display Description" in this section. 
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SELECTING FRAME DISPLAY FORMAT (cont.) 

<Filter Format> displays the headers you have selected, the fields of the filter 
you select, followed by the frame's data field. 

1 #1 

2 

The default filter format is the first filter matched. To select 
the filter for examining frames, press: 

<Select Format> 
<Filter Format> 
<OTHER CHOICES> 
<Change Filter> (Press filter softkey label) 

Filter fields of the filter you select are displayed above the 
data field. The first three fields of each filter are not 
displayed again since they are always Address and 
Type/Length fields. The first three filter field contents can be 
seen by selecting Ethernet or IEEE 802.3 header softkeys. 

Mar 9@ 6:10:34:55533 Len 61 Filters 0123 ............ No error 
Destination 01·23·45·67·89·AB Source FE·DC·BA·99·76·54 .!:iE! OA·OB 

3 data·filter1 30-30-30-31 0001 
4 

5 

6 

7 

15 54·68·69·73·20·69·73·20·46·72·61·6D·65·20·4E·75·6D 
32 62·65·72·20·30·30·30·31·27·73·20·44·41·54·41·20·46 
49 49·45·4C·44·20·63·6F·6E·74·65·6E·74·2E 

This is Frame Num 
ber 0001's Data F 
ield contents. 

23 Detailed Summary Filter Show Node Show Hex OTHER EXIT 

24 Format Format Format* Names Addresses CHOICES 

Figure 19-3. <Filter Format> Display. 

In the example above, notice in line l that field "Filters: 
0123 ............ " indicates four filters have been defined and have 
been matched by frame #I. 

The details of the first filter matched in the frame are 
displayed below the header. Line 3 shows the field defined in 
Filter 0. 
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SELECTING FRAME DISPLAY FORMAT (cont.) 

<Filter Format> 
(cont.) 

If the frame does not match any defined filter, message: 
"No filter matched" is displayed below the header lines. 

The example below illustrates a frame with <Filter Format> 
selected. In addition, other display format softkeys are 
selected. 

#1 

<Physical Header> 
<Ethernet Header> 
<802.2 Header> 
<Filter Format> 

displayed in line l 
displayed in line 2 
displayed in line 3 
displayed in lines 4-16 

Apr 1 @ 1:23:45.67890 Len 1514 Filters 01xx ............ No error 
2 

3 
4 
5 

6 

7 

8 
9 

Destination 01·23·45·67·89·AB Source FE·DC·BA·99·76·54 ~ OA·OB 
DSAP 54 SSAP 68 Control 69·73 

datafield 1 61·62 ab 
dataf ield 2 63·64 cd 
dataf ield 3 65·66·67·68 efgh 
dataf ield 4 
dataf ield 5 
dataf ield 6 

10 dataf ield 7 
dataf ield 8 11 

12 dataf ietd 9 
13 dataf ield 10 
14 datafield 11 

69·6A·6B·6C 
6D·6E·6F 
70·71 ·72·73·74 
75·76·77 
78·79·7A 
30·31·32·33·34 
35·36·37·38·39 
41·42-43-44-45-46·47·48 

15 dataf ield 12 49·4A·4B·4C 
16 dataf ield 13 4D·4E·4F 

i j kl 
mno 
pqrst 
uvw 
xyz 
01234 
56789 
ABCDEFGH 
IJKL 
MNO 

17 19 61·62·63·64·65·66·67·68·69·6A·6B·6C·6E·6F·70·71·72 
18 36 73·74·75·76·77·78·79·7A·30·31·32·33·34·35·36·37·38 
19 53 00-00·00·00·00·00·00·00·00· .... 

abcdefghijklmnop 
tuvwxyz123456789 
0000 ... 

20 
21 
22 
23 Detailed Summary Filter Show Node Show Hex OTHER EXIT 
24 Format Format Format* Names * Addresses CHOICES 

'------------------------------------------------------------------~ 
Figure 19-4. <Filter Format> With 13 Data Field filters. 
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SELECTING FRAME DISPLAY FORMAT (cont.) 

<Filter Format> 
(cont.) 

The previous example shows 13 filter fields and 3 lines of the 
Data Field. Since <Edit Filters> Menu lets you define up to 29 
filter fields in the Data Field, the Data Field contents may not 
be shown on the display. If 16 filter fields are defined, no line 
of data is displayed. To see past the 16th filter field and to see 
the Data Field, use the cursor keys to scroll the display. 

A label is displayed for each defined filter field. In addition, 
the characters located in each filter field are displayed in Hex 
along with the equivalent character. 

The equivalent character for the filter field is displayed in the 
last selection made between ASCII 7, ASCII 8, or EBCDIC. 
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SELECTING FRAME DISPLAY FORMAT (cont.) 

In each of the frame display formats, the Destination and Source Addresses can be 
displayed in either hexadecimal or as a functional node name. 

<Show Node 
Name> 

softkey displays any node address as a functional 
node name. 

The node name must be defined in the <Edit Nodelist> Menu. 
This softkey is available under the <Setup 497 lS> Menu. 

If the node name is not defined, the name is displayed in hex. 

An example of node names versus the Hexadecimal address is 
shown below: 

Hexadecimal 
Address 

08-AB-00·23-01-02 

66·CD·21·43·01·01 

08-AB-OO·XX·XX·XX 

Node 
Name 

Print_Server1 

JohnB 

al l_pr inters 

Notice that the node name can identify a device, the principal 
user at a nod~, or, by using a common prefix and don't cares 
(xx-xx), it can group nodes with common prefixes. 

<Show Hex Names> displays the node station as a six byte Hexadecimal address. 
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Selecting Frame Header Formats 

Each frame is displayed by the protocol analyzer with up to three headers. The first 
header is a physical header created by the protocol analyzer. The second header is the 
IEEE 802.3 or Ethernet header. The third header is for IEEE 802.2 protocol. 

The format used to display frame headers can be changed by softkeys. 

Softkeys used to control frame header formats include: 

<Change Headers> 

<Suppress Headers> 

<Physical Header> 

<Ethernet Header> 

<802.3 Header> 

<802.2 Header> 
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FRAME HEADER FORMATS (cont.) 

<Change Headers> softkey presents a softkey selection that is used to control the 
header display. 

<Suppress Headers> With <Suppress Headers> softkey selected, all physical headers 
and protocol headers are removed from each frame in the 
display. 

1 #1 

The example below shows a frame with all the headers 
removed. Lines l and 2 now contain the frame number and 
Data Field contents. The Destination Address, Source address, 
Length/Type, and Error fields are not displayed. 

2 15 54-68·69·73-20·69-73-20·46-72·61-6D-65·20-4E-75-6D 
3 32 62·65-72·20·30·30·30·31·27·73·20·44·41·54·41·20-46 
4 

5 

49 49-45·4C-44·20·63·6F-6E·74·65-6E·74·2E 

This is Frame Num 
ber 0001's Data F 
ield content. 

20 
21 
22 
23 Suppress Physical Ethernet 802.3 802.2 

Header 24 Headers* Header Header Header 

Figure 19-5. <Suppress Headers> Softkey Selection. 
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FRAME HEADER FORMATS (cont.) 

<Physical Header> The physical header contains information generated by the HP 
4971S about each frame stored in the Receive Buffer. 
Included in the physical header are: 

#1 

Time Stamp 
Calculated frame length 
Filters 
Errors 

Mar 9@ 6:10:34.55533 Len 61 Filters 0 ............... No error 
2 15 54-68-69-73·20·69-73-20-46-72-61-6D-65-20-4E-75-6D This is Frame Num 
3 32 62-65-72-20-30-30-30-31-27-73-20-44-41-54-41-20-46 ber 0001 1 s Data F 
4 

5 

6 

49 49-45-4C-44-20-63-6F-6E-74-65-6E-74-2E 

21 
22 
23 Suppress Physical Ethernet 802.3 
24 Headers Header* Header Header 

802.2 
Header 

ield content. 

Figure 19·6. <Physical Header> Softkey Selected. 

EXIT 

W'ith only <Physical Headers> header softkey selected, only the information added by 
the protocol analyzer is displayed. This header includes the physical description of the 
frame. Elements displayed are: Timestamp, calculated length of information fields, 
filters status, and error status. 
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SELECTING FRAME HEADER FORMATS (cont.) 

<Ethernet Header> 

<802.3 Header> 

The <Ethernet Header> softkey selects the Ethernet header for 
the display. This softkey is illustrated in figure 19-1. Ethernet 
displays use a "Type:" field for bytes 13 and 14. 

Ethernet displays also include the Destination Address and 
Source Address fields. 

IEEE 802.3 header is similar to Ethernet header, however, 
IEEE 802.3 uses a "Length:" field for bytes 13 and 14. 

<Ethernet Header> and <802.3 Header> softkeys toggle with each other. Selecting one 
cancels the other's display. Only one of these headers may be displayed at a time. 
Pressing the softkey that is active turns that function off and if the other header 
softkey is not pressed, neither header is displayed. 

#1 Destination 01·23·45-67·89-AB Source FE-DC·BA-99-76·54 Length OA·OB 
2 15 54-68-69·73-20·69-73·20-46·72·61·6D-65-20·4E·75·6D This is Frame Num 
3 32 62·65·72-20·30-30-30-31-27-73-20·44-41-54-41-20·46 ber 0001 1 s Data F 
4 

5 

21 
22 

49 49-45-4C-44-20-63-6F-6E·74·65·6E·74-2E 

23 Suppress Physical Ethernet 802.3 
24 Headers Header Header Header* 

802.2 
Header 

ietd content. 

Figure 19-7. <802.3 Header> Softkey Selection. 
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FRAME HEADER FORMATS (cont.) 

<802.2 Header> 

DSAP 

SSAP 

Control 

<802.2 Header> information is positioned in the first 3-4 bytes 
of the Data Field and contains the following information: 

DSAP (Destination Service Access Point) 
SSAP (Source Service Access Point) 
Control 

Byte 15 in the Data Field is labeled Destination Service Access 
Point address. This address references a specific protocol used 
within the device identified by the Destination Address. 
The DSAP field is displayed in hex. 

Byte 16 in the Data Field is labeled Source Service Access 
Point address. Similar to DSAP, this address references a 
specific protocol used within the device identified by the 
Source Address. 
The SSAP field is displayed in hex. 

The Control field, as it name implies, is used to control the 
communications between the processes or applications 
contained at the Destination and Source addresses. 

The Control field is also displayed in hex and may be either 
or 2 bytes. The 2 least significant bits of byte 17 determine if 
the protocol analyzer will display 1 or 2 bytes in the Control 
field. 

Byte 17 Byte 18 

MSB LSB MSB LSB 
xxxx xx 11 xxxx xxxx 

When the two least significant bits of byte 17 are l's, the 
protocol analyzer will display one byte for the Control Field. 
This determines whether the data field begins with byte 18 or 
19. 
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FRAME HEADER FORMATS (cont.) 

Control 
(cont.) 

Examples of control field contents include: 

Connection requested 
Connection accepted 
Connection denied 
Connection busy 

Confirmation of messages sent or received 

8 6 6 2 1- 2 46-1500 4 

1_1_1_1_._, 
Preamble Dest Source Type I I I Data FCS 

I I !_Control 

I l __ SSAP 

I DSAP 

The following example uses only the 802.2 header. Notice in the example below that 
the Control Field is two bytes and the Data Field starts at byte J 9. 

1 #1 
2 19 
3 36 

DSAP 54 SSAP 68 
20·69·73·20·46·72·61·6D·65·20·4E·75·6D·62·65·72·20 
30·30·30·31·27·73·20·44·41·54·41·20·46·49·45·4C·44 

4 
5 

53 20·63·6F·6E·74·65·6E·74·2E 

21 
22 
23 Suppress Physical Ethernet 802.3 
24 Headers Header Header Header 

802.2 
Header* 

Control 69-73 
is Frame Number 

0001 1 s Data Field 
content. 

EXIT 

Figure 19-8. <802.2 Header> Softkey Selection 
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Selecting Datafield Character Formats 

The information in the data fields can be presented in several formats. The data field 
can be suppressed from the display but is still available in the Receive Buffer. Also, the 
format of the data characters may be selected from a variety of choices. 

The softkey choices for data fields include: 

<Change Datafield> 

<Suppress Data> 

<Hex Data> 

<Character Data> 

<Hex/Char Data> 

<Select Data Code> 

<ASCII 7> 

<ASCll 8> 

<EBCDIC> 
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DATAFIELD CHARACTER FORMATS (cont.) 

<Change 
Datafield> 

softkey changes the softkey selections to let you select 
different formats for characters in the data field. 

<Suppress Data> The entire data field can be suppressed or deleted from the 
display by pressing the <Suppress Data> softkey. Whatever 
data field had been displayed is now removed. If physical 
header, frame header, and data fields had been displayed, 
pressing <Suppress Data> leaves only the physical header and 
frame header displayed. 

2 
3 
4 

#1 

5 #2 

6 

20 
21 
22 
23 Suppress 
24 Data * 

In the example below, notice that only selected header 
information is displayed. 

Mar 9@ 6:10:34.55533 Len 
Destination 01·23·45·67·89-AB 
DSAP 54 

61 Filters 0 ............... No error 
Source FE·DC·BA-99·76·54 .!.i:E! 00·53 
SSAP 68 Control 69·73 

Mar 9 Ql 6:10:34.55533 Len 61 Filters 0 ............... No error 

Hex 
Data 

Character Hex/Char 
Data Data 

Select 
Data Code 

Figure 19-9. <Suppress Data> Softkey Selected. 
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DATAFIELD CHARACTER FORMATS (cont.) 

<Hex/Char Data> 

<Hex Data> 
<Character Data> 

In the default <Examine Data> Menu, the data field is 
displayed below the header fields in two formats. The data is 
displayed in Hexadecimal format on the left side of the line 
with the interpreted data displayed on the right side of the 
same line. 

When <Character Data> or <Hex Data> softkeys are pressed, 
the data field is displayed only in that selected format. The 
equivalent data field is not displayed. 

These character formats are convenient since longer lines can 
be used to display the Data Field contents. <Character Data> 
formats display 73 characters per line while <Hex Data> 
format displays 24 characters per line. 

The example below shows the display with <Character Data> 
softkey selected. The data is presented only in the equivalent 
character format with no Hexadecimal equivalent display. 

1 #1 May 3 @12:21:03.24446 Len 167 Filters 1 ............... No error 
2 Destination 01·23·45·67·89·AB Source FE·DC·BA·99-76·54 Length 00·53 
3 15 This is an example with <Character Data> softkey selected. Notice that 
4 88 no equivalent Hex characters are presented on the right side of the d 
5 161 isplay. 
6 

20 
21 
22 
23 Suppress 
24 Data 

Hex 
Data 

Character Hex/Char Select 
Data * Data Data Code 

Figure 19·1 o. <Character Data> Display. 
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DATAFIELD CHARACTER FORMATS (cont.) 

<Select Data 
Code> 

<ASCII 7> 

softkey lets you choose the character code. 
The choices are: 

<ASCII 7> 
<ASCII 8> 
<EBCDIC> 

The default display described in the section "<Examine Data> 
Display" at the first of this chapter is an example of the two 
column data format. The data is first presented in 
Hexadecimal code and then in the equivalent selected code of 
ASCII or EBCDIC. Seventeen characters are displayed in each 
line with either of these combined character protocols 
selected. 

ASCII 7 
No Par 

ASCII 7 
Par= 0 

ASCII 7 
Par= 1 

ASCII 7 
Odd Par 

ASCII 7 
Even Par 

The parity bit is ignored. 

The parity bit is always 0. 

The parity bit is always 1 

The parity bit is set to always provide an 
odd number of bits in the byte. 

The parity bit is set to always provide an 
even number of bits in the byte. 
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Displaying Data In Filter Formats 

You can display frames in the format of filters you have defined in <Edit Filters> 
Menu. Use the following softkeys to select the filter used to display frames: 

<Change Filter> 

<Select Format> 
<Filter Format> 
<OTHER CHOICES> 
<Change Filter> 

softkey displays softkey choices for the filters you have 
defined in <Edit Filters> Menu. 

The default filter format is the first filter matched. To select 
the filter format, press any displayed softkey containing a 
filter name. 

<Use first Matched> 

<Filter_O> 

<Filter 1> 

If you have several filters defined, <Use first Matched> 
softkey displays a frame in the filter format of the first 
filter to be matched by that frame. 

lets you manually change the frame display format to 
that of another filter even if the filter did not 
specifically match that data frame. 

Softkeys are displayed for each of the filters defined in 
the <Edit Filters> Menu. You can display any frame in 
the format of a defined filter. 
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Selecting Timestamp Measurements 

The HP 49715 can perform measurements that reference the time when frames were 
received into the protocol analyzer. When each frame is received into the HP 497 lS, 
each frame is tagged with the date and time. Measurements using this timestamp 
function can be made with 32 microsecond accuracy. 

The timestamp softkey functions detect the start and stop points of frames. Timestamp 
softkey descriptions use the following conventions for start and stop points of frames: 

Sta'1 of Frame 
refers to the beginning of the Destination Address Field in a frame. 

End of Frame 
refers to the end of the FCS Field in a frame. 

Examples of timing measurements that you can measure include: 

What date/time did the message occur on the network? 

How much time occurred from when the run is started to when each frame 
is received? 

How much time occurred between two specific frames being received? 

With some frame identified as a reference point, what is the time 
relationship of all frames received before or after the reference frame? 
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TIMESTAMP MEASUREMENTS (cont.) 

The softkeys used to make timestamp measurements include: 

<Change 
Time stamp> 

<Change Timestamp> 

<Date/Time> 

<Time from Start> 

<Time from Frame #> 

<Time from Trigger> 

<Time btwn Frames> 

soft key changes the softkey selection to display sof tkeys used 
for timestamp measurements. 

The protocol analyzer causes the date and time of day to be 
transparently added to each frame as it is received. This 
timestamp enables the following measurements: 

<Date/Time> 

<Time From Start> 

<Time from Frame #> 

<Time from Trigger> 

<Time btwn Frames> 
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TIMESTAMP MEASUREMENTS (cont.) 

<Date/Time> 

<Time from 
Start> 

is the default softkey for <Examine Data> Menu. It causes the 
timestamp field in each frame's physical header to display the 
date and time that each frame occurred on the network. 

The timestamp displayed in the physical header is referenced 
to the date and time you enter via the <Set Date> and <Set 
Time> softkevs at power on. 

The display format for <Date/Time> softkey is: month, day, 
hour, minute, second 

Mar 9 @ 6:10:34.55533 

In a free run or continuous store application, the timestamp 
functions for approximately 1.5 days. After 1.5 days of 
continuous storage, the protocol analyzer stop$ and displays 
the message: 

** Timestamp Overflow ** 

A new run must be started in order to start the timestamp 
function again. 

The clock is reset each time a run is started and is stopped 
when the run is stopped. 

causes the timestamp field in each frame's physical 
header to contain: 

The elapsed time measured from the run start to when 
each frame was received. 

Frames have an elapsed time entered in the field: 

Elapsed 00:00:01.67543 
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TIMESTAMP MEASUREMENTS (cont.) 

<Time From 
Frame#> 

<Time From 
Trigger> 

prompts you to identify a particular frame number 
and the timestamp is set to zero for that frame time. 

This softkey causes the timestamp field in each frame's 
physical header to display: 

The elapsed time from the start of the reference frame 
to the start of the displayed frame. 

Frames received before the reference frame have a (-) sign 
preceding the number to show negative time. 

In the following example, frame #3 has been selected as the 
reference frame: 

#1 Elapsed· 0:00:01.99978 

#2 Elapsed · 0:00:00.99987 

#3 Elapsed 0:00:00.00000 

#4 Elapsed 0.00.00.87241 

lets a frame matching a filter or combination of filters 
be specified as a trigger reference point. 

This soft.key causes the timestamp field in each frame's 
physical header to display: 

The elapsed time from the start of the trigger frame to the 
start of the displayed frame. 
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TIMESTAMP MEASUREMENTS (cont.) 

<Time From 
Trigger> 
(cont.) 

<Time btwn 
Frames> 

A trigger frame is the frame identified in <Edit Programs> 
to control the Store function: 

<Starting With> 

<Centered About> 

<Ending With> 

Only one of these functions can be used in each program. 
Whichever function is used, that frame is referenced to zero 
for <Time From Trigger> measurements. 

causes the timestamp field in each frame's physical header 
to display: 

The elapsed time from the end of the previous frame to 
the start of the next frame. 

The end of the previous frame is after the last byte of the FCS 
field. 

In <Time btwn Frames> mode, the timestamp in the first 
frame contains the time from the start of the run to the start 
of the first frame. 
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Selecting Timers And Counters 

In addition to displaying the contents of the captured frames, the <Examine Data> 
softkey lets you view the timers and counters available in programs you can create. 

<Timers & 
Counters> 

softkey displays the labels and contents of all 16 counters 
and all 16 timers. This display shows the contents of the 
counters and timers that existed when a program run was 
halted. To update or refresh the display, repeat a <Run From 
Network> or <Run From Buffer> function. 

When names have been assigned to either the timers or counters in <Edit Programs> 
Menu, the assigned names are also displayed in the <Examine Data> Menu. 

COUNTERS TIMERS 
.. .. .. .. "' -...... - .......... -- ......... .. - ........................ -- ..................... 

Counter 0 0 Timer 0 0.00 ms - -
Counter 1 = 0 Timer 1 = 0.00 ms - -
Counter 2 = 0 Timer 2 = 0.00 ms - -
Counter 3 0 Timer _3 0.00 ms -
Counter_4 = 0 Timer 4 0.00 ms 
Counter 5 = 0 Timer 5 = 0.00 ms - -
Counter_6 0 Timer_6 = 0.00 ms 
Counter 7 = 0 Timer 7 = 0.00 ms - -
Counter_8 = 0 Timer_8 = 0.00 ms 
Counter_9 = 0 Timer 9 0.00 ms 
Counter_A 0 Timer_A 0.00 ms 
Counter B = 0 Timer B 0.00 ms - -
Counter c = 0 Timer c = 0.00 ms - -
Counter D = 0 Timer_D 0.00 ms 
Counter_E = 0 Timer E 0.00 ms -
Counter F 0 Timer F = 0.00 ms -

Return EXIT 
To Data 

Figure 19-11. <Timers & Counters> Menu Display. 
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Displaying Frame Errors 

The HP 4971S LAN protocol analyzer displays several types of frame errors that may 
occur. This section reviews the IEEE 802.3 frame format and also describes the possible 
causes of frame errors that can be displayed. 

Frame Error Field 

" 1 #1 Mar 9@ 6.10.34.55533 Len 61 Filters 0 ............... Nd err~r 
2 Destination 01·23·45·67·89·AB Source FE·DC·BA·99·76·54 ~ OA·OB 
3 15 54·68·69·73·20·69·73·20·46·72·61·6D·65·20·4E·75·6D This is Frame Num 

IEEE 802.3 Frame Protocol 

The IEEE 802.3 standard specifies a message frame as: 

Dest Source Length/ 
Preamble Add rs Add rs Type Data Field FCS 

1_1 1 __ 1 
8 6 6 2 46 .. 1500 4 

I< .......•... Min length is 64 bytes . ............ ·I 
I I 
I< ........... Max Length is 1518 bytes ............. >I 

Minimum Maximum 
IEEE 802.3 IEEE 802.3 
Length Length 

6 Dest Addrs 6 
6 Source Addrs 6 
2 Length/Type 2 

46 Data field 1500 
4 FCS field 4 

64 bytes 1518 bytes 
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DISPLAYING FRAME ERRORS (cont.) 

IEEE 802.3 Preamble 

IEEE 802.3 specifies that the Preamble have a 64 bit synchronization pattern of alter
nating l's and O's ending with two consecutive J's. The information immediately fol
lowing the last synchronizing byte is grouped into the frame elements: Destination 
Address, Source Address Length/Type Field, Data Field, and FCS. 

In actual practice, preamble length can vary between different network systems. The 
<Hardware Functions> Menu lets you choose different preamble lengths of 16, 32, 64, 
or 128 bits for HP 497 lS transmissions. 

Types Of Frame Errors 

Several types of errors can be detected by the HP 497 lS and displayed in the <Examine 
Data> Menu. Definitions and possible causes of frame. errors are listed on the follow
ing pages. 

Runt Frames 

Jabber Frames 

Misaligned Frames 

Corrupt Data Frames 

Bad CRC Frames 
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DISPLAYING FRAME ERRORS (cont.) 

RUNT FRAMES 

Definition 

Possible Causes 

A frame that is too short. It has less than the 60 bytes re
quired by IEEE 802.3 for the Destination Address through 
Data fields. 

"Runt" frame label is displayed in the Error Field of the <Ex
amine Data> Menu when frames have less than 60 bytes for 
Destination Address through Data fields. 

1. Frame collisions can cause Runt Frames. NormalJy, frame 
collisions occur very early in the frame transmission, well 
before the 512 bits needed before the protocol analyzer 
can receive the frame. 

2. The transmitting station sent a Data Field with less than 46 
bytes. 

3. Runt frames can also be caused by late collisions either 
because a node is not transmitting according to IEEE 802.3 
format or the network is physically too large. 
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DISPLAYING FRAME ERRORS (cont.) 

JABBER FRAMES 

Definition 

Possible Causes 

A frame that is too long; it has more than 1514 bytes in the 
information fields; Destination Address through Data fields. 

l. The transmitting station is not transmitting within specs. 

2. A MAU on the network has failed and is putting out 
garbage. 
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DISPLAYING FRAME ERRORS (cont.) 

MISALIGNED FRAME 

Definition 

Preamble 

Possible Causes 

A frame that has a total number of bits in the frame that is 
not divisible by 8 and also has a FCS error. 

The FCS error is usually caused by the uneven number of bits. 

Dest 
Add rs 

Source Type 
Addrs Field 

Data 
Field 

FCS 
(CRC) 

____ 1 •••• 

. I 
normal I 

FCS I 
position I 

I 
I 

FCS is assumed to be 
last 4 bytes on 
the frame. Ringing 
bits can cause the 
FCS to ~ to be 
displaced. 

1. Hardware impedance mismatch causes ringing on the 
network. 

2. The transmitting station may have sent the extra bits. 
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DISPLAYING FRAME ERRORS (cont.) 

CORRUPT DATA 

Definition 

Possible Causes 

Displayed when a possible error occurred in the message inside 
the protocol analyzer due to heavy network traffic conditions 
with frequent jabber frames occurring. 

1. Excessive number of jabber frames 

2. Hardware failure in the HP 497 lS. 
(Execute the Self-Test) 
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DISPLAYING FRAME ERRORS (cont.) 

BAD FCS 

Definition 

Possible Causes 

Displayed when the FCS error check generated inside the HP 
497 lS does not match the FCS field transmitted by the Source 
Address. 

1. Ringing on end of message for exactly eight bits. 

2. Frame disturbed during transmission. 

3. The transmitter may be defective or have a bad MAU. 

4. Sy.stem noise due to improper grounding of network 
cable. 
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20 
< Printer Functions > MENU 

This chapter describes the softkeys used to control printer functions with the HP 497 IS 
system. 

This chapter includes: 

• <Printer Functions> Softkey Selections 

• Getting Top Of Forms 

• Stopping The Printer 

• Selecting The Printer 

• Printing The Node List 

• Printing Filters 

• Printing Messages 

• Printing Programs 

• Printing Data 

• Print The Screen 

• <Printer Functions> In Remote Mode 
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Printer 

< Printer Functions > Softkey Selections 

Functions 

Select 

Print 

Print 

Print 

Print 

Print 

Printer 

Nodes 

Filters 

Messages 

Programs 

Data 
Range of F ram1es 
Single Frame 
Marked Frames 
All Frames 
Print the List 

The <Printer Functions> Menu lets you have printed copies of received frames, the 
protocol analyzer's setup configuration and the current screen contents. 

You can print frames stored in the protocol analyzer's buffer memory. You are able to 
select and print only the frames that interest you. 

You can also print the protocol analyzer setup configuration. The setup configuration 
includes: 

Node list 

Filters 

Messages 

Programs 

ex; t Menu Finally, you can "print the screen" which includes all the characters shown on the HP 
497 IS display. 
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Getting Top Of Forms 

The HP 497 lS is intended to work with the HP 2225A ThinkJet Printer. 

The protocol analyzer controls the printer so that it prints 60 lines of text and then 
spaces 6 lines. If you position the top of the form correctly, you have 3 blank lines at 
the top of the form and 3 blank lines at the bottom of the form. 

Position the form 

You should set the top of the form to the fourth line on the page, to leave a top 
margin of 3 lines or l /2 inch. 

To set the top of the form to the fourth line: 

Use the Line Feed (LF) button to position the paper so that the page perforation 
is just above the pinch rollers. 

After the top of form is positioned, press the blue button on the control panel to 
reinitialize the printer. 

Experiment with positioning the paper for several printouts to determine the correct 
position for your application. 

The protocol analyzer does not sense the perforations on the forms; it continues to 
print 60 lines and space 6 lines. If you use the line feed button to advance the page, the 
text is not centered on the page. If you want to advance the page and maintain text 
centering, use the Form Feed (FF) button on the control panel. 
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Stopping The Printer 

As each request for printed copies is being printed, the message Printing is 
displayed. 

The print operation may take several minutes if long lists of frames, programs, filters, 
messages, or node lists are to be printed. 

You can stop the printer if you decide the list being printed is not what you want or it 
will take too long to print. While the list is being printed, the softkey <Abort 
Operation> is displayed. Press <Abort Operation> to stop the print function. 

<Abort Operation> softkey stops the printing operation after the current file in 
the printer buffer is printed. The protocol analyzer displays 
the message: 

Printer operation aborted by the user. 

The printer does not stop printing immediately after the 
<Abort Operation> softkey is pressed. Printing continues until 
current data stored in the printer buffer has been printed. The 
printer buffer can hold approximately one page of printed 
text. 
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<Select Printer> 

Selecting The Printer 

softkey causes the protocol analyzer to establish its link with 
the printer. If the link is successful, the protocol analyzer 
displays: 

Local Printer is selected and initialized. 

If the link is not successful, the protocol analyzer displays: 

THERE IS NO COMMUNICATION WITH THE PRINTER. 

If this occurs, check the following: 

1. Is the HP-IB cable connected? 

2. Is the printer's HP-IB switch set to address 1? 

If the switch has to be changed to 1, cycle the printer 
power switch off and back on. 

For information about <Select Printer> fur.11;;tions in 
Master/Slave operation, see <I/0 Functions> chapter. 
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<Print Nodes> 

Printing The Node List 

causes the printer to output a listing of the nodes identified in 
the <Edit Nodes> Menu. 

Up to 1000 nodes can be defined. Press <Print Nodes> softkey 
to begin printing the defined node list and display the message: 

Printing. 

Example of <Print Nodes>: 

NETWORK NAME : Network_O Network TYPE : ETHERNET 
NODE # NODE NAME NODE ADDRESS BUS POSITION 

HP LAN Analyzer 08-00·09-XX·XX·XX 0 

All the nodes defined in <Edit Nodes> Menu are printed. 

Press <Abort Operation> softkey to stop printing before the 
complete list is printed. See <Abort Operation> description on 
page 20-4. 
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Printing Filters 

<Print Filters> causes the printer to print a listing of the filters defined in the 
<Setup 497 lS>, <Define Filters> softkey menus. 

If a fitter has been defined in <Edit Filters> Menu, all the 
details of that filter are printed when <Print Filters> softkey is 
executed. 

All of the 16 possible filters you create are printed. 

Press <Print Filters> softkey to begin printing the filters list 
and display: 

Printing. 

An example of <Print Filters> sof tkey is shown below: 

FILTER #0 Label: Filter_O MINIMUM Frame Length 51 
MAXIMUM Frame length = 2022 

BYTE 

7 
13 

15 

Frame Traits: REJECT Frame with GOOD FCS 
REJECT Frame with BAD FCS 
REJECT MISALIGNED Frame 
REJECT RUNT Frame 

FIELD LABEL FIELD DATA 

DESTINATION 
SOURCE 
TYPE 
DATA 

XX·XX·XX·XX·XX·XX 
XX·XX·XX·XX·XX·XX 
xx-xx 
xx 

Node Name: Not Defined 
Node Name: ·· Not Defined 

The printer inserts a ...... symbol before and after characters 
declared as "Not" characters in your filter definition. 

Press <Abort Operation> softkey to stop printing before the 
complete list is printed. See <Abort Operation> description on 
page 20-4. 

<Printer Functions> Menu 20-7 



<Print Messages> 

MESSAGE 0 

Printing Messages 

causes the messages created in <Edit Messages> Menu to be 
printed. 

The protocol analyzer causes the printer to print all the 
messages you have created. Up to 16 user created messages are 
possible. 

Press <Print Messages> softkey to begin printing and display 
the message: 

Printing. 

An example of <Print Messages> follows: 

FCS VALUE: Good MESSAGE Label: MESSAGE_O 
FRAME Length: 60 Bytes 

BYTES FIELD LABEL HEX DATA 

1 ••••• 6 DESTINATION 
7 •••. 12 SOURCE 

00·00·00·00·00·00 Node Name: Not Defined 
08·00·09·00·0A·44 Node Name: HP LAN Analyzer 
00-00 
00·00·00·00-00-00·00·00·00·00·00·00-00·00·00 
00·00·00·00·00-00-00·00-00·00·00·00·00-00·00 

13 •.•• 14 TYPE 
15 .••. 29 DATA 
30 •••• 44 

Press <Abort Operation> softkey to stop printing before the 
complete list is printed. See <Abort Operation> description on 
page 20-4. 
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<Print Programs> 

Printing Programs 

softkey lets you print a selected program created in <Setup 
4971S>, <Edit Programs> Menus. Up to five programs can be 
created in the <Edit Programs> Menu. 

Press <Print Programs> softkey to display softkey choices for 
existing programs. Press a softkey for the program you want 
printed. 

The example below shows the default Program_O that is 
printed when you do not have a program of your own 
created: 

Usting of program 11 Program_0 11 

Store: all frames 
until full 

Log file: not used 

Block 1: 

Press <Abort Operation> softkey to stop printing before the 
complete list is printed. See <Abort Operation> description on 
page 20-4. 
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<Print Data> 

Printing Data 

softkey lets you get printouts of frames you have captured in 
the protocol analyzer's memory. 

You do not have to print a11 frames in the protocol analyzer 
memory. In order to save time and print only the frames you 
want, the protocol analyzer provides softkeys to choose whnt 
frames you want printed. 

Press <Print Data> softkey to display the following softkey 
choices for printing frames: 

<Range of Frames> 
<Single Frame> 
<Marked Frames> 
<All FrameS> 
<Print the List> 

Each frame chosen is printed in the format you currently have 
selected in the <Examine Data> Menu. 

<Print Data> softkey displays the following table for choosing 
what frames to print: 

FRAMES IN THE LIST (15 elements maximum) : 

1. 
2. 

15. 

You can select up to 15 combinations of; All Frames, Range 
of Frames, Marked Frames, and Single Frames to be printed. 
The same frame(s) may be printed in different groupings of 
frames. 

After you have selected all of the combinations that you want, 
press <Print the List> softkey. 

<Printer Functions> Menu 20-10 



<Print Data> (cont.) 

<Range of Frames> 
lets you choose a range of consecutively numbered frames to 
be printed. Press this softkey to display: 

FRAMES IN THE LIST {15 elements maximum) 

1. RANGE OF FRAMES FROM # ___ .....;..1 TO # 

Enter the f ifst frame number. 

From the keyboard, enter the first number of a range of 
frames you want printed. If you decide your range of frames 
entry is wrong, press CLEAR LINE or DELETE CHAR to 
clear the field. Enter the new number and press RETURN 
key to complete the entry. If you decide not to enter a range 
of frames, press <EXIT> softkey to delete that current element 
from the list. 

The protocol analyzer displays: Enter last frame number. 
Again from the keyboard, enter the last number for the range 
of frames you want printed. Press RETURN key to complete 
the entry. 

To quickly find the last frame number in the protocol 
analyzer's memory, enter 9999999 and press RETURN key. 
The protocol analyzer displays the last available frame. 

You may enter up to 15 different ranges of frames to be 
printed. 

After you have selected all the combinations that you want, 
press <Print the List> softkey to start printing and display: 
Printing. 

Press <Abort Operation> softkey to stop printing before the 
complete list is printed. See <Abort Operation> description on 
page 20-4. 
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Print Data> (cont.) 

<Single Frame> 
softkey lets you print a single frame that is stored in the 
protocol analyzer's Receive Buffer. 

Press <Single Frame> softkey to display: 

FRAMES IN THE LIST (15 elements maximum) 

1. Single Frame # ___ _ 

2. 

Enter single frame number. 

From the keyboard, enter the frame number of the single 
frame you want printed. If you decide the Single Frame entry 
is wrong, press CLEAR LINE or DELETE CHAR keys to clear 
the field. Enter a new number and press RETURN key to 
complete the entry. 

Up to 15 separate frames can be printed using the <Single 
Frame> softkey selection. 

After you have selected all the frame combinations you want, 
press <Print The List> to start the printing and also display: 
Printing. 

Press <Abort Operation> softkey to stop printing before the 
complete list is printed. See <Abort Operation> description on 
page 20-4. 
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<Print Data> (cont.) 

<Marked Frames> 
softkey lets you print only the frames you have marked in the 
protocol analyzer's memory. 

In <Examine Data> Menu, you can manually mark frames that 
are of interest to you. Also, in <Edit Programs> Menu, you 
can create a program to mark particular frames as they are 
stored in the Receive Buffer. 

Press the <Marked Frames> softkey to display: 

FRAMES IN THE LIST C 15 elements maximum) 

1. MARKED FRAMES 
2. 

Press <Print the List> softkey to begin printing marked frames 
in the Receive Buffer and display the message: Printing. 

If you enter <Marked Frames> more than once, you repeat 
printing a marked frame list as many times as you entered the 
softkey. 

If no frames have been marked in the Receive Buffer, the 
protocol analyzer returns to the <Print Data> Menu and 
displays the message: 

NO MARKED FRAMES IN BUFFER. 

Press <Abort Operation> softkey to stop printing marked 
frames before the complete list is printed. See <Abort 
Operation> description on page 20-4. 
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<Print Data> (cont.) 

YES 

<All Frames> 
softkey lets you print all frames currently stored in the 
protocol analyzer's memory. Press <All Frames> softkey to 
display: 

FRAMES IN THE LIST (15 elements max;mum) : 

1. ALL FRAMES 
2. 

After you have selected all the frame combinations you want, 
press <Print The List> to start the printing and also display: 
printing. 

Press <Abort Operations> softkey to stop printing before the 
complete list is printed. See <Abort Operation> on page 20-4. 

<Print The List> 
softkey is the execute key for <Print Data>. Press <Print the 
List> soft.key to begin printing whatever group of frames you 
have selected. The protocol analyzer prompts: 

Would you like to print the timers and counters also? 

NO EXIT 

Press <YES> softkey if you want to print tue data list and the 
timers and counters list. 

Press <NO> softkey if you only want to print the data list. 

Press <Abort Operation> softkey to stop printing before the 
complete list is printed. See <Abort Operation> description on 
page 20-4. 
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<EXIT> softkey lets you delete a current element you are defining in 
the list. 

When the <Range of Frames> or <Single Frame> softkeys are 
currently selected, you can press <EXIT> to delete that 
element from the list and then make another softkey selection 
to add another frame combination to the list. 

WARNING 

If you press <EXIT> with no Range of Frames or Single 
Frame entry field currently active for entry, the protocol 
analyzer deletes the entire frame list. 
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Print The Screen 

The HP 497 lS has an additional important printer function. You can print the current 
screen display simply by pressing SHIFT and PRINT keys at the same time. 

These keys can be used whenever you are in any menu except <Printer Functions>. 

This function lets you conveniently print a hard copy of whatever function you are 
editing or frames you may be viewing at that moment. 
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< Printer Functions > In Remote Mode 

When two protocol analyzers are used for remote operation and each location has a 
printer, you can get printouts at either the slave location or the master location. 

Selecting The Printer In Remote Mode 

After the remote link is established, use the following procedure to select the printer 
location. 

1. Press <Select Printer> softkey. 

2. HP 497 lS prompts: Select the MASTER or SLAVE. 

3. Press either the <MASTER> or <SLAVE> softkey for the printer location you 
want to use.I 

4. 

If a printer location is not specified, the system defaults to the slave printer when 
the remote link is established. 

HP 497 lS displays: ____ printer is selected. 
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21 
< Hardware Functions > Menu 

This chapter describes the menus and softkeys used to display the hardware 
configuration of the HP 4971A and to test hardware circuitry in the HP 4971A 
instrument. 

A self test is performed automatically at power on. The power-on self test is a subset 
of the self tests available in the <Test LAN Analyzer> Menu. 

The <Test LAN Analyzer> softkey lets you run the more extensive self tests. 

This chapter includes: 

• HP 4971A Hardware Functions Display 

• HP 497 LA Hardware Functions Descriptions 

• <Test LAN Analyzer> Self Tests 

• Running The Self Tests 
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HP 4971A Hardware Functions Display 

From the Top Level Menu, press the <Hardware Functions> softkey to display the 
menu shown below. 

LAN Address of this Analyzer: 08-00·09·00·1A·34 

Memory bytes available: XXXXXX (varies with system usage) 

LAN Receiver hardware: 
LAN Transmitter hardware: 
Dual Port RAM hardware: 
Deep Trapmachine hardware: 
Shallow Trapmachine hardware: 

Runt Frame filter: 

Receiver Buffer size: 

Transmitter preamble length: 

Execute Network File at power-on: 
Network file name: 

Installed 
Installed 
Installed 
Installed 
Installed 

enabled 

1SOO bytes 

M bits 

Yes 
AUTOEX 

Test LAN 
Ana l_yzer 

Enabled Disabled 
(Normal) 

Figure 21-1. <Hardware Functions> Menu. 
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HP 4971A Hardware Functions Description 

LAN Address of this Analyzer: 
This line displays the IEEE 802.3 address unique to your HP 
497 lS. This is the six byte address used in default Source and 
Destination Address fields of IEEE 802.3 and Ethernet 
protocols. 

Memory bytes available: 
shows how many bytes of RAM memory are available for use 
by the HP 497 lS. This is the memory space used for protocol 
analyzer functions such as editing the node list, programs, 
filters, and messages. The available memory display is updated 
dynamically during operation of the analyzer. 

LAN Receiver hardware: 
LAN Transmitter hardware: 
Dual Port RAM hardware: 
Deep Trapmachine hardware: 
Shallow Trapmachlne hardware: 

These are the hardware printed circuit boards that are used to 
perform the protocol analyzer functions of the HP 497 lS. All 
of these boards must be installed for the protocol analyzer self 
test to pass and for the protocol analyzer to function. 
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Runt Frame filter. lets you choose the minimum frame length for the protocol 
analyzer to accept. 

It is common for frames shorter than the IEEE 802.3 require
ment to occur on the network due to collisions. 

The HP 4971S can capture frames shorter than the IEEE 802.3 minimum length. You 
can choose between two minimum sizes of Runt frames to be captured. You can store 
frames with information fields as short as: 

Approx. 52 bytes ·· with Runt Frame Filter: Enabled 
( 38 bytes in the data field ) 

15 bytes ·· with Runt Frame Filter: Disabled 
( 1 byte in the data field ) 

IEEE 802.3 specifies that the minimum frame length should be 64 bytes from Destina
tion Address through the FCS Field (60 bytes in Dest. Addrs, Source Addrs, Type/ 
Length, and Data Fields). 

Dest. 
Preamble Addrs 

Source 
Add rs 

Length/ 
Typ·e Data Field 

FCS 
(CRC) 

----- ---- ____ ! __ !_______ -------- ____ I 
8 6 6 2 46-1500 4 I 

I 
l<······IEEE 802.3 specifies minimum length as 64 bytes -----... -.. -. >I 
I 
I 
I<· ---

I 
I 

60 bytes (Data Field = 46 bytes ) -- .. -->I 
These fields are referred to as "Information Fields" 
in this manual. 
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Runt Frame Filter: (cont.) 

Enabled 

Disabled 

In default mode, the Runt frame filter is enabled. The 
protocol analyzer discards frames with less than approx. 52 
bytes in the information fields ( at least 38 bytes in the data 
field). 

Very short frames can cause problems in HP 4971S hardware 
used to capture frames. In "Enabled" mode, the HP 497 lS 
avoids the hardware problems by discarding the frames with 
less than 52 bytes in the information fields. 

The "Disabled" mode is provided for unique or specific 
applications when you need to capture and view very short 
frame fragments. You should return to the "Enabled" mode 
when you are finished with your special measurement. 
"Enabled" mode provides complete integrity for received data. 

In "Disabled" mode, the protocol analyzer can store frames 
with as few as 15 bytes in the information fields (at least one 
byte in the Data Field). 

WARNING 

In "Disabled:" mode, hardware filters and data frames stored 
in the HP 4971$ can be corrupted. Data frames can also be 
missed. Use "Runt Frame Filter. Enabled" mode for normal 
operation. 

The error message, "CORRUPT DATA", is displayed in the 
<Examine Data> Menu if an error occurs in a frame while it is 
being received inside the analyzer. When short frames occur, 
HP 497 LS filters start being loaded, however, if the frame is 
discarded, the filter is not reset until the next complete frame 
is received. Until the next complete frame is received, 
received data frames can be corrupted, frame fragments can 
be missed without an error message displayed. 
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Receive buffer 
size: 

480 bytes 

lets you select the length of buffer used to store frames 
received from the network. 

The "480 bytes" mode is provided for unique or specific 
applications when you need to capture more than 655 frames 
in the HP 4971S receive buffer. We recommend you return to 
the "1500 bytes" mode when you are finished with your special 
measurement. 

During normal, low traffic (Less than 10-20<Yo) monitoring, if 
your network generally transmits shorter length frames, you 
can store more frames in memory by setting the buff er length 
to 480 bytes. 

WARNING 

When operated In "480 bytes" mode, data integrity problems 
can occur under high network loads. The following llst 
shows the two possible conditions when data Integrity 
problems can occur. 

1500 bytes 

1. During heavy network loads, when frame lengths slightly 
greater than 480 bytes occur, an extra character may be 
added to the frame by the protocol analyzer. When this 
happens, the frame is marked as "CORRUPT DAT A" in 
the <Examine Data> Menu. 

2. When frames are received with mm1mum interframe 
spacing, (9.6 us), there is a slight possibility that one of the 
frames or both frames may be corrupted by the protocol 
analyzer. lf a frame is corrupted, it is marked as 
"CORRUPT DATA". 

is the default length. Use this buffer size when you do not 
want to risk missing a frame in the protocol analyzer. 

1500 byte buff er length lets all frames passing the runt frame 
filter be stored without the risk of corrupt buffers. 
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The number of frames that can be stored in the HP 49715 receive buffer depend on 
two conditions: 

STORE METHOD USED RECEIVE BUFFER LENGTH 

Linear Storage 
Until Full 
Starting With 

Circular Storage 
Centered About 
Ending With 
Nonstop 

480 byte buff er 
1500 byte buff er 

480 BYTE BUFFER LENGTH 
LINEAR STORAGE CIRCULAR STORAGE 

1 

2046 FRAMES MAX 

CIRCULAR 
OVERHEAD~ 

1500 BYTE BUFFER LENGTH 
LINEAR STORAGE 

1 

655 FRAMES MAX 

CIRCULAR STORAGE 

NEWEST FRAME ~ 

CIRCULAR 
OVERHEAD~ 

Figure 21-2. Receive Buffer Storage. 
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Transmitter 
preamble 
length: 

Execute Network 
Fiie 

at power-on: 

Network file name: 

You can change the length of the preamble for messages 
transmitted the HP 4971S. Using different preamble 
lengths lets you test receive functions of stations on your 
network, for preamble length are: 

16 bits 
32 bits 
64 bits 
128 bits 

The HP 497lS can not receive frames with only 16 bits in the 

lets you choose whether or not you want to automatically 
execute a network file when the protocol analyzer is turned 
on. You can create network files that automatically loads a 
program and menus to perform tests you specify. 

See chapter, <Disc Functions> Menu, for more information 
about creating and saving network files. 

lets you choose the network file that is to be automatically 
loaded at power on. A default network file name, AUTOEX 
(AUTO EXecute), is used by the HP 497 lS. 

If you want to automatically load a file name other than 
A UTOEX, enter the new file name and then press RETURN 
key to complete the entry. 
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< Test LAN Analyzer > Self Tests 

A brief description of tests performed by the <Test LAN Analyzer> softkey is listed on 
the following pages. This section gives you an overview of the self tests performed on 
the HP 497 lA instrument. A more detailed description is given in the HP 497 lS 
Hard ware Support Manual. 

Hardware boards test status 

The hardware list displayed for <Hardware Functions> Menu shows the status of 
boards after the power-on self test or <Test All Hardware> test is completed. If any 
board fails, the display indicates which board(s) failed. 

LAN receiver hardware: 
LAN Transmitter hardware: 
Dual Port RAM hardware: 
Deep Trapmachine hardware: 

INSTALLED 
INSTALLED 
INSTALLED <· FAILED HARDWARE TEST 
INSTALLED 

Shallow Trapmachine hardware: INSTALLED 

Loss of stored messages and data. 

After you select the <Test Hardware> softkey, a message is displayed to warn you that 
when the self test is performed, any setup menu information, and transmit and receive 
buffer data is lost. Internal memory is used during the hardware tests and any stored 
information is written over. 
The hardware tests give a high degree of assurance that the hardware of the protocol 
analyzer, the Access Unit Interface (AUI) cable, and the Media Access Unit (MAU) are 
working correctly. 

When you run the <Test All Hardware> and <Network Loop Test> softkey tests, you 
have run a very extensive test of the protocol analyzer and its link to the local area 
network (LAN). 

Test LAN Analyzer 
Test ALL Hardware 
Network Loop Test 
Reset MAU 
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<Test All 
Hardware> 

<Network Loop 

Test> 

<Reset MAU> 

softkey runs a self test without having to go through 
the power-on software loading routine. The <Test All 
Hardware> softkey tests the buffer memory more extensively 
than the power-on test. 

Functions tested by this softkey include: 

LAN Receiver 
LAN Transmitter 
Dual Port RAM 

Deep Trap Machine 
Shallow Trap Machine 
Internal Loopback 

After running the <Test All Hardware>self test, if your system 
is connected to a LAN, you may want to perform the 
<Network Loop Test> to also verify that the AUi cable, MAU, 
and the network are functioning. 
softkey causes the protocol analyzer to transmit two frames on 
the network. 
The frames pass through the AUi cable, through the MAU, 
onto the network cable, and then back to the protocol 
analyzer. 

If the received frames are the same as the transmitted frames. 
you have verified operation of the transmit/receive circuitry 
in the protocol analyzer, the AUi cable, the MAU and the fact 
that the network cable is functioning. 

The protocol analyzer resets or initializes the MAU by 
disconnecting the MA U's power for about one second. 
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Running the Self Tests 

When you elect to run the self tests, the protocol analyzer displays status messages 
during the test and at the end of the test. 

During the test. 

During the test, the protocol analyzer displays: 

Testing ( test name ). 

After the test. 

Depending on whether the test passes or fails, the protocol analyzer displays one of the 
messages: 

Pass Name of hardware board: INSTALLED 

Failed Name of hardware board: INSTALLED <- FAILED HARDWARE TEST 

If the test fails. 

Refer to the HP 4971S Hardware Support Manual for trouble shooting information if 
any test fails or, contact your nearest HP Service Office. 
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22 
< Passwords > MENU 

This chapter describes the password features used to control access to HP 497 lS 
Receiver and Transmitter functions. 

This chapter includes: 

• <Passwords> Sof tkey Selections 

• Introduction 

• Changing The Password 

• Storing The Password 

• Securing Receiver Or Transmitter Functions 

• Unsecuring Receiver Or Transmitter Functions 

• Passwords In Other Analyzer Menus 
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< Passwords > SOFTKEY SELECTIONS 

Passwords 

Enter Rev Password 

Secure Receiver 

Enter Xmt Password 

Secure Xmitter 

Change Password 
New Rev Password 

New Xmt Password 

Store New Password 

EXIT 
EXIT 
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WARNING 

The <Passwords> feature works. There is no procedure to 
recover a forgotten password from the protocol analyzer. If 
you forget your password, you must reboot your system 
using the original software supplied with your protocol 
analyzer. 

When a password is saved to the Configuration File, no 
procedure exists to recover the password from the file. 

You should keep a copy of the original software (without 
passwords) in a secure place. Store passwords only on 
working copies of your system software. Another 
suggestion is to record your password on paper and store 
the paper in a secure location. 



Introduction 

<Password> Menu lets you disable or block certain f ea tu res of the HP 497 lS. Two 
primary functions of the protocol analyzer that are disabled by passwords are: 

l. Displaying the data field portion of captured frames. 

2. Sending messages from the protocol analyzer. 

In the <Passwords> Menu, you can suppress displaying the data field portion of 
captured frames. IEEE 802.3/Ethernet headers as well as the HP 497 lS physical headers 
containing frame length and error information can be viewed for network trouble 
shooting. With the password feature enabled, only authorized operators may view 
confidential messages. 

<Passwords> can prevent the HP 497 lS from transmitting messages onto the network. 
Only authorized operators may send frames with the password function enabled. 

NULL Password 

In default mode, that is, no user password has yet been entered. the Receiver and 
Transmitter passwords are both NULL passwords, (all <BLANK> characters). 

The NULL password lets you have full access to reading frame data fields and sending 
messages on the netw9rk. 

Secured Operation 

To secure (disable) either the Receive or Transmit functions. you must define and enter 
a password into the protocol analyzer. 

You can use different passwords to secure the Transmit and Receive functions 
separately, or. if the Receive and Transmit passwords are the same, your password needs 
to be entered only once. 

Saving A Password 

A password can be saved to the Configuration File to cause the protocol analyzer to 
power up in a secured mode each time the power is cycled to ON. 
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Using passwords involves the operations: 

l. Changing a password. 

2. Storing a password. 

3. Securing the receiver and/or the transmitter functions. 

4. Unsecuring the receiver and/or transmitter functions. 

Each of these operations are discussed on the following pages. 

PRACTICE PRACTICE PRACTICE PRACTICE PRACTICE 

You should practice using the password softkeys until you are sure you understand the 
password menu. Use a single character such as "l" or "A" for the password entry. As 
you change or edit the passwords, increment the character to the next value "2" or "B". 

If you forget the password or get confused, it is much quicker and easier to enter single 
characters until you find the password. 

When you are comfortable with the procedures for passwords, then enter longer and 
more complex passwords ( up to eight keyboard characters). 
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Changing The Password 

In default mode, the Receiver and Transmitter passwords are both NULL (all <SPACE> 
characters). To secure the Receiver and/or Transmitter functions, use the <Change 
Password> softkey. 

If another password has been entered, the <Change Password> menu also lets you 
revoke the previous password and enter a new password. 

Enter Rev Secure Enter Xmt Secure Change EXIT 
Password Receiver Password Xmitter Password 

~ 

New Rev New Xmt Store New EXIT 
Password Password Password 

<Change Password> This softkey presents a display to let you enter new passwords. 
The new password can replace the NULL password or, it can 
replace a previously defined password. 

Press <Change Password> softkey to display: 

<Enter New Rev Password> 

Enter Rev 
Password 

Enter Xmt 
Password 

Store New 
Password . 

opens the protocol analyzer to accept a new password for 
Receiver functions. 

<Enter New Xmt Password> 
opens the protocol analyzer to accept a new password for 
Transmitter functions. 
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PROCEDURE TO CHANGE PASSWORDS 

1. From the <Passwords> Menu, press <Change Password> softkey. 

2. Which password do you want to change? Choose one of the following. 

Press <New Rev Password> to change the Receiver password. 

Press <New Xmt Password> to change the Transmitter password. 

3. A. Current password is NULL 

a. 497 lS prompts: Enter your NEW password. C0 •• 8 characters) 

b. Enter up to 8 keyboard characters and press the RETURN key. 

c. 4971 S prompts: Please verify your new password by retyping it. 

d. Enter the new password again and press the RETURN key. 

e. 4971 S displays: Secured (Enter password for access) 
Password changed 

B. Current password is not NULL 

a. 497 lS prompts: Enter your CURRENT password. (0 .. 8 characters) 

b. Enter your current password and press the RETURN key. 

If you enter the wrong password, the HP 4971S prompts: 
INCORRECT PASSWORD 

After you correctly enter the CURRENT password, 

497 lS prompts: Enter. your NEW password. (0 .. 8 characters> 
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c. Enter up to 8 keyboard characters and press the RETURN key. 

d. 497 IS prompts: Please verify your new password by retyping it. 

e. Enter the new password again and press the RETURN key. 

f. 497 IS displays: Password changed 
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Storing The Password 

After a password is changed, you can use the new password to secure Receiver and 
Transmitter functions temporarily or until the power is turned off, 

In order to automatically restore the same password when the power is turned on again, 
you must store or save the password to the Configuration File, CNFG. 

<Store New Password> 
overwrites the new password over the current password on the 
Configuration File, CNFG. 

The Configuration File is located on the LANCOD system 
disc. When you store the password, the protocol analyzer 
looks for the LANCOD disc. The analyzer prompts you to 
install LANCOD if it is not found. 

In systems using only the HP 91220 Dual Disc Drive, you must 
install the LANCOD disc in a disc drive slot. In systems with 
system software loaded on a Winchester disc drive, the 
analyzer finds the LANCOD volume on the hard disc. If two 
LANCOD volumes are found, the analyzer stores the password 
on the volume with the lowest unit number. Floppy disc 
volumes always have a lower number than hard disc volumes. 

<Store New Password> overwrites a new password over a 
previously defined password without disturbing any other 
elements on the configuration file. 

WARNING 

If you define a new password and use the <Save Config.> 
softkey, you overwrite the entire configuration file not just 
the old password. 

Use <Store New Password> when you want to change only 
the password on the configuration file. 
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Securing Receiver Or Transmitter Functions 

You can cause the Receiver and/or Transmitter function to become secured by 
changing to a new password. 

Also. you can use the current password and secure the Receiver and/or Transmitter 
functions with the softkeys <Secure Receiver> and <Secure Transmitter>. 

<Secure Receiver> 

<Secure Xmitter> 

This softkey lets you disable the Receiver function. You can 
not view data fields in any frames received from the network. 

To unsecure or enable the Receiver function, you must press 
the <Enter Rev Password> softkey and enter the current 
password or change the password with <Change Password> 
softkey. 

This softkey lets you disable the Transmitter function. You 
can not transmit frames from the protocol analyzer onto the 
network. 

To unsecure or enable the Transmitter function, you must 
press the <Enter Xmt Password> sof tkey and enter the current 
password or· change the password with <Change Password> 
softkey. 
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Unsecuring Receiver Or Transmitter Functions 

There are two methods to unsecure or remove a password from the Receiver or 
Transmitter functions while you are in the <Passwords> Menu. 

1. Change an existing password to a new name by using the <Change Password> 
softkey. See the section "Changing The Password" in this chapter. 

2. Use the <Enter Rev Password> or <Enter Xmt Password> softkeys to enter the 
current password. 

<Enter Rev Password> 

<Enter Xmt Password> 

Press this softkey and then enter the current Receiver 
password. Press the RETURN key. 

If you correctly enter the password, the HP 497 lS displays: 

Unsecured (Password has been entered) 

Press this softkey and then enter the current Transmitter 
password. Press the RETURN key. 

If you correctly entered the password, the HP 497 lS displays: 

Unsecured (Password has been entered ) 
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Passwords In Other Analyzer Menus 

If a password is used to secure Receive or Transmit functions, the following analyzer 
menus display an error message when you try to view a frame's data field or send a 
message. 

<Edit Filters> Menu 

<Edit Messages> Menu 

<Edit Programs> Menu 

<Examine Data> Menu 

<Printer Functions> Menu 

Receiver Functions 

When a Receiver password is active, the data field portion of received frames is not 
displayed in any analyzer menu. Only the physical header generated by the analyzer 
and the IEEE 802.3/Ethernet headers can be displayed. 

The data field information for each frame is in the protocol analyzer's receive buffer. 
To view the data fields, you must unsecure the Receiver function password. 

Transmitter Functions 

In <Execute Programs> Menu, 'when a Transmitter password is active and a <Send 
Message> command occurs, no message is sent. 

An error message is displayed to alert you that the protocol analyzer can not send 
messages until the Transmitter function password is unsecured. 
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23 
< Set Date > AND < Set Time > MENUS 

This chapter describes how to set the date and time for your protocol analyzer. 

At power up, or any time the power to the HP 4971 A system has been interrupted, the 
date and time should be set. It is important to set date and time so that disc functions 
and time measurement functions that reference the time are accurate. 

This chapter includes: 

• Setting The Date 

• Setting the Time 
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Setting The Date 

PROCEDURE: 

1. From the Top Level Menu, press the <OTHER CHOICES> softkey to 
display softkeys for setting the date and time. 

2. Press <Set Date> softkey. 

Entry format 

The date entry must follow the format: 

day month year 

For example: 

15 jan 87 

Entry values 

(separate each entry with n space) 
(use three letters for month) 

January 15, 1987 

The values you can enter for the day and year must be within the range 
listed below: 

years= => 0 
=< 99 

days= 

3. Press the RETURN key to complete the entry. 

=> l 
=< 31 
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Setting The Time 

PROCEDURE: 

1. From the Top Level Menu, press the <Set Time> softkey. 

Entry format 

2. The time entry must follow the format: 

hour:minute:second (separate each entry with a colon :) 
(use 24 hour entry to denote AM and PM) 

For example: 

9:30:00 = 9:30 AM 

21:30:00 9:30 PM 

Entry values 

The values you enter for the hours, minutes, and seconds must be within the 
ranges listed below: 

hours = => 0 
=< 23 

minutes => 0 
=< 59 

seconds => 0 
=< 59 

3. Press the RETURN key to complete the entry. 
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INDEX 

This index references both volumes of the HP 497 IS Operating Manual. 

Volume! contains chapters 1 through 8, Appendices A-D and a glossary 
Volume II contains chapters 9 through 23 
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10BASE2 
10BASE5 
1500 byte buffer 
480 byte buff er 

<802.2 Format> 
<802.2 Header> 
<802.3 Format> 
<802.3 Header> 
802.3 Frame Protocol 

<Abort Operation> 
Accessories for the HP 497 J A 
Accessories for the HP 497 lS 
Accessory boards, locations 
Access Unit Interface (AUI) 

Active sof tkeys 
<Add Filter> 
<Add Message> 
Address, HP 4971S LAN address 
Address switches, memory boards 
<All Frames> 

Altitude 
<And> 
<And Frame Traits> 
<And Then> 
<Append Nodes> 

ARROW-DOWN key 
ARROW-HOME key 
ARROW-LEFT key 
ARROW-RIGHT key 
ARROW-UP key 

<ASCII 7> 
<ASCH 8/Roman 8> 
ASCII code tables 

A 

6-21, 6-22 
6-14, 6-22 

21-6 
21-6 

12-18 
19-29 
12-17 
19-28 
6-17 

20-4 
2-12 

2-9 
4-32 
6-14 

1-10 
12-10 

13-4 
21-3 
4-34 

14-7, 18-13 

2-7, 3-2 
14-43 

14-14, 14-44 
14-31 
18-15 

1-11 
1-11 
1-11 
1-12 
1-12 

12-16, 13-6, 19-34 
12-16, 19-34 
Appendix B 

Volume I contains chapters 1 through 8, appendices A-D and a glossary. 
Volume II contains chapters 9 through 23. 
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Assigning A Printer 
Assigning The Mass Storage Device: 

Backing up system software 
BACKSPACE key 
Bad FCS 
Baseband 
Baud Rate: 
<Beep> 

<Binary LSB Left> 
<Binary LSB Right> 
<Bin LSB Left> 
<Bin LSB Right> 

Bits/Character: 
<Block l> 
Block structure 
Buff er Memory 

Bus position 
Bus Topology 

B 

Byte position in <Examine Data> Menu 

<Capture Slave> 
Carrier Sense 
<Centered About> 
<Change Data field> 
<Change Filter> 

<Change Headers> 
<Change Password> 
<Change Timestamp> 
<Character Data> 
Character entry 
CLEAR LINE key 
Coaxial Cable 

c 

20-5 
15-13 

5-17 
l-15 

19-5, 19-48 
6-14 
15-4 

14-37 

11-11 
IJ-10 
12-16 
12-16 

15-6 
14-14 
14-24 

7-4 

11-6 
6-10 
19-6 

15-13 
6-15 

14-l l 
19-32 
19-35 

19-26 
22-5 

19-37 
19-33 

l-16 
1-12 
6-11 

Vol~me I contains chapters 1 through 8, appendices A-D and a glossary. 
Volume II contains chapters 9 through 23. 
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Collision 
<Collision Counter> 
Collision Detect 
Collision LED 
<Compress Volume> 
Configuration file 
Control field (IEEE 802.2) 

<Copy Block> 
<Copy Files> 
Copy Files Syntax 
<Copy Filter> 
<Copy Frame> 
Copying <All Files> 
Copying <Analyzer Files> 
Copying <Unique Files> 

<Copy Message> 
<Copy Program> 
Copy system software 
Corrupt Data 
<Counters & Timers> 

<Create New File> 
CSMA 
CS MA/CD 

<Datafield = 0000 ... > 
<Datafield = 0101 ... > 
<Datafield = 1010 ... > 
<Datafield = 11 l l ... > 
Data Field, IEEE 802.3, Ethernet 
<Data Field Pattern> 

<Data File> 
Date (Setting The Date) 
<Date/Time> 
DDCMP: 
DDCMP Buff er size:· 

D 

12-21 
14-29, 14-4 7 

6-15 
16-8, 17-6 

18-27 
18-8 

19-29 

14-38 
18-16 
18-22 
12-19 

13-7 
18-20 
18-18 
18-21 

13-8 
14-39 
5-17 

19-5, 19-47 
19-39 

18-9 
6-15 
6-15 

13-8 
13-8 
13-8 
13-8 

6-19, 19-6 
19-16 

18-10 
5-23, 23-2 

19-38 
15-8, 15-10 

15-9 

Volume I contains Chapters 1 through 8, appendices A-D and a glossary. 
Volume II contains chapters 9 through 23. 
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DDCMP Timeout 
<Define Search> 
<Delete Block> 
<Delete Bytes> 
DELETE CHAR key 

<Delete Field> 
<Delete File> 
<Delete Filter> 
DELETE LINE key 
<Delete Message> 

<Delete Node> 
<Delete Program> 
Destination Address, IEEE 802.3 
<Detailed Format> 
Disabled hand shaking 

Disc Designations 
Disc Drive Numbers 
Disc drives available 
Disc file syntax 
Disc File Type 

<Disc Functions> Menu 
Disc Number or Name 
Disc Sequence Number 
Discs Supplied With System 
<Display> 

<Display Frame> 
Display, installation 
DSAP 

15-9 
19-14 
14-39 

12-15, 13-5 
1-12 

6-15 
18-7 

12-10 
1-12 
13-4 

11-7 
14-5 

6-18, 19-5 
19-18 

15-6 

18-3 
4-25, 4-27, 4-29 

5-3 
18-22 
18-23 

18-1 
5-18 

18-23 
18-4 

14-27 

14-32, 14-50 
4-16 

19-29 

Volume I contains chapters 1 through 8, appendices A-D and a glossary. 
Volume II contains chapters 9 through 23 
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<EBCDIC> 
EBCDIC code table 
<EBCDIC> 
<EBCDIC Entry> 
<Edit All Fields> 

<Edit Config.> 
<Edit Datafiel<l> 
<Edit Filters> 
Editing programs 
Editing With Keyboard Keys 
Edit Message example 
<Edit Messages> 
<Edit Modem Str> 
<Edit New Program?> 

<Edit Nodelist> 
adding stations to list 
deleting stations from list 
searching for a node 
sorting the node list 

<Edit Programs> 

Edit Which Program? 
<Else.If> 
<Else When> 
<Enable 1/0> 

Encoded DDCMP: 
<End Edit> 
<Ending With> 
End of Frame 
<Enter New Rev Password> 
<Enter New Xmit Password> 
<Enter Node Name> 
<Enter Rev Password> 
<Enter Xmit Password> 

E 19-34 
Appendix 8 

13-6 
12-16 
12-12 

15-4 
13-5 

12-1, 12-9, 14-43 
14-24 

l-1 l 
13-12 
13-l 

15-15 
14-4 

1 1-1 
11-5 
11-7 
l l-9 
11-8 
14-1 

14-4 
14-41 

14-41, 14-48 
15-19 

15-8, 15-11 
14-14, 14-31, 14-41 

14-12 
19-36 
22-5 
22-5 

12-11, 13-4 
22-10 
22-10 

Volume I contains chapters 1 through 8, appendices A-D and a glossary. 
Volume II contains chapters 9 through 23. 
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Environment, operating 3-2 
<Error Frame> 19-15 
Error, 1/0 15-20 
Error Messages Appendix A 
<Ethernet> I J-4 
<Ethernet Format> 12-17 
Ethernet, frame 6-20 
<Ethernet Header> 19-28 

<Examine Data> 19-1 
Examine Data Display 19-2 

Byte Position 19-6 
Data 19-6 
Destination Address 19-5 
Error 19-5 
Filters 19-4 
Frame Number 19-2 
Message Length 19-3 
Source Address 19-7 
Time Stamp 19-3 
Type 19-7 

<Execute Program> 16-1 
<EXIT> 20-15 

F 
FCS, Bad, Good 12-21 
FCS, selecting an FCS value 13-12 
FCS Field, IEEE 802.3 6-19 
Files, name syntax 18-22 
File space available 18-5 
File type 18-6 
Filter examples 12-24 

Volume I contains chapters 1 through 8, appendices A-D and a glossary. 
Volume II contains chapters 9 through 23. 
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<Filter Format> 
Filter, introduction 
Filter length 
<Filter Matched> 
<Find Block> 
Finding Frames 

<Followed By> 
<Format As Filter #> 

<Format Volume> 

Formatting (Initializing) a Floppy Disc 
Formatting (initializing) a hard disc 
Formatting volumes 
Frame Acquisition vs Display Speed 
<Frame Counter> 
Frame Errors 
Frame filter, Runt 
<Frame Matches> 
Frame match operation precedence 
Frame Number 
<Frames Matching> 
Fuses 

<Go To Block> 
<Go To Byte> 
<Go To Frame #> 
<Go To Trigger> 

<HARDSC (#13)> 

G 

H 

<HARDWARE FUNCTIONS> MENU 
Hardware Handshake: 
<Hex> 
<Hex Data> 
<Hex/Char Data> 
<Hex Entry> 
HP-18 Cables, installation 
HP-18 Cables, part numbers 
Humidity 

19-21 
7-6, 12-2 

12-22 
19-15 
14-38 
19-10 

14-36 
13-9 

18-25 

5-17, 18-25 
5-9' 5-13, 5-15 

18-25 
16-2 

14-29, ] 4-46 
19-42 
21-4 

14-43 
14-44 

17-9, 19-2 
14-7 
4-6 

14-32 
13-7 

19-11 
19-13 

5-10 
21-1 
15-6 
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